
Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

W niniejszym podręczniku opisano konfigurację i działanie kamery Interchangeable Lens Digital Camera ILME-
FR7/ILME-FR7K.

Należy zapoznać się z niniejszą instrukcją obsługi i w razie potrzeby instrukcjami obsługi powiązanych urządzeń.

Informacje ogólne

Typowe zastosowania

Konfiguracja systemu

Sterowanie pojedynczym urządzeniem za pomocą dołączonego do zestawu pilota zdalnego sterowania na
podczerwień

Sterowanie pojedynczym urządzeniem przy użyciu tabletu lub komputera

Sterowanie pojedynczym urządzeniem przy użyciu zewnętrznego pilota zdalnego sterowania

Sterowanie wieloma urządzeniami przy użyciu zewnętrznego pilota zdalnego sterowania

Położenie i funkcje elementów

Widok z przodu

Widok z tyłu

Blok złączy

Widok z boku

Widok z góry

Widok z dołu

Wspornik obiektywu

Umiejscowienie i funkcja poszczególnych elementów pilota zdalnego sterowania ma podczerwień (w
zestawie)

Ekran aplikacji internetowej

Omówienie ekranu aplikacji internetowej

Struktura wspólnego obszaru ekranów

Struktura ekranu sterowania w czasie rzeczywistym

Struktura ekranu operacji odtwarzania
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Przygotowanie

Struktura ekranu ustawień

Menu kamery

Ekran kamery

Montaż urządzenia

Montaż pionowy w stałym miejscu

Montaż pionowy w wysoko położonym stałym miejscu

Montaż na suficie

Mocowanie/zdejmowanie obiektywu

Zalecenia eksploatacyjne dotyczące mocowania/zdejmowania obiektywu

Sprawdzanie przełączników obiektywu

Zalecenia eksploatacyjne dotyczące korzystania z obiektywu zmiennoogniskowego

Mocowanie obiektywu

Odłączanie obiektywu

Kable połączeniowe

Podłączanie urządzenia do urządzenia sieciowego za pomocą połączenia przewodowego

Podłączanie zasilania

Zasilanie prądem przemiennym

Korzystanie z zasilania PoE++

Resetowanie obrotu w poziomie/pionie

Konfigurowanie przed rozpoczęciem filmowania

Inicjalizacja urządzenia za pomocą aplikacji internetowej

Uzyskiwanie dostępu do aplikacji internetowej z poziomu przeglądarki internetowej

Inicjalizacja urządzenia

Konfigurowanie podstawowych ustawień

Przygotowanie karty pamięci

Obsługiwane karty pamięci

Wkładanie kart pamięci
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Filmowanie

Wyjmowanie karty pamięci

Formatowanie (inicjalizacja) kart pamięci

Sprawdzanie pozostałego czasu nagrywania

Przywracanie kart pamięci

Podstawowe działania

Rozpoczynanie/zatrzymywanie nagrywania

Przełączanie między kartami pamięci

Sprawdzanie ustawień sygnału audio

Określanie danych dotyczących czasu

Przeglądanie nagrania (funkcja Rec Review)

Kadrowanie

Ekran kadrowania

Dostosowywanie kierunku filmowania

Dostosowywanie kierunku filmowania za pomocą aplikacji internetowej

Ustawianie prędkości obrotu w poziomie/pionie

Ustawianie przyspieszenia operacji obrotu w poziomie/pionie

Dostosowywanie kierunku filmowania za pomocą dołączonego do zestawu pilota zdalnego sterowania na podczerwień

Regulacja zoomu

Ustawianie typu zoomu

Dostosowywanie zoomu za pomocą aplikacji internetowej

Ustawianie szybkości działania zoomu

Regulacja zoomu za pomocą dołączonego do zestawu pilota zdalnego sterowania na podczerwień

Zapisywanie/przywracanie kąta obrotu w poziomie/pionie i pozycji zoomu (ustawienia wstępnego położenia)

Kalibracja obiektywu z mocowaniem typu E

Zapisywanie/przywracanie kąta obrotu w poziomie/pionie, pozycji zoomu i ustawienia ostrości za pomocą aplikacji internetowej

Zmienianie nazw ustawień wstępnych położenia za pomocą aplikacji internetowej

Zastępowanie zapisanego ustawienia wstępnego położenia nowym położeniem za pomocą aplikacji internetowej

Usuwanie zapisanego ustawienia wstępnego położenia za pomocą aplikacji internetowej
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Synchronizacja operacji obrotu w poziomie/pionie oraz operacji regulacji zoomu/ostrości podczas przywracania ustawienia
wstępnego położenia

Zmienianie szybkości przejścia (obrót w poziomie/pionie, zoom, ostrość) podczas przywracania ustawienia wstępnego położenia

Zapisywanie/przywracanie kąta obrotu w poziomie/pionie i pozycji zoomu za pomocą dołączonego do zestawu pilota zdalnego
sterowania na podczerwień

Rejestrowanie/odtwarzanie operacji kadrowania wykonywanych przez kamerę (funkcja PTZ Trace)

Rejestrowanie operacji kadrowania wykonywanych przez kamerę przy użyciu aplikacji internetowej

Odtwarzanie operacji kadrowania wykonywanych przez kamerę przy użyciu aplikacji internetowej

Usuwanie zarejestrowanych operacji kadrowania wykonywanych przez kamerę przy użyciu aplikacji internetowej

Rejestrowanie operacji kadrowania wykonywanych przez kamerę za pomocą dołączonego do zestawu pilota zdalnego sterowania
na podczerwień

Odtwarzanie operacji kadrowania wykonywanych przez kamerę za pomocą dołączonego do zestawu pilota zdalnego sterowania
na podczerwień

Regulacja ostrości

Ekran regulacji ostrości

Ręczna regulacja ostrości (ustawienie Manual Focus)

Ręczne ustawianie ostrości za pomocą aplikacji internetowej

Ręczne ustawianie ostrości za pomocą dołączonego do zestawu pilota zdalnego sterowania na podczerwień

Ustawianie ostrości poprzez określenie pozycji ustawiania ostrości (ustawienie Spot Focus)

Tymczasowe korzystanie z funkcji automatycznej regulacji ostrości (ustawienie Push Auto Focus (AF))

Korzystanie z automatycznej regulacji ostrości przy jednym ujęciu (ustawienie Push Auto Focus (AF-S))

Automatyczna regulacja ostrości (ustawienie Auto Focus)

Automatyczna regulacja za pomocą aplikacji internetowej

Automatyczne ustawianie ostrości za pomocą dołączonego do zestawu pilota zdalnego sterowania na podczerwień

Ustawianie obszaru automatycznej regulacji ostrości oraz jego położenia (ustawienie Focus Area)

Szybka zmiana obszaru regulacji ostrości (ustawienie Focus Setting)

Przesuwanie ramki obszaru regulacji ostrości za pomocą dotyku (obszar regulacji ostrości za pomocą dotyku)

Dostosowywanie działania funkcji automatycznej regulacji ostrości (szybkość przejścia w trybie AF, czułość zmiany obiektu w trybie
AF)

Ręczne określanie obiektu, na którym ma być automatycznie ustawiana ostrość (ustawienie AF Assist), za pomocą aplikacji
internetowej

Ręczna regulacja ostrości podczas automatycznego ustawiania ostrości za pomocą dołączonego do zestawu pilota zdalnego
sterowania na podczerwień
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Tymczasowe korzystanie z funkcji ręcznej regulacji ostrości podczas automatycznej regulacji ostrości (ustawienie Push Manual
Focus)

Śledzenia przy użyciu funkcji wykrywania twarzy i oczu (ustawienie Face/Eye Detection AF)

Śledzenie określonego obiektu (funkcja Realtime Tracking AF)

Regulacja jasności

Ekran regulacji jasności

Ustawianie czułości podstawowej

Ustawianie docelowego poziomu automatycznej regulacji jasności

Regulacja przysłony

Automatyczna regulacja przysłony

Ręczna regulacja przysłony

Regulacja wzmocnienia

Automatyczna regulacja wzmocnienia

Ręczna regulacja wzmocnienia

Dostosowywanie ustawień migawki

Automatyczne dostosowywanie ustawienia migawki

Ręczne dostosowywanie ustawienia migawki

Regulacja poziomu światła (filtr ND)

Informacje dotyczące filtra ND

Regulacja w trybie ustawień wstępnych

Regulacja automatyczna w trybie zmiennym

Regulacja ręczna w trybie zmiennym

Regulacja w celu uzyskania naturalnych kolorów (balans bieli)

Ekran regulacji balansu bieli

Automatyczna regulacja balansu bieli

Ręczna regulacja balansu bieli

Uruchomianie funkcji automatycznego balansu bieli

Konfigurowanie dźwięku do nagrywania

Ekran konfigurowania dźwięku
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Przydatne funkcje

Wybór wejściowego urządzenia audio

Automatyczna regulacja poziomu nagrywania dźwięku

Ręczna regulacja poziomu nagrywania dźwięku

Korzystanie z menu bezpośredniego

Przyciski konfigurowalne

Zwolnione/przyspieszone tempo

Nagrywanie interwałowe (Interval Rec)

Nagrywanie obrazu z pamięci podręcznej (Picture Cache Rec)

Jednoczesne nagrywanie na karty pamięci A i B (nagrywanie jednoczesne przy użyciu dwóch gniazd)

Monitor sygnału wideo

Znaczniki klipów

Kompensacja efektu „oddychania” obiektywu

Nagrywanie pomocnicze

Informacje ogólne na temat nagrywania pomocniczego

Nagrywanie pliku nagrywania pomocniczego

Filmowanie z odpowiednim wyglądem

Informacje ogólne dotyczące wyglądu

Wybieranie wyglądu

Importowanie wyglądu podstawowego

Dostosowywanie wyglądu

Zapisywanie wyglądu

Usuwanie wyglądu podstawowego

Filmowanie z korektą wyglądu na etapie postprodukcji

Filmowanie z korektą wyglądu na etapie postprodukcji

Stosowanie ustawienia LUT do wyjścia HDMI i przesyłania strumieniowego

Zmienianie tablicy LUT

Zmienianie rozmieszczenia ciemnych i jasnych obszarów na nagranym obrazie
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Funkcje sieciowe

Ekran miniatur

Nagrywanie w formacie RAW

Nagrywanie wideo w formacie RAW

Nagrywanie wideo w formacie RAW w trybie zwolnionego/przyspieszonego tempa

Regulacja efektu bokeh (funkcja sterowania efektem bokeh)

Włączanie/wyłączanie funkcji sterowania efektem bokeh

Dostosowywanie poziomu efektu bokeh

Zapisywanie i wczytywanie danych konfiguracyjnych

Informacje ogólne na temat zapisywania i wczytywania danych konfiguracyjnych

Zapisywanie pliku ALL

Wczytywanie pliku ALL

Przesyłanie plików

Informacje na temat funkcji transferu plików

Rejestrowanie miejsca docelowego transferu plików

Wybieranie i przesyłanie pliku

Przesyłanie pliku nagrywania pomocniczego na kartę pamięci z poziomu ekranu miniatur

Przesyłanie oryginalnego pliku na kartę pamięci z poziomu ekranu miniatur

Sprawdzanie stanu transferu plików

Przesyłanie za pomocą bezpiecznego protokołu FTP

Konfigurowanie ustawień przesyłania strumieniowego

Informacje dotyczące przesyłania strumieniowego

Ustawianie formatu przesyłania strumieniowego

Ustawianie kodeka wideo do przesyłania strumieniowego

Ustawianie kodeka audio do przesyłania strumieniowego

Rozpoczynanie/zatrzymywanie przesyłania strumieniowego

Ekran miniatur

Odtwarzanie klipów i inne operacje na klipach

7



Menu kamery i ustawienia szczegółowe

Odtwarzanie nagranych klipów

Operacje na nagranych klipach

Konfiguracja menu kamery

Korzystanie z menu kamery

Korzystanie z menu kamery

Wprowadzanie ciągu znaków

Menu User

User

Menu Edit User

Edit User

Menu Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Menu Project

Base Setting
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Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Menu Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Menu Pan-Tilt

P/T Acceleration

Menu TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life
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Menu Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Menu Audio

Audio Input

Audio Output

Menu Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Menu Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Menu Network

Wired LAN

File Transfer
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Menu internetowe i ustawienia szczegółowe

Menu Maintenance

Language

Clock Set

Hours Meter

Ustawienia menu Shooting i ich wartości domyślne

Ustawienia ISO/Gain i ich wartości domyślne

Ustawienia AGC Limit i ich wartości domyślne

Ustawienia jakości obrazu zapisane dla każdego trybu filmowania

Konfiguracja menu internetowego

Operacje w menu internetowym

Menu Shooting

Focus

Menu Project

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Menu Paint/Look

Base Look

Menu Pan-Tilt

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction
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P/T Preset

Menu Monitoring

Output Format

Output Display

Menu Audio

Audio Input

Audio Output

Menu Technical

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Menu Network

Camera Name

User

Wired LAN

File Transfer

FTP Server 1–3

SSL

Referer Check

Brute Force Attack Protection

Menu Stream

Stream

Video Stream

Audio Stream

Menu Maintenance

Language
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Podłączanie urządzeń zewnętrznych

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software

Podłączanie zewnętrznych monitorów i urządzeń nagrywających

Podłączenie jednostki RCP/MSU (do nabycia osobno)

Łączenie z jednostką RCP/MSU

Połączenie indywidualne między urządzeniem a jednostką RCP

Korzystanie z urządzenia w środowisku z wieloma kamerami z jednostką MSU / oprogramowaniem do zdalnego
sterowania kamerami

Lista obsługiwanych funkcji

Obsługa za pomocą pilota zdalnego sterowania RM-IP500 (do nabycia osobno)

Informacje o obsłudze za pomocą pilota zdalnego sterowania RM-IP500 (do nabycia osobno)

Podłączanie pilota zdalnego sterowania RM-IP500

Synchronizacja z urządzeniem zewnętrznym

Informacje o synchronizacji z urządzeniem zewnętrznym

Synchronizacja fazy sygnałów wideo (Genlock)

Synchronizowanie kodu czasowego z innymi urządzeniami

Podłączanie mikrofonu zewnętrznego lub zewnętrznego urządzenia audio

Zarządzanie klipami i ich edytowanie za pomocą komputera

Wyprowadzanie sygnału światłowodowego

Doprowadzanie sygnału lampki typu Tally

Przesyłanie danych śledzenia (free-d)
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Załącznik

5-041-958-33(1) Copyright 2022 Sony Corporation

Podłączanie sterownika obiektywu

Dostosowywanie zoomu za pomocą sterownika obiektywu

Zalecenia eksploatacyjne

Formaty wyjściowe i ograniczenia

Rozwiązywanie problemów

Komunikaty o błędach / komunikaty ostrzegawcze

Lista pozycji menu

Zapisane ustawienia wstępne położenia

Schematy blokowe

Aktualizacja oprogramowania obiektywu z mocowaniem typu E

Mocowanie osłony przycisku zwalniania obiektywu

Licencje

Dane techniczne

Znaki towarowe
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Konfiguracja systemu

Urządzenie można połączyć z urządzeniami peryferyjnymi w celu utworzenia różnych konfiguracji systemu.

Obiektyw z mocowaniem typu E1.

LA-EA3/LA-EA4 — adapter mocowania typu A2.

Pilot zdalnego sterowania ma podczerwień (w zestawie)3.

Karty pamięci CFexpress typu A / karty pamięci SDXC4.

Czytnik kart CFexpress typu A / czytnik kart SD5.

Mikrofon ECM-680S, ECM-678*, ECM-674*6.
Wymagany jest kabel XLR EC-0.5X3F5M z przejściówką z 3-styków na 5-styków.*

Zasilacz sieciowy (w zestawie)7.

Monitor8.

Pilot zdalnego sterowania RM-IP5009.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sterowanie pojedynczym urządzeniem za pomocą dołączonego do zestawu pilota
zdalnego sterowania na podczerwień

Za pomocą dołączonego do zestawu pilota zdalnego sterowania na podczerwień można sterować zdalnie jednym
urządzeniem.

 sygnał wideo
 kierunek sygnału

5-041-958-33(1) Copyright 2022 Sony Corporation

Pilot zdalnego sterowania ma podczerwień (w zestawie)1.

Monitor2.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sterowanie pojedynczym urządzeniem przy użyciu tabletu lub komputera

Urządzenie można połączyć z tabletem lub komputerem, a następnie z urządzeniem sterującym za pomocą przeglądarki
internetowej.

 sygnał wideo
 sygnał zdalnego sterowania

  kierunek sygnału

5-041-958-33(1) Copyright 2022 Sony Corporation

Monitor1.

Tablet2.

Komputer3.

Punkt dostępu4.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sterowanie pojedynczym urządzeniem przy użyciu zewnętrznego pilota zdalnego
sterowania

Urządzeniem można sterować zdalnie za pomocą pilota zdalnego sterowania.

 sygnał wideo
 sygnał zdalnego sterowania

  kierunek sygnału

5-041-958-33(1) Copyright 2022 Sony Corporation

Monitor1.

Pilot zdalnego sterowania RM-IP5002.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sterowanie wieloma urządzeniami przy użyciu zewnętrznego pilota zdalnego
sterowania

Za pomocą jednego pilota zdalnego sterowania można sterować zdalnie maksymalnie 100 urządzeniami.

 sygnał wideo
 sygnał zdalnego sterowania
 sygnał lampki typu Tally / sygnał ze styków

  kierunek sygnału

5-041-958-33(1) Copyright 2022 Sony Corporation

Monitor1.

Mikser wideo2.

Koncentrator sieciowy3.

Pilot zdalnego sterowania RM-IP5004.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Widok z przodu

W tym temacie opisano umiejscowienie i funkcję poszczególnych elementów znajdujących się z przodu urządzenia.

Wskazówka

Ten opis odnosi się do ilustracji przedstawiającej urządzenie bez zamocowanego obiektywu.

Głowica kamery

Uwaga

Nie narażać głowicy kamery na silne wstrząsy.

1.

Kontrolka nagrywania (lampka typu Tally)
Jeśli jest skonfigurowana jako kontrolka nagrywania, świeci na czerwono podczas nagrywania na karcie pamięci.
Kontrolka miga, gdy ilość wolnego miejsca na nośniku do nagrywania jest niska lub wystąpi błąd.

2.
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Szczegółowe informacje na ten temat podano w sekcji „Komunikaty o błędach / komunikaty ostrzegawcze”.

Jeśli jest skonfigurowana jako lampka typu Tally, świeci na czerwono lub zielono zgodnie z zewnętrznym sygnałem
lampki typu Tally.

Szczegółowe informacje na ten temat podano w sekcji „Doprowadzanie sygnału lampki typu Tally”.
Przetwornik obrazu

Uwaga

Nie dotykać bezpośrednio rękami.

3.

Przycisk zwalniania obiektywu
Naciśnij ten przycisk, aby odłączyć obiektyw.

Szczegółowe informacje na ten temat podano w sekcji „Odłączanie obiektywu”.

4.

Styki sygnałowe obiektywu

Uwaga

Nie dotykać bezpośrednio rękami.

5.

Kontrolka POWER6.

Kontrolka NETWORK
Stan urządzenia jest wskazywany przez kombinację kolorów i stanu (świecenie, miganie, wyłączenie) kontrolek
POWER i NETWORK.

7.

Kontrolka POWER Kontrolka
NETWORK Stan urządzenia

Świeci na zielono*1

Świeci na
zielono

Włączone (połączono siecią)

Wyłączona Włączone (nie połączono siecią)

Miga na zielono Wyłączona Trwa włączanie zasilania

Świeci na
pomarańczowo

Wyłączona Stan zasilania w trybie gotowości

Miga na żółto Wyłączona Trwa aktualizacja oprogramowania

Miga powoli na
pomarańczowo*2

Miga powoli
na zielono*2

Urządzenie nie może działać normalnie. Szczegółowe informacje podano
w dzienniku systemowym. Jeśli problem nie ustąpi nawet po przełączeniu
urządzenia do trybu gotowości lub wyłączeniu i ponownym włączeniu
zasilania, należy skontaktować się z przedstawicielem serwisu firmy Sony.

Miga szybko na
pomarańczowo*3

Miga szybko
na zielono*3

W urządzeniu wystąpiła usterka. Należy skontaktować się z
przedstawicielem serwisu firmy Sony.

Miga na zielono po odebraniu polecenia z dołączonego do zestawu pilota na podczerwień.*1

Miga powoli: Miga raz na sekundę*2

Miga szybko: Miga cztery razy na sekundę*3

Czujnik pilota zdalnego sterowania
Służy do odbierania sygnału sterującego z dołączonego do zestawu pilota zdalnego sterowania na podczerwień.

8.
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Powiązany temat

Komunikaty o błędach / komunikaty ostrzegawcze

Doprowadzanie sygnału lampki typu Tally

Odłączanie obiektywu

5-041-958-33(1) Copyright 2022 Sony Corporation

Wlot powietrza

Uwaga

Nie blokować przepływu powietrza. W przeciwnym razie może dojść do awarii.

9.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Widok z tyłu

W tym temacie opisano umiejscowienie i funkcję poszczególnych elementów znajdujących się z tyłu urządzenia.

Powiązany temat

Widok z boku

5-041-958-33(1) Copyright 2022 Sony Corporation

Dźwignia blokady głowicy kamery
Blokuje ruch głowicy kamery do przodu / do tyłu.

Uwaga

Jeśli nie zmienia się obiektywu, dźwignia powinna być zawsze ustawiona w położeniu blokady.

Podczas transportu urządzenia należy zawsze zdjąć obiektyw i przestawić dźwignię w położenie blokady.

Przed użyciem suwaka blokady obrotu w poziomie/pionie wyłącz zasilanie urządzenia i zablokuj głowicę kamery w położeniu
poziomym za pomocą suwaka blokady obrotu w poziomie/pionie, aby zapobiec obrażeniom, które mogą powstać w wyniku
przytrzaśnięcia palców. Szczegółowe informacje na temat suwaka blokady obrotu w poziomie/pionie podano w sekcji „Suwak
blokady obrotu w poziomie/pionie” w rozdziale „Widok z boku”.

1.

Podstawa do przesuwania2.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Blok złączy

W tym temacie opisano umiejscowienie i funkcję poszczególnych elementów znajdujących się w bloku złączy
urządzenia.

 Złącze uziemienia
Należy połączyć z masą, podłączając do uziemienia w gniazdku elektrycznym lub do pręta uziemiającego.

1.

Złącze DC IN (standardowe gniazdo DC)
Należy podłączyć do zasilacza sieciowego.

Uwaga

Nie używać zasilacza innego niż dołączony do zestawu. Podłączenie innego zasilacza może spowodować pożar lub awarię.

2.

Złącze  LAN (sieciowe) typu RJ-45
Należy podłączyć kabel sieciowy (kategorii 5e lub wyższej) służący do komunikacji sieciowej oraz zasilania PoE++*.

Stan kontrolki szybkości połączenia
Wskazuje szybkość połączenia sieciowego.

3.

PoE++: Power over Ethernet Plus Plus. Zgodność ze standardem IEEE802.3bt (typ 4, klasa 8). Szczegółowe informacje dotyczące
podłączania można znaleźć w instrukcji obsługi urządzenia zasilającego.

*
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Stan kontrolki Link/ACT
Wskazuje stan połączenia sieciowego.

Uwaga

Po podłączeniu tego produktu do Internetu należy nawiązać połączenie za pośrednictwem systemu, który zapewnia funkcje
zabezpieczające, takiego jak router lub zapora internetowa. W przypadku połączenia bez takiego zabezpieczenia mogą
wystąpić problemy z bezpieczeństwem.

Stan kontrolki Szybkość połączenia

Wyłączona
10 Mb/s

100 Mb/s

Świeci na pomarańczowo 1000 Mb/s

Stan kontrolki Stan połączenia

 Wyłączona Brak połączenia

Miga na zielono Połączenie nawiązane, transmisja danych aktywna

Świeci na zielono Połączenie aktywne

Złącze TC IN
Służy do wprowadzania zewnętrznego sygnału referencyjnego kodu czasowego.

Szczegółowe informacje na ten temat podano w sekcji „Synchronizowanie kodu czasowego z innymi
urządzeniami”.

4.

Złącze HDMI
Służy do wyprowadzania obrazu z urządzenia w postaci sygnału HDMI.

Szczegółowe informacje na ten temat podano w sekcji „Złącze HDMI (typu A)” w rozdziale „Podłączanie
zewnętrznych monitorów i urządzeń nagrywających”.

5.

Wkręt montażowy płytki mocującej do kabla HDMI
Aby zapobiec odłączeniu kabla HDMI, należy przymocować dołączoną do zestawu płytkę mocującą kabel HDMI za
pomocą wkręta montażowego (M2.6×6, w zestawie) i zamocować do niej kabel HDMI za pomocą dostępnej na rynku
opaski kablowej lub taśmy.

Szczegółowe informacje na temat mocowania płytki mocującej do kabla HDMI podano w sekcji „Kable
połączeniowe”.

6.

Złącze OPTION
Służy do doprowadzanie sygnału lampki typu Tally z urządzenia zewnętrznego lub sterownika obiektywu.

Szczegółowe informacje na ten temat podano w sekcjach „Doprowadzanie sygnału lampki typu Tally” oraz
„Podłączanie sterownika obiektywu”.

7.

Uchwyt kablowy
Służy do zabezpieczenia przewodu zasilacza sieciowego.

8.

Przełącznik RESET
Naciśnij przełącznik i przytrzymaj go przez co najmniej 5 sekund, używając końcówki długopisu lub podobnego
przedmiotu, aby przywrócić domyślne wartości fabryczne urządzenia.

9.
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Za pomocą przełącznika 1 w sekcji SETUP można określić, czy chce się zresetować tylko ustawienia połączenia
sieciowego, czy wszystkie ustawienia.
Złącze wyjściowe OPTICAL
Umożliwia wyprowadzanie sygnału SDI konwertowanego na format optyczny w przypadku podłączenia modułu SFP+
(do nabycia osobno).

Szczegółowe informacje na temat podano w sekcji „Wyprowadzanie sygnału światłowodowego”.

10.

Sekcja przełączników SETUP

Umożliwia skonfigurowanie podanych poniżej ustawień.
Przełącznik 1: określa, które ustawienia są resetowane po naciśnięciu przełącznika RESET.

Przełącznik 2: określa, czy zasilanie +48 V (zasilanie Phantom) jest włączane/wyłączane po podłączeniu urządzenia
wejściowego audio. Ustawienie jest stosowane natychmiast.
Ta funkcja jest dostępna, gdy opcja [Audio] > [Audio Input] > [AUDIO IN Select] jest ustawiona na [MIC] w menu
kamery.

Uwaga

Przestawienie przełącznika 2 w położenie ON i podłączenie mikrofonu, który nie jest zgodny ze źródłem +48 V, może
spowodować uszkodzenie podłączonego urządzenia. Należy sprawdzić ustawienie przed podłączeniem urządzenia.

Przełącznik 3: włączanie/wyłączanie komunikacji VISCA over IP. Ustawienia są stosowane po włączeniu kamery.
Przestaw przełącznik w położenie ON, aby korzystać z urządzenia z podłączonym pilotem zdalnego sterowania (RM-
IP500).

11.

Ustawienie Opis

OFF
(domyślne)

Resetowane są tylko ustawienia połączenia sieciowego. Ustawienia sieciowe, ustawienia
zabezpieczeń urządzenia i informacje o użytkowniku (nazwa użytkownika i hasło) zostaną
zresetowane.

ON Przywracany jest domyślny stan fabryczny wszystkich ustawień.

Ustawienie Opis

OFF
(domyślne)

Zasilanie +48 V (zasilanie Phantom) nie jest doprowadzane. Ustawienie to należy skonfigurować w
przypadku korzystania z zewnętrznego urządzenia audio (np. miksera), mikrofonu dynamicznego
lub mikrofonu z wbudowanym akumulatorem.

ON
Zasilanie +48 V (zasilanie Phantom) jest doprowadzane do mikrofonu zgodnego z zasilaniem
Phantom podłączonego do złącza AUDIO IN (CH-1 lub CH-2).

Ustawienie Opis

OFF (domyślne) Urządzenie nie reaguje na polecenia protokołu VISCA over IP.

ON Urządzenie akceptuje polecenia protokołu VISCA over IP.
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Powiązany temat
Synchronizowanie kodu czasowego z innymi urządzeniami

Podłączanie zewnętrznych monitorów i urządzeń nagrywających

Kable połączeniowe

Doprowadzanie sygnału lampki typu Tally

Podłączanie sterownika obiektywu

Wyprowadzanie sygnału światłowodowego

Inicjalizacja urządzenia

Synchronizacja fazy sygnałów wideo (Genlock)

Uwaga

Jeśli hasło administratora nie zostało skonfigurowane, komunikacja VISCA over IP jest wyłączona — niezależnie od
ustawienia przełącznika. Szczegółowe informacje na temat konfigurowania hasła administratora podano w sekcji „Inicjalizacja
urządzenia”.

Przełącznik 4: umożliwia zmianę prędkości obrotu w poziomie/pionie za pomocą pilota zdalnego sterowania na
podczerwień. Ustawienie jest stosowane natychmiast.

Ustawienie Opis

OFF (domyślne) Działanie z normalną prędkością.

ON Działanie z maksymalną prędkością.

Złącze SDI OUT
Służy do wyprowadzania obrazu z urządzenia w postaci sygnału 12G/6G/3G/HD-SDI.
Urządzenie można również skonfigurować do wyprowadzania sygnału RAW.

Szczegółowe informacje na ten temat podano w sekcji „Złącze SDI OUT (typu BNC)” w rozdziale „Podłączanie
zewnętrznych monitorów i urządzeń nagrywających”.

12.

 Czujnik pilota zdalnego sterowania ma podczerwień (tylny)
Czujnik podczerwieni do dołączonego do zestawu pilota zdalnego sterowania na podczerwień.

13.

Wentylator / wylot powietrza
Odprowadza ciepło z wnętrza urządzenia.

Uwaga

Nie zakrywać wylotu powietrza. W przeciwnym razie może dojść do awarii.

Obszar w pobliżu wylotu powietrza może się nagrzewać.

14.

Złącze GENLOCK
Służy do wprowadzania zewnętrznego sygnału synchronizacyjnego.

Szczegółowe informacje na ten temat można znaleźć w sekcji „Synchronizacja fazy sygnałów wideo (Genlock)”.

15.

Złącze AUDIO IN (5-stykowe złącze typu XLR)
Służy do wprowadzania sygnału z zewnętrznego mikrofonu lub urządzenia audio.
Pełni funkcję złącza AUDIO IN CH-1 lub AUDIO IN CH-2.

Szczegółowe informacje na ten temat podano w sekcji „Podłączanie mikrofonu zewnętrznego lub zewnętrznego
urządzenia audio”.

16.
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Podłączanie mikrofonu zewnętrznego lub zewnętrznego urządzenia audio

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Widok z boku

W tym temacie opisano umiejscowienie i funkcję poszczególnych elementów znajdujących się z boku urządzenia.

Wskazówka

Ten opis odnosi się do ilustracji przedstawiającej urządzenie bez zamocowanego obiektywu.

Suwak blokady obrotu w poziomie/pionie
Służy do blokowania mechanizmu obrotu w poziomie/pionie. Używać w podanych poniżej przypadkach.

Podczas transportu lub pakowania urządzenia.
Podczas mocowania lub odłączania obiektywu. Szczegółowe informacje na ten temat podano w sekcjach
„Mocowanie obiektywu” i „Odłączanie obiektywu”.
W przypadku korzystania z obiektywu, który nie obsługuje funkcji obrotu w poziomie/pionie (np. obiektywów
SEL100400GM / SEL200600G / SEL400F28GM / SEL600F40GM firmy Sony).
Podczas transportu urządzenia należy zawsze zdjąć obiektyw i przestawić dźwignię w położenie blokady.

1.
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Powiązany temat

Mocowanie obiektywu

Odłączanie obiektywu

Wkładanie kart pamięci

Uzyskiwanie dostępu do aplikacji internetowej z poziomu przeglądarki internetowej

5-041-958-33(1) Copyright 2022 Sony Corporation

Wskazówka

Obrót w poziomie/pionie można ustawić na podane poniżej kąty.

Podstawa do przesuwania2.

Otwory pod wkręty do mocowania urządzeń zewnętrznych (w 4 miejscach)
Pod wkręty M3 o długości do 6 mm.

Uwaga

Nie używać wkrętów o długości większej niż 6 mm. W przeciwnym razie może dojść do awarii.

3.

Wskaźnik dostępu A4.

Wskaźnik dostępu B
Wskaźnik świeci lub miga po włożeniu nośnika do nagrywania.

Szczegółowe informacje na ten temat podano w sekcji „Wkładanie kart pamięci”.

5.

Gniazdo na karty CFexpress typu A / karty SD (A)6.

Gniazdo na karty CFexpress typu A / karty SD (B)
Służy do wkładania nośników do nagrywania.

Szczegółowe informacje na ten temat podano w sekcji „Wkładanie kart pamięci”.

7.

Kod QR używany do nawiązania połączenia sieciowego
Należy z niego skorzystać podczas konfigurowania ustawień początkowych.

Szczegółowe informacje na ten temat podano w sekcji „Uzyskiwanie dostępu do aplikacji internetowej z poziomu
przeglądarki internetowej”.

8.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Widok z góry

W tym temacie opisano umiejscowienie i funkcję poszczególnych elementów znajdujących się w górnej części
urządzenia.

Wskazówka

Ten opis odnosi się do ilustracji przedstawiającej urządzenie bez zamocowanego obiektywu.

5-041-958-33(1) Copyright 2022 Sony Corporation

Otwory pod wkręty do mocowania urządzeń zewnętrznych (w 2 miejscach)
Zgodne z wkrętami 1/4-20 UNC do mocowania statywu.
Maksymalna długość: 6 mm.

1.

ɸ (symbol przetwornika obrazu)
Symbol przetwornika obrazu znajduje się w tej samej płaszczyźnie co przetwornik obrazu.
Aby dokładnie zmierzyć odległość między urządzeniem a obiektem, należy użyć tego symbolu przetwornika obrazu
jako punktu odniesienia.

2.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Widok z dołu

W tym temacie opisano umiejscowienie i funkcję poszczególnych elementów znajdujących się w dolnej części
urządzenia.

Wskazówka

Ten opis odnosi się do ilustracji przedstawiającej urządzenie bez zamocowanego obiektywu.

Otwory na wkręty mocujące uchwyt sufitowy (w 6 miejscach, efektywna głębokość gwintu: 5,5 mm)
Podczas montażu urządzenia na suficie lub półce w wysoko położonym miejscu należy przymocować uchwyt
korpusu (do nabycia osobno) do podstawy urządzenia za pomocą sześciu wkrętów mocujących wspornik obudowy,
wkręcając je w te otwory.

Szczegółowe informacje na temat montażu podano w sekcjach „Montaż pionowy w wysoko położonym stałym
miejscu” i „Montaż na suficie”.

1.

Wkręty do mocowania statywu (w 2 miejscach)
Służą do montażu urządzenia na statywie (do nabycia osobno, wkręty 1/4-20 UNC o długości do 5,5 mm).

2.
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Powiązany temat

Montaż pionowy w wysoko położonym stałym miejscu

Montaż na suficie

5-041-958-33(1) Copyright 2022 Sony Corporation

Uwaga

Nie używać wkrętów o długości większej niż 5,5 mm. W przeciwnym razie może dojść do awarii.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Wspornik obiektywu

W tym temacie opisano umiejscowienie i funkcję poszczególnych elementów wspornika obiektywu urządzenia.

Wskazówka

Ten opis odnosi się do ilustracji przedstawiającej urządzenie bez zamocowanego obiektywu.

Wałek wspornika obiektywu (2)
Podpiera obiektyw.
Może być również stosowany do montażu ogólnych akcesoriów do wałków Ø15.

1.
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5-041-958-33(1) Copyright 2022 Sony Corporation

Zespół wspornika obiektywu
Wspornik obiektywu może przesuwać się do przodu lub do tyłu zgodnie z ruchem obiektywu, a następnie zostaje
zablokowany.

2.

Śruba mocująca podstawę wspornika obiektywu
Należy ją przykręcić do podstawy wspornika obiektywu. Śrubę można regulować w górę/w dół, aby dopasować ją do
wysokości podstawy wspornika obiektywu.

3.

Dźwignia zaciskowa wałków wspornika obiektywu (w 2 miejscach)
Zabezpiecza zespół wspornika obiektywu w położeniu przednim/tylnym.

4.

Dźwignia zaciskowa śruby mocującej podstawę wspornika obiektywu
Zabezpiecza śrubę mocującą podstawę wspornika obiektywu w pionowym położeniu.

Wskazówka

Jeśli dźwignia zaciskowa znajduje się w położeniu, które utrudnia obracanie nią, należy ją zwolnić i obrócić w położenie, które
ułatwi obsługę. Po ustawieniu w żądanym położeniu należy zamknąć dźwignię zaciskową.

A: Dźwignia zaciskowa śruby mocującej podstawę wspornika obiektywu
B: Dźwignia zaciskowa wałków wspornika obiektywu

Uwaga

Aby zapobiec zakłócania działania funkcji obrotu w poziomie/pionie przez wspornik obiektywu, należy przesunąć wspornik
obiektywu (gdy nie jest używany) do góry, a następnie przekręcić śrubę mocującą podstawę wspornika obiektywu w
najwyższe położenie (najbliżej obiektywu).

5.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Umiejscowienie i funkcja poszczególnych elementów pilota zdalnego sterowania ma
podczerwień (w zestawie)

W tym temacie opisano umiejscowienie i funkcję poszczególnych elementów pilota zdalnego sterowania ma podczerwień
(w zestawie).

Przycisk REC● (przycisk START/STOP do obsługi nagrywania)
Naciśnij ten przycisk, aby rozpocząć lub zatrzymać nagrywanie.

1.

Przycisk MENU
Naciśnij ten przycisk, aby wyświetlić lub ukryć menu kamery.

2.

Przyciski do obsługi interfejsu użytkownika
Służą do wykonywania operacji w menu kamery, w oknach dialogowych komunikatów zawierających przyciski oraz w
oknach innych funkcji wyświetlanych na ekranie.

3.

Przycisk CANC./BACK4.
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Baterie pilota zdalnego sterowania ma podczerwień

Do pilota zdalnego sterowania ma podczerwień wymagane są dwie baterie AA (LR6).
Włóż baterie do pilota zdalnego sterowania na podczerwień w sposób pokazany na poniższym rysunku.

Naciśnij ten przycisk, aby anulować ustawienie lub powrócić do poprzedniego ekranu menu kamery.
Przyciski sterowania obrotem w poziomie/pionie
Za pomocą przycisków strzałek można sterować obrotem kamery w poziomie/pionie. Naciśnij przycisk HOME, aby
ustawić kamerę z powrotem do przodu.

5.

Przyciski sterowania ustawieniami wstępnymi
Naciśnij i przytrzymaj przycisk PRESET, a następnie naciśnij jeden z przycisków od 1 do 3, aby zachować stan
ustawień kierunku kamery, zoomu i ostrości pod naciśniętym przyciskiem numerycznym.
Naciśnij przycisk numeryczny z zapisanymi ustawieniami, aby przywrócić zapisany stan.

6.

Przyciski do regulacji ostrości
Służą do regulacji ostrości.
Aby automatycznie wyregulować ostrość, naciśnij przycisk AF.
Aby wyregulować ostrość ręcznie, naciśnij przycisk MF, a następnie naciśnij przycisk F (Far), aby ustawić ostrość na
obiektach znajdujących się daleko, lub przycisk N (Near), aby ustawić ostrość na obiektach znajdujących się blisko.

7.

Przyciski konfigurowalne od 1 do 3
Służą do uruchamiania funkcji przypisanych do przycisków konfigurowalnych za pomocą menu kamery.
W przypadku przypisania funkcji [Direct Menu] do przycisku konfigurowalnego można dostosować ekspozycję,
balans bieli i inne ustawienia za pomocą przycisków do obsługi interfejsu użytkownika.

Szczegółowe informacje na temat przypisywania funkcji za pomocą menu kamery podano w sekcji „Przyciski
konfigurowalne”.

Szczegółowe informacje na temat menu bezpośredniego podano w sekcji „Korzystanie z menu bezpośredniego”.

8.

 Przycisk zasilania
Naciśnij ten przycisk, aby włączyć urządzenie lub przełączyć zasilanie w tryb gotowości.

9.

Przycisk THUMBNAIL
Służy do wyświetlania ekranu miniatur przedstawiającego klipy nagrane na karcie pamięci urządzenia.

Szczegółowe informacje na temat ekranu miniatur podano w sekcji „Ekran miniatur”.

Za pomocą przycisków do obsługi interfejsu użytkownika można wybierać klipy i sterować odtwarzaniem na ekranie
miniatur.

Szczegółowe informacje na temat wybierania klipów i sterowania odtwarzaniem podano w sekcjach „Odtwarzanie
nagranych klipów” i „Operacje na nagranych klipach”.

10.

Przycisk SLOT SEL (wybór gniazda kart pamięci (A)/(B))
Gdy włożone są dwie karty pamięci, przycisk ten umożliwia przełączanie między kartami pamięci w celu wybrania
karty pamięci do nagrywania.
Naciśnij ten przycisk, gdy wyświetlany jest ekran miniatur, aby przełączać między kartami pamięci, których zawartość
ma być wyświetlana.

11.

Przycisk P/T RESET (resetowanie obrotu w poziomie/pionie)
Resetuje funkcję obrotu w poziomie/pionie. Naciśnij ten przycisk, gdy kontrolki POWER i NETWORK migają
jednocześnie lub gdy w panelu kadrowania w aplikacji internetowej wyświetlany jest pozycja [Execute Pan-Tilt Reset].

12.

Przyciski sterowania zoomem
Aby zwiększyć powiększenie, naciśnij przycisk T (telephoto).
Aby zmniejszyć powiększenie, naciśnij przycisk W (wide).

13.
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Uwaga

Nie wolno używać żadnych baterii innych niż manganowe lub alkaliczne, ponieważ mogą wybuchnąć.

Zużyte baterie należy usuwać zgodnie z przepisami obowiązującymi w danym kraju lub regionie.

Powiązany temat

Przyciski konfigurowalne

Korzystanie z menu bezpośredniego

Ekran miniatur

Odtwarzanie nagranych klipów

Operacje na nagranych klipach

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Omówienie ekranu aplikacji internetowej

Po podłączeniu tabletu lub komputera można wykonywać operacje obrotu w poziomie/pionie, nagrywania, odtwarzania
nagranego wideo i zmiany poziomu zoomu oraz konfigurować ustawienia urządzenia za pomocą przeglądarki
internetowej (w dalszej części funkcja ta jest nazywana „aplikacją internetową”).

Szczegółowe informacje na temat uruchamiania aplikacji internetowej podano w sekcji „Uzyskiwanie dostępu do
aplikacji internetowej z poziomu przeglądarki internetowej”.

Uwaga

Aplikacja internetowa nie obsługuje wyjścia audio kamery.

Po uruchomieniu aplikacji internetowej zostanie wyświetlony poniższy ekran sterowania w czasie rzeczywistym.

Ekran sterowania w czasie rzeczywistym

Szczegółowe informacje na temat ekranu sterowania w czasie rzeczywistym podano w sekcji „Struktura ekranu
sterowania w czasie rzeczywistym”.
W górnej części ekranu wyświetlane są przyciski i ikony wspólne dla ekranu sterowania w czasie rzeczywistym oraz
ekranu sterowania odtwarzaniem.
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Szczegółowe informacje na temat wspólnego obszaru ekranów podano w sekcji „Struktura wspólnego obszaru
ekranów”.
Ekrany można przełączać, naciskając karty przełączania ekranów w obszarze wspólnym.

Ekran operacji odtwarzania

Naciśnij kartę [Playback], aby wyświetlić ekran operacji odtwarzania.

Szczegółowe informacje na temat ekranu operacji odtwarzania podano w sekcji „Struktura ekranu operacji
odtwarzania”.

Ekran ustawień

Naciśnij kartę [Settings], aby wyświetlić ekran ustawień (nazywany dalej menu internetowym).
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Uwaga

W menu internetowym ustawienia nie zostaną zastosowane, dopóki nie naciśnie się przycisku [OK]. Jeśli chcesz zmienić
ustawienia na stronie zawierającej przycisk [OK], naciśnij przycisk [OK].

Szczegółowe informacje na temat ekranu ustawień podano w sekcji „Struktura ekranu ustawień”.
W tym Przewodniku pomocy ekran ustawień aplikacji internetowej jest nazywany menu internetowym.

Powiązany temat
Uzyskiwanie dostępu do aplikacji internetowej z poziomu przeglądarki internetowej

Struktura ekranu sterowania w czasie rzeczywistym

Struktura wspólnego obszaru ekranów

Struktura ekranu operacji odtwarzania

Struktura ekranu ustawień

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktura wspólnego obszaru ekranów

W tym temacie opisano strukturę wspólnego obszaru ekranów.

Nazwa kamery
Wyświetlanie nazwy kamery.
Nazwę można zmienić za pomocą opcji [Network] > [Camera Name] w menu internetowym.
Kolor tła zmienia się zgodnie z zewnętrznym sygnałem lampki typu Tally.

1.

Przełącznik zasilania
Po włączeniu urządzenia wyświetlana jest pozycja [Power ON]. Naciśnięcie przełącznika i wybranie pozycji [Power
Standby] powoduje przełączenie zasilania urządzenia w tryb gotowości.
Po wyświetleniu pozycji [Power Standby] można nacisnąć przełącznik i wybrać pozycję [Power ON], aby włączyć
zasilanie urządzenia.

2.

Zakładki przełączania ekranu obsługi
Naciśnij kartę, aby wyświetlić odpowiedni ekran obsługi.
Karta [Live]: Wyświetlanie ekranu sterowania w czasie rzeczywistym.
Karta [Playback]: Wyświetlanie ekranu operacji odtwarzania.
Karta [Settings]: Wyświetlanie ekranu ustawień (menu internetowe).

3.

Ikona powiadomień
Po odebraniu komunikatu ikona zmienia się w sposób przedstawiony poniżej.

 (powiadomienia włączone)
Wykonaj niezbędne działania zgodnie z komunikatem wyświetlanym w panelu obrazu z kamery.

Uwaga

Komunikaty nie są wyświetlane, jeśli w menu internetowym dla opcji [Monitoring] > [Output Display] > [HDMI/Stream]
wybrano ustawienie [Off]. Wybierz ustawienie [On], aby wyświetlić treść komunikatów.

4.

Przycisk  (stan kamery)
Naciśnij ten przycisk, aby wyświetlić na osobnym ekranie informacje o obrazie nagranym na kamerze / obrazie
przekazywanym sygnałem wyjściowym, a także informacje obiektywie i stanie sterownika obiektywu (do nabycia
osobno).

5.
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Gdy pojawi się powiadomienie związane ze sterownikiem obiektywu (do nabycia osobno), wskazanie zmieni się w
sposób przedstawiony poniżej.

Przełącznik blokowania operacji na ekranie
 (odblokowanie operacji): ustaw przełącznik w lewym położeniu, aby wykonywać operacje na ekranie

sterowania w czasie rzeczywistym i ekranie sterowania odtwarzaniem.
 (zablokowanie operacji): ustaw przełącznik w prawym położeniu w celu zablokowania możliwości wykonywania

operacji na ekranie sterowania w czasie rzeczywistym i ekranie sterowania odtwarzaniem, aby zapobiec
przypadkowej zmianie.

6.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktura ekranu sterowania w czasie rzeczywistym

W tym temacie opisano strukturę ekranu sterowania w czasie rzeczywistym.

Panel ustawień wstępnych położenia
Służy do wyświetlania zarejestrowanych ustawień wstępnych położenia w postaci miniatur. Dotknij dwukrotnie
miniatury, aby przywrócić położenie zapisane w ustawieniu wstępnym.

Szczegółowe informacje na temat ustawień wstępnych położenia podano w sekcji „Zapisywanie/przywracanie
kąta obrotu w poziomie/pionie, pozycji zoomu i ustawienia ostrości za pomocą aplikacji internetowej”.
Szczegółowe informacje na temat funkcji PTZ Trace podano w sekcji „Rejestrowanie operacji kadrowania
wykonywanych przez kamerę przy użyciu aplikacji internetowej”/

1.

Panel obrazu z kamery
Służy do wyświetlania bieżącego obrazu z kamery i stanu urządzenia.
Wyświetlany jest ten sam obraz, co w przypadku wyjścia HDMI.
Nad obrazem wyświetlane są podane poniżej informacje o stanie. Wokół obrazu wyświetlana jest również czerwona
lub zielona ramka zgodnie z odebranym zewnętrznym sygnałem lampki typu Tally.

2.
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Przycisk [Display]
Naciśnij ten przycisk, aby wyświetlić informacje z kamery na obrazie.
Naciśnij ponownie, gdy wyświetlane są informacje z kamery, aby je ukryć.

Oprócz znaczników wyświetlane są pewne wskaźniki i komunikaty związane z automatyczną regulacją ostrości — w
zależności od stanu. Nie można ich ukryć poprzez naciśnięcie przycisku [Display].

Aby dowiedzieć się więcej na temat informacji wyświetlanych na ekranie kamery, zapoznaj się z sekcję „Ekran
kamery”.

Nr Wyświetlana pozycja Opis

2-
1

Wskaźnik trybu ustawiania ostrości
Patrz: „Wskaźnik trybu ustawiania ostrości” w rozdziale „Ekran
kamery”.

2-
2

Tryb nagrywania, gniazdo A/B,
wskaźnik interwału w trybie
nagrywania interwałowego

Patrz: „Tryb nagrywania, gniazdo A/B, wskaźnik interwału w trybie
nagrywania interwałowego” w rozdziale „Ekran kamery”.

2-
3

Wskaźnik stanu przesyłania
strumieniowego

Wyświetlany podczas przesyłania strumieniowego (gdy dla opcji
[Stream Setting] wybrano wyłącznie ustawienie [RTMP] lub [SRT-
Caller]).

2-
4

Wskaźnik stanu sygnału wyjściowego
RAW

Służy do wyświetlania informacji o stanie sygnału wyjściowego RAW.
Szczegółowe informacje na temat formatu RAW podano w sekcji
„Nagrywanie wideo w formacie RAW”.

2-
5

Wskaźnik pozostałej pojemności
nośnika

Patrz: „Wskaźnik pozostałej pojemności nośnika” w rozdziale „Ekran
kamery”.

2-
6

Wskaźnik pozycji zoomu

Patrz „Wskaźnik pozycji zoomu” w rozdziale „Ekran kamery”.
Gdy podłączony jest sterownik obiektywu (do nabycia osobno),
wyświetlana jest pozycja . Jeśli w sterowniku obiektywu (do
nabycia osobno) wystąpi błąd, wyświetlana jest pozycja .

2-
7

Wskaźnik trybu AE / poziomu AE Patrz: „Wskaźnik trybu AE / poziomu AE” w rozdziale „Ekran kamery”.
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Przycisk zatrzymania trybu AF ze śledzeniem w czasie rzeczywistym
Naciśnij ten przycisk, aby zatrzymać śledzenie obiektu.

Szczegółowe informacje podano w sekcji „Śledzenie określonego obiektu (funkcja Realtime Tracking AF)”.
Przycisk START/STOP do obsługi nagrywania
Naciśnij przycisk, aby rozpocząć nagrywanie. Podczas nagrywania przycisk START/STOP do obsługi nagrywania
świeci na czerwono.
Naciśnij przycisk podczas nagrywania, aby zatrzymać nagrywanie.
Można przestawić przełącznik blokady w położenie blokady, aby zapobiec przypadkowemu naciśnięciu przycisku
START/STOP do obsługi nagrywania.

3.

Panel podstawowej konfiguracji kamery
Zawiera ustawienia podstawowych funkcji wymaganych do filmowania za pomocą przycisków. Naciśnij przycisk, aby
wyświetlić odpowiedni ekran konfiguracji dla każdej funkcji na przedstawionym poniżej panelu dostosowywania
podstawowej konfiguracji kamery (5).

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

Szczegółowe informacje podano w opisie poszczególnych funkcji.

4.

Funkcja Sekcja

FPS „Zwolnione/przyspieszone tempo”

ISO/Gain
Sekcja „Ustawianie czułości podstawowe”, „Automatyczna regulacja wzmocnienia” i „Ręczna
regulacja wzmocnienia” w rozdziale „Regulacja wzmocnienia”

Exposure
Index

„Ustawianie czułości podstawowej” i „Zmienianie rozmieszczenia ciemnych i jasnych obszarów na
nagranym obrazie”

Shutter
Sekcje „Automatyczne dostosowywanie ustawienia migawki” i „Ręczne dostosowywanie ustawienia
migawki” w rozdziale „Dostosowywanie ustawień migawki”

Iris
Sekcje „Automatyczna regulacja przysłony” i „Ręczna regulacja przysłony” w rozdziale „Regulacja
przysłony”

ND Filter Sekcja „Informacje dotyczące filtra ND” w rozdziale „Regulacja poziomu światła (filtr ND)”
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Funkcja Sekcja

Scene File
Sekcja „Informacje ogólne dotyczące wyglądu” oraz inne sekcje rozdziału „Filmowanie z
odpowiednim wyglądem”

Base
Look/LUT

„Filmowanie z korektą wyglądu na etapie postprodukcji”

White
Balance

„Ekran regulacji balansu bieli”

Przyciski konfigurowalne / panel dostosowywania podstawowej konfiguracji kamery
Podczas normalnej pracy wyświetlane są przyciski konfigurowalne. Naciśnij przyciski panelu podstawowej
konfiguracji kamery (pozycja 4), aby wyświetlić odpowiednie pozycje ustawień. Naciśnij przycisk [X] lub ponownie
naciśnij przycisk panelu ustawień konfiguracyjnych kamery, aby powrócić do wyświetlania przycisków
konfigurowalnych.

Szczegółowe informacje na temat przycisków konfigurowalnych podano w sekcji „Przyciski konfigurowalne”.
Szczegółowe informacje na temat panelu dostosowywania podstawowej konfiguracji kamery podano w opisie
poszczególnych funkcji.

5.

Panel kadrowania / panel do obsługi interfejsu użytkownika
Służy do przełączania między panelem kadrowania i panelem do obsługi interfejsu użytkownika przy użyciu kart
dostępnych u góry.
Możesz nacisnąć przycisk  (zamknij) w prawym górnym rogu ekranu, aby ukryć panel sterowania w celu
zapobieżenia niezamierzonemu działaniu. Jeśli panel sterowania nie jest wyświetlany, naciśnij przycisk  (otwórz),
aby go wyświetlić.
Panel kadrowania służy do ustawiania kadrowania. Naciśnij kartę  (obrót w poziomie/pionie i zoom), aby
wyświetlić panel kadrowania.

Szczegółowe informacje na temat korzystania z tego panelu podano w sekcji „Kadrowanie”.

Wskazówka

Obszar joysticka w panelu kadrowania jest wyświetlany w przedstawiony poniżej sposób, gdy funkcja obrotu w
poziomie/pionie jest wyłączona i gdy wymagana jest jej inicjalizacja.

Gdy funkcja obrotu w poziomie/pionie jest zablokowana za pomocą suwaka blokady obrotu w poziomie/pionie

6.
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Gdy funkcja obrotu w poziomie/pionie nie została zainicjowana

Gdy konieczne jest zresetowanie funkcji obrotu w poziomie/pionie

Gdy funkcja obrotu w poziomie/pionie jest wyłączona

Jeśli nie zainicjowano funkcji obrotu w poziomie/pionie lub konieczne jest jej zresetowanie, można szybko uzyskać dostęp do
przycisku  (resetowanie obrotu w poziomie/pionie) w panelu ustawień kamery, naciskając komunikat wyświetlany pod
joystickiem.

Panel do obsługi interfejsu użytkownika służy do obsługi menu kamery, odtwarzania klipów i innych funkcji. Naciśnij
kartę  (graficzny interfejs użytkownika kamery), aby wyświetlić panel do obsługi interfejsu użytkownika.
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Szczegółowe informacje na temat obsługi podano w sekcjach „Korzystanie z menu kamery” i „Odtwarzanie
nagranych klipów”.

Panel ustawień kamery
Służy do konfigurowania funkcji wymaganych do obsługi kamery.
Do przełączanie między ekranami, które mają być wyświetlane, służą karty u góry ekranu.
Możesz nacisnąć przycisk  (zamknij) w prawym górnym rogu ekranu, aby ukryć panel sterowania w celu
zapobieżenia niezamierzonemu działaniu. Jeśli panel sterowania nie jest wyświetlany, naciśnij przycisk  (otwórz),
aby go wyświetlić.

Szczegółowe informacje podano w opisie poszczególnych funkcji.

Karta  (Main)
Zawiera ustawienia konfiguracyjne często używanych funkcji.
Funkcję górnego i dolnego suwaka można zmienić, naciskając przycisk [▼] i wybierając odpowiednią funkcję z
wyświetlonej listy. Można dokonać wyboru spośród podanych poniżej funkcji.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

Karta  (Focus)

7.

Wyświetlana zgodnie z ustawieniami menu.*
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Zawiera ustawienia konfiguracyjne związane z ostrością.

Karta  (Audio)

Zawiera ustawienia konfiguracyjne związane z dźwiękiem.

Karta  (Stream)
Zawiera ustawienia konfiguracyjne związane z przesyłaniem strumieniowym.
Wyświetlane pozycje będą się różnić w zależności od ustawienia formatu przesyłania strumieniowego.
Po wybraniu opcji [RTMP] lub [SRT-Caller] można na tym ekranie rozpoczynać/zatrzymywać przesyłanie
strumieniowe.

Szczegółowe informacje na ten temat podano w sekcji „Informacje dotyczące przesyłania strumieniowego” oraz w
innych sekcjach rozdziału „Konfigurowanie ustawień przesyłania strumieniowego”.
W przypadku błędu połączenia wyświetlane są informacje o błędzie. Szczegółowe informacje na temat informacji
o błędach podano w sekcji „Komunikaty o błędach / komunikaty ostrzegawcze”.
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Powiązany temat

Zapisywanie/przywracanie kąta obrotu w poziomie/pionie, pozycji zoomu i ustawienia ostrości za pomocą aplikacji
internetowej

Rejestrowanie operacji kadrowania wykonywanych przez kamerę przy użyciu aplikacji internetowej

Ekran kamery

Nagrywanie wideo w formacie RAW

Karta  (Others)
Zawiera ustawienia konfiguracyjne związane z innych funkcjami.

Naciśnięcie przycisku [Full Screen Display] powoduje otwarcie nowej karty w przeglądarce internetowej oraz
wyświetlenie obrazu w panelu obrazu z kamery na pełnym ekranie.
Następuje tylko wyświetlenie obrazu. Automatyczna regulacja ostrości za pomocą dotyku i inne funkcje nie są
dostępne.

Uwaga

Ekran sterowania w czasie rzeczywistym na oryginalnej karcie nadal działa. Zaleca się zamknięcie tej karty w celu
zmniejszenia liczby jednoczesnych połączeń, jeśli nie jest wymagane wykonanie żadnej operacji.

Naciśnij przycisk  (inicjowanie sterownika obiektywu), aby zainicjować sterownik obiektywu (do
nabycia osobno od innej firmy). Ten przycisk jest dostępny tylko wtedy, gdy opcja [Technical] > [Lens Controller] >
[Zoom] > [Setting] jest ustawiona na [On] w menu internetowym.
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Śledzenie określonego obiektu (funkcja Realtime Tracking AF)

Zwolnione/przyspieszone tempo

Ustawianie czułości podstawowej

Automatyczna regulacja wzmocnienia

Ręczna regulacja wzmocnienia

Zmienianie rozmieszczenia ciemnych i jasnych obszarów na nagranym obrazie

Automatyczne dostosowywanie ustawienia migawki

Ręczne dostosowywanie ustawienia migawki

Automatyczna regulacja przysłony

Ręczna regulacja przysłony

Informacje dotyczące filtra ND

Informacje ogólne dotyczące wyglądu

Filmowanie z korektą wyglądu na etapie postprodukcji

Ekran regulacji balansu bieli

Przyciski konfigurowalne

Odtwarzanie nagranych klipów

Korzystanie z menu kamery

Informacje dotyczące przesyłania strumieniowego

Komunikaty o błędach / komunikaty ostrzegawcze

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktura ekranu operacji odtwarzania

W tym temacie opisano strukturę ekranu operacji odtwarzania.

Panel obrazu z kamery
Służy do wyświetlania odtwarzanego obrazu i powiązanych informacji. Po zatrzymaniu odtwarzania zostanie
wyświetlony ekran obrazu z kamery.

1.
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1-1 Data i godzina filmowania
1-2 Wskaźnik stanu odtwarzania
1-3 Wskaźnik formatu odtwarzania (rozmiar obrazu)
1-4 Wskaźnik formatu odtwarzania (kodek)
1-5 Wyświetlanie nazwy klipu
1-6 Numer klipu / łączna liczba klipów
1-7 Wyświetlanie nazwy pliku LUT
1-8 Wskaźnik stanu przesyłania strumieniowego
1-9 Wskaźnik formatu odtwarzania (szybkość klatek i metoda skanowania)
1-10 Wskaźnik wyglądu do nagrywania

Panel sterowania odtwarzaniem

Zawiera przyciski do sterowania odtwarzaniem.

Przycisk [Display]
Przycisk ten służy do przełączania ekranu wyświetlanego na obrazie.
Przycisk [Thumbnail]
Służy do wyświetlania klipów zarejestrowanych na karcie pamięci w panelu obrazu z kamery w postaci miniatur.

2.

Przycisk Funkcja

Przycisk  (wstrzymanie/odtwarzanie) Służy do odtwarzania klipów. Podczas odtwarzania służy do
wstrzymywania odtwarzania klipu.

Przycisk  (przewijanie do przodu),
przycisk  (przewijanie do tyłu)

Służy do odtwarzania klipu z dużą szybkością. Naciśnięcie
przycisku powoduje zmianę szybkości odtwarzania (w trzech
stopniach).

Przycisk  (następny), przycisk 
(poprzedni)

Przejście do początku klipu lub poprzedniego/następnego klipu.

Przycisk  (zatrzymanie) Służy do zatrzymywania odtwarzania.
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Powiązany temat

Ekran miniatur

Przyciski konfigurowalne

Odtwarzanie nagranych klipów

5-041-958-33(1) Copyright 2022 Sony Corporation

Naciśnięcie przycisku [Thumbnail], gdy wyświetlany jest ekran miniatur, spowoduje zamknięcie ekranu miniatur i
powrót do wyświetlania obrazu z kamery.

Szczegółowe informacje na temat ekranu miniatur podano w sekcji „Ekran miniatur”.

Przycisk [Slot Select]
Umożliwia przełączanie między nośnikami, które mają być używane do odtwarzania.

Przyciski konfigurowalne
Przyciski konfigurowalne przypisane do funkcji urządzenia.

Szczegółowe informacje na temat przycisków konfigurowalnych podano w sekcji „Przyciski konfigurowalne”.

3.

Panel do obsługi interfejsu użytkownika
Panel do obsługi interfejsu użytkownika służy do obsługi menu kamery, odtwarzania klipów i innych funkcji.

Szczegółowe informacje na temat obsługi podano w sekcjach „Korzystanie z menu kamery” i „Odtwarzanie
nagranych klipów”.

4.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktura ekranu ustawień

Użyj ekranu ustawień do skonfigurowania różnych pozycji konfiguracji urządzenia, w tym ustawień początkowych,
ustawień sieciowych oraz ustawień filmowania/odtwarzania, za pomocą menu internetowego.

Uwaga

W menu internetowym ustawienia z zasady nie są stosowane do momentu naciśnięcia przycisku [OK]. Jeśli chcesz zmienić
ustawienia na stronie zawierającej przycisk [OK], naciśnij przycisk [OK].

Szczegółowe informacje na temat ekranu ustawień podano w sekcji „Menu internetowe i ustawienia szczegółowe”.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Menu kamery

Naciśnij przycisk [Menu] w panelu do obsługi interfejsu użytkownika na ekranie sterowania w czasie rzeczywistym lub
ekranie operacji odtwarzania, aby wyświetlić menu kamery w panelu obrazu z kamery.

Ustawienia wymagane do filmowania i odtwarzania można skonfigurować za pomocą menu kamery.
Naciśnij przycisk [Menu], gdy wyświetlane jest menu kamery, aby je ukryć.
Do obsługi menu kamery służy panel do obsługi interfejsu użytkownika.

Szczegółowe informacje na temat menu kamery podano w sekcji „Menu kamery i ustawienia szczegółowe”.

Uwaga

Jeśli opcja [Monitoring] > [Output Display] > [HDMI/Stream] jest ustawiona na Off w menu internetowym (wyłączenie wyświetlania
informacji nałożonych na obraz z kamery), menu kamery nie jest wyświetlane w oknie obrazu z kamery. Należy jednak pamiętać,
że można nadal wykonywać operacje w menu za pomocą panelu do obsługi interfejsu użytkownika. Aby zapobiec
niezamierzonemu działaniu, należy uważać, aby przypadkowo nie wykonać operacji w menu za pomocą panelu do obsługi
interfejsu użytkownika, gdy opcja [HDMI/Stream] jest ustawiona na Off.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ekran kamery

Istnieje możliwość wyświetlania informacji o stanie i ustawieniach urządzenia nałożonych na obraz wyjściowy z kamery.
Można ustawić wyjścia, dla których ma być włączone wyświetlanie informacji na ekranie, korzystając z opcji [Monitoring]
> [Output Display] w menu internetowym.
Informacje te można wyświetlać/ukrywać za pomocą przycisku [Display]. Nawet jeśli są one ukryte, pojawią się podczas
wykonywania operacji w menu bezpośrednim.
Można wyświetlać/ukrywać poszczególne pozycje za pomocą opcji [Monitoring] > [Display On/Off] w menu kamery.

Informacje wyświetlane na ekranie podczas filmowania

Wskaźnik przesyłania / wskaźnik liczby pozostałych plików

Szczegółowe informacje na temat przesyłania plików podano w sekcji „Informacje na temat funkcji transferu
plików” oraz w innych sekcjach rozdziału „Przesyłanie plików”.

1.

Wskaźnik obszaru regulacji ostrości
Służy do wyświetlania obszaru nastawiania ostrości dla funkcji automatycznego ustawiania ostrości.

Szczegółowe informacje na temat automatycznej regulacji ostrości podano w sekcji „Automatyczna regulacja za
pomocą aplikacji internetowej” oraz w innych sekcjach rozdziału „Automatyczna regulacja ostrości (ustawienie
Auto Focus)”.

2.

Tryb nagrywania, gniazdo A/B, wskaźnik interwału w trybie nagrywania interwałowego

Szczegółowe informacje na temat nagrywania interwałowego podano w sekcji „Nagrywanie interwałowe (Interval
Rec)”.

3.

Wyświetlana pozycja Znaczenie

●Rec Nagrywanie

Stby Stan gotowości do nagrywania
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Wskaźnik głębi ostrości4.

Wskaźnik trybu skanowania przetwornika obrazu
Oznaczenie  (niedopasowanie) jest wyświetlane w przypadku niedopasowania między rozmiarem okręgu obrazu
obiektywu a ustawieniem trybu skanowania efektywnego rozmiaru obrazu przez przetwornik obrazu.
Gdy opcja Imager Scan Mode jest ustawiona na FF, wyświetlana jest litera „C” w trybach z węższym kątem widzenia
(przycięty obraz).
Przycinanie jest stosowane w podanych poniżej trybach.

Gdy format nagrywania to 3840×2160, a szybkość klatek w trybie S&Q Motion wynosi 100 kl./s lub 120 kl./s
Gdy opcja [Codec] jest ustawiona na RAW lub RAW & XAVC-I, a format wyjściowy RAW to 3840×2160
Szczegółowe informacje na temat trybu skanowania przetwornika obrazu podano w sekcji „Ustawianie trybu
skanowania przetwornika obrazu” w rozdziale „Konfigurowanie podstawowych ustawień”.

5.

Wskaźnik stanu sygnału wyjściowego RAW
Służy do wyświetlania informacji o stanie sygnału wyjściowego RAW.

Szczegółowe informacje na temat formatu RAW podano w sekcji „Nagrywanie wideo w formacie RAW”.

6.

Wskaźnik szybkości klatek przy filmowaniu w trybie zwolnionego/przyspieszonego tempa

Szczegółowe informacje na temat funkcji zwolnionego/przyspieszonego tempa podano w sekcji
„Zwolnione/przyspieszone tempo”.

7.

Wskaźnik pozycji ustawiania ostrości

Pokazuje pozycję ustawiania ostrości.

8.

Wskaźnik trybu ustawiania ostrości

Tryb AF z wykrywaniem twarzy/oczu

Szczegółowe informacje na temat funkcji AF z wykrywaniem twarzy/oczu podano w sekcji „Śledzenia przy użyciu
funkcji wykrywania twarzy i oczu (ustawienie Face/Eye Detection AF)”.

9.

Wyświetlana pozycja Znaczenie

Focus Hold Tryb Focus Hold

MF Tryb MF

AF Tryb AF

 (Tryb AF ze śledzeniem w czasie rzeczywistym) Tryb AF ze śledzeniem w czasie rzeczywistym

Wyświetlana pozycja Znaczenie

 (Tryb AF z wykrywaniem twarzy/oczu) Wskazuje, że tryb AF z wykrywaniem twarzy/oczu jest aktywny

 (Tryb Face/Eye Only AF) Wskazuje, że tryb Face/Eye Only AF jest aktywny

 (zapisana śledzona twarz) Wskazuje, że śledzona twarz została zapisana

 (wstrzymanie trybu AF) Wskazuje, że działanie funkcji AF zostało wstrzymane*

Jest wyświetlana w przypadku, gdy nie ma zapisanej śledzonej twarzy i żadna twarz nie została wykryta, lub w przypadku, gdy istnieje
zapisana śledzona twarz, ale śledzona twarz nie została wykryta.

*
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Wskaźnik pozycji zoomu
Służy do wyświetlania pozycji zoomu w zakresie od 0 (tryb szerokokątny) do 99 (tryb teleobiektywu) (jeśli
zainstalowany jest obiektyw obsługujący wyświetlanie pozycji zoomu).
Wskaźnik można zmienić na wyświetlanie bargrafu lub ogniskowej za pomocą ustawienia [Technical] > [Lens] >
[Zoom Position Display] w menu kamery.
Podane poniżej pozycje pojawią się na wyświetlaczu w przypadku włączenia funkcji Clear Image Zoom.

Szczegółowe informacje na temat zoomu podano w sekcji „Ustawianie typu zoomu” oraz w innych sekcjach
rozdziału „Regulacja zoomu”.

10.

Wyświetlana pozycja Znaczenie

 (funkcja Clear Image Zoom jest włączona) Funkcja Clear Image Zoom jest włączona

Wartość współczynnika powiększenia Podczas korzystania z funkcji Clear Image Zoom

Wskaźnik trybu stabilizacji obrazu11.

Wskaźnik stanu Rec Control dla wyjścia SDI / wyjścia HDMI
Służy do wyświetlania stanu wyjściowego sygnału sterującego REC.

Szczegółowe informacje na ten temat podano w sekcji „Podłączanie zewnętrznych monitorów i urządzeń
nagrywających”.

12.

Wskaźnik ostrości

Szczegółowe informacje na ten temat podano w sekcji „Korzystanie z automatycznej regulacji ostrości przy
jednym ujęciu (ustawienie Push Auto Focus (AF-S))” w rozdziale „Regulacja ostrości”.

13.

Wskaźnik pozostałej pojemności nośnika
Ikona  (blokada) jest wyświetlana, gdy karta pamięci jest zabezpieczona przed zapisem.

14.

Wskaźnik trybu balansu bieli15.

Wyświetlana pozycja Znaczenie

 (ATW) Tryb automatyczny

 (ATW Hold) Tryb automatyczny wstrzymany

W:P Tryb ustawień wstępnych

W:A Tryb pamięci A

Wskaźnik zewnętrznej blokady kodu czasowego / wyświetlanie danych dotyczących czasu
Gdy kod czasowy urządzenia zewnętrznego jest zablokowany, wyświetlany jest symbol „EXT-LK”.

Szczegółowe informacje na temat kodu czasowego podano w sekcji „Określanie danych dotyczących czasu”.

16.

Wskaźnik filtra ND17.

Wyświetlana pozycja Znaczenie

 (A) Tryb automatyczny

 (B) Tryb sterowania efektem bokeh
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Szczegółowe informacje na temat filtrów ND podano w sekcji „Regulacja poziomu światła (filtr ND)”.
Szczegółowe informacje na temat regulacji efektu bokeh podano w sekcji „Regulacja efektu bokeh (funkcja
sterowania efektem bokeh)”.

Wskaźnik pliku sceny

Szczegółowe informacje na temat plików sceny podano w sekcji „Informacje ogólne dotyczące wyglądu” oraz w
innych sekcjach rozdziału „Filmowanie z odpowiednim wyglądem”.

18.

Wskaźnik przysłony
Wyświetla informacje o położeniu przysłony (wartość F) (jeśli zainstalowany jest obiektyw obsługujący wyświetlanie
ustawień przysłony).

Szczegółowe informacje na temat przysłony podano w sekcjach „Automatyczna regulacja przysłony” i „Ręczna
regulacja przysłony”.

19.

Wskaźnik ostrzegawczy poziomu sygnału wideo20.

Wskaźnik wzmocnienia
Służy do wyświetlania wartości EI w trybie Cine EI/Cine EI Quick.

Szczegółowe informacje na temat wzmocnienia podano w sekcjach „Automatyczna regulacja wzmocnienia” i
„Ręczna regulacja wzmocnienia”.
Szczegółowe informacje na temat trybu Cine EI/Cine EI Quick podano w sekcji „Konfigurowanie trybu filmowania”
w rozdziale „Konfigurowanie podstawowych ustawień”.

21.

Wyświetlana pozycja Znaczenie

 (A) Tryb automatyczny

L Tryb ustawień wstępnych L

 (tryb nastaw tymczasowych) Tryb nastaw tymczasowych

 (B) Tryb sterowania efektem bokeh

Wyświetlanie nazwy klipu
Nazwa nagrywanego klipu lub klipu, który ma zostać nagrany jako następny.
Jeśli miga, występuje niezgodność między ostatnim klipem na nośniku przeznaczonym do nagrywania a ustawieniem
[Camera ID] lub [Reel Number]. Szczegółowe informacje można znaleźć w opisie ustawienia [Clip Name Format] >
[Auto Naming].

22.

Wskaźnik migawki

Szczegółowe informacje na temat migawki podano w sekcjach „Automatyczne dostosowywanie ustawienia
migawki” i „Ręczne dostosowywanie ustawienia migawki”.

23.

Wskaźnik trybu AE / poziomu AE

Szczegółowe informacje na temat wskaźnika ekspozycji (EI) podano w sekcji „Ustawianie docelowego poziomu
automatycznej regulacji jasności”.

24.

Wskaźnik poziomu
Służy do wyświetlania poziomu z regulacją co ±1° do maksymalnego kąta pochylenia ±15°.

25.

Miernik poziomu dźwięku
Służy do wyświetlania poziomu dźwięku na każdym kanale.

26.
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Informacje wyświetlane na ekranie podczas odtwarzania

Podane poniżej informacje są nakładane na odtwarzany obraz.

Monitor sygnału wideo
Służy do wyświetlania przebiegu, wektoroskopu i histogramu.
Pomarańczowa linia wskazuje ustawioną wartość znacznika poziomu jasności.
W trybach filmowania Log docelowy typ tablicy LUT monitora jest wyświetlany nad obszarem monitorowania.

Szczegółowe informacje na ten temat podano w sekcji „Monitor sygnału wideo”.
Szczegółowe informacje na temat trybów filmowania Log podano w sekcji „Konfigurowanie trybu filmowania” w
rozdziale „Konfigurowanie podstawowych ustawień”.

27.

Wskaźnik Base Sensitivity / Base ISO
W trybie Custom wskaźnik ten przedstawia czułość podstawową ustawioną za pomocą przycisku [ISO/Gain /
Exposure Index] w panelu podstawowej konfiguracji kamery lub za pomocą opcji [Shooting] > [ISO/Gain/EI] > [Base
Sensitivity] w menu kamery.
W trybach filmowania Log wskaźnik ten przedstawia czułość Base ISO ustawioną za pomocą przycisku [ISO/Gain /
Exposure Index] w panelu podstawowej konfiguracji kamery lub za pomocą opcji [Shooting] > [ISO/Gain/EI] > [Base
ISO] w menu kamery.

Szczegółowe informacje na temat czułości podstawowej podano w sekcji „Wybieranie czułości podstawowej”.
Szczegółowe informacje na temat trybów filmowania Log podano w sekcji „Konfigurowanie trybu filmowania” w
rozdziale „Konfigurowanie podstawowych ustawień”.

28.

Wskaźnik wyglądu do funkcji monitorowania
W trybach filmowania Log przedstawia ustawienie LUT monitora.

Szczegółowe informacje na temat ustawienia LUT podano w sekcji „Filmowanie z korektą wyglądu na etapie
postprodukcji” i powiązanych sekcjach.
Szczegółowe informacje na temat trybów filmowania Log podano w sekcji „Konfigurowanie trybu filmowania” w
rozdziale „Konfigurowanie podstawowych ustawień”.

29.

Wskaźnik wyglądu podstawowego / wyglądu do nagrywania
Służy do wyświetlania ustawienia wyglądu podstawowego.
W trybach filmowania Log wyświetlany jest sygnał wideo, który ma być nagrywany na kartach pamięci.

Szczegółowe informacje na temat wyglądu podstawowego podano w sekcji „Informacje ogólne dotyczące
wyglądu” w rozdziale „Filmowanie z odpowiednim wyglądem”.
Szczegółowe informacje na temat trybów filmowania Log podano w sekcji „Konfigurowanie trybu filmowania” w
rozdziale „Konfigurowanie podstawowych ustawień”.

30.

Wskaźnik stanu nagrywania pomocniczego31.

Wskaźnik formatu nagrywania (kodek)
Służy do wyświetlania nazwy formatu nagrywania na kartach pamięci.
Ustaw format nagrywania (kodek) za pomocą opcji [Project] > [Rec Format] > [Codec] w menu internetowym lub w
menu kamery.

32.

Wskaźnik formatu nagrywania (szybkość klatek i metoda skanowania)33.

Wskaźnik formatu nagrywania (rozmiar obrazu)
Służy do wyświetlania rozmiaru obrazu w przypadku nagrywania na kartach pamięci.
Ustaw format nagrywania (rozmiar obrazu) za pomocą opcji [Project] > [Rec Format] > [Codec] w menu internetowym
lub w menu kamery.

34.

Wskaźnik lampki typu Tally
Wyświetlanie czerwonej lub zielonej ramki wokół obrazu zgodnie z odebranym zewnętrznym sygnałem lampki typu
Tally.

35.
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Powiązany temat

Informacje na temat funkcji transferu plików

Automatyczna regulacja za pomocą aplikacji internetowej

Nagrywanie interwałowe (Interval Rec)

Konfigurowanie podstawowych ustawień

Nagrywanie wideo w formacie RAW

Zwolnione/przyspieszone tempo

Wskaźnik przesyłania / wskaźnik liczby pozostałych plików1.

Numer klipu2.

Wskaźnik stanu odtwarzania3.

Wskaźnik formatu odtwarzania (szybkość klatek i metoda skanowania)4.

Wskaźnik formatu odtwarzania (rozmiar obrazu)5.

Wskaźnik formatu odtwarzania (kodek)6.

Wskaźnik nośnika
Ikona  (blokada) jest wyświetlana, gdy karta pamięci jest zabezpieczona przed zapisem.

7.

Wyświetlanie danych dotyczących czasu8.

Wyświetlanie nazwy klipu9.

Wskaźnik wspomagania wyświetlania gamma10.

Miernik poziomu dźwięku
Służy do wyświetlania poziomu dźwięku podczas odtwarzania.

11.

Wskaźnik wyglądu podstawowego / wyglądu do nagrywania12.

Wskaźnik lampki typu Tally13.
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Śledzenia przy użyciu funkcji wykrywania twarzy i oczu (ustawienie Face/Eye Detection AF)

Ustawianie typu zoomu

Podłączanie zewnętrznych monitorów i urządzeń nagrywających

Korzystanie z automatycznej regulacji ostrości przy jednym ujęciu (ustawienie Push Auto Focus (AF-S))

Określanie danych dotyczących czasu

Informacje ogólne dotyczące wyglądu

Automatyczna regulacja przysłony

Ręczna regulacja przysłony

Automatyczna regulacja wzmocnienia

Ręczna regulacja wzmocnienia

Automatyczne dostosowywanie ustawienia migawki

Ręczne dostosowywanie ustawienia migawki

Ustawianie docelowego poziomu automatycznej regulacji jasności

Monitor sygnału wideo

Filmowanie z korektą wyglądu na etapie postprodukcji

Clip Name Format

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montaż pionowy w stałym miejscu

W tym temacie opisano sposób montażu urządzenia na biurku lub statywie.

Uwagi dotycząca montażu
Aby zabezpieczyć obiektyw i blok złączy obiektywu na urządzeniu, nie należy zdejmować pokrywy obiektywu ani
osłony urządzenia do momentu zamocowania obiektywu.
Aby zapobiec uszkodzeniu obiektywu, nie należy trzymać jego elementów podczas pracy.
Aby zapobiec uszkodzeniu urządzenia, nie należy trzymać głowicy kamery podczas pracy.

Sprawdź miejsce montażu.

Montaż na biurku
Urządzenie należy zamontować na płaskiej powierzchni, biorąc pod uwagę przestrzeń wymaganą do obrócenia
obiektywu oraz okablowania z tyłu urządzenia.

Uwaga

Montaż należy wykonać w stabilnym miejscu, które nie jest narażone na wibracje. Miejsca narażone na wibracje mogą
powodować drgania obrazu.

Jeśli urządzenie musi być zamontowane na nachylonej powierzchni, jej kąt względem poziomu nie powinien przekraczać
±15°, a ponadto należy podjąć środki zapobiegające upadkowi urządzenia.

Montaż na statywie
Przymocuj statyw do otworu na wkręt do montażu statywu w dolnej części.
Użyj wkręta do mocowania statywu, który będzie wystawać z powierzchni montażu o podaną poniżej długość, i
dokręć go za pomocą wkrętaka ręcznego.

A: Wkręty do mocowania statywu 1/4-20 UNC, ISO 1222 (6,35 mm)

1
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Następnie zamocuj obiektyw. Zapoznaj się z sekcją „Mocowanie obiektywu”, biorąc pod uwagę informacje podane w
sekcjach „Zalecenia eksploatacyjne dotyczące mocowania/zdejmowania obiektywu”, „Sprawdzanie przełączników
obiektywu” i „Zalecenia eksploatacyjne dotyczące korzystania z obiektywu zmiennoogniskowego”.

Powiązany temat

Zalecenia eksploatacyjne dotyczące mocowania/zdejmowania obiektywu

Sprawdzanie przełączników obiektywu

Zalecenia eksploatacyjne dotyczące korzystania z obiektywu zmiennoogniskowego

Mocowanie obiektywu

5-041-958-33(1) Copyright 2022 Sony Corporation

B: Część wystająca: od 4,5 mm do 5,5 mm

Nie używać wkręta do mocowania statywu w przypadku montażu urządzenia w wysoko położonym miejscu.

Uwaga

Należy wybrać statyw, który nie przewróci się nawet po obróceniu obiektywu.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montaż pionowy w wysoko położonym stałym miejscu

W tym temacie opisano procedurę montażu pionowego urządzenia w wysoko położonym stałym miejscu za pomocą
uchwytu CIB-PCM1 (do nabycia osobno).

Aby zamontować urządzenie w wysoko położonym miejscu, należy zwrócić się do profesjonalnego wykonawcy.
W przypadku montażu w wysoko położonym miejscu należy upewnić się, że powierzchnia montażu i materiały
montażowe (z wyjątkiem akcesoriów) mogą utrzymać ciężar co najmniej 200 kg, a następnie zamontować urządzenie
zgodnie z opisem podanym w niniejszym Przewodniku pomocy. Jeśli mocowanie nie jest wystarczająco wytrzymałe,
urządzenie może spaść i spowodować poważne obrażenia.
Przymocuj dołączoną do zestawu linkę do uchwytu sufitowego CIB-PCM1 (do nabycia osobno), aby zabezpieczyć
urządzenie przed upadkiem.
Po zamontowaniu urządzenia w wysoko położonym miejscu należy raz w roku sprawdzać, czy mocowanie nie uległo
poluzowaniu. Odstęp między kontrolami można skrócić w zależności od warunków użytkowania.

Uwagi dotycząca montażu
Aby zabezpieczyć obiektyw i blok złączy obiektywu na urządzeniu, nie należy zdejmować pokrywy obiektywu i osłony
do momentu zamocowania obiektywu.
Aby zapobiec uszkodzeniu obiektywu, nie należy trzymać jego elementów podczas pracy.
Aby zapobiec uszkodzeniu urządzenia, nie należy trzymać głowicy kamery podczas pracy.

Sprawdź akcesoria do montażu w wysoko położonym miejscu i miejsce montażu.

Zestaw uchwytu sufitowego CIB-PCM1 (do nabycia osobno)
Przed rozpoczęciem sprawdź, czy masz wszystkie poniższe elementy.

Uchwyt korpusu (1)
Uchwyt sufitowy (1)
Osłona przycisku zwalniania obiektywu (1)
Linka zabezpieczająca przed upadkiem (1)
Wkręty +PSW M3×8 (9)
Wkręt +PSW M4×8 ze stali nierdzewnej do linki zabezpieczającej przed upadkiem (1)

1
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Uwaga

Linka zabezpieczająca przed upadkiem jest przeznaczona do utrzymania ciężaru urządzenia, gdy zostanie na niej
zawieszone. Nie należy przykładać do niej żadnego obciążenia innego niż obciążenie urządzeniem.

Miejsce montażu
Podczas określania miejsca i kierunku montażu należy korzystać z poniższego rysunku, biorąc pod uwagę
przestrzeń wymaganą do obrócenia obiektywu oraz okablowania z tyłu urządzenia.

A: Zakres ruchu głowicy kamery (np. obiektyw SEL70200GM2 (z zainstalowanym telekonwerterem SEL20TC):
Ø370)
B: Uchwyt sufitowy (otwór po stronie powierzchni montażu (Ø150))
C: Otwór ustalający

Uwaga

Montaż należy wykonać w stabilnym miejscu, które nie jest narażone na wibracje. Miejsca narażone na wibracje mogą
powodować drgania obrazu.

Jeśli urządzenie musi być zamontowane na nachylonej powierzchni, jej kąt względem poziomu nie powinien przekraczać
±15°, a ponadto należy podjąć środki zapobiegające upadkowi urządzenia.

Przestaw suwak blokady obrotu w poziomie/pionie w położenie LOCK, aby zablokować obrót głowicy
kamery w poziomie/pionie.

2
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Uwaga

Jeśli możliwość obrotu głowicy kamery w poziomie/pionie nie jest zablokowana, gdy dźwignia blokująca znajduje się w
położeniu LOCK, należy ręcznie przesunąć głowicę kamery do momentu jej zablokowania.

Przymocuj uchwyt korpusu do dolnej części urządzenia za pomocą sześciu dołączonych do zestawu
wkrętów (M3×8).

3
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Należy użyć wkrętów dołączonych do zestawu. Użycie wkrętów innych niż dołączone do zestawu może
spowodować uszkodzenie elementów wewnętrznych urządzenia.

Przymocuj linkę zabezpieczająca przed upadkiem do uchwytu korpusu.4
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A: Linka dołączona do zestawu 
B: Dołączony do zestawu wkręt z łbem z gniazdem krzyżowym (M4×8)
C: Metalowe oczko na linkę

Należy użyć wkręta dołączonego do zestawu. Użycie wkręta innego niż dołączony do zestawu może zmniejszyć
skuteczność działania linki.

Przymocuj uchwyt sufitowy do powierzchni (np. półki), na której ma zostać zamontowane urządzenie.5
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A: Ściana 
B: Oznaczenie △ (kierunek przodu kamery)
C: Otwór na kable połączeniowe
D: Półka lub inna powierzchnia montażowa

Przymocuj linkę zabezpieczająca przed upadkiem do miejsca w pobliżu powierzchni montażu.

Użyj wkręta z łbem sześciokątnym M5 (3/16 cala) (do nabycia osobno), aby przymocować linkę do obiektu
znajdującego się w pobliżu półki lub innej powierzchni, do której przymocowany jest uchwyt sufitowy.

6
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A: Linka 
B: Śruba z łbem sześciokątnym (M5, 3/16 cala)

Wyrównaj otwór na wkręt 〇 z przodu uchwytu korpusu z otworem ◇ w uchwycie sufitowym, włóż
urządzenie i tymczasowo zamocuj uchwyt korpusu w uchwycie sufitowym, obracając urządzenie zgodnie z
kierunkiem ruchu wskazówek zegara.

7
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A: Otwór 〇
B: Otwór ◇

Przymocuj uchwyt korpusu i uchwyt sufitowy za pomocą trzech dołączonych do zestawu wkrętów blokady
obrotu (M3×8).

8
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Następnie zamocuj obiektyw. Zapoznaj się z sekcją „Mocowanie obiektywu”, biorąc pod uwagę informacje podane w
sekcjach „Zalecenia eksploatacyjne dotyczące mocowania/zdejmowania obiektywu”, „Sprawdzanie przełączników
obiektywu” i „Zalecenia eksploatacyjne dotyczące korzystania z obiektywu zmiennoogniskowego”.

Uwaga

Po zamocowaniu obiektywu sprawdź, czy obiektyw jest stabilnie zamocowany.
Obiektyw nie jest wyposażony w zabezpieczenie przed upadkiem. Firma Sony nie ponosi żadnej odpowiedzialności za
wypadnięcie obiektywu z urządzenia.

Powiązany temat
Zalecenia eksploatacyjne dotyczące mocowania/zdejmowania obiektywu

Sprawdzanie przełączników obiektywu

Zalecenia eksploatacyjne dotyczące korzystania z obiektywu zmiennoogniskowego

Mocowanie obiektywu

Sprawdź stan montażu.

W szczególności sprawdź, czy: 

wkręty montażowe są prawidłowo zamocowane,
linka zabezpieczająca przed upadkiem jest prawidłowo zamocowana i nie jest skręcona,
urządzenie jest zamocowane poziomo (nie może się przechylać ani chwiać),
po obróceniu urządzenie nie obraca się swobodnie.

9
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montaż na suficie

W tym temacie opisano procedurę montażu urządzenia na suficie za pomocą uchwytu sufitowego (CIB-PCM1 — do
nabycia osobno).

Aby zamontować urządzenie na suficie, należy zwrócić się do profesjonalnego wykonawcy.
W przypadku montażu na suficie należy upewnić się, że powierzchnia montażu i materiały montażowe (z wyjątkiem
akcesoriów) mogą utrzymać ciężar co najmniej 200 kg, a następnie zamontować urządzenie zgodnie z opisem
podanym w niniejszym Przewodniku pomocy. Jeśli mocowanie nie jest wystarczająco wytrzymałe, urządzenie może
spaść i spowodować poważne obrażenia.
Przymocuj dołączoną do zestawu linkę do uchwytu sufitowego CIB-PCM1 (do nabycia osobno), aby zabezpieczyć
urządzenie przed upadkiem.
Po zamontowaniu urządzenia na suficie należy raz w roku sprawdzać, czy mocowanie nie uległo poluzowaniu.
Odstęp między kontrolami można skrócić w zależności od warunków użytkowania.

Uwagi dotycząca montażu
Aby zabezpieczyć obiektyw i blok złączy obiektywu na urządzeniu, nie należy zdejmować pokrywy obiektywu i osłony
do momentu zamocowania obiektywu.
Aby zapobiec uszkodzeniu obiektywu, nie należy trzymać jego elementów podczas pracy.
Aby zapobiec uszkodzeniu urządzenia, nie należy trzymać głowicy kamery podczas pracy.

Sprawdź akcesoria do montażu sufitowego i miejsce montażu.

Zestaw uchwytu sufitowego CIB-PCM1 (do nabycia osobno)
Przed rozpoczęciem sprawdź, czy masz wszystkie poniższe elementy.

Uchwyt korpusu (1)
Uchwyt sufitowy (1)
Osłona przycisku zwalniania obiektywu (1)
Linka zabezpieczająca przed upadkiem (1)
Wkręty +PSW M3×8 (9)

1
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Wkręt +PSW M4×8 ze stali nierdzewnej do linki zabezpieczającej przed upadkiem (1)

Uwaga

Linka zabezpieczająca przed upadkiem jest przeznaczona do utrzymania ciężaru urządzenia, gdy zostanie na niej
zawieszone. Nie należy przykładać do niej żadnego obciążenia innego niż obciążenie urządzeniem.

Miejsce montażu
Podczas określania miejsca i kierunku montażu należy korzystać z poniższego rysunku, biorąc pod uwagę
przestrzeń wymaganą do obrócenia obiektywu oraz okablowania z tyłu urządzenia.

A: Zakres ruchu głowicy kamery (np. obiektyw SEL70200GM2 (z zainstalowanym telekonwerterem SEL20TC):
Ø370)
B: Uchwyt sufitowy (otwór po stronie sufitu (Ø150))
C: Otwór ustalający

Uwaga

Montaż należy wykonać na suficie o odpowiedniej wytrzymałości (np. betonowym).

Aby zamontować urządzenie na suficie o niewystarczającej wytrzymałości, należy zapewnić odpowiednie wzmocnienie.

Montaż należy wykonać w stabilnym miejscu, które nie jest narażone na wibracje. Miejsca narażone na wibracje mogą
powodować drgania obrazu.

Jeśli urządzenie musi być zamontowane na nachylonej powierzchni, jej kąt względem poziomu nie powinien przekraczać
±15°, a ponadto należy podjąć środki zapobiegające upadkowi urządzenia.

Strona przeciwległa do otworu △ w uchwycie sufitowym to przód kamery (kierunek filmowania).

Przestaw suwak blokady obrotu w poziomie/pionie w położenie UNLOCK, aby odblokować obrót głowicy
kamery w poziomie/pionie i obrócić głowicę kamery o 180° w pionie.

2

Przestaw suwak blokady obrotu w poziomie/pionie w położenie LOCK, aby zablokować obrót głowicy
kamery w poziomie/pionie.

3
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Głowica kamery obrócona o 180°

Uwaga

Jeśli możliwość obrotu głowicy kamery w poziomie/pionie nie jest zablokowana, gdy dźwignia blokująca znajduje się w
położeniu LOCK, należy ręcznie przesunąć głowicę kamery do momentu jej zablokowania.

Przymocuj uchwyt korpusu do dolnej części urządzenia za pomocą sześciu dołączonych do zestawu
wkrętów (M3×8).

4
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Należy użyć wkrętów dołączonych do zestawu. Użycie wkrętów innych niż dołączone do zestawu może
spowodować uszkodzenie elementów wewnętrznych urządzenia.

Przymocuj uchwyt sufitowy do płyty montażowej (do nabycia osobno), a następnie przymocuj płytę do
sufitu.

5
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A: Uchwyt sufitowy
B: Sufit
C: Płyta montażowa
D: Otwór △
Zamocuj uchwyt zgodnie z orientacją uchwytu sufitowego
Uwaga: W przypadku montażu na suficie przód kamery znajduje się po przeciwnej stronie uchwytu sufitowego w
porównaniu z normalnym montażem pionowym. Należy wykonać montaż prawidłowo, korzystając ze schematu
przedstawiającego kierunek montażu.

A: Przód w przypadku montażu pionowego (orientacja otworu △)
B: Przód w przypadku montażu sufitowego

Uwaga

Za materiał powierzchni montażowej odpowiada klient.

Przymocuj linkę zabezpieczająca przed upadkiem do sufitu.6
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A: Uchwyt sufitowy
B: Śruba z łbem sześciokątnym (M5, 3/16 cala)
C: Linka (w zestawie)
D: Płyta montażowa
E: Sufit

Przeciągnij linkę zabezpieczająca przed upadkiem przez otwór w środku uchwytu sufitowego i przymocuj ją
do uchwytu korpusu.

Poprowadź linkę zabezpieczająca przed upadkiem przez metalowe oczko na linkę na uchwycie korpusu i przymocuj
ją do uchwytu za pomocą dołączonego do zestawu wkręta ze stali nierdzewnej (M4×8).

A: Linka dołączona do zestawu
B: Dołączony do zestawu wkręt z łbem z gniazdem krzyżowym (M4×8)
C: Metalowe oczko na linkę

7
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Należy użyć wkręta dołączonego do zestawu. Użycie wkręta innego niż dołączony do zestawu może zmniejszyć
skuteczność działania linki.

Uwaga

Zaleca się, aby jedna osoba trzymała urządzenie w sposób przedstawiony na poniższym rysunku, gdy druga osoba będzie
mocowała urządzenie.

Podczas montażu nie należy trzymać głowicy kamery ani wspornika obiektywu. W przypadku upuszczenia lub upadku
urządzenia istnieje ryzyko uszkodzenia mienia lub obrażeń ciała.

Należy zachować ostrożność podczas podłączania przewodów, aby nie dopuścić do zwarcia złączy i przewodów
elektrycznych przez linkę zabezpieczająca przed upadkiem.

Mocowanie może utrzymać podwieszoną masę o wadze do 8,8 kg (łącznie z obiektywem). Aby zapobiec upadkowi
urządzenia, nie wolno przekraczać maksymalnej dopuszczalnej masy.

Wyrównaj otwór na wkręt (A) w uchwycie korpusu z otworem ◇ (B) w uchwycie sufitowym, włóż urządzenie
i obrócić je o ok. 60 stopni w kierunku zgodnym z ruchem wskazówek zegara, aż otwór na wkręt (A) i otwór
na wkręt (C) będą wyrównane.

8
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A: Otwór na wkręt w uchwycie korpusu
B: Otwór na wkręt w uchwycie sufitowym (otwór ◇)
C: Otwór na wkręt
D: Sufit
E: Płyta montażowa

Przymocuj uchwyt korpusu i uchwyt sufitowy za pomocą trzech dołączonych do zestawu wkrętów blokady
obrotu (M3×8).

9
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Następnie zamocuj obiektyw. Zapoznaj się z sekcją „Mocowanie obiektywu”, biorąc pod uwagę informacje podane w
sekcjach „Zalecenia eksploatacyjne dotyczące mocowania/zdejmowania obiektywu”, „Sprawdzanie przełączników
obiektywu” i „Zalecenia eksploatacyjne dotyczące korzystania z obiektywu zmiennoogniskowego”.

Uwaga

Aby móc prawidłowo sterować obrotem w poziomie/pionie, gdy urządzenie jest zamontowane na suficie, w menu internetowym
ustaw opcję [Pan-Tilt] > [Direction] > [Ceiling] na [On].

Po zamocowaniu obiektywu sprawdź, czy obiektyw jest stabilnie zamocowany.
Obiektyw nie jest wyposażony w zabezpieczenie przed upadkiem. Firma Sony nie ponosi żadnej odpowiedzialności za
wypadnięcie obiektywu z urządzenia.

Powiązany temat

Sprawdź stan montażu.

W szczególności sprawdź, czy:

wkręty montażowe są prawidłowo zamocowane,
linka zabezpieczająca przed upadkiem jest prawidłowo zamocowana i nie jest skręcona,
urządzenie jest zamocowane poziomo (nie może się przechylać ani chwiać),
po obróceniu urządzenie nie obraca się swobodnie.

10
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Zalecenia eksploatacyjne dotyczące mocowania/zdejmowania obiektywu

Sprawdzanie przełączników obiektywu

Zalecenia eksploatacyjne dotyczące korzystania z obiektywu zmiennoogniskowego

Mocowanie obiektywu

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zalecenia eksploatacyjne dotyczące mocowania/zdejmowania obiektywu

Nie należy pozostawiać obiektywu skierowanego w stronę słońca. Bezpośrednie promienie słoneczne mogą przedostać
się przez obiektyw, skupić się w urządzeniu i spowodować pożar.

Uwaga

Obiektyw należy mocować/zdejmować, gdy urządzenie jest wyłączone.

Obiektyw jest elementem precyzyjnym. Nie umieszczać obiektywu na powierzchni z mocowaniem obiektywu skierowanym w dół.
Założyć osłonę mocowania obiektywu dołączoną do zestawu.

Wskazówka

Aby uzyskać szczegółowe informacje na temat obiektywów obsługiwanych przez urządzenie, należy skontaktować się z
przedstawicielem serwisu firmy Sony.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sprawdzanie przełączników obiektywu

W zależności od typu obiektywu wymagane są następujące czynności sprawdzające i ustawienia.

W przypadku obiektywu z przełącznikiem trybu regulacji ostrości

Ustaw przełącznik w położenie AF/MF lub AF.
Gdy przełącznik jest ustawiony na MF lub Full MF, ostrość można regulować tylko za pomocą pierścienia obiektywu.

Uwaga

W przypadku korzystania z obiektywu z mocowaniem typu A możliwość ręcznej regulacji za pomocą pilota zdalnego sterowania
może być niedostępna.

W przypadku obiektywu z przełącznikiem zoomu

Ustaw przełącznik w położenie SERVO.
Gdy przełącznik znajduje się w położeniu MANUAL, zoom można regulować tylko za pomocą pierścienia zoomu.
Sterowanie zoomem z poziomu urządzenia nie daje żadnego efektu.

W przypadku obiektywu z przełącznikiem funkcji automatycznej przysłony

Ustaw przełącznik w położenie AUTO.
Jeśli przełącznik nie jest ustawiony na AUTO, przysłonę można regulować tylko za pomocą pierścienia obiektywu.
Regulacja przysłony z poziomu urządzenia nie daje żadnego efektu.

W przypadku obiektywu z przełącznikiem funkcji stabilizacji obrazu

Ustaw przełącznik w położenie OFF.
Jeśli przełącznik jest ustawiony w położeniu ON, podczas operacji obrotu w poziomie/pionie może wystąpić
nieoczekiwane działanie.

SELP28135G

A: Przesuń pierścień regulacji ostrości do przodu (tryb AF/MF).
B: Ustaw przełącznik ZOOM w położenie SERVO.
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C: Przestaw pierścień przysłony w położenie „A”, a przełącznik IRIS LOCK w położenie LOCK.
D: Przestaw przełącznik funkcji stabilizacji obrazu w położenie OFF.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zalecenia eksploatacyjne dotyczące korzystania z obiektywu zmiennoogniskowego

W przypadku korzystania z obiektywu zmiennoogniskowego innego niż obiektyw z elektryczną regulacją zoomu, pozycja
zoomu może się zmieniać w zależności od warunków montażu. Zabezpiecz pierścień zoomu w odpowiednim położeniu
za pomocą taśmy.

Taśma z foliowa: 471 BLA 50 lub odpowiednik

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Mocowanie obiektywu

W tym temacie opisano sposób instalowania obiektywu z mocowaniem typu E lub obiektywu z mocowaniem typu A.

Uwaga

Nie należy transportować urządzenia z zamocowanym obiektywem.

W przypadku korzystania z obiektywu z mocowaniem typu A przysłona jest ustawiana ręcznie, a ostrość jest ustawiana w trybie
MF.

Przestaw suwak blokady obrotu w poziomie/pionie w położenie LOCK, aby zablokować obrót głowicy
kamery w poziomie/pionie.

Uwaga

Jeśli możliwość obrotu głowicy kamery w poziomie/pionie nie jest zablokowana, gdy dźwignia blokująca znajduje się w
położeniu LOCK, należy ręcznie przesunąć głowicę kamery do momentu jej zablokowania.

1

Obróć dźwignię zaciskową śruby mocującej podstawę wspornika obiektywu w kierunku przeciwnym do
ruchu wskazówek zegara, aby poluzować blokadę, a następnie odkręć śrubę mocującą podstawę wspornika
obiektywu, tak aby znajdowała się w położeniu, w którym nie będzie kolidowała z obiektywem.

2
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A: Prawidłowo
B: Nieprawidłowo

Obróć dźwignię blokady głowicy kamery w kierunku wskazanym strzałką, aby odblokować głowicę kamery.

Uwaga

Do momentu ponownego zablokowania głowicy kamery istnieje ryzyko, że głowica kamery może się przesunąć pod
własnym ciężarem. Podczas wykonywania tej operacji należy podtrzymywać głowicę kamery ręką.

3

Przesuń głowicę kamery do najbardziej wysuniętego do przodu położenia.4
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Obróć dźwignię blokady głowicy kamery w kierunku wskazanym strzałką, aby zablokować głowicę kamery.

Uwaga

Upewnij się, że dźwignia blokady głowicy kamery nie styka się z innymi częściami, aby zapobiec zakłóceniom działania
funkcji obrotu w pionie.

5

Zdejmij pokrywę oraz osłonę z urządzenia i obiektywu.6

Wyrównaj oznaczenie na mocowaniu obiektywu (białe) z oznaczeniem na urządzeniu, ostrożnie włóż
obiektyw do głowicy kamery, a następnie obracaj go zgodnie z kierunkiem ruchu wskazówek zegara do
momentu zablokowania.

A: Oznaczenia montażowe (białe)

Uwaga

Aby użyć obiektywu z mocowaniem typu A, zainstaluj adapter mocowania obiektywu (opcjonalny) w urządzeniu, a
następnie podłącz obiektyw z mocowaniem typu A.

7

Obróć dźwignię blokady głowicy kamery w kierunku wskazanym strzałką, aby odblokować głowicę kamery.8

94



Uwaga

Do momentu ponownego zablokowania głowicy kamery istnieje ryzyko, że głowica kamery może się przesunąć pod
własnym ciężarem. Podczas wykonywania tej operacji należy podtrzymywać głowicę kamery ręką.

Wyreguluj głowicę kamery, tak aby była zapewniona równowaga podczas ruchu do przodu / do tyłu, a
podstawa do przesuwania była ustawiona poziomo.

W przypadku korzystania z jednego z poniższych obiektywów można przeprowadzić regulację zgrubną w celu
utrzymania urządzenia i obiektywu w równowadze, korzystając ze skali na podstawie do przesuwania.

9

Wskazanie na skali Nazwa obiektywu

0,5 SEL70200GM (z zainstalowanym telekonwerterem SEL20TC)

1,7 SEL70200GM

2,0 SEL70200GM2 (z zainstalowanym telekonwerterem SEL20TC)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G
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Uwaga

Podczas regulacji zgrubnej w celu zapewnienia równowagi należy skorzystać ze skali na podstawie do przesuwania jako
odniesienia.

Podczas mocowania obiektywu należy przeprowadzić regulację w celu zapewnienia odpowiedniej równowagi, aby
urządzenie nie przechylało się do przodu i do tyłu.

Regulację w celu zapewnienia odpowiedniej równowagi należy przeprowadzić na poziomej powierzchni.

Odłącz zespół wspornika obiektywu w przypadku korzystania z obiektywu SELC1635G.

Wskazanie na skali Nazwa obiektywu

5,0 lub więcej SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

Obróć dźwignię blokady głowicy kamery w kierunku wskazanym strzałką, aby zablokować głowicę kamery.

Uwaga

Upewnij się, że dźwignia blokady głowicy kamery nie styka się z innymi częściami, aby zapobiec zakłóceniom działania
funkcji obrotu w pionie.
Metoda potwierdzania: Przestaw suwak blokady obrotu w poziomie/pionie w położenie UNLOCK, obróć ręcznie blok
kamery tak, aby był skierowany do góry, i wizualnie potwierdź, że nie styka się z innymi elementami. Jeśli dochodzi do
kontaktu, obróć ponownie dźwignię blokady głowicy kamery w kierunku wskazanym strzałką.

10

Obróć dźwignie zaciskowe wspornika obiektywu w kierunku przeciwnym do ruchu wskazówek zegara, aby
poluzować zespół wspornika obiektywu.

11
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A: Dźwignia zaciskowa wałków wspornika obiektywu (w 2 miejscach)
B: Zespół wspornika obiektywu

Przesuń zespół wspornika obiektywu, tak aby podstawa wspornika obiektywu była wyrównana ze śrubą
mocującą podstawę wspornika obiektywu, a następnie obróć śrubę zgodnie z ruchem wskazówek zegara,
aby zabezpieczyć podstawę wspornika obiektywu.

Uwaga

Upewnij się, że podstawa wspornika obiektywu jest ustawiona prostopadle do śruby mocującej podstawę obiektywu, a
następnie dokręć ją.

12

Obróć dźwignię zaciskową śruby mocującej podstawę wspornika obiektywu zgodnie z ruchem wskazówek
zegara, aby zablokować śrubę mocującą podstawę wspornika obiektywu.

A: Śruba mocująca podstawę wspornika obiektywu
B: Otwór na śrubę mocującą
C: Dźwignia zaciskowa śruby mocującej podstawę wspornika obiektywu

Wskazówka

Jeśli dźwignia zaciskowa znajduje się w położeniu, które utrudnia obracanie nią, należy ją zwolnić i obrócić w położenie,
które ułatwi obsługę. Po ustawieniu w żądanym położeniu należy zamknąć dźwignię zaciskową.

13
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Powiązany temat
Kalibracja obiektywu z mocowaniem typu E

5-041-958-33(1) Copyright 2022 Sony Corporation

A: Dźwignia zaciskowa śruby mocującej podstawę wspornika obiektywu
B: Dźwignia zaciskowa wałków wspornika obiektywu

Obróć dwie dźwignie zaciskowe wałków wspornika obiektywu w kierunku zgodnym z ruchem wskazówek
zegara, aby zabezpieczyć zespół wspornika obiektywu.

14

Sprawdź, czy obie dźwignie są w odpowiednim położeniu i nie są poluzowane, czy obiektyw jest
prawidłowo zamocowany oraz czy przełączniki obiektywu są prawidłowo ustawione.

Jeśli dźwignia jest poluzowana lub obiektyw nie jest prawidłowo zamocowany, obiektyw może spaść i ulec
uszkodzeniu.
W przypadku korzystania z obiektywu z mocowaniem typu E i elektryczną regulacją zoomu należy również
przeprowadzić oddzielną kalibrację obiektywu, aby dokładnie przywrócić pozycje zoomu zapisane w kamerze
jako ustawienia wstępne. Szczegółowe informacje na ten temat podano w sekcji „Kalibracja obiektywu z
mocowaniem typu E”.

15
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Odłączanie obiektywu

Obiektyw należy odłączyć, wykonując czynności podane w procedurze mocowania obiektywu w odwrotnej kolejności.

Uwaga

Należy mocno trzymać obiektyw ręką, aby nie spadł.

Jeśli nie zostanie od razu podłączony inny obiektyw, należy zawsze założyć pokrywę na korpus.

Powiązany temat

Mocowanie obiektywu

5-041-958-33(1) Copyright 2022 Sony Corporation

Sprawdź, czy włączona jest blokada obrotu w poziomie/pionie.1

Obróć dźwignię zaciskową śruby mocującej podstawę wspornika obiektywu w kierunku przeciwnym do
ruchu wskazówek zegara, aby poluzować blokadę.

2

Odkręć śrubę mocującą podstawę wspornika obiektywu do zespołu wspornika obiektywu, tak aby
znajdowała się w położeniu, w którym nie będzie kolidowała z obiektywem.

3

Odblokuj głowicę kamery i przesuń ją do najbardziej wysuniętego do przodu położenia.

Szczegółowe informacje podano w krokach od 3 do 5 w sekcji „Mocowanie obiektywu”.

4

Naciśnij i przytrzymaj przycisk zwalniania obiektywu i obróć obiektyw w kierunku przeciwnym do ruchu
wskazówek zegara, podtrzymując go.

5

Po wyrównaniu oznaczeń montażowych (w kolorze białym) na kamerze i obiektywie wyjmij obiektyw,
ciągnąc go do przodu.

6
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kable połączeniowe

W tym temacie opisano połączenia kablowe.

5-041-958-33(1) Copyright 2022 Sony Corporation

Podłącz wymagane kable do złącz na panelu tylnym.

Aby zapobiec odłączeniu kabla HDMI, wykręć wkręt montażowy płytki mocującej do kabla HDMI (M2.6×6, czarny) z
bloku złączy i zamocuj dołączoną do zestawu płytkę mocującą do kabla HDMI za pomocą wkręta montażowego.
Zamocuj kabel HDMI do płytki mocującej do kabla HDMI za pomocą dostępnej na rynku opaski kablowej lub taśmy.

A: Wkręt montażowy płytki mocującej do kabla HDMI (M2.6×6, czarny)
B: Dostępna na rynku opaska kablowa lub taśma
C: Płytka mocująca do kabla HDMI (w zestawie)

1
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Podłączanie urządzenia do urządzenia sieciowego za pomocą połączenia
przewodowego

W tym temacie opisano sposób podłączania urządzenia do urządzenia sieciowego za pomocą połączenia
przewodowego.

5-041-958-33(1) Copyright 2022 Sony Corporation

Podłącz urządzenie do urządzenia sieciowego (np. punktu dostępu do sieci Wi-Fi lub koncentratora
przełączającego) za pomocą kabla LAN kategorii 5e lub wyższej.

1

101



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zasilanie prądem przemiennym

W tym temacie opisano procedurę zasilania tego urządzenia przy użyciu zasilania sieciowego.

Przestaw suwak blokady obrotu w poziomie/pionie w położenie LOCK, aby zablokować obrót głowicy
kamery w poziomie/pionie.

1

Podłącz zasilacz sieciowy (w zestawie) do złącza DC IN w urządzeniu, a następnie podłącz przewód
zasilający (w zestawie) do źródła zasilania prądem przemiennym.

A: Złącze DC IN
B: Przewód zasilający
C: Zasilacz sieciowy

2

Zabezpiecz przewód zasilacza AC za pomocą uchwytu kablowego, aby zapobiec odłączeniu przewodu.

Odblokuj uchwyt kablowy, przełóż przewód przez uchwyt w sposób przedstawiony poniżej, a następnie zablokuj
uchwyt.

3
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Uwaga

Nie używać zasilaczy ani przewodów zasilających innych niż dostarczone z urządzeniem. Podłączenie innego zasilacza lub
przewodu zasilającego może spowodować pożar lub awarię.

Nie podłączać ani nie używać zasilacza sieciowego w miejscach o ograniczonej przestrzeni, na przykład między ścianą a
meblami.

Nie zwierać metalowych elementów wtyczki zasilacza sieciowego, W przeciwnym razie może dojść do awarii.

A: Uchwyt kablowy
B: Blokada uchwytu kablowego
C: Przewód zasilacza sieciowego

Sprawdź, czy stan kontrolki POWER z przodu urządzenia zmienił się z migania na zielono na ciągłe
świecenie na zielono oraz czy operacja uruchamiania została zakończona.

Po normalnym uruchomieniu urządzenia i podłączeniu go do sieci kontrolka NETWORK zacznie świecić na zielono.

W przypadku korzystania z obiektywu, który nie obsługuje funkcji obrotu w poziomie/pionie, należy zablokować
suwak blokady obrotu w poziomie/pionie i pominąć poniższe kroki. Szczegółowe informacje na temat
obiektywów obsługujących obrót w poziomie/pionie można uzyskać u sprzedawcy lub przedstawiciela serwisu
firmy Sony.

4

Przestaw suwak blokady obrotu w poziomie/pionie w położenie UNLOCK, aby odblokować obrót głowicy
kamery w poziomie/pionie.

5

Zresetuj obrót w poziomie/pionie.

Szczegółowe informacje na ten temat podano w sekcji „Resetowanie obrotu w poziomie/pionie”.

6
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Podłączyć zasilacz sieciowy do najbliższego źródła prądu przemiennego. Jeśli podczas pracy wystąpi problem, natychmiast
odłączyć przewód zasilający od źródła zasilania prądem przemiennym.

W przypadku odłączania zasilacza sieciowego od urządzenia należy chwycić za wtyczkę i wyciągnąć ją na wprost z urządzenia.
Pociąganie za kabel może spowodować uszkodzenie.

Powiązany temat

Resetowanie obrotu w poziomie/pionie

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Korzystanie z zasilania PoE++

Gdy to urządzenie jest podłączone do urządzenia zasilającego zgodnego ze standardem PoE++, zasilanie jest
dostarczane do urządzenia za pośrednictwem dostępnego na rynku kabla sieciowego.
Metoda ta umożliwia zasilanie urządzenia bez konieczności podłączania przewodów zasilających w miejscach, w których
nie ma gniazdka elektrycznego w pobliżu.

Przestaw suwak blokady obrotu w poziomie/pionie w położenie LOCK, aby zablokować obrót głowicy
kamery w poziomie/pionie.

1

Podłącz to urządzenie i urządzenie zasilające zgodne ze standardem PoE++ za pomocą dostępnego na
rynku kabla sieciowego.

A: Kabel sieciowy
B: Urządzenie zasilające zgodne ze standardem PoE++

2

Sprawdź, czy stan kontrolki POWER z przodu urządzenia zmienił się z migania na zielono na ciągłe
świecenie na zielono oraz czy operacja uruchamiania została zakończona.

Po normalnym uruchomieniu urządzenia i podłączeniu go do sieci kontrolka NETWORK zacznie świecić na zielono.

3
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Uwaga

Urządzenie jest zgodne ze standardem IEEE802.3bt, typ 4, klasa 8. Aby uzyskać szczegółowe informacje na temat
zweryfikowanych urządzeń zasilających zgodnych ze standardem PoE++, skontaktuj się ze sprzedawcą lub przedstawicielem
serwisu firmy Sony.

Urządzenie jest zgodne z uwierzytelnianiem programowym (LLDP), ale może być konieczne skonfigurowanie urządzeń
sieciowych (zgodnych ze standardem IEEE802.3bt).

Nie należy podłączać zasilacza sieciowego w przypadku korzystania z zasilania PoE++ z włączonym uwierzytelnianiem
programowym (LLDP).

Jeśli zasilacz sieciowy i urządzenie zasilające PoE++ są podłączone jednocześnie, zasilanie jest dostarczane z zasilacza
sieciowego.

W przypadku zasilania przez PoE++ należy użyć kabla sieciowego kategorii 5e lub wyższej.

Po ponownym włączeniu urządzenia przy zasilaniu przez PoE++ należy odczekać około 10 sekund.

W przypadku korzystania z zasilania PoE++ należy podłączyć złącze uziemienia do masy.

W przypadku podłączaniu do zasilania PoE++ nie należy prowadzić okablowania na zewnątrz.

Powiązany temat

Resetowanie obrotu w poziomie/pionie

5-041-958-33(1) Copyright 2022 Sony Corporation

Uwaga

Gdy zasilanie jest dostarczane przez PoE++, wstępne uwierzytelnianie odbywa się przed zakończeniem uruchamiania.

W przypadku korzystania z obiektywu, który nie obsługuje funkcji obrotu w poziomie/pionie, należy zablokować suwak
blokady obrotu w poziomie/pionie i pominąć poniższe kroki. Szczegółowe informacje na temat obiektywów obsługujących
obrót w poziomie/pionie można uzyskać u sprzedawcy lub przedstawiciela serwisu firmy Sony.

Przestaw suwak blokady obrotu w poziomie/pionie w położenie UNLOCK, aby odblokować obrót głowicy
kamery w poziomie/pionie.

4

Zresetuj obrót w poziomie/pionie.

Szczegółowe informacje na ten temat podano w sekcji „Resetowanie obrotu w poziomie/pionie”.

5
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Resetowanie obrotu w poziomie/pionie

Funkcję obrotu w poziomie/pionie można zresetować, na przykład po wymianie obiektywu, postępując zgodnie z
poniższą procedurą.

5-041-958-33(1) Copyright 2022 Sony Corporation

Przestaw suwak blokady obrotu w poziomie/pionie w położenie UNLOCK i sprawdź, czy obrót głowicy
kamery w poziomie/pionie został odblokowany.

1

Uruchom funkcję resetowania obrotu w poziomie/pionie.

Funkcję resetowania obrotu w poziomie/pionie można uruchomić za pomocą pilota zdalnego sterowania na
podczerwień, aplikacji internetowej lub pilota zdalnego sterowania RM-IP500 (do nabycia osobno).

Obsługa za pomocą pilota zdalnego sterowania na podczerwień: naciśnij przycisk P/T RESET.
Obsługa za pomocą aplikacji internetowej: naciśnij przycisk  (reset obrotu w poziomie/pionie) na karcie

 (Others) w panelu ustawień kamery lub na ekranie sterowania w czasie rzeczywistym.
Obsługa za pomocą pilota zdalnego sterowania RM-IP500: zapoznaj się z instrukcją obsługi pilota RM-IP500.

Uwaga

Zresetowanie obrotu w poziomie/pionie spowoduje obrót głowicy kamery i obiektywu. Przed wykonaniem tej czynności
sprawdź, czy obiektyw nie uderzy w przeszkody.

Urządzenie jest wyposażone w funkcję ograniczający zakres obrotu w poziomie/pionie, ale funkcja ta jest wyłączana po
włączeniu urządzenia lub wykonaniu resetu obrotu w poziomie/pionie.

Wskazówka

Po zakończeniu resetowania obrotu w poziomie/pionie urządzenie powraca do pozycji sprzed wykonania tej operacji.

2
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Uzyskiwanie dostępu do aplikacji internetowej z poziomu przeglądarki internetowej

Po podłączeniu urządzenia do tabletu lub komputera można obsługiwać i konfigurować urządzenie za pomocą
przeglądarki internetowej.

Sprawdź, czy tablet lub komputer obsługuje aplikację internetową.

Uwaga

W przypadku niespełnienia wymagań dotyczących środowiska lub w zależności od sposobu korzystania z
tabletu/komputera funkcja wyświetlania wideo w przeglądarce internetowej może nie działać prawidłowo.

Aplikacja internetowa tego urządzenia korzysta z języka JavaScript. W przypadku korzystania z oprogramowania
antywirusowego na tablecie/komputerze, strona internetowa może nie być wyświetlana prawidłowo.

1

Pozycja Wymaganie

Wyświetlacz

Zalecana rozdzielczość: co najmniej
1080×810 pikseli
Zalecany rozmiar wyświetlacza
tabletu: co najmniej 10 cali

Obsługiwane systemy operacyjne i
przeglądarka internetowa

Windows

System operacyjny Windows 10 lub nowszy

Przeglądarka
internetowa

Google Chrome

Mac

System operacyjny macOS 10.15 lub nowszy

Przeglądarka
internetowa

Google Chrome
Safari

iPad

System operacyjny iPadOS 15 lub nowszy

Przeglądarka
internetowa

Google Chrome
Safari

Android

System operacyjny Android 12 lub nowszy

Przeglądarka
internetowa

Google Chrome

Sprawdź, czy urządzenie, tablet lub komputer oraz urządzenia peryferyjne są włączone.2

Sprawdź, czy urządzenie i tablet lub komputer są połączone poprzez sieć Wi-Fi lub przewodową sieć LAN.3

Nawiąż połączenie z urządzeniem za pomocą przeglądarki internetowej na tablecie lub komputerze.

Nawiązywania połączenia poprzez zeskanowanie kodu QR
Zeskanuj kod QR nadrukowany na pokrywie sekcji gniazd kart z boku urządzenia, korzystając z aparatu tabletu.

4
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Uwaga

Jeśli numer portu HTTP został zmieniony z wartości 80, w pasku adresu wprowadź „http://adres IP urządzenia:numer portu”.

W przypadku nawiązywania połączenia poprzez zeskanowanie kodu QR lub wprowadzenie adresu URL w pasku adresu
przeglądarki internetowej należy korzystać z urządzenia obsługującego protokół mDNS*.

Wskazówka

Później będzie można uzyskiwać szybki dostęp do urządzenia za pomocą funkcji zakładki w przeglądarce internetowej.

5-041-958-33(1) Copyright 2022 Sony Corporation

Otwórz wyświetlone łącze na tablecie.
Na tablecie zostanie uruchomiona przeglądarka internetowa i pojawi się ekran aplikacji internetowej urządzenia.

Nawiązywanie połączenia poprzez wprowadzenie adresu URL w pasku adresu przeglądarki internetowej
Uruchom przeglądarkę internetową na tablecie lub komputerze i wprowadź adres URL wydrukowany na pokrywie
sekcji gniazd kart z boku urządzenia.
W przeglądarce internetowej powinien zostać wyświetlony ekran aplikacji internetowej urządzenia.

Nawiązywanie połączenia poprzez wprowadzenie adresu IP w pasku adresu przeglądarki internetowej
Uruchom przeglądarkę internetową na tablecie lub komputerze i wpisz „http://adres IP urządzenia” w pasku adresu.
W przeglądarce internetowej powinien zostać wyświetlony ekran aplikacji internetowej urządzenia.

mDNS: protokół komunikacyjny używany do określenia adresu IP na podstawie nazwy hosta w sieci lokalnej.*
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Inicjalizacja urządzenia

Przy pierwszym użyciu urządzenia należy je skonfigurować, postępując zgodnie z poniższą procedurą.

Wskazówka

Jeśli akumulator rezerwowy zostanie całkowicie rozładowany, konieczne będzie ponowne skonfigurowanie ustawień
początkowych.

Nawiąż połączenie z urządzeniem za pomocą tabletu lub komputera i uruchom aplikację internetową.

Gdy urządzenie jest używane po raz pierwszy, w przeglądarce internetowej zostanie wyświetlony monit o
wprowadzenie nazwy użytkownika i hasła. Wprowadź następujące ustawienia.

Nazwa użytkownika: admin
Hasło: (pozostaw puste)

Postępuj zgodnie z instrukcjami wyświetlanymi na ekranie, aby skonfigurować ustawienia początkowe.

1

Wprowadź nazwę użytkownika (Administrator) i hasło administratora, a następnie naciśnij przycisk [OK].

1: Wprowadź nazwę użytkownika będącego administratorem.
2: Ustaw hasło administratora.
3: Wprowadź ponownie to samo hasło w celu potwierdzenia.

Uwaga

W nazwie użytkownika i haśle dozwolone są podane poniżej znaki. Hasło musi zawierać co najmniej jedną wielką literę,
jedną małą literę, jedną cyfrę i składać się z 8–64 znaków.

Znaki alfanumeryczne

2

110



Zostanie wyświetlony ekran sterowania operacjami filmowania w czasie rzeczywistym. Kontynuuj konfigurację
podstawowych ustawień urządzenia zgodnie z trybem działania.

Wskazówka

W niektórych przypadkach, na przykład przy korzystaniu z urządzenia w połączeniu z tabletem, łatwiejsze może być użycie
stałego adresu IP urządzenia.

Symbole (!$%`*+-./<=>?@[]^_{|}~)

Przeglądarka internetowa zostanie ponownie załadowana i pojawi się monit o wprowadzenie nazwy użytkownika i
hasła.

Wprowadź nazwę użytkownika i hasło skonfigurowane w kroku 2.

Zostanie wyświetlony ekran konfiguracji języka oraz zegara.

3

Określ następujące pozycje i dotknij przycisku [OK].

[Language]
Umożliwia wybranie języka, który będzie używany w aplikacji internetowej i na ekranie kamery. Zmiana języka
spowoduje zmianę języka zawartości wyświetlanej w aplikacji internetowej.
[Date & Time Format]
Umożliwia wybranie formatu wyświetlania daty i godziny spośród następujących opcji.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
„yyyy” wskazuje rok, „mm” wskazuje miesiąc, „dd” wskazuje dzień, „hh” wskazuje godzinę, „mm” wskazuje minutę, a
„ss” sekundę.
[12 h/24 h]
Umożliwia wybranie sposobu wyświetlania godziny: [12 h](zegar 12-godzinny) lub [24 h] (zegar 24-godzinny).
[Time Setting]
Umożliwia wybranie sposobu ustawiania daty/godziny.
[Synchronize with PC]: Synchronizacja daty/godziny z datą/godziną na komputerze lub tablecie.
[Manual setting]: Ustawianie ręczne. Po wybraniu tej metody wyświetlane są pola wprowadzania daty i godziny.
[Time Zone]
Umożliwia wybór strefy czasowej.

4
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Aby ustawić stały adres IP, najpierw wyłącz opcję [Network] > [Wired LAN] > [IPv4] > [DHCP] (przełącznik suwakowy ustawiony w
lewym położeniu) w menu internetowym.

Zostaną wyświetlone pozycje ustawień związane ze stałym adresem IP. Skonfiguruj te pozycje, a następnie naciśnij przycisk [OK]
na ekranie.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Konfigurowanie podstawowych ustawień

W tym temacie opisano sposób konfigurowania podstawowych ustawień urządzenia.

Konfigurowanie trybu filmowania

Można wybrać tryb filmowania odpowiedni do danej sytuacji.

Tryb Custom: elastyczność opcji przy filmowaniu.
Tryb filmowania Log: nagrywanie materiału S-Log.

Tryb Flexible ISO: ustawienia ekspozycji są określane poprzez dostosowywanie wartości ISO do filmowanej
sceny.
Tryb Cine EI / tryb Cine EI Quick: urządzenie działa podobnie jak kamera filmowa (podczas filmowania obrazy nie
są w pełni tworzone), a materiał filmowy jest przetwarzany w procesie postprodukcji.

W trybie Cine EI Quick czułość podstawowa odpowiednia dla wskaźnika ekspozycji jest wybierana automatycznie.
Do przełączania trybu filmowania służy opcja [Project] > [Base Setting] > [Shooting Mode] w menu internetowym lub w
menu kamery.

Tryb Custom
Można wybrać standard transmisji wideo.
Do przełączania służy opcja [Project] > [Base Setting] > [Target Display] w menu internetowym lub w menu kamery.

[SDR(BT.709)]: filmowanie zgodnie ze standardem transmisji HD
[HDR(HLG)]: filmowanie zgodnie ze standardem transmisji 4K nowej generacji

Szczegółowe informacje podano w sekcji „Informacje ogólne dotyczące wyglądu” oraz w innych sekcjach rozdziału
„Filmowanie z odpowiednim wyglądem”.

Tryby filmowania Log
(Flexible ISO / Cine EI / Cine EI Quick)
W trybach filmowania Log można wybrać podstawową gamę kolorów dla sygnałów nagrywanych i sygnałów
wyjściowych. Wybrana tutaj gama kolorów to gama kolorów wyjścia wideo w przypadku, gdy dla ustawienia [LUT On/Off]
wybrano [MLUT Off].
Gamę kolorów można przełączyć za pomocą opcji [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] w menu kamery.

[S-Gamut3.Cine/SLog3]: łatwa w regulacji gama kolorów na potrzeby kina cyfrowego (DCI-P3).
[S-Gamut3/SLog3]: szeroka gama kolorów firmy Sony, która obejmuje gamę kolorów ITU-R BT.2020.

Aby uzyskać szczegółowe informacje, zapoznaj się z sekcją „ Filmowanie z korektą wyglądu na etapie postprodukcji”.
 
Obsługiwane funkcje w każdym trybie filmowania przedstawiono w poniższej tabeli.
●: Obsługiwana, –: Nieobsługiwana

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –
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Wskazówka

Tryby Cine EI Quick i Cine EI umożliwiają filmowanie z podstawową czułością ISO bez stosowania wzmocnienia w celu
maksymalnego zwiększenia efektywności przetwornika obrazu. Jasność można regulować za pomocą oświetlenia oraz filtra ND,
aby dostosować ilość światła docierającego do przetwornika obrazu.

Ustawienie częstotliwości systemowej

Do przełączania służy opcja [Project] > [Rec Format] > [Frequency] w menu internetowym lub w menu kamery. W
zależności od wybranej wartości urządzenie może automatycznie uruchomić się ponownie po przełączeniu.

Uwaga

Podczas nagrywania lub odtwarzania nie można zmieniać częstotliwości systemu.

Ustawianie trybu skanowania przetwornika obrazu

Można ustawić efektywny rozmiar obrazu i rozdzielczość przetwornika obrazu.
Do przełączania służy opcja [Project] > [Rec Format] > [Imager Scan Mode] w menu internetowym lub w menu kamery.
[FF]: rozmiar pełnej klatki.
[S35]: rozmiar Super 35 mm.

Uwaga

Podczas nagrywania lub odtwarzania nie można zmienić trybu skanowania przetwornika obrazu.

W przypadku wybrania ustawienia S35 format wideo jest ograniczony do rozdzielczości 1920×1080.

Ustawianie kodeka

Istnieje możliwość ustawienia kodeka na potrzeby nagrywania.
Do przełączania służy opcja [Project] > [Rec Format] > [Codec] w menu internetowym lub w menu kamery.

Uwaga

Podczas nagrywania lub odtwarzania nie można zmienić kodeka.

Ustawianie formatu wideo

Istnieje możliwość ustawienia formatu wideo na potrzeby nagrywania oraz formatu sygnału wyprowadzanego z kamery.

Custom Flexible ISO Cine EI Cine EI Quick

Base ISO – ● ● ● (powiązanie ze wskaźnikiem ekspozycji)

Exposure Index – – ● ●

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(z wyjątkiem ustawienia Base Look)

● – – –
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Do przełączania formatu wideo służy opcja [Project] > [Rec Format] > [Video Format] w menu internetowym lub w
menu kamery.
Do przełączania formatu sygnału wyjściowego wyprowadzanego ze złącz SDI OUT i HDMI OUT służy opcja
[Monitoring] > [Output Format] w menu internetowym lub w menu kamery.

Uwaga

Podczas nagrywania lub odtwarzania nie można zmienić formatu wideo.

W zależności od ustawienia formatu wideo mogą występować ograniczenia dotyczące sygnału ze złączy SDI OUT i HDMI OUT.

Powiązany temat

Informacje ogólne dotyczące wyglądu

Filmowanie z korektą wyglądu na etapie postprodukcji

5-041-958-33(1) Copyright 2022 Sony Corporation
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Obsługiwane karty pamięci

Urządzenie nagrywa dźwięk i obraz na kartach pamięci CFexpress typu A (do nabycia osobno) lub kartach pamięci
SDXC (do nabycia osobno) włożonych do gniazd kart. Karty pamięci są używane również do nagrywania pomocniczego.

Karty pamięci CFexpress typu A

W urządzeniu należy używać kart pamięci CFexpress typu A firmy Sony* wskazanych w sekcji „Nośniki zalecane do
nagrywania”.
Aby uzyskać szczegółowe informacje na temat działania kamery z nośnikami innych producentów, zapoznaj się z
instrukcją obsługi nośnika lub z informacjami udostępnianymi przez danego producenta.

Karty pamięci SDXC

W urządzeniu należy używać kart pamięci SDXC* wskazanych w sekcji „Nośniki zalecane do nagrywania”.

Nośniki zalecane do nagrywania

Gwarancja działania jest uzależniona od ustawień Rec Format i Recording.

CFexpress typu A
Zgodne ze standardem VPG400
Obsługiwane w przypadków wszystkich formatów nagrywania urządzenia.

SDXC
Obsługiwane w warunkach podanych w poniższej tabeli. „●” oznacza, że działanie zostało zweryfikowane, a „–”
wskazuje, że działanie nie jest gwarantowane.

RAW Out & XAVC-I, 4096×2160 Class 300, tryb normalny

RAW Out & XAVC-I, 3840×2160 Class 300, tryb normalny

Określane jako „karty CFexpress” w niniejszym Przewodniku pomocy.*

Określane jako „karty SD” w niniejszym Przewodniku pomocy.*

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●
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RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (60 fps lub mniej)

RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Zweryfikowany nośnik jest niedostępny.

XAVC-I, 4096×2160 Class 300, tryb normalny

XAVC-I, 4096×2160 Class 300, S&Q (60 fps lub mniej)

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●
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XAVC-I, 3840×2160 Class 300, tryb normalny

XAVC-I, 3840×2160 Class 300, S&Q (60 fps lub mniej)

XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Zweryfikowany nośnik jest niedostępny.

XAVC-I, 1920×1080 Class 100, tryb normalny

XAVC-I, 1920×1080 Class 100, S&Q (60 fps lub mniej)

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

24P – – – – – – ●

23.98P – – – – – – ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●
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XAVC-I, 1920×1080 Class 100, S&Q (100 fps, 120 fps)

XAVC-I, 1920×1080 Class 100, S&Q (150 fps, 180 fps)
Zweryfikowany nośnik jest niedostępny.

XAVC-I, 1920×1080 Class 100, S&Q (200 fps, 240 fps)
Zweryfikowany nośnik jest niedostępny.

XAVC-L, 3840×2160 420, tryb normalny

XAVC-L, 3840×2160 420, S&Q (60 fps lub mniej)

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 3840×2160 420, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, tryb normalny

XAVC-L, 1920×1080 HD50, S&Q (60 fps lub mniej)

XAVC-L, 1920×1080 HD50, S&Q (100 fps, 120 fps)

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 1920×1080 HD50, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD50, S&Q (200 fps, 240 fps)

XAVC-L, 1920×1080 HD35, tryb normalny

XAVC-L, 1920×1080 HD35, S&Q (60 fps lub mniej)

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●
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XAVC-L, 1920×1080 HD35, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD35, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD35, S&Q (200 fps, 240 fps)

5-041-958-33(1) Copyright 2022 Sony Corporation

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – ● – ● ● ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Częstotliwość systemu Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●

122



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Wkładanie kart pamięci

W tym temacie opisano zalecenia eksploatacyjne dotyczące wkładania kart pamięci.

Otwórz pokrywę sekcji gniazd kart.1

Włóż kartę pamięci.

W przypadku kart CFexpress etykieta powinna być skierowana do góry.

Uwaga

W przypadku urządzenia zamocowanego na suficie etykieta powinna być skierowana w dół.

W przypadku kart SD etykieta powinna być skierowana w dół.

Uwaga

W przypadku urządzenia zamocowanego na suficie etykieta powinna być skierowana w górę.

Wskaźnik dostępu świeci się na czerwono, a następnie zmienia kolor na zielony, jeśli karta nadaje się do użycia.

2
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Uwaga

Karta pamięci, gniazdo karty pamięci i dane obrazu na karcie pamięci mogą zostać uszkodzone, jeśli karta zostanie na siłę
włożona do gniazda w niewłaściwej orientacji.

Jeżeli nagrywa się na nośnikach włożonych do obu gniazd (A i B) na karty pamięci CFexpress typu A / karty pamięci SD, należy
włożyć do obu gniazd nośniki zalecane w przypadku danego formatu nagrywania.

5-041-958-33(1) Copyright 2022 Sony Corporation

Uwaga

Jeśli wskaźnik dostępu miga nieprzerwanie na czerwono i nie zmienia koloru na zielony, należy na chwilę wyłączyć
urządzenie, a następnie wyjąć i ponownie włożyć kartę pamięci.

Zamknij pokrywę sekcji gniazd kart.3
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Wyjmowanie karty pamięci

Otwórz osłonę sekcji gniazd kart i delikatnie naciśnij kartę pamięci, aby ją wysunąć.

Uwaga

Jeśli urządzenie zostanie wyłączone lub karta pamięci zostanie wyjęta podczas uzyskiwania dostępu do karty, integralność
danych na karcie nie jest gwarantowana. Wszystkie dane zapisane na karcie mogą zostać usunięte. Przed wyłączeniem
urządzenia lub wyjęciem karty pamięci należy się zawsze upewnić, że wskaźnik dostępu świeci na zielono lub jest wyłączony.

W przypadku wyjmowania karty pamięci natychmiast po zakończeniu nagrywania karta może być gorąca, ale nie wskazuje to na
występowanie problemu.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Formatowanie (inicjalizacja) kart pamięci

W przypadku włożenia niesformatowanej karty pamięci lub karty pamięci sformatowanej zgodnie z inną specyfikacją w
panelu obrazu z kamery zostanie wyświetlony komunikat „Media Needs to be Formatted”.
Sformatuj kartę zgodnie z poniższą procedurą.

Uwaga

Formatowanie karty pamięci powoduje usunięcie wszystkich danych, w tym zarejestrowanych danych wideo i plików
konfiguracyjnych.

Podczas procesu formatowania mogą pojawiać się komunikaty — w zależności od czasu jego trwania.

Niepowodzenie operacji formatowania
Nie można sformatować kart pamięci nieobsługiwanych przez urządzenie.
W przypadku podjęcia takiej próby zostanie wyświetlony komunikat ostrzegawczy. Należy postępować zgodnie z
instrukcjami, aby wymienić kartę pamięci na obsługiwaną.

Korzystanie z karty sformatowanej w tym urządzeniu w gnieździe innego urządzenia
Najpierw należy wykonać kopię zapasową zawartości karty, a następnie sformatować ponownie kartę w innym
urządzeniu.

5-041-958-33(1) Copyright 2022 Sony Corporation

Wybierz opcję [TC/Media] > [Format Media] w menu kamery.1

Wybierz opcję Media(A) (gniazdo A) lub Media(B) (gniazdo B), a następnie wybierz metodę formatowania
(Full Format lub Quick Format).

Zostanie wyświetlony komunikat z prośbą o potwierdzenie.
[Full Format]: pełna inicjalizacja nośnika, łącznie z informacjami dotyczącymi regionu danych i zarządzania
danymi.
[Quick Format]: inicjalizacja wyłącznie informacji dotyczących zarządzania danymi na nośniku.

2

Wybierz pozycję [Execute].

W trakcie formatowania wyświetlany jest komunikat, a wskaźnik dostępu świeci się na czerwono.
Po zakończeniu formatowania pojawi się komunikat informujący o jego ukończeniu.

3
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sprawdzanie pozostałego czasu nagrywania

Podczas filmowania (tryb nagrywania/gotowości) można monitorować pozostałą pojemność karty pamięci w każdym
gnieździe, korzystając ze wskaźników pozostałej pojemności nośników w gniazdach A/B w panelu obrazu z kamery.
Pozostały czas nagrywania jest obliczany na podstawie pozostałej pojemności nośnika w każdym gnieździe oraz
bieżącego formatu nagrywania (szybkości bitowej nagrywania). Jest on wyświetlany w minutach.

Moment wymiany karty pamięci
Gdy całkowity pozostały czas nagrywania na dwóch kartach pamięci spadnie poniżej 5 minut, pojawi się komunikat
„Media Near Full”, a kontrolka nagrywania (lampka typu Tally) zacznie migać w celu ostrzeżenia użytkownika.
Należy wymienić nośnik na inny, na którym jest wolne miejsce.
Jeżeli będzie się kontynuować nagrywanie do chwili, gdy całkowity pozostały czas nagrywania spadnie do zera,
komunikat zmieni się na „Media Full” i nagrywanie zostanie zatrzymane.

Uwaga

Na jednej karcie pamięci można zapisać maksymalnie około 600 klipów.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Przywracanie kart pamięci

Jeśli z jakiegokolwiek powodu wystąpi błąd na karcie pamięci, należy ją przywrócić przed użyciem.
Po włożeniu karty pamięci wymagającej przywrócenia w panelu obrazu z kamery pojawi się komunikat z pytaniem, czy
chce się ją przywrócić.

Przywracanie karty
Wybierz pozycję [Execute] za pomocą przycisków strzałek w panelu do obsługi interfejsu użytkownika i naciśnij przycisk
[Set].
Podczas formatowania wyświetlany jest komunikat i bieżący postęp (w %), a wskaźnik dostępu świeci się na czerwono.
Po zakończeniu przywracania pojawi się komunikat o ukończeniu.

Niepowodzenie operacji przywracania
Karty pamięci, w których wystąpiły błędy pamięci, nie mogą zostać przywrócone. W przypadku podjęcia takiej próby
zostanie wyświetlony komunikat ostrzegawczy. Należy postępować zgodnie z instrukcjami, aby wymienić kartę
pamięci.
Karty pamięci, w których wystąpiły błędy pamięci, mogą nadawać się do użytku, jeśli zostaną ponownie
sformatowane.
W pewnych przypadkach niektóre klipy mogą zostać przywrócone, a inne nie. Przywrócone klipy można normalnie
odtwarzać.

Uwaga

Do przywracania nośników nagranych za pomocą niniejszego urządzenia należy używać tego urządzenia.

Nośniki nagrane za pomocą urządzenia innego niż to urządzenie lub za pomocą innego urządzenia o innej wersji (nawet w
przypadku tego samego modelu) mogą nie zostać przywrócone za pomocą tego urządzenia.

Klipy krótsze niż 2 sekundy nie mogą zostać przywrócone.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rozpoczynanie/zatrzymywanie nagrywania

W tym temacie opisano sposób rozpoczynania/zatrzymywania nagrywania.

Podłącz niezbędne urządzenia i sprawdź, czy zasilanie jest dostarczane do urządzenia oraz urządzeń
peryferyjnych.

1

Włóż karty pamięci.2

Sprawdź stan zasilania urządzenia w lewym górnym rogu ekranu aplikacji internetowej.

Gdy zasilanie jest włączone
Po włączeniu urządzenia w przełączniku zasilania w górnej części ekranu aplikacji internetowej wyświetlana jest
pozycja [Power ON].

Kontrolka POWER z przodu urządzenia zacznie świecić, a na ekranie sterowania w czasie rzeczywistym w aplikacji
internetowej pojawi się obraz z kamery.

Uwaga

Jeśli hasło administratora nie zostało skonfigurowane, zostanie wyświetlony ekran z prośbą o skonfigurowanie hasła. Patrz:
„Inicjalizacja urządzenia”.

Gdy włączony jest stan zasilania w trybie gotowości
Gdy urządzenie jest w trybie gotowości, w przełączniku zasilania w aplikacji internetowej wyświetlana jest pozycja
[Power Standby].

Gdy urządzenie jest tym stanie zasilania, naciśnij przełącznik zasilania i wybierz pozycję [Power ON]. Urządzenie
włączy się, kontrolka POWER z przodu urządzenia zacznie świecić na zielono, a na ekranie sterowania w czasie
rzeczywistym w aplikacji internetowej pojawi się obraz z kamery.

3
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Przełączanie urządzenia w tryb gotowości
Naciśnij przełącznik zasilania w aplikacji internetowej i wybierz pozycję [Power Standby], aby przełączyć urządzenie w
tryb gotowości.

Wskazówka

Urządzenie można również włączyć za pomocą przycisku zasilania na dołączonym do zestawu pilocie zdalnego sterowania
na podczerwień.

Naciśnij przycisk START/STOP do obsługi nagrywania.

Rozpocznie się nagrywanie, a kontrolka nagrywania (lampka typu Tally) urządzenia (dostępna w 2 miejscach)
zacznie świecić.
Podczas nagrywania świeci się przycisk START/STOP do obsługi nagrywania. Ponadto wyświetlana jest ikona
docelowego nośnika przeznaczonego do nagrywania oraz pozycja [●Rec].

4

Aby zatrzymać nagrywanie, naciśnij ponownie przycisk START/STOP do obsługi nagrywania.

Nagrywanie zostanie zatrzymane, a kontrolka nagrywania (lampka typu Tally) urządzenia (dostępna w 2 miejscach)
przestanie świecić.
Podczas nagrywania w trybie gotowości przycisk START/STOP do obsługi nagrywania nie świeci się. Ponadto
wyświetlana jest ikona docelowego nośnika przeznaczonego do nagrywania oraz pozycja [Stby].

Wskazówka

Nagrywanie można również rozpocząć/zatrzymać za pomocą przycisku START/STOP do obsługi nagrywania na
dołączonym do zestawu pilocie zdalnego sterowania na podczerwień.

5
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Wskazówka

Tryb gotowości można również włączyć za pomocą przycisku zasilania na dołączonym do zestawu pilocie zdalnego sterowania
na podczerwień.

Powiązany temat
Inicjalizacja urządzenia

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przełączanie między kartami pamięci

Gdy włożone są dwie karty pamięci, można nacisnąć przycisk [Slot Select] na panelu sterowania odtwarzaniem w
aplikacji internetowej, aby przełączyć karty pamięci.

Wskazówka

W celu przełączenia kart pamięci można również nacisnąć przycisk SLOT SEL (wybór gniazda kart pamięci (A)/(B)) na
dołączonym do zestawu pilocie zdalnego sterowania na podczerwień.

Informacje o nagrywaniu ciągłym

Podczas nagrywania urządzenie zostanie automatycznie przełączone na drugą kartę pamięci tuż przed wyczerpaniem
miejsca na pierwszej karcie (nagrywanie ciągłe). Można przełączać między kartami pamięci i kontynuować nagrywanie w
sposób ciągły, wymieniając pełną kartę pamięci na nową.

Uwaga

Nie można przełączać między kartami pamięci w trybie odtwarzania. Nie jest również obsługiwane ciągłe odtwarzanie klipu
obejmującego multimedia zarówno w gnieździe A, jak i gnieździe B.

Informacje o zapisanych danych

Po zatrzymaniu nagrywania obraz i dźwięk oraz dane towarzyszące od początku do końca nagrania są zapisywane jako
pojedynczy klip na karcie pamięci.

Nazwa nagranego klipu

Do każdego klipu nagranego przez urządzenie automatycznie przypisywana jest nazwa przy użyciu opcji [TC/Media] >
[Clip Name Format] w menu kamery.

Maksymalny czas trwania klipu

Do 6 godzin na klip.
Maksymalny czas trwania ciągłego nagrywania jest taki sam jak maksymalny czas trwania klipu. Jeśli czas nagrywania
przekracza maksymalny czas trwania klipu, tworzony jest automatycznie nowy klip i nagrywanie jest kontynuowane.
Nowy klip pojawi się jako oddzielny klip na ekranie miniatur.
Podczas nagrywania ciągłego nagrywanych jest kolejno wiele klipów, ale nagrywanie zatrzyma się automatycznie po
upływie około 24 godzin.

Uwaga

Nie wyjmować karty pamięci, gdy odbywa się na niej nagrywanie. Podczas nagrywania należy wymieniać karty pamięci tylko w
gniazdach, w których wskaźnik dostępu do gniazda jest wyłączony.

Gdy pozostała pojemność karty pamięci, na której odbywa się nagrywanie, spadnie do poziomu poniżej jednej minuty, a do
drugiego gniazda zostanie włożona karta pamięci umożliwiająca nagrywanie, pojawi się komunikat „Will Switch Slots Soon”.
Komunikat zniknie po przełączeniu gniazd kart pamięci.

Nagrywanie ciągłe może nie działać, jeśli nagrywanie rozpocznie się, gdy pozostała pojemność karty pamięci jest mniejsza niż
jedna minuta. Aby zapewnić prawidłowe nagrywanie ciągłe, przed rozpoczęciem nagrywania należy sprawdzić, czy pozostała
pojemność karty pamięci wynosi ponad minutę.

Wideo utworzone za pomocą funkcji nagrywania ciągłego urządzenia nie może być prawidłowo odtwarzane na urządzeniu.
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Aby połączyć wideo utworzone za pomocą funkcji nagrywania ciągłego urządzenia, należy użyć oprogramowania „Catalyst
Browse”.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Sprawdzanie ustawień sygnału audio

Dźwięk jest wyprowadzany ze złączy SDI i HDMI urządzenia. Wybierz kombinację kanałów audio wyprowadzanych ze
złącza HDMI, korzystając z opcji [Audio] > [Audio Output] > [HDMI/Stream Output CH] w menu kamery.
CH1/CH2: Kombinacja kanałów CH1 i CH2
CH3/CH4: Kombinacja kanałów CH3 i CH4
Podczas monitorowania dźwięku w aplikacji internetowej można użyć miernika poziomu dźwięku dostępnego w prawym
dolnym rogu panelu obrazu z kamery.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Określanie danych dotyczących czasu

W tym temacie opisano sposób ustawiania danych dotyczących czasu.

Ustawianie kodu czasowego

Kod czasowy można ustawić za pomocą opcji [TC/Media] > [Timecode] w menu kamery.

Ustawianie bitów użytkownika

Do zapisanego obrazu można dodać 8-cyfrową liczbę szesnastkową jako bity użytkownika. Można także ustawić bity
użytkownika na bieżący czas. Ustawienie to można skonfigurować, wybierając kolejno opcje [TC/Media] > [Users Bit] w
menu kamery.

Wyświetlanie danych dotyczących czasu

Kod czasowy, który ma być wyświetlany, można ustawić za pomocą opcji [TC/Media] > [TC Display] > [Display Select] w
menu kamery.
Naciśnięcie przycisku konfigurowalnego, do którego przypisano funkcję [DURATION/TC/U-BIT] powoduje przełączenie
wyświetlania między kodem czasowym, bitami użytkownika i czasem trwania (w tej kolejności).

5-041-958-33(1) Copyright 2022 Sony Corporation

135



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Przeglądanie nagrania (funkcja Rec Review)

Ostatnio nagrany klip można przeglądać na ekranie (przeglądanie nagrania).

Uwaga

Funkcja Rec Review nie jest obsługiwana, jeśli format wideo został zmieniony po nagraniu klipu.

Ustawianie pozycji początkowej funkcji Rec Review

Pozycję rozpoczęcia odtwarzania można ustawić na jedną z podanych poniżej, używając ustawienia [Technical] > [Rec
Review] w menu kamery.

Ostatnie 3 sekundy klipu
Ostatnie 10 sekundy klipu
Początek klipu

Wskazówka

Jeśli chce się przejrzeć określony klip po nagraniu wielu klipów, należy nacisnąć przycisk [Thumbnail], aby wyświetlić ekran
miniatur, a następnie wybrać klip w celu rozpoczęcia odtwarzania.

Można również nacisnąć przycisk THUMBNAIL na dołączonym do zestawu pilocie zdalnego sterowania na podczerwień, aby
wyświetlić ekran miniatur.

Sposób korzystania z funkcji Rec Review

Przypisz wcześniej funkcję Rec Review do jednego z przycisków konfigurowalnych na panelu dostosowywania
podstawowej konfiguracji kamery.

Szczegółowe informacje na temat przypisania podano w sekcji „Przyciski konfigurowalne” w rozdziale „Przydatne
funkcje”.

Zatrzymaj nagrywanie, a następnie naciśnij przycisk konfigurowalny, do którego przypisano funkcję Rec Review, aby
rozpocząć odtwarzanie wcześniej nagranego klipu.
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Klip zostanie odtworzony do końca, działanie funkcji Rec Review zakończy się, a urządzenie wróci do trybu gotowości
(Stby).

Zatrzymanie działania funkcji Rec Review
Naciśnij przycisk konfigurowalny, do którego przypisano funkcję Rec Review, lub naciśnij przycisk [Cancel/Back].
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Wskazówka

Aby zatrzymać działanie funkcji Rec Review, możesz również nacisnąć przycisk [Cancel/Back] na dołączonym od zestawu pilocie
zdalnego sterowania na podczerwień.

Powiązany temat

Przyciski konfigurowalne

5-041-958-33(1) Copyright 2022 Sony Corporation
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Ekran kadrowania

Do kadrowania służą podane poniżej elementy ekranu sterowania w czasie rzeczywistym.

Uwaga

W zależności od kierunku kamery, ogniskowej obiektywu i pozycji zoomu może być widoczna część urządzenia lub przewody
podłączone do bloku złączy. Przed rozpoczęciem filmowania należy sprawdzić pole widzenia obiektywu i stosowaną ogniskową.
Zakres obrotu w poziomie/pionie można również kontrolować za pomocą opcji [Pan-Tilt] > [P/T Range Limit] w menu
internetowym. Po włączeniu urządzenia lub wykonaniu resetu obrotu w poziomie/pionie, to ustawienie ograniczenia zakresu jest
ignorowane. Szczegółowe informacje są dostępne w sekcji [Pan-Tilt] > [P/T Range Limit] w menu internetowym.

Wskazówka

Kadrowaniem można sterować również za pomocą dołączonego do zestawu pilota zdalnego sterowania na podczerwień.

5-041-958-33(1) Copyright 2022 Sony Corporation

Panel ustawień wstępnych położenia1.

Karta  (Main) / karta  (Others)2.

Panel kadrowania3.
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Dostosowywanie kierunku filmowania za pomocą aplikacji internetowej

Przesuwanie kamery w poziomie określane jest jako operacja obrotu w poziomie, a przesuwanie kamery w pionie
określane jest jako operacja obrotu w pionie.
Kierunek filmowania można dostosować za pomocą operacji obrotu w poziomie/pionie.

Wskazówka

Jeśli pod joystickiem zostanie wyświetlony komunikat [Execute Pan-Tilt Reset], oznacza to, że wystąpiła niespójność w
informacjach o pochodzeniu sygnału sterowania obrotem urządzenia w poziomie/pionie. Uruchom funkcję resetowania obrotu w
poziomie/pionie, aby zaktualizować informacje o pochodzeniu sygnału. Szczegółowe informacje na ten temat podano w sekcji
„Resetowanie obrotu w poziomie/pionie”.

Ustawienie kamery z powrotem do przodu
Naciśnij przycisk  (położenie początkowe obrotu w poziomie/pionie) na karcie  (Others) w panelu ustawień
kamery.

Uwaga

W zależności od kierunku kamery, ogniskowej obiektywu i pozycji zoomu może być widoczna część urządzenia lub przewody
podłączone do bloku złączy. Przed rozpoczęciem filmowania należy sprawdzić pole widzenia obiektywu i stosowaną ogniskową.
Zakres obrotu w poziomie/pionie można również kontrolować za pomocą opcji [Pan-Tilt] > [P/T Range Limit] w menu
internetowym. Po włączeniu urządzenia lub wykonaniu resetu obrotu w poziomie/pionie, to ustawienie ograniczenia zakresu jest
ignorowane. Szczegółowe informacje są dostępne w sekcji [Pan-Tilt] > [P/T Range Limit] w menu internetowym.

Powiązany temat
Resetowanie obrotu w poziomie/pionie

Aby wyświetlić joystick, naciśnij kartę  (obrót w poziomie/pionie i zoom) w panelu kadrowania.1

Przeciągnij środek joysticka w kierunku, który chcesz widzieć podczas monitorowania panelu obrazu z
kamery.

Kierunek i szybkość ruchu kamery zmienia się w zależności od kierunku i poziomu przeciągnięcia.
Obrót w poziomie/pionie można wyregulować dokładniej, naciskając obszary przy obwodzie joysticka.

2
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Ustawianie prędkości obrotu w poziomie/pionie

Szybkość zmiany prędkości obrotu w poziomie/pionie za pomocą suwaka [Pan-Tilt Speed] w panelu sterowania kamerą
można zmienić przy użyciu joysticka w panelu kadrowania.

Uwaga

Jeśli w zasięgu ruchu kamery znajduje się ściana lub inna przeszkoda, należy uważać, aby nie uszkodzić kamery lub obiektywu
podczas operacji obrotu w poziomie/pionie.

Przyspieszenie operacji obrotu w poziomie/pionie zależy od właściwości fizycznych, takich jak wyważenie obiektywu. Ustawienie
przyspieszenia można zmienić za pomocą opcji [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] w menu internetowym lub w menu
kamery.

5-041-958-33(1) Copyright 2022 Sony Corporation

Naciśnij kartę  (Main) w panelu ustawień kamery.1

Wybierz suwak [Pan-Tilt Speed] z listy.

Jeśli suwak [Pan-Tilt Speed] nie jest wyświetlany, wybierz jeden z dwóch przycisków wyboru funkcji suwaka, aby
wyświetlić suwak.

2

Przesuń kółko suwaka w lewo lub w prawo.

Przesunięcie kółka w lewo zmniejsza szybkość działania, a przesunięcie kółka w prawo zwiększa ją.

3
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Ustawianie przyspieszenia operacji obrotu w poziomie/pionie

Można ustawić jeden z dziewięciu stopni przyspieszenia za pomocą opcji [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve]
w menu internetowym lub w menu kamery. Zwiększanie wartości powoduje szybsze zmiany prędkości, a jej zmniejszanie
pozwala uzyskać bardziej stopniowe zmiany prędkości.
Aby uzyskać większą szybkość reakcji podczas operacji obrotu w poziomie/pionie, należy wybrać wartość z zakresu od 7
do 9.
W celu uzyskania większej dokładności pozycjonowania na początku/końcu ruchu do położenia określonego przez
ustawienie wstępne, zaleca się stosowanie wartości z zakresu od 1 do 6.

Szczegółowe informacje na temat ustawień wstępnych położenia podano w sekcji „Zapisywanie/przywracanie kąta
obrotu w poziomie/pionie i pozycji zoomu”.

Uwaga

W przypadku ustawieniu wysokiej wartości funkcja może nie działać prawidłowo, jeśli zainstalowany jest ciężki obiektyw. Należy
sprawdzić działanie przed faktycznym użyciem.

Zależność między ustawieniem [Ramp Curve] a działaniem funkcji obrotu w poziomie/pionie

Przy korzystaniu z funkcji obrotu w poziomie/pionie

Po przywracaniu ustawienia wstępnego położenia
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Dostosowywanie kierunku filmowania za pomocą dołączonego do zestawu pilota
zdalnego sterowania na podczerwień

Kierunek filmowania można dostosować za pomocą przycisków sterowania obrotem w poziomie/pionie na dołączonym
do zestawu pilocie zdalnego sterowania na podczerwień.

Ustawienie kamery z powrotem do przodu
Naciśnij przycisk HOME.

Uwaga

W zależności od kierunku kamery, ogniskowej obiektywu i pozycji zoomu może być widoczna część urządzenia lub przewody
podłączone do bloku złączy. Przed rozpoczęciem filmowania należy sprawdzić pole widzenia obiektywu i stosowaną ogniskową.
Zakres obrotu w poziomie/pionie można również kontrolować za pomocą opcji [Pan-Tilt] > [P/T Range Limit] w menu
internetowym. Po włączeniu urządzenia lub wykonaniu resetu obrotu w poziomie/pionie, to ustawienie ograniczenia zakresu jest
ignorowane. Szczegółowe informacje są dostępne w sekcji [Pan-Tilt] > [P/T Range Limit] w menu internetowym.
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Naciśnij przyciski strzałek, aby sterować obrotem w poziomie/pionie.

Naciśnij przycisk strzałki w kierunku, który chcesz widzieć podczas monitorowania obrazu z kamery.
Aby przesunąć o niewielką odległość, naciśnij krótko przycisk strzałki.
Aby przesunąć o dużą odległość, naciśnij i przytrzymaj przycisk strzałki.
Aby przesuwać pod kątem, naciśnij i przytrzymaj przycisk  (strzałka w górę) lub  (strzałka w dół), a następnie
naciśnij przycisk  (strzałka w lewo) lub  (strzałka w prawo).

1
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Ustawianie typu zoomu

Ustaw typ zoomu za pomocą opcji [Technical] > [Zoom] > [Zoom Type] w menu kamery.
Typ zoomu zależy od typu zainstalowanego obiektywu.

Uwaga

Funkcja Clear Image Zoom nie jest dostępna w następujących przypadkach:

Gdy w menu kamery dla opcji [Shooting] > [S&Q Motion] > [Setting] wybrano ustawienie On, a ustawienie [Frame Rate] ma
wartość wyższą niż 60 fps.
Gdy w menu kamery dla opcji [Project] > [Rec Format] > [Codec] wybrano ustawienie[RAW] lub ustawienie obejmujące RAW.

Użycie przełącznika wyboru SERVO/MANUAL na obiektywie powoduje zresetowanie powiększenia funkcji Clear Image Zoom do
wartości 1×.

Funkcja AF-S nie jest obsługiwana podczas działania funkcji Clear Image Zoom.

Clear Image Zoom

Urządzenie jest wyposażona w funkcję zoomu, która wykorzystuje technologię przetwarzania sygnału obrazu o nazwie
Clear Image Zoom. Gdy funkcja Clear Image Zoom jest włączona, zoom jest obsługiwany nawet w przypadku
obiektywów stałoogniskowych. Funkcji tej można również używać do rozszerzania zakresu poza zakres optyczny
obiektywu z elektryczną regulacją zoomu.
Maksymalny współczynnik powiększenia w przypadku korzystania z funkcji Clear Image Zoom różni się w zależności od
rozdzielczości nagrywania.

Rozdzielczość nagrywania QFHD/4K: 1,5×
Rozdzielczość nagrywania HD: 2×

5-041-958-33(1) Copyright 2022 Sony Corporation

Typ zainstalowanego obiektywu
Ustawienie [Zoom Type]

[Optical Zoom Only] [On(Clear Image Zoom)]

Obiekty stałoogniskowy / obiektyw z
ręczną regulacją zoomu

Funkcja zoomu nie jest
obsługiwana.

Funkcja Clear Image Zoom jest
obsługiwana.

Obiektyw z elektryczną regulacją zoomu
Obsługiwany jest tylko
zoom optyczny.

Obsługiwany jest zoom optyczny i funkcja
Clear Image Zoom.
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Dostosowywanie zoomu za pomocą aplikacji internetowej

Zoom kamery można regulować za pomocą funkcji zoomu optycznego lub funkcji Clear Image Zoom. W tym temacie
opisano sposób regulacji za pomocą aplikacji internetowej. Szczegółowe informacje na temat funkcji Clear Image Zoom
podano w sekcji „Ustawianie typu zoomu”.

Uwaga

W zależności od kierunku kamery, ogniskowej obiektywu i pozycji zoomu może być widoczna część urządzenia lub przewody
podłączone do bloku złączy. Przed rozpoczęciem filmowania należy sprawdzić pole widzenia obiektywu i stosowaną ogniskową.
Zakres obrotu w poziomie/pionie można również kontrolować za pomocą opcji [Pan-Tilt] > [P/T Range Limit] w menu
internetowym. Po włączeniu urządzenia lub wykonaniu resetu obrotu w poziomie/pionie, to ustawienie ograniczenia zakresu jest
ignorowane. Szczegółowe informacje są dostępne w sekcji [Pan-Tilt] > [P/T Range Limit] w menu internetowym.

Rzeczywista szybkość i dokładność regulacji zoomu będzie zależeć od obiektywu. Należy sprawdzić działanie przed użyciem.

Wskazówka

Zoomem obiektywu z ręczną regulacją zoomu można sterować za pomocą sterownika obiektywu (do nabycia osobno) zgodnego
z tym urządzeniem. Szczegółowe informacje na temat podano w sekcjach „Podłączanie sterownika obiektywu” oraz
„Dostosowywanie zoomu za pomocą sterownika obiektywu”.

Powiązany temat
Ustawianie typu zoomu

Podłączanie sterownika obiektywu

Dostosowywanie zoomu za pomocą sterownika obiektywu

Aby wyświetlić panel sterowania obrotem w poziomie/pionie, naciśnij kartę  (obrót w
poziomie/pionie i zoom) w panelu kadrowania.

1

Przesuń kółko suwaka [Zoom] w kierunku [T] (Telephoto) lub [W] (Wide), aby dostosować poziom zoomu.

Szybkość regulacji zoomu zmienia się wraz z ruchem suwaka.

2
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Ustawianie szybkości działania zoomu

Szybkość zmiany poziomu zoomu za pomocą suwaka [Zoom] w panelu kadrowania można zmienić przy użyciu suwaka
[Zoom Speed] w panelu sterowania kamerą.

Uwaga

Rzeczywista szybkość i dokładność regulacji zoomu będzie zależeć od obiektywu. Należy sprawdzić działanie przed użyciem.

5-041-958-33(1) Copyright 2022 Sony Corporation

Naciśnij kartę  (Main) w panelu ustawień kamery.1

Wybierz suwak [Zoom Speed] z listy.

Jeśli suwak [Zoom Speed] nie jest wyświetlany, wybierz jeden z dwóch przycisków wyboru funkcji suwaka, aby
wyświetlić suwak.

 

2

Przesuń kółko suwaka [Zoom Speed] w lewo lub w prawo.

Przesunięcie kółka w lewo zmniejsza szybkość działania, a przesunięcie kółka w prawo zwiększa ją.

3
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Regulacja zoomu za pomocą dołączonego do zestawu pilota zdalnego sterowania na
podczerwień

Zoom kamery można regulować za pomocą funkcji zoomu optycznego lub funkcji Clear Image Zoom. W tym temacie
opisano sposób regulacji za pomocą dołączonego do zestawu pilota zdalnego sterowania na podczerwień. Szczegółowe
informacje na temat funkcji Clear Image Zoom podano w sekcji „Ustawianie typu zoomu”.

Uwaga

W zależności od kierunku kamery, ogniskowej obiektywu i pozycji zoomu może być widoczna część urządzenia lub przewody
podłączone do bloku złączy. Przed rozpoczęciem filmowania należy sprawdzić pole widzenia obiektywu i stosowaną ogniskową.
Zakres obrotu w poziomie/pionie można również kontrolować za pomocą opcji [Pan-Tilt] > [P/T Range Limit] w menu
internetowym. Po włączeniu urządzenia lub wykonaniu resetu obrotu w poziomie/pionie, to ustawienie ograniczenia zakresu jest
ignorowane. Szczegółowe informacje są dostępne w sekcji [Pan-Tilt] > [P/T Range Limit] w menu internetowym.

Wskazówka

Zoomem obiektywu z ręczną regulacją zoomu można sterować za pomocą sterownika obiektywu (do nabycia osobno) zgodnego
z tym urządzeniem. Szczegółowe informacje na temat podano w sekcjach „Podłączanie sterownika obiektywu” oraz
„Dostosowywanie zoomu za pomocą sterownika obiektywu”.

Powiązany temat
Ustawianie typu zoomu

Podłączanie sterownika obiektywu

Dostosowywanie zoomu za pomocą sterownika obiektywu

Naciśnij przycisk zoomu, aby dostosować zoom.

Naciśnij przycisk T (Telephoto) lub W (Wide), obserwując jednocześnie ekran, aby dostosować zoom.
Aby powiększyć obraz, naciśnij przycisk T.
Aby pomniejszyć obraz, naciśnij przycisk W.

1
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Kalibracja obiektywu z mocowaniem typu E

Kalibracja koryguje różnice w pozycji zoomu powstałe ze względu na różnice w poszczególnych obiektywach podczas
korzystania z obiektywu z mocowanie typu E z elektryczną regulacją zoomu.
Aby dokładnie obliczyć pozycję zoomu, należy skalibrować obiektyw w celu skorygowania poszczególnych różnic w
obiektywie, postępując zgodnie z poniższą procedurą.

Dane kalibracji
W urządzeniu można zapisać dane kalibracji dla maksymalnie pięciu obiektywów. Najstarsze dane zostaną
nadpisane po skalibrowaniu szóstego lub kolejnego obiektywu.
Można sprawdzić, czy dane kalibracji dla podłączonego obiektywu są dostępne, naciskając przycisk  (stan
kamery) w obszarze wspólnym ekranu aplikacji internetowej i wybierając kolejno [Lens] > [Calibration Data].
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Jeśli obiektyw jest wyposażony w przełącznik SERVO/MANUAL, należy ustawić go w położeniu SERVO.

Uwaga

Obiektyw nie będzie mógł odbierać instrukcji dotyczących zoomu z urządzenia, jeśli przełącznik jest ustawiony w położeniu
MANUAL.

1

Uruchom kalibrację za pomocą opcji [Technical] > [Lens] > [Lens Calibration] w menu kamery.

Podczas kalibracji obiektyw zmiennoogniskowy porusza się automatycznie i odbywa się pomiar.

2
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Zapisywanie/przywracanie kąta obrotu w poziomie/pionie, pozycji zoomu i ustawienia
ostrości za pomocą aplikacji internetowej

W razie potrzeby można zapisać kąt obrotu w poziomie/pionie, pozycję zoomu i ustawienie ostrości, a następnie
przywrócić te ustawienia za pomocą aplikacji internetowej (funkcja ustawień wstępnych położenia).

Szczegółowe informacje na temat pozycji, które można zapisać/przywrócić, podano w sekcji „Zapisane ustawienia
wstępne położenia”.

Uwaga

Ustawienia wstępnego położenia nie można zapisać, jeśli współczynnik Clear Image Zoom ma wartość wyższą niż 1×.

W przypadku zmiany ustawienia [Pan-Tilt] > [P/T Direction] > [Ceiling] w menu internetowym wszystkie ustawienia wstępne
położenia zostaną usunięte.

Ustaw tryb wspomagania PTZ (obrót w poziomie/pionie oraz zoom) na [Pos.] na liście rozwijanej w górnej
części panelu ustawień wstępnych położenia.

1

Określ położenie, który chcesz zapisać, za pomocą operacji obrotu w poziomie/pionie oraz zoomu.2

Naciśnij przycisk [+] w panelu ustawień wstępnych położenia.

Obraz o zapisanym położeniu zostanie wyświetlony w panelu ustawień wstępnych położenia.

Wskazówka

Jeśli panel ustawień wstępnych położenia nie jest wyświetlany, naciśnij przycisk  (otwórz), aby go wyświetlić.

Ustawienia położenia są zapisywane w kolejności określonej w menu [Preset1].

3
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Anulowanie operacji przywracania ustawienia wstępnego położenia
Podczas przywracania ustawienia wstępnego położenia naciśnij przycisk  (anuluj przywracanie) wyświetlany w panelu
ustawień wstępnych położenia, aby anulować operację przywracania. Użyj joysticka i suwaka [Zoom], aby dostosować
kadrowanie.

Jeśli w sekwencji ustawień wstępnych są nieużywane ustawienia wstępne, ustawienia położenia będą zapisywane w
ustawieniach wstępnych, zaczynając od nieużywanych ustawień. Przykład: jeśli ustawienia wstępne położenia zostały
zapisane w pozycjach [Preset1] i [Preset3], ale nie w pozycji [Preset2], kolejne ustawienia wstępne położenia zostaną
zapisane w pozycji [Preset2], a następnie w pozycji [Preset4].

Można zapisać maksymalnie 100 ustawień wstępnych położenia.

Nazwę każdego ustawienia wstępnego położenia można zmienić. Szczegółowe informacje na ten temat podano w sekcji
„Zmienianie nazw ustawień wstępnych położenia za pomocą aplikacji internetowej”.

Przywróć zapisane położenie.

Naciśnij dwukrotnie miniaturę obrazu o położeniu, które chcesz przywrócić, w panelu ustawień wstępnych
położenia, aby przywrócić wybrane położenie.

Wskazówka

W celu przywrócenia położenia można również nacisnąć obraz, a następnie nacisnąć wyświetlony przycisk  (menu
ustawień wstępnych położenia) i wybrać opcję [Recall].

Szybkość przejścia do zapisanego położenia jest określana przez ustawienie [Pan-Tilt] > [P/T Preset] > [Pan-Tilt] > [Pan-Tilt
Speed for Common] skonfigurowane w menu internetowym podczas zapisywania położenia. Istnieje również możliwość
zmiany szybkości przejścia po zapisaniu. Szczegółowe informacje na ten temat podano w sekcji „Zmienianie szybkości
przejścia (obrót w poziomie/pionie, zoom, ostrość) podczas przywracania ustawienia wstępnego położenia”.

Szybkość zmiany kąta obrotu w poziomie/pionie podczas przesuwania kamery do wstępnie ustawionego położenia można
regulować za pomocą ustawienia szybkości przejścia oraz ustawień [Ramp Curve]. Szczegółowe informacje na ten temat
podano w sekcjach „Zmienianie szybkości przejścia (obrót w poziomie/pionie, zoom, ostrość) podczas przywracania
ustawienia wstępnego położenia” oraz „Ustawianie przyspieszenia operacji obrotu w poziomie/pionie”.

Jeśli podczas odtwarzania zostanie przywrócone inne ustawienie wstępne położenia, działanie zgodnie z pierwszym
przywróconym ustawieniem wstępnym zostanie zatrzymane i rozpocznie się działanie zgodnie z kolejnym przywróconym
ustawieniem wstępnym.

Uwaga

Jeśli temperatura otoczenia uległa znacznej zmianie między momentem zapisania ustawienia wstępnego położenia a
momentem jego odtworzenia, mogą wystąpić różnice w kadrowaniu.

Podczas przywracania ustawienia wstępnego położenia nie można wykonywać żadnych operacji innych niż przywracanie
lub anulowanie ustawienia wstępnego położenia.

4
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Powiązany temat

Zapisane ustawienia wstępne położenia

Zmienianie nazw ustawień wstępnych położenia za pomocą aplikacji internetowej

Zmienianie szybkości przejścia (obrót w poziomie/pionie, zoom, ostrość) podczas przywracania ustawienia
wstępnego położenia

Ustawianie przyspieszenia operacji obrotu w poziomie/pionie

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zmienianie nazw ustawień wstępnych położenia za pomocą aplikacji internetowej

Nazwy zapisanych ustawień wstępnych położenia można zmienić.

5-041-958-33(1) Copyright 2022 Sony Corporation

Ustaw tryb wspomagania PTZ (obrót w poziomie/pionie oraz zoom) na [Pos.] na liście rozwijanej w górnej
części panelu ustawień wstępnych położenia.

1

Naciśnij ustawienie wstępne położenia, którego nazwę chcesz zmienić.

W prawym górnym rogu obrazu pojawi się przycisk  (menu ustawień wstępnych położenia).

2

Naciśnij przycisk  (menu ustawień wstępnych położenia) i w wyświetlonym menu wybierz pozycję
[Rename].

3

Wprowadź nową nazwę ustawienia wstępnego.4
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zastępowanie zapisanego ustawienia wstępnego położenia nowym położeniem za
pomocą aplikacji internetowej

Istnieje możliwość zastąpienia zapisanego ustawienia wstępnego położenia nowym położeniem.

5-041-958-33(1) Copyright 2022 Sony Corporation

Ustaw tryb wspomagania PTZ (obrót w poziomie/pionie oraz zoom) na [Pos.] na liście rozwijanej w górnej
części panelu ustawień wstępnych położenia.

1

Określ położenie, który chcesz zapisać, za pomocą operacji obrotu w poziomie/pionie oraz zoomu.2

Naciśnij obraz o położeniu, które ma zostać zastąpione, w panelu ustawień wstępnych położenia.

W prawym górnym rogu obrazu pojawi się przycisk  (menu ustawień wstępnych położenia).

3

Naciśnij przycisk  (menu ustawień wstępnych położenia) i w wyświetlonym menu wybierz pozycję
[Replace].

Nowe położenie zastąpi bieżące ustawienie.

4

157



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Usuwanie zapisanego ustawienia wstępnego położenia za pomocą aplikacji
internetowej

Zapisane ustawienia wstępnego położenia można usunąć.

5-041-958-33(1) Copyright 2022 Sony Corporation

Ustaw tryb wspomagania PTZ (obrót w poziomie/pionie oraz zoom) na [Pos.] na liście rozwijanej w górnej
części panelu ustawień wstępnych położenia.

1

Naciśnij obraz o położeniu, które ma zostać usunięte, w panelu ustawień wstępnych położenia.

W prawym górnym rogu obrazu pojawi się przycisk  (menu ustawień wstępnych położenia).

2

Naciśnij przycisk  (menu ustawień wstępnych położenia) i w wyświetlonym menu wybierz pozycję
[Delete].

Zapisane położenie zostanie usunięte.

3
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Synchronizacja operacji obrotu w poziomie/pionie oraz operacji regulacji
zoomu/ostrości podczas przywracania ustawienia wstępnego położenia

Operacje obrotu w poziomie/pionie oraz operacje regulacji zoomu/ostrości można synchronizować podczas przywracania
zapisanego ustawienia wstępnego położenia, aby uzyskać płynniejsze kadrowanie.

Wskazówka

Można wcześniej określić ustawienia używane do rejestracji położenia wstępnego. W menu internetowym ustaw opcję [Pan-Tilt] >
[P/T Preset] > [Default] > [Zoom Sync] na [On].

W przypadku ustawienia opcji [Pan-Tilt] > [P/T Preset] > [Speed Select] na [Common] wszystkie ustawienia wstępne położenia
zostaną przywrócone z szybkością określoną za pomocą opcji [Pan-Tilt] > [P/T Preset] > [Common Speed].

Po zakończeniu ruchu mechanizmu zoomu kamera przejdzie do zapisanego położenia obszaru ustawiania ostrości.

Ustaw tryb wspomagania PTZ (obrót w poziomie/pionie oraz zoom) na [Pos.] na liście rozwijanej w górnej
części panelu ustawień wstępnych położenia.

1

Naciśnij obraz o ustawieniu wstępnym położenia, dla którego ma zostać zmieniona szybkość przejścia.

W prawym górnym rogu obrazu pojawi się przycisk  (menu ustawień wstępnych położenia).

2

Naciśnij przycisk  (menu ustawień wstępnych położenia) i w wyświetlonym menu wybierz pozycję
[Edit…].

Pojawi się ekran konfiguracji dla wybranego ustawienia wstępnego położenia.

3

Przesuń przełącznik [Zoom Sync] w prawo, aby włączyć tę funkcję i naciśnij przycisk [OK].

Gdy następnym razem zostanie przywrócone zapisane położenie, kamera będzie poruszać się ze skonfigurowaną
szybkością.

4
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Po zakończeniu ruchu zostanie przywrócona pierwotna wartość ustawienia [AF Transition Speed].

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zmienianie szybkości przejścia (obrót w poziomie/pionie, zoom, ostrość) podczas
przywracania ustawienia wstępnego położenia

Szybkość przejścia (obrót w poziomie/pionie, zoom, ostrość) można zmienić podczas przywracania ustawienia
wstępnego położenia.

Wskazówka

W przypadku ustawienia opcji [Pan-Tilt] > [P/T Preset] > [Speed Select] na [Common] wszystkie położenia zostaną przywrócone
zgodnie z ustawieniem [Pan-Tilt] > [P/T Preset] > [Common Speed].

Po zakończeniu ruchu mechanizmu zoomu kamera przejdzie do zapisanego położenia obszaru ustawiania ostrości.

Ustaw opcję [Pan-Tilt] > [P/T Preset] > [Speed Select] na [Separate] w menu internetowym.1

Ustaw tryb wspomagania PTZ (obrót w poziomie/pionie oraz zoom) na [Pos.] na liście rozwijanej w górnej
części panelu ustawień wstępnych położenia.

2

Naciśnij obraz o ustawieniu wstępnym położenia, dla którego ma zostać zmieniona szybkość przejścia.

W prawym górnym rogu obrazu pojawi się przycisk  (menu ustawień wstępnych położenia).

3

Naciśnij przycisk  (menu ustawień wstępnych położenia) i w wyświetlonym menu wybierz pozycję
[Edit…].

Pojawi się ekran konfiguracji dla wybranego ustawienia wstępnego położenia.

4

Ustaw szybkości przejścia (obrót w poziomie/pionie, zoom, ostrość), które chcesz zmienić, korzystając z
suwaków, lub wprowadź wartości bezpośrednio i naciśnij przycisk [OK].

Gdy następnym razem zostanie przywrócone zapisane położenie, kamera będzie poruszać się ze skonfigurowaną
szybkością.

5
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Po zakończeniu ruchu zostanie przywrócona pierwotna wartość ustawienia [AF Transition Speed].

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zapisywanie/przywracanie kąta obrotu w poziomie/pionie i pozycji zoomu za pomocą
dołączonego do zestawu pilota zdalnego sterowania na podczerwień

W razie potrzeby można zapisać kąt obrotu w poziomie/pionie i pozycję zoomu, a następnie przywrócić zapisane
ustawienia za pomocą dołączonego do zestawu pilota zdalnego sterowania na podczerwień.

Powiązany temat
Zmienianie szybkości przejścia (obrót w poziomie/pionie, zoom, ostrość) podczas przywracania ustawienia
wstępnego położenia

Dostosuj kąt obrotu w poziomie/pionie i poziom zoomu kamery.1

Ustaw tryb wspomagania PTZ (obrót w poziomie/pionie oraz zoom) na [Pos.] na liście rozwijanej w górnej
części panelu ustawień wstępnych położenia w aplikacji internetowej.

2

Naciśnij i przytrzymaj przycisk PRESET, a następnie naciśnij jeden z przycisków od 1 do 3.

Położenie zostanie zapisane.

3

Przywróć zapisane położenie.

Naciśnij jeden z przycisków od 1 do 3, aby przywrócić ustawienie wstępne położenia.

Wskazówka

Szybkość przejścia podczas przywracania ustawienia wstępnego położenia jest określana przez zapisaną wartość [Pan-
Tilt] > [P/T Preset] > [Pan-Tilt Speed] w menu internetowym. Istnieje możliwość zmiany szybkości przejścia po zapisaniu
wartości. Szczegółowe informacje na ten temat podano w sekcji „Zmienianie szybkości przejścia (obrót w poziomie/pionie,
zoom, ostrość) podczas przywracania ustawienia wstępnego położenia”.

4
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rejestrowanie operacji kadrowania wykonywanych przez kamerę przy użyciu aplikacji
internetowej

Operacje kadrowania wykonywane przez kamerę można zarejestrować za pomocą aplikacji internetowej.

Dostosuj położenie początkowe kamery na potrzeby operacji kadrowania.1

Ustaw tryb wspomagania PTZ (obrót w poziomie/pionie oraz zoom) na [Trace] na liście rozwijanej w górnej
części panelu ustawień wstępnych położenia.

2

Naciśnij przycisk [+] w panelu ustawień wstępnych położenia.

Zostanie dodana miniatura i kamera przełączy się do stanu gotowości do nagrywania.

Wskazówka

3
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Wskazówka

Pozostały czas rejestracji jest wyświetlany w górnej części panelu obrazu z kamery podczas rejestrowania.

Uwaga

Zarejestrowane operacje kadrowania zostaną usunięte po przełączeniu na tryb mocowania sufitowego.

Zmiana częstotliwości systemu może spowodować usunięcie zarejestrowanych operacji kadrowania.

Operacje zoomu nie są rejestrowane, gdy podłączony jest sterownik obiektywu.

Maksymalny czas rejestracji pojedynczej operacji kadrowania wynosi 3 minuty. Rejestracja zostanie automatycznie zatrzymana,
gdy czas rejestracji będzie wynosić 3 minuty.

Rejestracji operacji kadrowania nie można rozpocząć, jeśli współczynnik Clear Image Zoom jest większy niż 1×.

Jeśli podczas rejestrowania operacji kadrowania kamera jest obsługiwana przy użyciu innego urządzenia, operacje wykonywane
z innego urządzenia zostaną również zarejestrowane. Aby uzyskać szczegółowe informacje na temat rejestrowania przy użyciu
pilota zdalnego sterowania innej firmy, należy skontaktować się z jego producentem.

Ustawienia ostrości i jakości obrazu nie są rejestrowane przez tę funkcję.

Możesz nacisnąć przycisk  (zamknij) na miniaturze, aby wyjść ze stanu gotowości do nagrywania i powrócić do
normalnego trybu działania.

Rozpocznij wykonywanie operacji kadrowania za pomocą joysticka i suwaka [Zoom].

Rejestracja rozpocznie się od momentu rozpoczęcia operacji kadrowania.

4

Naciśnij przycisk  (zatrzymanie rejestracji) na miniaturze, aby zatrzymać rejestrację.5
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Operacje obrotu w poziomie i pionie oraz zoomu zarejestrowane podczas rejestracji operacji kadrowania nie mogą być dokładnie
odwzorowane podczas odtwarzania operacji kadrowania.

Jeśli po zarejestrowaniu operacji kadrowania zostanie ustawione ograniczenie zakresu obrotu w poziomie/pionie za pomocą opcji
[Pan-Tilt] > [P/T Range Limit] w menu internetowym, ograniczenie zakresu obrotu w poziomie/pionie nie będzie stosowane
podczas odtwarzania operacji kadrowania. Jeśli chcesz używać operacji kadrowania i funkcji ograniczenia zakresu obrotu w
poziomie/pionie, ustaw ograniczenie zakresu obrotu w poziomie/pionie przed zarejestrowaniem operacji kadrowania.

Zarejestrowane operacje kadrowania nie mogą być odtwarzane w przypadku wybraniu wyjścia wideo RAW.

Zarejestrowane operacje kadrowania nie mogą być odtwarzane, gdy sygnał wideo nie jest wyprowadzany ze złącza wyjściowego
SDI.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Odtwarzanie operacji kadrowania wykonywanych przez kamerę przy użyciu aplikacji
internetowej

Zarejestrowane operacje kadrowania wykonywane przez kamerę można odtwarzać za pomocą aplikacji internetowej.

Ustaw tryb wspomagania PTZ (obrót w poziomie/pionie oraz zoom) na [Trace] na liście rozwijanej w górnej
części panelu ustawień wstępnych położenia.

1

Wybierz miniaturę z operacją kadrowania, którą chcesz odtworzyć.

Na miniaturze pojawi się przycisk  (przygotowanie).

2

Naciśnij przycisk  (przygotowanie).

Kamera ustawi się w położeniu odpowiadającym ustawieniom początkowym operacji kadrowania i przełączy się do
stanu gotowości do odtwarzania.

3

Naciśnij przycisk  (odtwórz) na miniaturze.4
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Wskazówka

Rozpocznie się odtwarzanie operacji kadrowania.
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W stanie gotowości do odtwarzania i podczas odtwarzania można anulować odtwarzanie i powrócić do normalnego trybu
działania, wykonując dowolną z poniższych czynności.

Naciśnięcie przycisku  (zatrzymanie) na miniaturze lub w panelu ustawień wstępnych położenia.
Użycie joysticka.
Użycie suwaka [Zoom].

Czas odtwarzania jest wyświetlany w górnej części panelu obrazu z kamery podczas odtwarzania.

Uwaga

Jeśli ustawienie Clear Image Zoom nie jest takie samo dla rejestrowania i odtwarzania operacji kadrowania, może wystąpić
nieoczekiwane działanie.

Odtwarzanie operacji zoomu nie jest obsługiwane, gdy podłączony jest sterownik obiektywu. Użycie zoomu spowoduje
zatrzymanie odtwarzania operacji kadrowania.

Podczas odtwarzania operacji kadrowania zmiana ograniczenia zakresu obrotu w poziomie/pionie za pomocą opcji [Pan-Tilt] >
[P/T Range Limit] w menu internetowym nie daje żadnego efektu. Ograniczenie zakresu obrotu w poziomie/pionie należy ustawić
przed zarejestrowaniem operacji kadrowania.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Usuwanie zarejestrowanych operacji kadrowania wykonywanych przez kamerę przy
użyciu aplikacji internetowej

Zarejestrowane operacje kadrowania wykonywane przez kamerę można usunąć za pomocą aplikacji internetowej.

5-041-958-33(1) Copyright 2022 Sony Corporation

Ustaw tryb wspomagania PTZ (obrót w poziomie/pionie oraz zoom) na [Trace] na liście rozwijanej w górnej
części panelu ustawień wstępnych położenia.

1

Wybierz miniaturę z operacją kadrowania, którą chcesz usunąć.

Na miniaturze pojawi się przycisk  (menu śledzenia).

2

Naciśnij przycisk  (menu śledzenia).

Wyświetli się menu.

3

W wyświetlonym menu wybierz opcję [Delete].

Wybrana operacja kadrowania zostanie usunięta.

4
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rejestrowanie operacji kadrowania wykonywanych przez kamerę za pomocą
dołączonego do zestawu pilota zdalnego sterowania na podczerwień

Operacje kadrowania wykonywane przez kamerę można rejestrować za pomocą dołączonego do zestawu pilota
zdalnego sterowania na podczerwień.

Szczegółowe informacje na temat odtwarzania zarejestrowanych operacji kadrowania podano w sekcji „Odtwarzanie
operacji kadrowania wykonywanych przez kamerę za pomocą dołączonego do zestawu pilota zdalnego sterowania na
podczerwień”.

Uwaga

Maksymalny czas rejestracji pojedynczej operacji kadrowania wynosi 3 minuty. Rejestracja zostanie automatycznie zatrzymana,
gdy czas rejestracji będzie wynosić 3 minuty.

Jeśli podczas rejestrowania operacji kadrowania kamera jest obsługiwana przy użyciu innego urządzenia, obsługa z innego
urządzenia zostanie również zarejestrowana jako część operacji kadrowania.

Jeśli podczas rejestrowania operacji kadrowania zostanie dostosowana jakość obrazu, zmiana ta nie zostanie zarejestrowana.

Powiązany temat
Odtwarzanie operacji kadrowania wykonywanych przez kamerę za pomocą dołączonego do zestawu pilota zdalnego
sterowania na podczerwień

5-041-958-33(1) Copyright 2022 Sony Corporation

Otwórz ekran sterowania w czasie rzeczywistym w aplikacji internetowej.1

Ustaw tryb wspomagania PTZ (obrót w poziomie/pionie oraz zoom) na [Trace] na liście rozwijanej w górnej
części panelu ustawień wstępnych położenia.

2

Dostosuj początkowe położenie kamery na potrzeby operacji kadrowania za pomocą pilota zdalnego
sterowania na podczerwień.

3

Naciśnij i przytrzymaj przycisk PRESET, a następnie naciśnij jeden z przycisków POSITION1–3.

Kamera przełączy się do stanu gotowości do nagrywania.

4

Wykonaj operację kadrowania, którą chcesz zarejestrować.5

Aby zakończyć rejestrowanie, naciśnij i przytrzymaj przycisk PRESET, a następnie naciśnij przycisk
POSITION wybrany w kroku 4.

6
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Odtwarzanie operacji kadrowania wykonywanych przez kamerę za pomocą
dołączonego do zestawu pilota zdalnego sterowania na podczerwień

Zarejestrowane operacje kadrowania wykonywane przez kamerę można odtwarzać za pomocą dołączonego do zestawu
pilota zdalnego sterowania na podczerwień.

Uwaga

Użycie funkcji obrotu w poziomie/pionie lub zoomu spowoduje zatrzymanie odtwarzania.

Powiązany temat

Rejestrowanie operacji kadrowania wykonywanych przez kamerę za pomocą dołączonego do zestawu pilota
zdalnego sterowania na podczerwień

5-041-958-33(1) Copyright 2022 Sony Corporation

Otwórz ekran sterowania w czasie rzeczywistym w aplikacji internetowej.1

Ustaw tryb wspomagania PTZ (obrót w poziomie/pionie oraz zoom) na [Trace] na liście rozwijanej w górnej
części panelu ustawień wstępnych położenia.

2

Wybierz i naciśnij jeden z przycisków POSITION1–3, dla którego zarejestrowano operację kadrowania.

Kamera ustawi się w położeniu odpowiadającym ustawieniom początkowym obrotu w poziomie/pionie oraz zoomu
określonym w zarejestrowanej operacji, która ma być odtwarzana.

3

Gdy kamera ustawi się w położeniu odpowiadającym ustawieniom początkowym odtwarzania, naciśnij
ponownie ten sam przycisk POSITION.

Rozpocznie się odtwarzanie.

4
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Ekran regulacji ostrości

Do regulacji ostrości służą podane poniżej elementy ekranu sterowania w czasie rzeczywistym.

5-041-958-33(1) Copyright 2022 Sony Corporation

Panel obrazu z kamery
Ostrość można dostosować, dotykając obrazu z kamery. Działanie funkcji obsługi dotykowej można wyłączyć w
aplikacji internetowej. W tym celu należy wyłączyć przełącznik [Touch Focus] na karcie  (Focus) w panelu
ustawień kamery.

1.

Panel ustawień kamery — karta  (Focus)2.

Panel do obsługi interfejsu użytkownika3.
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Ręczne ustawianie ostrości za pomocą aplikacji internetowej

Ostrość można ustawić ręcznie — na przykład w następujących przypadkach.

Obiekty częściowo przesłonięte przez krople wody
Obiekty o niskim kontraście w stosunku do tła
Obiekty położone dalej w stosunku do innych filmowanych obiektów w pobliżu

Uwaga

Ręcznym ustawianiem ostrości nie można sterować z aplikacji internetowej, gdy trwa operacja zoomu.

Wskazówka

Z funkcji automatycznej regulacji ostrości można korzystać także w przypadku, gdy główną metodą obsługi jest regulacja ręczna.
Szczegółowe informacje na ten temat podano w sekcji „Ręczne określanie obiektu, na którym ma być automatycznie ustawiana
ostrość (ustawienie AF Assist), za pomocą aplikacji internetowej”.

Powiązany temat
Sprawdzanie przełączników obiektywu

Ręczne określanie obiektu, na którym ma być automatycznie ustawiana ostrość (ustawienie AF Assist), za pomocą
aplikacji internetowej

5-041-958-33(1) Copyright 2022 Sony Corporation

Jeśli obiektyw jest wyposażony w przełącznik wyboru metody regulacji ostrości, należy ustawić ten
przełącznik w położenie „AF/MF” lub „AF”.

Uwaga

Jeśli przełącznik jest ustawiony w położeniu „Full MF” lub „MF”, ogniskowej obiektywu nie można regulować z poziomu
urządzenia. Patrz: „W przypadku obiektywu z przełącznikiem trybu regulacji ostrościi” w rozdziale „Sprawdzanie
przełączników obiektywu”.

1

Przesuń przełącznik [Auto Focus] w lewo w panelu ustawień kamery, aby wyłączyć funkcję automatycznego
ustawiania ostrości.

Tryb ręcznego ustawiania ostrości zostanie aktywowany.

 (MF)

2

Wyregulować ostrość za pomocą suwaka u dołu karty  (Focus).3
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Ręczne ustawianie ostrości za pomocą dołączonego do zestawu pilota zdalnego
sterowania na podczerwień

Ostrość można ustawić ręcznie za pomocą dołączonego do zestawu pilota zdalnego sterowania na podczerwień.

Wskazówka

Z funkcji automatycznej regulacji ostrości można korzystać także w przypadku, gdy główną metodą obsługi jest regulacja ręczna.
Szczegółowe informacje na ten temat podano w sekcji „Ręczna regulacja ostrości podczas automatycznego ustawiania ostrości
za pomocą dołączonego do zestawu pilota zdalnego sterowania na podczerwień”.

Powiązany temat
Ręczna regulacja ostrości podczas automatycznego ustawiania ostrości za pomocą dołączonego do zestawu pilota
zdalnego sterowania na podczerwień

5-041-958-33(1) Copyright 2022 Sony Corporation

Naciśnij przycisk MF na pilocie zdalnego sterowania na podczerwień.1

Ustaw ostrość ręcznie za pomocą przycisków F (Far) i N (Near).

Aby ustawić ostrość na odległym obiekcie, naciśnij przycisk F.
Aby ustawić ostrość na bliskim obiekcie, naciśnij przycisk N.

2
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Ustawianie ostrości poprzez określenie pozycji ustawiania ostrości (ustawienie Spot
Focus)

W trybie ręcznego ustawiania ostrości można w panelu obrazu z kamery określić pozycję, w której ma być ustawiana
ostrość.

Uwaga

Funkcja punktowej regulacji ostrości nie działa, jeśli obiektyw jest ustawiony na ręczną regulację ostrości.

Wskazówka

W trybie punktowej regulacji ostrości można nacisnąć przycisk konfigurowalny, do którego przypisano funkcję [Push AF/MF], aby
tymczasowo zatrzymać punktową regulację ostrości i włączyć automatyczną regulację ostrości do chwili zwolnienia przycisku.
Funkcja ręcznej regulacji ostrości zostanie przywrócona po zwolnieniu przycisku.

5-041-958-33(1) Copyright 2022 Sony Corporation

Ustaw opcję [Shooting] > [Focus] > [Touch Function in MF] na [Spot Focus] w menu internetowym lub w
menu kamery.

1

Przesuń przełącznik funkcji [Touch Focus] na karcie  (Focus) w prawo aby ją włączyć.2

Przesuń przełącznik funkcji [Auto Focus] na karcie  (Focus) w lewo, aby ją wyłączyć.3

Określanie pozycji ustawiania ostrości.

Zostanie wyświetlony znacznik punktowej regulacji ostrości. Regulacja ostrości obrazu będzie odbywać się we
wskazanej pozycji.

Przykład określania pozycji ustawiania ostrości za pomocą dotyku

4
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Tymczasowe korzystanie z funkcji automatycznej regulacji ostrości (ustawienie Push
Auto Focus (AF))

W trybie ręcznej regulacji ostrości można tymczasowo ustawiać ostrość za pomocą funkcji automatycznej regulacji
ostrości. W tym celu należy nacisnąć przycisk [Push AF/MF]. Gdy przycisk ten jest wciśnięty, ostrość jest ustawiana
automatycznie.
Jest to przydatne, gdy chce się powoli przesuwać ostrość z jednego obiektu na inny podczas ręcznej regulacji ostrości.

Uwaga

Funkcja automatycznej regulacji ostrości za pomocą przycisku nie działa, jeśli obiektyw jest ustawiony na ręczną regulację
ostrości.

Wskazówka

Tę samą operację można wykonać za pomocą przycisku konfigurowalnego przypisanego do funkcji [Push AF/MF].

5-041-958-33(1) Copyright 2022 Sony Corporation

Ustaw opcję [Shooting] > [Focus] > [Push AF Mode] na [AF] w menu kamery.1

Przesuń przełącznik funkcji [Auto Focus] na karcie  (Focus) w lewo, aby ją wyłączyć.2

Naciśnij przycisk [Push AF/MF].

Funkcja automatycznej regulacji ostrości jest aktywna, gdy przycisk ten jest wciśnięty.

Funkcja automatycznej regulacji ostrości za pomocą przycisku zostanie aktywowana, a po zwolnieniu przycisku
zostanie przywrócona funkcja ręcznej regulacji ostrości.

3
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Korzystanie z automatycznej regulacji ostrości przy jednym ujęciu (ustawienie Push
Auto Focus (AF-S))

Można nacisnąć przycisk [Push AF/MF] w trybie ręcznej regulacji ostrości, aby automatycznie ustawić ostrość z dużą
szybkością.
Ta funkcja jest przydatna, gdy ustawia się ostrość na obiekcie przed rozpoczęciem filmowania.

Uwaga

Ustaw opcję [Shooting] > [Focus] > [Push AF Mode] na [Single-shot AF(AF-S)] w menu internetowym lub w
menu kamery.

1

Określ położenie obszaru, w którym chcesz wyregulować ostrość, korzystając z opcji [Shooting] > [Focus]
> [Focus Area (AF-S)] w menu kamery.

Wskazówka

W celu zmiany położenia można nacisnąć przycisk konfigurowalny, do którego przypisano funkcję [Focus Setting], aby
wyświetlić pomarańczową ramkę wokół obszaru regulacji ostrości, a następnie przesunąć obszar za pomocą dotyku.

2

Przesuń przełącznik funkcji [Auto Focus] na karcie  (Focus) w lewo, aby ją wyłączyć.3

Naciśnij przycisk [Push AF/MF].

Jeśli przycisk zostanie zwolniony przed zakończeniem ustawiania ostrości, działanie funkcji automatycznego
ustawiania ostrości za pomocą przycisku zostanie zatrzymane.

Podczas działania funkcji automatycznego ustawiania ostrości za pomocą przycisku stan ustawienia ostrości jest
wskazywany przez wskaźnik ostrości.
Wskaźnik świeci się: ostrość jest stała w pozycji ustawiania ostrości.
Wskaźnik miga: brak ostrości. Ponieważ urządzenie nie ustawi ostrości automatycznie, zmień ustawienia
kompozycji i ostrości, aby uzyskać odpowiednią ostrość.
Funkcja ręcznej regulacji ostrości zostanie przywrócona po zwolnieniu przycisku.

4
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Funkcja automatycznej regulacji ostrości za pomocą przycisku nie działa, jeśli obiektyw jest ustawiony na ręczną regulację
ostrości.

Ramka obszaru regulacji ostrości nie jest ukrywana w przypadku użycia przycisku [Display].

Podczas działania funkcji Clear Image Zoom nie można ustawić położenia ramki funkcji [Focus Area (AF-S)]. Podczas działania
funkcji automatycznego ustawiania ostrości za pomocą przycisku priorytetem działania funkcji AF będzie również obszar w
środkowej części.

Wskazówka

Tę samą operację można wykonać za pomocą przycisku konfigurowalnego przypisanego do funkcji [Push AF/MF].

Funkcję [Push AF Mode] można również przypisać do przycisku konfigurowalnego.

Funkcję [Focus Area (AF-S)] można również przypisać do przycisku konfigurowalnego.

Ramkę obszaru regulacji ostrości można wyświetlić/ukryć za pomocą opcji [Monitoring] > [Display On/Off] > [Focus Area Ind.(AF-
S)] w menu kamery.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Automatyczna regulacja za pomocą aplikacji internetowej

Tryb AF z detekcją fazy służy do szybkiego ustawiania ostrości, a tryb AF z detekcją kontrastu do precyzyjnego
ustawiania ostrości.
Połączenie tych dwóch metod AF zapewnia automatyczną regulację ostrości o dużej szybkości i wysokiej dokładności.

Uwaga

Wymagany jest obiektyw obsługujący automatyczną regulację ostrości.

Wymagana dokładność może nie zostać osiągnięta — zależy to od warunków filmowania.

Ostrości nie można regulować automatycznie w przypadku obiektywu z mocowaniem typu A.

Wskazówka

W trybie automatycznego ustawiania ostrości można regulować ostrość za pomocą suwaka Focus w panelu ustawień kamery.
Szczegółowe informacje na ten temat podano w sekcji „Ręczne określanie obiektu, na którym ma być automatycznie ustawiana
ostrość (ustawienie AF Assist), za pomocą aplikacji internetowej”.

Powiązany temat
Sprawdzanie przełączników obiektywu

Ręczne określanie obiektu, na którym ma być automatycznie ustawiana ostrość (ustawienie AF Assist), za pomocą
aplikacji internetowej

5-041-958-33(1) Copyright 2022 Sony Corporation

Jeśli obiektyw jest wyposażony w przełącznik wyboru metody regulacji ostrości, należy ustawić ten
przełącznik w położenie „AF/MF” lub „AF”.

Uwaga

Jeśli przełącznik jest ustawiony w położeniu „Full MF” lub „MF”, ogniskowej obiektywu nie można regulować z poziomu
urządzenia. Patrz: „W przypadku obiektywu z przełącznikiem trybu regulacji ostrościi” w rozdziale „Sprawdzanie
przełączników obiektywu”.

1

Przesuń przełącznik funkcji [Auto Focus] w prawo w panelu ustawień kamery, aby ją włączyć.

Tryb automatycznego ustawiania ostrości zostanie aktywowany.

 (AF)

2

181



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Automatyczne ustawianie ostrości za pomocą dołączonego do zestawu pilota
zdalnego sterowania na podczerwień

Ostrość można ustawić automatycznie za pomocą dołączonego do zestawu pilota zdalnego sterowania na podczerwień.

Uwaga

Z funkcji automatycznej regulacji ostrości można korzystać także w przypadku, gdy główną metodą obsługi jest regulacja ręczna.
Szczegółowe informacje na ten temat podano w sekcji „Ręczna regulacja ostrości podczas automatycznego ustawiania ostrości
za pomocą dołączonego do zestawu pilota zdalnego sterowania na podczerwień”.

Powiązany temat
Ręczna regulacja ostrości podczas automatycznego ustawiania ostrości za pomocą dołączonego do zestawu pilota
zdalnego sterowania na podczerwień

5-041-958-33(1) Copyright 2022 Sony Corporation

Naciśnij przycisk AF na pilocie zdalnego sterowania na podczerwień.

Ostrość na obiekcie jest regulowana automatycznie.

1
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Ustawianie obszaru automatycznej regulacji ostrości oraz jego położenia (ustawienie
Focus Area)

Można ustawić obszar docelowy automatycznego ustawiania ostrości i dostosować ostrość w tym obszarze.

Naciśnij przycisk [Menu] w panelu do obsługi interfejsu użytkownika, aby otworzyć menu kamery.1

Ustaw obszar docelowy automatycznego ustawiania ostrości za pomocą opcji [Shooting] > [Focus] >
[Focus Area] w menu kamery.

[Wide]:
Wyszukuje obiekt na obrazie pod szerokim kątem podczas ustawiania ostrości. Ramka nie jest wyświetlana.

[Zone]:
Automatycznie wyszukuje pozycję ustawiania ostrości w określonej strefie.
Po dokonaniu wyboru określ położenie za pomocą przycisków strzałek w panelu do obsługi interfejsu użytkownika.

Aby wrócić do położenia środkowego, naciśnij i przytrzymaj przycisk [Set].
[Flexible Spot]:

2
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Uwaga

Ramka obszaru regulacji ostrości nie jest ukrywana w przypadku użycia przycisku [Display] w panelu obrazu z kamery.

Podczas działania funkcji Clear Image Zoom obszar regulacji ostrości jest ustawiony na [Wide] (bez możliwości zmiany).

Wskazówka

Ramkę obszaru regulacji ostrości można wyświetlić/ukryć za pomocą opcji [Monitoring] > [Display On/Off] > [Focus Area
Indicator] w menu kamery.

5-041-958-33(1) Copyright 2022 Sony Corporation

Ustawia ostrość w określonej pozycji na obrazie.
Po dokonaniu wyboru określ położenie za pomocą przycisków strzałek w panelu do obsługi interfejsu użytkownika.

Aby wrócić do położenia środkowego, naciśnij i przytrzymaj przycisk [Set].
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Szybka zmiana obszaru regulacji ostrości (ustawienie Focus Setting)

Położenie i rozmiar obszaru automatycznej regulacji ostrości można zmienić podczas filmowania, jeśli funkcja [Focus
Setting] została przypisana do przycisku konfigurowalnego.

Szczegółowe informacje na temat przycisków konfigurowalnych podano w sekcji „Przyciski konfigurowalne”.

Sposób działania tej funkcji różni się w zależności od ustawienia obszaru regulacji ostrości.

W przypadku ustawienia opcji [Shooting] > [Focus] > [Focus Area] na [Flexible Spot] lub
[Zone] w menu kamery

Aby zmienić położenie obszaru regulacji ostrości, należy nacisnąć przycisk konfigurowalny, do którego przypisano
funkcję [Focus Setting], a następnie dostosować położenie za pomocą przycisków strzałek w panelu do obsługi
interfejsu użytkownika. Można przywrócić położenie środkowe obszaru regulacji ostrości, dostosowując położenie za
pomocą przycisku [Set].
Rozmiar obszaru regulacji ostrości można zmienić poprzez naciśniecie i przytrzymanie przycisku konfigurowalnego,
do którego przypisano funkcję [Focus Setting]. Po zmianie rozmiaru można zmienić położenie obszaru regulacji
ostrości, naciskając przycisk [Set]. Po zakończeniu należy nacisnąć przycisk konfigurowalny, do którego przypisano
funkcję [Focus Setting], aby powrócić do poprzedniego ekranu.

W przypadku ustawienia opcji [Shooting] > [Focus] > [Focus Area] na [Wide] w menu kamery

Rozmiar obszaru regulacji ostrości można zmienić tylko poprzez naciśniecie i przytrzymanie przycisku konfigurowalnego,
do którego przypisano funkcję [Focus Setting]. Można również zmienić położenie tego obszaru. W tym celu należy
najpierw zmienić typ obszaru na [Flexible Spot] lub [Zone].

Wskazówka

Jeśli w menu kamery dla opcji [Shooting] > [Focus] > [Push AF Mode] wybrano ustawienie [Single-shot AF(AF-S)], a przełącznik
[Auto Focus] znajduje się w pozycji wyłączonej (tryb ręcznej regulacji ostrości), można zmienić pozycję obszaru regulacji ostrości
(ustawienie [Focus Area (AF-S)]).

Ramka obszaru regulacji ostrości jest wyświetlana na pomarańczowo, gdy położenie obszaru regulacji ostrości można zmienić.

Powiązany temat
Przyciski konfigurowalne

5-041-958-33(1) Copyright 2022 Sony Corporation
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ILME-FR7 / ILME-FR7K

Przesuwanie ramki obszaru regulacji ostrości za pomocą dotyku (obszar regulacji
ostrości za pomocą dotyku)

W celu zmiany położenia obszaru regulacji ostrości naciśnij przycisk konfigurowalny, do którego przypisano funkcję
[Focus Setting], aby zmienić kolor wyświetlanego obszaru regulacji ostrości na pomarańczowy, a następnie przesuń
obszar w panelu obrazu z kamery za pomocą dotyku.
Dotknij ekranu, aby przesunąć obszar regulacji ostrości — zostanie on wyśrodkowany w położeniu, w którym dotknięto
ekranu. Przeciągnij palcem po ekranie, aby przesunąć obszar regulacji ostrości w położenie końcowe wskazane palcem.

Wskazówka

Funkcję regulacji ostrości za pomocą dotyku można włączyć/wyłączyć na ekranie filmowania za pomocą przycisku
konfigurowalnego, do którego przypisano funkcję [Focus Setting].

Dotknij w dowolnym miejscu ekranu.

Pozycja dotknięcia staje się środkiem obszaru regulacji ostrości.

1

Przeciągnij palcem po ekranie, aby przesunąć obszar regulacji ostrości w położenie końcowe wskazane
palcem.

2
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Uwaga

Jeśli dotknie się położenia, które wykracza poza zakres ustawień, lub przeciągnie się obszar regulacji ostrości w takie położenie,
obszar regulacji ostrości zostanie ustawiony na górną/dolną/lewą/prawą krawędź zakresu ustawień.

Ta funkcja nie jest dostępna w podanych poniżej sytuacjach.

Gdy przełącznik [Touch Focus] jest wyłączony w panelu ustawień kamery
W przypadku, gdy ramka obszaru regulacji ostrości jest wyświetlane w kolorze szarym lub nie jest wyświetlana w ogóle

5-041-958-33(1) Copyright 2022 Sony Corporation
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Dostosowywanie działania funkcji automatycznej regulacji ostrości (szybkość
przejścia w trybie AF, czułość zmiany obiektu w trybie AF)

Działanie funkcji automatycznej regulacji ostrości można dostosować, zmieniając ustawienie szybkości przejścia i
ustawienie czułości zmiany obiektu.

Ustawianie szybkości przejścia w trybie AF

Gdy filmowany obiekt zmienia się, można ustawić szybkość działania napędu regulacji ostrości za pomocą przycisku [AF
Transition Speed] w panelu ustawień kamery.

Ustawienie szybkości można wybrać z zakresu od [Speed 1] (Slow) do [Speed 7] (Fast), z krokiem co 1. Naciśnięcie
przycisku < zmniejsza wartość (wolniej), a naciśnięcie przycisku > zwiększa ją (szybciej).
W przypadku ustawienia małej szybkości ostrość jest przesuwana powoli podczas zmieniania obiektu, na którym ma być
ustawiona ostrość, co umożliwia rejestrowanie scen z imponującą ekspresją.
W przypadku ustawienia dużej szybkości ostrość jest przełączana szybko między obiektami. W poniższym przykładzie
ustawienie ostrości szybko przechodzi z budynku w tle na osobę idącą na pierwszym planie. Obiekt, który pojawia się w
kadrze, jest natychmiast wyostrzany, dzięki czemu ustawienie to nadaje się doskonale do nagrywania filmów
dokumentalnych wymagających szybkiego ustawiania ostrości.

Czułość zmiany obiektu w trybie AF

Czułość wykrywania zmian przy zmienianiu filmowanych obiektów można ustawić za pomocą przycisku [AF Subj. Shift
Sens.] w panelu ustawień kamery.
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Ustawienie czułości można wybrać z zakresu od [Sens 1] (Locked On) do [Sens 5], z krokiem co 1. Naciśnięcie przycisku
< zmniejsza wartość (wolniejsza zmiana), a naciśnięcie przycisku > zwiększa ją (szybsza zmiana).
W przypadku ustawienia niskiej czułości ostrość nie powinna się zmieniać, nawet jeśli inny obiekt porusza się przed
obiektem, na którym ustawiona jest ostrość.

W przypadku ustawienia wysokiej czułości ostrość zmienia się tak, by nadać priorytet obiektowi poruszającemu się z
przodu.

Wskazówka

Jeśli funkcja [AF Speed/Sens.] jest przypisana do przycisku konfigurowalnego, poziome pasy służące do regulacji wartości są
wyświetlane w panelu obrazu z kamery w określonej poniżej kolejności po każdym naciśnięciu przycisku, co umożliwia zmianę
ustawień szybkości przejścia w trybie AF i czułości wykrywania zmian obiektu w trybie AF.
Szybkość przejścia w trybie AF → Czułość zmiany obiektu w trybie AF → Brak wyświetlania …

5-041-958-33(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ręczne określanie obiektu, na którym ma być automatycznie ustawiana ostrość
(ustawienie AF Assist), za pomocą aplikacji internetowej

Po przesunięciu ostrości na inny obiekt i jej wyregulowaniu w trybie ręcznym można przekazać sterowanie ostrością
funkcji automatycznego ustawiania ostrości w celu dokładnej regulacji ostrości.

Uwaga

W trybie wspomagania AF przesunięcie ostrości na inny obiekt jest trudniejsze niezależnie od ustawienia opcji [Shooting] >
[Focus] > [AF Subj. Shift Sens.] w menu kamery.

Tryb wspomagania AF jest anulowany w podanych poniżej przypadkach.

Gdy obiekt, na którym ustawiono ostrość za pomocą suwaka [Focus] nie jest już widoczny.
Gdy następuje przełączenie na ręczną regulację ostrości.
Gdy włączony zostanie tryb AF ze śledzeniem w czasie rzeczywistym

Wskazówka

Ustaw opcję [Shooting] > [Focus] > [AF Assist] na [On] w menu kamery.1

Ustaw opcję [Shooting] > [Focus] > [AF Assist Control] na [On] w menu internetowym.2

Przesuń przełącznik funkcji [Auto Focus] w prawo w panelu ustawień kamery, aby ją włączyć.

Tryb automatycznego ustawiania ostrości zostanie aktywowany.

3

Określ obiekt, na którym ma być ustawiana ostrość, za pomocą suwaka [Focus] w panelu ustawień kamery.

[Near]: Ostrość ustawiona na obiekcie znajdującym się blisko.
[Far]: Ostrość ustawiona na obiekcie znajdującym się daleko.

W trybie wspomagania AF ostrość zostanie automatycznie ustawiona na obiekcie znajdującym się w odległości
określonej za pomocą suwaka [Focus].

4
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Tryb wspomagania AF można szybko anulować za pomocą przycisku konfigurowalnego, do którego przypisano funkcję [Push
AF/MF].

Tryb AF ze śledzeniem w czasie rzeczywistym zostanie wyłączony w przypadku użycia suwaka [Focus].

W trybie Face/Eye Only AF funkcja automatycznej regulacji ostrości ustawia ostrość na twarzy znajdującej się najbliżej pozycji, na
której ustawiono ostrość za pomocą suwaka [Focus].

5-041-958-33(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
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Ręczna regulacja ostrości podczas automatycznego ustawiania ostrości za pomocą
dołączonego do zestawu pilota zdalnego sterowania na podczerwień

Jeśli w menu kamery dla opcji [Shooting] > [Focus] > [AF Assist] wybrano ustawienie [On], można użyć przycisków F
(Far) i N (Near) na pilocie zdalnego sterowania na podczerwień do ustawienia ostrości na obiekcie nawet podczas
automatycznej regulacji ostrości.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
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Tymczasowe korzystanie z funkcji ręcznej regulacji ostrości podczas automatycznej
regulacji ostrości (ustawienie Push Manual Focus)

Należy nacisnąć przycisk [Push AF/MF] w trybie automatycznej regulacji ostrości, aby móc ustawiać ostrość ręcznie, gdy
przycisk ten jest wciśnięty. Działanie funkcji automatycznej regulacji ostrości zostanie przywrócone po zwolnieniu
przycisku.
Pozwala to na tymczasowe zatrzymanie działania funkcji automatycznej regulacji ostrości i przeprowadzenie ręcznej
regulacji ostrości, gdy przed filmowanym obiektem przemieszcza się coś innego.

Wskazówka

Tę samą operację można wykonać za pomocą przycisku konfigurowalnego przypisanego do funkcji [Push AF/MF].

5-041-958-33(1) Copyright 2022 Sony Corporation
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Śledzenia przy użyciu funkcji wykrywania twarzy i oczu (ustawienie Face/Eye
Detection AF)

Urządzenie może wykrywać twarze i oczy ludzi w celu ich śledzenia, a następnie ustawiać ostrość na twarzach i oczach
w obszarze regulacji ostrości.
Po wykryciu twarzy wyświetlane są szare ramki wykrywania twarzy/oczu. Gdy automatyczne ustawienie ostrości jest
możliwe, ramki zmieniają kolor na biały i rozpoczyna się śledzenie. Po wykryciu oczu i ustawieniu ostrości ramka
wykrywania twarzy/oczu jest wyświetlana na oczach. W przypadku wykrycia wielu osób obiekt główny jest określany
automatycznie.
Ta funkcja jest dostępna tylko wtedy, gdy trybem regulacji ostrości jest tryb AF lub gdy włączono automatyczną regulację
ostrości za pomocą przycisku.

Wskazówka

Gdy obszar regulacji ostrości jest ustawiony na opcję [Zone] lub [Flexible Spot], a twarze lub oczy nakładają się w określonym
obszarze regulacji ostrości, ramki wykrywania twarzy/oczu zmieniają kolor na biały i urządzenie automatycznie ustawia ostrość na
te twarze/oczy.

Gdy używana jest funkcja automatycznego ustawiania ostrości za pomocą przycisku (AF-S), ramki wykrywania twarzy/oczu w
przypadku twarzy/oczu z ustawioną ostrością zmieniają kolor na zielony.

Ustawianie za pomocą przycisku [Face/Eye Detection AF] w panelu ustawień kamery

Naciśnij przycisk [Face/Eye Detection AF] i ustaw tryb AF z wykrywaniem twarzy/oczu.

[Face/Eye Only AF]: Kamera wykrywa twarze/oczy osób, śledzi tylko twarze/oczy i automatycznie ustawia na nich
ostrość. W przypadku niewykrycia twarzy ani oczu działanie funkcji AF jest tymczasowo zatrzymywane i wyświetlana jest
ikona  (wstrzymanie automatycznej regulacji ostrości w trybie Face/Eye Only AF). Ten tryb jest przydatny, gdy chce się
śledzić tylko twarze/oczy i automatycznie ustawiać na nich ostrość.
[Face/Eye Priority AF]: Kamera wykrywa twarze/oczy osób i nadaje priorytet ustawieniu ostrości na twarzach/oczach. W
przypadku niewykrycia twarzy ani oczu ustawianie ostrości odbywa się w trybie AF (ustawienie domyślne).
[AF]: Funkcja AF z wykrywaniem twarzy/oczu jest wyłączona.

Uwaga

Podczas działania funkcji automatycznego ustawiania ostrości za pomocą przycisku funkcja [Face/Eye Priority AF] jest
aktywowana, nawet jeśli aktualnie wybrana jest opcja [Face/Eye Only AF].
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Gdy przełącznik [Auto Focus] znajduje się w położeniu wyłączonym, funkcja AF z wykrywaniem twarzy/oczu jest wyłączona (z
wyjątkiem przypadku automatycznego ustawiania ostrości za pomocą przycisku).

Jeśli kamera zostanie wyłączona, gdy wybrana jest opcja [Face/Eye Only AF], tryb zostanie automatycznie przełączony na
[Face/Eye Priority AF] przy następnym włączeniu kamery.

Wskazówka

Tryb AF z wykrywaniem twarzy/oczu można ustawić również za pomocą opcji [Shooting] > [Focus] > [Face/Eye Detection AF] w
menu kamery.

Ukrywanie ramek wykrywania twarzy/oczu
Ramki wykrywania twarzy/oczu można wyświetlić/ukryć za pomocą opcji [Monitoring] > [Display On/Off] > [Face/Eye
Detection Frame] w menu kamery.

Uwaga

Zielone ramki wykrywania twarzy/oczu są wyświetlane w odniesieniu do twarzy i oczu z ustawioną ostrością podczas korzystania
z automatycznego ustawiania ostrości za pomocą przycisku (AF-S). Nie są one ukrywane przy korzystaniu z przycisku [Display]
ani w przypadku ustawienia opcji [Face/Eye Detection Frame] na [Off].

Przełączanie trybu AF z wykrywaniem twarzy/oczu za pomocą przycisku konfigurowalnego
Przypisz funkcję [Face/Eye Detection AF] do przycisku konfigurowalnego. Następnie możesz przełączać tryb AF z
wykrywaniem twarzy/oczu, który po każdym naciśnięciu przycisku zmienia się w następującej kolejności: [Face/Eye
Priority AF], [Face/Eye Only AF], [AF].

Ustawianie za pomocą menu bezpośredniego

Tryb AF z wykrywaniem twarzy/oczu można również ustawić za pomocą menu bezpośredniego.

Szczegółowe informacje na temat menu bezpośredniego podano w sekcji „Korzystanie z menu bezpośredniego”.

Powiązany temat

Korzystanie z menu bezpośredniego

5-041-958-33(1) Copyright 2022 Sony Corporation
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Śledzenie określonego obiektu (funkcja Realtime Tracking AF)

Można utrzymać ostrość ustawioną na dany obiekt, określając go za pomocą obsługi dotykowej lub wybierając ramkę
wykrywania twarzy w panelu ustawień kamery.
Po wybraniu obiektu wyświetlana jest biała ramka śledzenia i rozpoczyna się śledzenie.

Wskazówka

Śledzenie odbywa się w całym obszarze obrazu niezależnie od ustawienia obszaru ostrości.

Gdy opcja [Shooting] > [Focus] > [Touch Function in MF] jest ustawiona na [Tracking AF] w menu internetowym lub w menu
kamery, funkcja AF ze śledzeniem w czasie rzeczywistym jest obsługiwana nawet wtedy, gdy trybem ustawiania ostrości jest tryb
MF.

W zależności od ustawienia trybu działania funkcji AF z wykrywaniem twarzy/oczu wykonywane są następujące działania
względem śledzonego obiektu.

[Face/Eye Only AF] lub [Face/Eye Priority AF]: Śledzenie określonego obiektu i ustawianie na nim ostrości.
Jeśli śledzonym obiektem jest osoba i zostanie wykryta twarz/oko, kamera ustawi ostrość na tę twarz/oko.
W przypadku wykrycia twarzy/oczu śledzonej osoby zostanie zapisana jej twarz. Po zapisaniu wyświetlana jest ikona 
(ikona zapisanej śledzonej twarzy).

Uwaga

Jeśli tryb AF ze śledzeniem zostanie włączony podczas ręcznego ustawiania ostrości, twarz śledzonej osoby nie zostanie
zapisana.

[AF]: Służy do ustawiania ostrości na określonym obiekcie oraz śledzenia go. Wykrywanie twarzy/oczu nie będzie
działać, nawet jeśli śledzonym obiektem jest osoba.

Uwaga

Funkcja AF ze śledzeniem w czasie rzeczywistym nie działa, jeśli obiektyw jest ustawiony na ręczną regulację ostrości.

Aktywowanie trybu AF ze śledzeniem w czasie rzeczywistym

Po określeniu konkretnego obiektu do śledzenia rozpoczyna się śledzenie tego obiektu.
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Określanie za pomocą obsługi dotykowej
Przesuń przełącznik funkcji [Touch Focus] na karcie  (Focus) w panelu ustawień kamery w prawo, aby ją włączyć, a
następnie dotknij obiektu docelowego w dowolnym z poniższych stanów.

Podczas ręcznej regulacji ostrości lub ręcznej regulacji ostrości za pomocą przycisku oraz w przypadku, gdy opcja
[Shooting] > [Focus] > [Touch Function in MF] jest ustawiona na [Tracking AF] w menu internetowym lub w menu
kamery
Podczas działania funkcji automatycznej regulacji ostrości lub funkcji automatycznego ustawiania ostrości za pomocą
przycisku (AF)

Określanie poprzez wybór ramki wykrywania twarzy
Przesuń kursor wyboru twarzy (pomarańczowe podkreślenie) na obiekt, który ma być śledzony, używając przycisków
strzałek w panelu do obsługi interfejsu użytkownika, a następnie naciśnij przycisk [Set].

A: Ramki wykrywania twarzy (szare)
B: Ramka śledzenia
C: Kursor wyboru twarzy (pomarańczowy)

Uwaga

Podczas ręcznego ustawiania ostrości nie można rozpocząć śledzenia poprzez wybór ramki wykrywania twarzy.

Wskazówka

Obiekt śledzenia można również zmienić w trybie AF ze śledzeniem w czasie rzeczywistym.

Zatrzymywanie trybu AF ze śledzeniem w czasie rzeczywistym

Naciśnij przycisk  (zatrzymanie funkcji AF ze śledzeniem w czasie rzeczywistym).

Wskazówka
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Tryb AF ze śledzeniem w czasie rzeczywistym zostanie zatrzymany w następujących przypadkach:

Po przestawieniu przełącznika [Auto Focus] lub przełącznika AUTO/MANUAL na obiektywie
Po zmianie trybu regulacji ostrości
Po włączeniu wspomagania automatycznej regulacji ostrości
Po zmianie ustawienia obszaru regulacji ostrości lub sposobu działania trybu AF z wykrywaniem twarzy/oczu
Po naciśnięciu przycisku konfigurowalnego, do którego przypisano funkcję [Push AF/MF]
Gdy śledzony obiekt nie znajduje się na ekranie filmowania lub gdy nie można ustawić ostrości na obiekcie przez kilka sekund

Gdy śledzona twarz jest zapisana (wyświetlana jest ikona  (ikona zapisanej śledzonej twarzy)), tryb AF ze śledzeniem w czasie
rzeczywistym zostanie przywrócony po ponownym pojawieniu się zapisanej śledzonej twarzy w obszarze obrazu. Aby usunąć
śledzoną twarz, należy zatrzymać tryb AF ze śledzeniem w czasie rzeczywistym w sposób opisany powyżej.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Ekran regulacji jasności

Jasność można regulować, dostosowując przysłonę, wzmocnienie i czas otwarcia migawki oraz ustawiając poziom
światła za pomocą filtrów ND w podanych poniżej panelach ustawień na ekranie sterowania w czasie rzeczywistym w
aplikacji internetowej. Jasność można regulować także automatycznie.

Uwaga

Nie można regulować wzmocnienia, gdy opcja [Shooting Mode] jest ustawiona na [Cine EI Quick] lub [Cine EI]. Ponadto jasności
nie można regulować automatycznie za pomocą czasu otwarcia migawki w przypadku wybrania ustawienia [Cine EI Quick] lub
[Cine EI]. Obsługiwana jest automatyczna regulacja jasności za pomocą przysłony i filtra ND.

Wskazówka

Panel ustawień kamery — karta  (Main)1.

Panel podstawowej konfiguracji kamery
Zawiera informacje o statusie ustawień podstawowych funkcji wymaganych do filmowania za pomocą przycisków.
Naciśnij przycisk, aby wyświetlić odpowiedni ekran konfiguracji dla każdej funkcji na przedstawionym poniżej panelu
dostosowywania podstawowej konfiguracji kamery.

2.

Panel dostosowywania podstawowej konfiguracji kamery
Panel umożliwiający dostosowanie ustawienia wybranego w panelu podstawowej konfiguracji kamery.

3.
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Tryb Cine EI umożliwia filmowanie z czułością podstawową bez stosowania wzmocnienia w celu maksymalnego zwiększenia
efektywności przetwornika obrazu. Jasność można regulować za pomocą oświetlenia oraz filtra ND, aby dostosować ilość światła
docierającego do przetwornika obrazu. Szczegółowe informacje na temat opcji Exposure Index (wskaźnik ekspozycji) podano w
sekcji „Zmienianie rozmieszczenia ciemnych i jasnych obszarów na nagranym obrazie”.

Powiązany temat

Zmienianie rozmieszczenia ciemnych i jasnych obszarów na nagranym obrazie
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Ustawianie czułości podstawowej

Przed rozpoczęciem regulacji jasności można ustawić czułość podstawową.

Gdy opcja [Shooting Mode] jest ustawiona na [Custom]

Naciśnij przycisk [ISO/Gain] w panelu podstawowej konfiguracji kamery i ustaw opcję [Base Sensitivity] w panelu
ustawień ISO/Gain na [High] lub [Low].
Wybierz opcję [Low] w warunkach normalnego oświetlenia lub opcję [High] w warunkach słabego oświetlenia.
Ekran, gdy opcja [AGC] jest wyłączona

Ekran, gdy opcja [AGC] jest włączona

Gdy opcja [Shooting Mode] jest ustawiona na [Flexible ISO] lub [Cine EI]

Naciśnij przycisk [Base ISO/Exposure Index] w panelu podstawowej konfiguracji kamery i ustaw opcję [Base ISO] w
panelu ustawień Base ISO/Exposure Index na [ISO 12800] lub [ISO 800].
Wybierz opcję [ISO 800] w warunkach normalnego oświetlenia lub opcję [ISO 12800] w warunkach słabego oświetlenia.

Wskazówka
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Można to ustawić także na karcie  (Main) w panelu ustawień kamery.

Można również użyć opcji [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] lub [Base ISO] w menu kamery.

Funkcję [Base ISO/Sensitivity] można również przypisać do przycisku konfigurowalnego.

W trybie filmowania [Cine EI Quick] czułość podstawowa jest ustawiana automatycznie zgodnie z ustawieniem wskaźnika
ekspozycji.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Ustawianie docelowego poziomu automatycznej regulacji jasności

Do ustawiania docelowego poziomu automatycznej regulacji jasności służy suwak [AE Level] w panelu ustawień kamery.
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Naciśnij kartę  (Main) w panelu ustawień kamery.

Jeśli suwak [AE Level] nie jest wyświetlany, wybierz jeden z dwóch przycisków wyboru funkcji suwaka, a następnie
wybierz z listy suwak [AE Level].

Zostanie wyświetlony suwak [AE Level].

1

Ustaw poziom docelowy za pomocą suwaka.

Przesuń kółko suwaka w lewo, aby przyciemnić obraz. Przesuń kółko suwaka w prawo, aby rozjaśnić obraz.

Wskazówka

Można również użyć opcji [Shooting] > [Auto Exposure] > [Level] w menu kamery.

2
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Automatyczna regulacja przysłony

Przysłonę można regulować automatycznie w zależności od filmowanego obiektu. Wymagany jest zgodny obiektyw.

Uwaga

Przysłony nie można regulować automatycznie w przypadku obiektywu z mocowaniem typu A.

Wskazówka

Funkcję [Auto Iris] można również przypisać do przycisku konfigurowalnego.
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Jeśli zainstalowany jest obiektyw z przełącznikiem Auto Iris, ustaw ten przełącznik w położenie AUTO.1

Naciśnij przycisk [Iris] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [Iris] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień Iris.

2

Przesuń przełącznik funkcji [Auto] w prawo, aby ją włączyć.

Zostanie włączony tryb automatycznej regulacji przysłony. Automatycznie wyregulowana wartość przysłony jest
wyświetlana po prawej stronie przełącznika.

3
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Ręczna regulacja przysłony

Jasność można regulować ręcznie.

Tymczasowa automatyczna regulacja przysłony
Można również nacisnąć przycisk [Push Auto] na panelu ustawień Iris, aby automatycznie regulować przysłonę do chwili
zwolnienia przycisku.

Jeśli zainstalowany jest obiektyw z przełącznikiem Auto Iris, ustaw ten przełącznik w położenie AUTO.

Uwaga

Gdy przełącznik Auto Iris obiektywu jest ustawiony w położeniu MANUAL, funkcje [Auto Iris] i [Push Auto Iris] urządzenia
nie działają. Ręczna regulacja przysłony w urządzeniu również nie przynosi żadnego efektu.

1

Naciśnij przycisk [Iris] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [Iris] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień Iris.

2

Przesuń przełącznik funkcji [Auto] w lewo, aby ją wyłączyć.

Zostanie włączony tryb ręcznej regulacji przysłony.

3

Wyreguluj przysłonę za pomocą suwaka [Iris] lub przycisków regulacji [Iris].

Wskazówka

Ustawienia suwaka i przycisków regulacji są ze sobą powiązane.

Funkcję regulacji przysłony można również przypisać do suwaka na karcie  (Main) w panelu ustawień kamery.

4
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Wskazówka

Naciśnij przycisk konfigurowalny, do którego przypisana jest funkcja [Push Auto Iris], aby automatycznie regulować przysłonę, gdy
przycisk ten jest wciśnięty.
Ręczny tryb regulacji przysłony zostanie przywrócony po zwolnieniu przycisku.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Automatyczna regulacja wzmocnienia

Jasność można regulować automatycznie, korzystając z ustawienia wzmocnienia, gdy dla opcji [Shooting Mode]
wybrano ustawienie [Custom] lub [Flexible ISO].
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Ustaw opcję [Project] > [Shooting Mode] na [Custom] w menu internetowym lub w menu kamery.1

Naciśnij przycisk [ISO/Gain] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [ISO/Gain] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień ISO/Gain.

2

Przesuń przełącznik funkcji [AGC] w prawo, aby ją włączyć.

Zostanie włączony tryb automatycznej regulacji wzmocnienia. Automatycznie wyregulowana wartość wzmocnienia
jest wyświetlana po prawej stronie przełącznika.

Wskazówka

Tę samą operację można wykonać również poprzez ustawienie opcji [Shooting] > [Auto Exposure] > [AGC] na [On] w menu
kamery.

Funkcję [AGC] można również przypisać do przycisku konfigurowalnego.

3
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Ręczna regulacja wzmocnienia

Jasność można regulować ręcznie, korzystając z ustawienia wzmocnienia, gdy dla opcji [Shooting Mode] wybrano
ustawienie [Custom] lub [Flexible ISO].
Można przeprowadzić regulację wzmocnienia, gdy chce się dostosować ekspozycję przy stałym ustawieniu przysłony lub
gdy chce się zapobiec zwiększeniu wzmocnienia w wyniku działania funkcji AGC.

Tymczasowa ręczna regulacja wzmocnienia
Wzmocnienie można także tymczasowo regulować ręcznie, przypisując funkcję [ISO/Gain] do przycisku wyboru funkcji
suwaka na karcie  (Main) w panelu ustawień kamery i używając suwaka.
Jest to przydatne, gdy chce się zmienić ekspozycję o jeden poziom bez zmiany głębi ostrości.
Wstępnie ustawiona wartość skonfigurowana za pomocą opcji [ISO/Gain<L>] jest przywracana po wykonaniu dowolnej z
poniższych operacji.

Ustaw opcję [Project] > [Shooting Mode] na [Custom] w menu internetowym lub w menu kamery.1

Naciśnij przycisk [ISO/Gain] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [ISO/Gain] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień ISO/Gain.

2

Przesuń przełącznik funkcji [AGC] w lewo, aby ją wyłączyć.

Zostanie włączony tryb ręcznej regulacji wzmocnienia.

3

Wyreguluj wzmocnienie za pomocą suwaka [ISO/Gain] lub przycisków regulacji [ISO/Gain].

Wskazówka

Ustawienia suwaka i przycisków regulacji są ze sobą powiązane.

4
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Zmiana ustawień regulacji opcji ISO/Gain
Przełączenie czułości podstawowej
Ustawienie przełącznika AGC w położenie włączenia
Przełączenie urządzenia w tryb gotowości

Tymczasowa automatyczna regulacja wzmocnienia za pomocą przycisku konfigurowalnego
Naciśnij przycisk konfigurowalny, do którego przypisana jest funkcja [Push AGC], aby automatycznie regulować
wzmocnienie, gdy przycisk ten jest wciśnięty.
Ręczny tryb regulacji wzmocnienia zostanie przywrócony po zwolnieniu przycisku.
Wstępnie ustawiona wartość skonfigurowana za pomocą opcji [ISO/Gain<L>] jest przywracana po wykonaniu dowolnej z
poniższych operacji.

Zmiana ustawień regulacji opcji ISO/Gain
Przełączenie czułości podstawowej
Ustawienie przełącznika AGC w położenie włączenia
Przełączenie urządzenia w tryb gotowości

Uwaga

Tej funkcji nie można uruchomić, jeśli opcja [Shooting] > [Iris] > [Bokeh Control] jest ustawiona na [On] w menu kamery.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Automatyczne dostosowywanie ustawienia migawki

Można automatycznie dostosować ustawienie migawki w zależności od jasności obrazu.

5-041-958-33(1) Copyright 2022 Sony Corporation

Naciśnij przycisk [Shutter] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [Shutter] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień Shutter.

1

Naciśnij przycisk [Shutter Type] i wybierz z listy pozycję [Auto].

Wskazówka

Tę samą operację można wykonać również poprzez ustawienie opcji [Shooting] > [Auto Exposure] > [Auto Shutter] na [On]
w menu kamery.

Funkcję [Auto Shutter] można również przypisać do przycisku konfigurowalnego.

2
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Ręczne dostosowywanie ustawienia migawki

Ustawienie migawki można dostosować ręcznie.

Naciśnij przycisk [Shutter] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [Shutter] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień Shutter.

1

Naciśnij przycisk [Shutter Type] i wybierz z listy pozycję [Speed].2

Dostosuj ustawienie migawki za pomocą suwaka [Speed] lub przycisków regulacji [Speed].

Aby dostosować czas ekspozycji do interwału klatek, należy wybrać opcję [Off] w kroku 2. Można także ustawić
stałą wartość, korzystając z opcji [ECS] (częstotliwość), lub dostosować wartość automatycznie za pomocą opcji
[Auto].
Przykład: ustawienie wartości za pomocą opcji [ECS] (częstotliwość)

Wskazówka

Ustawienia suwaka i przycisków regulacji są ze sobą powiązane.

Aby użyć opcji [Angle] zamiast opcji [Speed] lub [Off], ustaw opcję [Shooting] > [Shutter] > [Mode] na [Angle] w menu
kamery.
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Informacje dotyczące filtra ND

W warunkach zbyt jasnego oświetlenia można ustawić odpowiednią jasność, zmieniając filtr ND.
Podczas filmowania jasno oświetlonego obiektu zbyt mały stopień otwarcia przysłony może spowodować rozmycie
dyfrakcyjne, w wyniku którego obraz zacznie tracić ostrość (typowe zjawisko w kamerach). Efekt ten można zredukować
za pomocą filtra ND, aby uzyskać lepsze rezultaty filmowania.
Urządzenie obsługuje podane poniżej tryby filtra ND.
Tryb ustawień wstępnych

Patrz: „Regulacja w trybie ustawień wstępnych”.

Tryb zmienny (regulacja automatyczna)

Patrz: „Regulacja automatyczna w trybie zmiennym”.

Tryb zmienny (regulacja ręczna)

Patrz: „Regulacja ręczna w trybie zmiennym”.

Powiązany temat

Regulacja w trybie ustawień wstępnych

Regulacja automatyczna w trybie zmiennym

Regulacja ręczna w trybie zmiennym

5-041-958-33(1) Copyright 2022 Sony Corporation
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Regulacja w trybie ustawień wstępnych

Można wybrać wcześniej trzy wartości przepuszczalności filtra ND i szybko przełączać między nimi podczas filmowania.

Wskazówka

Po naciśnięciu przycisku konfigurowalnego, do którego przypisano funkcję [ND Filter Position], ustawienia filtra ND zmieniają się
w następującej kolejności: [Clear] → [Preset1] → [Preset2] → [Preset3] → [Clear].
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Ustaw opcję [Shooting] > [ND Filter] > [Mode] na [Preset] w menu kamery.1

Naciśnij przycisk [ND Filter] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [ND Filter] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień ND Filter.

2

Naciśnij przycisk [ND Filter] i wybierz z listy jedną z poniższych pozycji.

[Clear]: brak filtra ND.
[Preset1]: przepuszczalność ustawiana za pomocą opcji [Shooting] > [ND Filter] > [Preset1] w menu kamery.
[Preset2]: przepuszczalność ustawiana za pomocą opcji [Shooting] > [ND Filter] > [Preset2] w menu kamery.
[Preset3]: przepuszczalność ustawiana za pomocą opcji [Shooting] > [ND Filter] > [Preset3] w menu kamery.

Jeśli dla filtra ND wybrano jedną z opcji [Preset1] – [Preset3], obok nazwy filtra ND wyświetlana jest wartość
przepuszczalności.

3
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Regulacja automatyczna w trybie zmiennym

Automatyczną regulację ekspozycji można włączyć za pomocą filtra ND.

Uwaga

Gdy filtr ND jest przełączany na opcję [Clear] lub z tej opcji podczas filmowania, na obrazie wyświetlana jest ramka filtra ND, a
emitowane do ścieżki dźwiękowej.

Wskazówka

Funkcję [Auto ND Filter] można również przypisać do przycisku konfigurowalnego, a następnie naciskać ten przycisk w celu
przełączania ustawienia między opcjami [Auto] i [Manual].

5-041-958-33(1) Copyright 2022 Sony Corporation

Ustaw opcję [Shooting] > [ND Filter] > [Mode] na [Variable] w menu kamery.1

Naciśnij przycisk [ND Filter] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [ND Filter] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień ND Filter.

2

Naciśnij przycisk [ND Filter] i wybierz z listy pozycję [Auto].

Automatycznie ustawiona wartość przepuszczalności filtra ND jest wyświetlana obok przycisku [ND Filter].

3
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Regulacja ręczna w trybie zmiennym

Ręczną regulację ekspozycji można przeprowadzić za pomocą filtra ND.

Tymczasowa regulacja automatyczna
Funkcję [Push Auto ND] można przypisać do przycisku konfigurowalnego i tymczasowo włączyć funkcję automatycznego
filtra ND do chwili zwolnienia przycisku. Zwolnienie przycisku powoduje wyłączenie funkcji automatycznego filtra ND.
Wybierz ustawienie [Manual] dla filtra ND.

Uwaga

Gdy filtr ND jest przełączany na opcję [Clear] lub z tej opcji podczas filmowania, na obrazie wyświetlana jest ramka filtra ND, a
emitowane do ścieżki dźwiękowej.

Ustaw opcję [Shooting] > [ND Filter] > [Mode] na [Variable] w menu kamery.1

Naciśnij przycisk [ND Filter] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [ND Filter] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień ND Filter.

2

Naciśnij przycisk [ND Filter] i wybierz z listy pozycję [Manual].3

Wyreguluj przepuszczalność filtra ND za pomocą suwaka [ND Filter] lub przycisków regulacji [ND Filter].

Wskazówka

Ustawienia suwaka i przycisków regulacji są ze sobą powiązane.

Filtr ND można również dostosować na karcie  (Main) w panelu sterowania kamerą.

4
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Wskazówka

Funkcję [ND Filter Position] można również przypisać do przycisku konfigurowalnego, a następnie naciskać ten przycisk w celu
przełączania ustawienia między opcjami [Manual] i [Clear].

Można również nacisnąć przycisk [Push Auto] na panelu ustawień ND Filter, aby włączyć automatyczny filtr ND do chwili
zwolnienia przycisku.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Ekran regulacji balansu bieli

Balans bieli można wyregulować na ekranie sterowania w czasie rzeczywistym w aplikacji internetowej, aby uzyskać
bardziej naturalny wygląd obrazu.
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Panel podstawowej konfiguracji kamery1.

Panel dostosowywania podstawowej konfiguracji kamery
Panel umożliwiający dostosowanie ustawienia wybranego w panelu podstawowej konfiguracji kamery.

2.
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Automatyczna regulacja balansu bieli

Za pomocą funkcji ATW (automatyczne śledzenie balansu bieli) można zawsze uzyskać odpowiedni balans bieli.
Po włączeniu funkcji ATW balans bieli jest automatycznie regulowany, gdy zmienia się temperatura barwowa źródła
światła.

Uwaga

Funkcji ATW nie można używać, gdy opcja [Shooting Mode] jest ustawiona na [Cine EI] lub [Cine EI Quick].

W zależności od warunków oświetlenia i warunków dotyczących filmowanego obiektu dostosowanie do odpowiedniego koloru za
pomocą funkcji ATW może nie być możliwe.
Przykłady:

Gdy w obiekcie dominuje jeden kolor — np. w przypadku nieba, morza, ziemi lub kwiatów.
Gdy temperatura barwowa jest bardzo wysoka lub bardzo niska.

Jeśli szybkość automatycznego śledzenia ATW jest niska lub nie można uzyskać odpowiedniego efektu, naciśnij przycisk [WB
SET], aby uruchomić funkcję automatycznego balansu bieli.

Wskazówka

W trybie ATW można wybrać jeden z pięciu poziomów szybkości (1, 2, 3, 4, 5), korzystając z opcji [Shooting] > [White Setting] >
[ATW Speed] w menu kamery. Im mniejsza liczba, tym większa szybkość reakcji.

Aby zatrzymać bieżące ustawienie balansu bieli, należy przypisać funkcję [ATW Hold] do przycisku konfigurowalnego, a
następnie nacisnąć przycisk konfigurowalny w celu tymczasowego wstrzymania funkcji ATW w trybie ATW.
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Naciśnij przycisk [White Balance] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [White Balance] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień White Balance.

1

Naciśnij przycisk [White Mode] i wybierz z listy pozycję [ATW].2
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Ręczna regulacja balansu bieli

Balans bieli można wyregulować ręcznie.

Naciśnij przycisk [White Balance] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [White Balance] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień White Balance.

1

Naciśnij przycisk [White Mode] i wybierz z listy jedną z poniższych pozycji.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

Wyreguluj balans bieli za pomocą suwaków lub przycisków regulacji.

Wskazówka

Ustawienia suwaka i przycisków regulacji są ze sobą powiązane.

Różnica pomiędzy ustawieniem [Memory A(T/T)] i ustawieniem [Memory A(R/B)] jest taka, że oś regulacji jest inna, ale
rezultaty regulacji są ze sobą powiązane.

Tryb [Memory A(T/T)]
W tym trybie ustawienie balansu bieli zapisane w pamięci A jest dostosowywane poprzez regulację temperatury
barwowej (Temp) oraz ustawienia Tint.

3
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Temperaturę barwową można ustawiać w zakresie od 2000 K do 5600 K z krokiem co 20 K. Wartości powyżej 5600
K można ustawiać w odstępach równych wartości zmiany koloru (mired) w zakresie od 5580 K do 5600 K.
Naciśnięcie przycisku [Reset] z prawej strony pozycji [Temp] lub [Tint] powoduje przywrócenie wartości domyślnej
odpowiedniego ustawienia.
Tryb [Memory A(R/B)]
W tym trybie ustawienie balansu bieli zapisane w pamięci A jest dostosowywane poprzez regulację ustawień R Gain
i B Gain.
Naciśnięcie przycisku [Reset] powoduje przywrócenie wartości domyślnej odpowiedniego ustawienia wzmocnienia.
Tryb [Preset]
W trybie tym temperatura barwowa jest dostosowywana do wartości ustawienia wstępnego.
Wartość można ustawiać z krokiem co 100 K.
W trybie ustawień wstępnych można również przypisać opcję [Preset White Select] do przycisku konfigurowalnego,
a następnie nacisnąć ten przycisk, aby zmienić wartość wcześniej skonfigurowanego ustawienia wstępnego.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…
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Uruchomianie funkcji automatycznego balansu bieli

Balans bieli zapisywany w trybie pamięci A jest dostosowywany automatycznie.

Naciśnij przycisk [White Balance] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [White Balance] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień White Balance.

1

Naciśnij przycisk [White Mode] i wybierz z listy pozycję [Memory A(T/T)] lub [Memory A(R/B)].

[Memory A(T/T)]

[Memory A(R/B)]

2

Umieść biały papier (lub inny przedmiot) w miejscu, które jest oświetlone tym samym źródłem światła i w
którym są te same warunki co w przypadku filmowanego obiektu, a następnie powiększ papier, aby
wyświetlić biały kolor na ekranie.

3

Wyreguluj jasność.

Wyreguluj przysłonę zgodnie z procedurą opisaną w sekcji „Ręczna regulacja przysłony”.

4

Naciśnij przycisk [WB SET] na panelu ustawień balansu bieli.

[Memory A(T/T)]

5
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Uwaga

Jeśli regulacja się nie powiedzie, na ekranie zostanie wyświetlony komunikat o błędzie przez około trzy sekundy. Jeśli komunikat
o błędzie będzie nadal występować po wielu próbach ustawienia balansu bieli, należy skontaktować się z przedstawicielem
serwisu Sony.

Wskazówka

Funkcję tę można uruchomić także w trybie ATW. Można z niej skorzystać, aby szybko dostosować balans bieli podczas działania
funkcji ATW. Po zakończeniu regulacji nastąpi powrót do normalnego trybu działania funkcji ATW.

Powiązany temat
Ręczna regulacja przysłony

5-041-958-33(1) Copyright 2022 Sony Corporation

[Memory A(R/B)]

Jeśli funkcja automatycznego balansu bieli działa w trybie pamięci, rezultat automatycznej regulacji jest zapisywany
w pamięci A.
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Ekran konfigurowania dźwięku

Poziom dźwięku, który ma być nagrywany przez urządzenie, można wyregulować na ekranie sterowania w czasie
rzeczywistym w aplikacji internetowej. Skonfiguruj przełączniki w bloku złączy urządzenia oraz skonfiguruj ustawienia
dźwięku za pomocą menu kamery lub menu internetowego.

5-041-958-33(1) Copyright 2022 Sony Corporation

Panel ustawień kamery — karta  (Audio)1.

224



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Wybór wejściowego urządzenia audio

Ustaw następujące przełączniki zgodnie z typem urządzenia podłączonego do złącza AUDIO IN.

Uwaga

Dźwięk nie jest nagrywany w trybie nagrywania interwałowego ani w trybie zwolnionego/przyspieszonego tempa.

5-041-958-33(1) Copyright 2022 Sony Corporation

W przypadku podłączenia mikrofonu ustaw przełącznik 2 w sekcji SETUP w bloku złączy z tyłu urządzenia.

Kanały CH-1 i CH-2 mają wspólne ustawienia.

1

Ustawienie Opis

OFF
(domyślne)

Wybierz tę opcję w przypadku korzystania z mikrofonu dynamicznego lub mikrofonu zasilanego
bateryjnie. Powoduje wyłączenie zasilania Phantom +48 V i ustawienie wejścia LINE lub MIC
jako źródła dźwięku CH-1 i CH-2.

ON
Wybierz tę opcję w przypadku korzystania z mikrofonu zgodnego z zasilaniem Phantom +48 V.
Powoduje włączenie zasilania Phantom +48 V i ustawienie mikrofonu zgodnego z zasilaniem
Phantom jako źródła dźwięku CH-1 i CH-2.

Ustaw typ podłączonego urządzenia za pomocą opcji [Audio] > [Audio Input] > [AUDIO IN Select] w menu
kamery.

2

Wybierz wejście audio za pomocą opcji [Audio] > [Audio Input] > [CH1 Input Select] – [CH4 Input Select] w
menu internetowym lub w menu kamery.

3
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Automatyczna regulacja poziomu nagrywania dźwięku

Ustaw kanał, dla którego chcesz automatycznie wyregulować poziom nagrywania dźwięku, na opcję [Auto] na stronie
[Audio] w menu internetowym. W tym celu możesz również skorzystać z opcji [Audio] > [Audio Input] > [CH1 Level
Control] – [CH4 Level Control] w menu kamery.
Kanały do automatycznej regulacji są oznaczone ikoną  (Auto) wyświetlaną obok odpowiednich kanałów na karcie 
(Audio) ekranu sterowania w czasie rzeczywistym.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Ręczna regulacja poziomu nagrywania dźwięku

Poziom nagrywania dźwięku można wyregulować ręcznie.

5-041-958-33(1) Copyright 2022 Sony Corporation

Ustaw kanał, dla którego chcesz ręcznie wyregulować poziom nagrywania dźwięku, na opcję [Manual] na
stronie [Audio] w menu internetowym. W tym celu możesz również skorzystać z opcji [Audio] > [Audio
Input] > [CH1 Level Control] – [CH4 Level Control] w menu kamery.

1

Naciśnij kartę  (Audio) w panelu ustawień kamery.2

Na ekranie [Audio] w panelu ustawień kamery skorzystaj z suwaka lub przycisków regulacji, aby ustawić
poziom nagrywania dźwięku dla kanału, na którym chcesz ręcznie wyregulować poziom nagrywania
dźwięku.

Uwaga

W przypadku kanałów z wyświetloną ikoną  (Auto) regulacja odbywa się automatycznie. Zmiany wartości za pomocą
suwaka lub przycisków nie są stosowane do nagranego dźwięku.

Wskazówka

Ustawienia suwaka i przycisku regulacji w każdym wierszu są ze sobą powiązane.

Poziom sygnału wejściowego audio można sprawdzić w czasie rzeczywistym za pomocą miernika poziomu dźwięku
wyświetlanego na ekranie filmowania.

3
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Korzystanie z menu bezpośredniego

Można sprawdzić informacje o stanie i ustawieniach urządzenia, które są wyświetlane w formie nakładki na obrazie z
kamery, a następnie wybrać i zmienić ustawienia za pomocą przycisków do obsługi interfejsu użytkownika na pilocie
zdalnego sterowania na podczerwień.
Można skonfigurować podane poniżej pozycje.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
Wartość ustawienia [ND Filter]
[Auto Iris]
Wartość ustawienia [Iris]
[AGC]
Wartość ustawienia [Gain]
Wartość ustawienia [ISO]
[Exposure Index]
[Shutter Type]
[Auto Shutter]
Wartość ustawienia [Shutter]
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] i [Frame Rate]

Wskazówka

Tę samą funkcję można również wywołać za pomocą przycisku konfigurowalnego oraz panelu do obsługi interfejsu użytkownika
w aplikacji internetowej.

Na pilocie zdalnego sterowania na podczerwień naciśnij przycisk konfigurowalny, do którego przypisano
funkcję [Direct Menu].

Przycisk [Direct Menu] jest domyślnie przypisany fabrycznie do przycisku konfigurowalnego 1.
Za pomocą pomarańczowego kursora można wybrać tylko te pozycje na ekranie, które można skonfigurować przy
użyciu menu bezpośredniego.

1

Za pomocą przycisków strzałek w panelu do obsługi interfejsu użytkownika przesuń kursor do pozycji,
którą chcesz ustawić, a następnie naciśnij przycisk [Set].

Zostanie wyświetlone menu lub pozycja na białym tle.

2

Wybierz ustawienie za pomocą przycisków strzałek i naciśnij przycisk [Set].

Menu lub białe tło zniknie, a nowe ustawienie zostanie wyświetlone z pomarańczowym kursorem.
Naciśnij ponownie przycisk konfigurowalny, do którego przypisano funkcję [Direct Menu], lub odczekaj 3 sekundy
bez wykonywania żadnych działań, aby wyjść z menu bezpośredniego.

3
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Przyciski konfigurowalne

W aplikacji internetowej urządzenia dostępnych jest dziesięć przycisków konfigurowalnych, do których można przypisać
funkcje.
Przyciski konfigurowalne są wyświetlane na ekranie sterowania w czasie rzeczywistym i na ekranie operacji odtwarzania.

Uwaga

Lista przycisków konfigurowalnych nie jest wyświetlana podczas konfigurowania ustawień w panelu podstawowej konfiguracji
kamery na ekranie sterowania w czasie rzeczywistym. Aby zakończyć, naciśnij przycisk [X] w prawym górnym rogu panelu
ustawień.

Poniżej podano funkcje domyślne przypisane fabrycznie do przycisków.
Przycisk 1: [Direct Menu]
Przycisk 2: [Focus Setting]
Przycisk 3: [Rec Review]

Przyciski od 1 do 3 są odpowiednikami przycisków oznaczonych tymi samymi cyframi na dołączonym do zestawu
pilocie zdalnego sterowania na podczerwień.

Przycisk 4: [Push Auto ND]
Przycisk 5: [Crop Select]
Przycisk 6: [Marker]
Przycisk 7: [Video Signal Monitor]
Przycisk 8: [Clip Flag OK]
Przycisk 9: [Color Bars]
PrzyciskFocus Hold: [Focus Hold]

Przycisk Focus Hold jest odpowiednikiem przycisku Focus Hold na obiektywie z mocowaniem typu E.

Zmienianie funkcji przycisku
Wybierz kolejno opcje [Project] > [Assignable Button] w menu kamery.
Po zmianie przypisania zmienia się sposób wyświetlania listy przycisków konfigurowalnych.
Szczegółowe informacje na temat funkcji, które można przypisać, podano w sekcji „Assignable Button” w rozdziale
„Menu kamery i ustawienia szczegółowe”.

Powiązany temat

Assignable Button
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Zwolnione/przyspieszone tempo

Gdy format nagrywania jest ustawiony na poniższe opcje, można określić różne wartości szybkości klatek dla filmowania
i odtwarzania.
W poniższej tabeli przedstawiono szybkości klatek, które można ustawić.

Częstotliwość systemowa: 59.94/50/29.97/25/23.98, tryb skanowania przetwornika obrazu: FF

Częstotliwość systemowa: 59.94/50/29.97/25/23.98, tryb skanowania przetwornika obrazu: S35

Częstotliwość systemowa: 24, tryb skanowania przetwornika obrazu: FF

Uwaga

Trybu zwolnionego/przyspieszonego tempa nie można ustawić podczas nagrywania lub odtwarzania ani też podczas
wyświetlania ekranu miniatur.

Nagrywanie dźwięku nie jest obsługiwane w trybie zwolnionego/przyspieszonego tempa.

Funkcje automatycznej przysłony i automatycznej migawki są wyłączone w trybie zwolnionego/przyspieszonego tempa.

Funkcja automatycznego ustawiania ostrości ma następujące ograniczenia w trybie zwolnionego/przyspieszonego tempa.

Ograniczenia związane z modelem obiektywu, częstotliwością systemu i szybkością klatek przy filmowaniu

Kodek Format wideo Szybkości klatek, które można ustawić

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Kodek Format wideo Szybkości klatek, które można ustawić

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Kodek Format wideo Szybkości klatek, które można ustawić

XAVC-I 4096×2160P 1–60
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Funkcja automatycznego ustawiania ostrości jest tymczasowo wyłączona, jeśli przysłona jest ustawiona na wartość F18 lub
wyższą.

Szczegółowe informacje na temat korzystania z wyjścia RAW podano w sekcji „Nagrywanie wideo w formacie RAW”.

Powiązany temat

Nagrywanie wideo w formacie RAW

5-041-958-33(1) Copyright 2022 Sony Corporation

Obiektyw Sony Częstotliwość systemu Dostępność funkcji AF

Inny niż SEL16F28 – Obsługa szybkości 7 kl./s lub większej

SEL16F28

59,94/29,97/23,98 Obsługa szybkości 30, 60, 120, 240 kl./s

50,00/25,00 Obsługa szybkości 25, 50, 100, 200 kl./s

24,00 Brak obsługi
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Nagrywanie interwałowe (Interval Rec)

Funkcja nagrywania interwałowego umożliwia nagrywanie filmów w określonych odstępach czasu w pamięci
wewnętrznej urządzenia. Funkcja ta pozwala w skuteczny sposób filmować wolno poruszające się obiekty.
Po rozpoczęciu nagrywania urządzenie automatycznie nagrywa określoną liczbę klatek (Number of Frames) w
określonych odstępach czasu (Interval Time).

A: Interwał filmowania (Interval Time)
B: Liczba klatek w jednym ujęciu (Number of Frames)

Uwaga

Jednocześnie można korzystać tylko z jednej specjalnej funkcji nagrywania, takiej jak nagrywanie interwałowe.

Jeśli zostanie włączony inny specjalny tryb nagrywania, gdy korzysta się z trybu nagrywania interwałowego, tryb nagrywania
interwałowego zostanie automatycznie wyłączony.

Tryb nagrywania interwałowego jest automatycznie wyłączany po zmianie ustawień systemu, takich jak format wideo.

Ustawień nagrywania interwałowego nie można zmieniać podczas nagrywania lub odtwarzania ani też podczas wyświetlania
ekranu miniatur.

Ograniczenia podczas nagrywania
Dźwięk nie jest nagrywany.
Przeglądanie nagrania (funkcja Rec Review) nie jest możliwe.

Wyłączenie urządzenia podczas nagrywania
Jeśli zasilanie urządzenia jest ustawione na tryb gotowości, obrazy przechowywane do tej pory w pamięci zostaną
zapisane na nośniku (trwa to kilka sekund), a następnie urządzenie zostanie automatycznie przełączone do trybu
gotowości.
W przypadku odłączenia kabla zasilania prądem stałym, wyłączenia zasilacza sieciowego lub odłączenia zasilania
PoE++ może dojść do utraty ujęć zarejestrowanych do tego momentu (maksymalnie 10 sekund). Należy zachować
ostrożność.

Ustawianie liczby klatek i interwałów nagrywania
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W menu internetowym ustaw opcję [Project] > [Interval Rec] > [Setting] na [On], a następnie skonfiguruj opcje [Number of
Frames] i [Interval Time].
Po wyłączeniu zasilania urządzenie wyjdzie z trybu nagrywania interwałowego, ale ustawienia [Number of Frames] i
[Interval Time] są zachowywane. Nie trzeba ponownie ich ustawiać przy kolejnym filmowaniu w trybie nagrywania
interwałowego.

Wskazówka

Można również użyć opcji [Project] > [Interval Rec] w menu kamery.

Rozpoczynanie filmowania

Aby rozpocząć nagrywanie, należy nacisnąć przycisk START/STOP do obsługi nagrywania. Pozycje „Int●Rec” i
„Int●Stby” będą wyświetlane na przemian.

Kończenie filmowania

Należy zakończyć nagrywanie.
Po zakończeniu filmowania dane wideo zarejestrowane do tej pory w pamięci są zapisywane na nośniku.
Aby wyjść z trybu nagrywania interwałowego, wykonaj jedną z poniższych czynności.

Przełącz zasilanie urządzenia na tryb gotowości.
W trybie gotowości do nagrywania ustaw opcję [Project] > [Interval Rec] > [Setting] na [Off].

Ponadto tryb nagrywania interwałowego jest wyłączany automatycznie po ponownym uruchomieniu urządzenia.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Nagrywanie obrazu z pamięci podręcznej (Picture Cache Rec)

Funkcja Picture Cache Rec umożliwia retroaktywne rejestrowanie obrazu wideo po rozpoczęciu nagrywania dzięki
utrzymywaniu wewnętrznej pamięci podręcznej pozwalającej na zarejestrowanie obrazu wideo o określonym czasie
trwania podczas filmowania.

Ustawianie rozmiaru pamięci podręcznej

W menu internetowym ustaw opcję [Project] > [Picture Cache Rec] > [Setting] na [On], a następnie ustaw rozmiar
pamięci podręcznej za pomocą opcji [Cache Size].

Uwaga

Funkcja Picture Cache Rec nie może być używana w połączeniu z funkcją Interval Rec, funkcją jednoczesnego nagrywania z
użyciem 2 gniazd ani funkcją nagrywania pomocniczego. Gdy opcja Picture Cache Rec jest ustawiona na On, te inne specjalne
tryby nagrywania są automatycznie ustawiane na Off.

Trybu Picture Cache Rec nie można wybrać, gdy trwa nagrywanie lub działa funkcja Rec Review.

Gdy opcja Picture Cache Rec jest ustawiona na On, kod czasowy jest rejestrowany w trybie [Free Run] nawet w przypadku
wybrania ustawienia [Regen] lub [Rec Run].

Konfiguracja ustawienia [Output Format] może nie być możliwa w trybie Picture Cache Rec. W takim przypadku należy
tymczasowo ustawić opcję Picture Cache Rec na Off, a następnie zmienić ustawienie.

Wskazówka

Czas rejestracji w pamięci podręcznej może być krótszy w zależności od formatu zapisu. Sprawdź czas wyświetlany w pozycji
[Project] > [Picture Cache Rec] > [Cache Rec Time] w menu internetowym.

Można również użyć opcji [Project] > [Picture Cache Rec] w menu kamery.

Opcję [Picture Cache Rec] można również przełączać między ustawieniami On i Off za pomocą przycisku konfigurowalnego.

Włączanie funkcji Picture Cache Rec

Gdy opcja [Picture Cache Rec] jest ustawiona na On, wyświetlana jest pozycja „●Cache” (symbol ● jest zielony).
Po naciśnięciu przycisku START/STOP do obsługi nagrywania rozpocznie się nagrywanie i obraz wideo będzie
zapisywany na kartach pamięci, zaczynając od obrazu wideo przechowywanego w pamięci podręcznej.

Uwaga

Zmiana formatu zapisu lub wyglądu podstawowego powoduje usunięcie obrazu wideo zapisanego do tego momentu w pamięci
podręcznej i rozpoczęcie zapisywania nowego obrazu wideo w pamięci podręcznej. W związku z tym nagrywanie obrazów z

Ustawienie [Cache Size] Czas rejestracji w pamięci podręcznej (przybliżony)

[Short] 5 sekund

[Medium] 10 sekund

[Long] 20 sekund

[Max] Wartość maksymalna dla każdego formatu zapisu
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pamięci podręcznej przed zmianą formatu nie jest możliwe, nawet jeśli rozpocznie się nagrywanie natychmiast po zmianie
formatu.

Jeśli opcja Picture Cache Rec zostanie ustawiona na On lub Off bezpośrednio po włożeniu karty pamięci, dane z pamięci
podręcznej mogą nie zostać zapisane na karcie.

Obraz wideo jest zapisywany w pamięci podręcznej, gdy opcja Picture Cache Rec jest ustawiona na On. Przed ustawieniem tej
funkcji na On obraz wideo nie jest zapisywany w pamięci podręcznej.

Obraz wideo nie jest zapisywany w pamięci podręcznej podczas uzyskiwania dostępu do karty pamięci, np. podczas odtwarzania,
korzystania z funkcji Rec Review lub wyświetlania ekranu miniatur. Nagrywanie obrazów z pamięci podręcznej nie jest w tym
czasie możliwe.

Wyłączanie funkcji Picture Cache Rec

W menu internetowym ustaw opcję [Project] > [Picture Cache Rec] > [Setting] na [Off] lub naciśnij przycisk
konfigurowalny, do którego przypisano funkcję [Picture Cache Rec].
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Jednoczesne nagrywanie na karty pamięci A i B (nagrywanie jednoczesne przy użyciu
dwóch gniazd)

Aby nagrywać jednocześnie na karty pamięci A i B, należy ustawić opcję [Project] > [Simul Rec] > [Setting] na [On] w
menu internetowym lub w menu kamery.

Oddzielne nagrywanie na kartę pamięci A i kartę pamięci B

Nagrywanie na każdej karcie pamięci można rozpocząć/zatrzymać niezależnie, używając przycisku START/STOP do
obsługi nagrywania lub przycisku [2nd Rec START/STOP] na karcie  (Others).
Przy domyślnych ustawieniach fabrycznych oba przyciski są ustawione na rozpoczynanie/zatrzymywanie jednoczesnego
nagrywania na kartach pamięci A i B.
Gdy przyciski są ustawione na sterowanie nagrywaniem na różnych kartach pamięci, sterowanie
rozpoczynaniem/zatrzymywaniem nagrywania w ramach funkcji [SDI/HDMI Rec Control] działa zgodnie ze stanem
nagrywania na karcie w gnieździe A.

Zmienianie ustawienia

Skonfiguruj poniższe ustawienia za pomocą opcji [Project] > [Simul Rec] > [Rec Button Set] w menu kamery.
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Ustawienie [Rec
Button Set] Przyciski i karty pamięci

Rec Button:<Slot
A> <Slot B>
2nd Rec Button:
<Slot A> <Slot B>

Rozpoczynanie/zatrzymywanie jednoczesnego nagrywania na kartach pamięci A i B za pomocą
dowolnego z tych przycisków.

Rec Button:<Slot
A>
2nd Rec Button:
<Slot B>

Przycisk START/STOP do obsługi nagrywania rozpoczyna/zatrzymuje nagrywanie na karcie
pamięci A, a przycisk [2nd Rec START/STOP] na karcie  (Others) rozpoczyna/zatrzymuje
nagrywanie na karcie pamięci B.

Rec Button:<Slot
B>
2nd Rec Button:
<Slot A>

Przycisk START/STOP do obsługi nagrywania rozpoczyna/zatrzymuje nagrywanie na karcie
pamięci B, a przycisk [2nd Rec START/STOP] na karcie  (Others) rozpoczyna/zatrzymuje
nagrywanie na karcie A.
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Monitor sygnału wideo

Typ sygnału wideo, który ma być wyświetlany w panelu obrazu z kamery, można ustawić na przebieg, wektoroskop lub
histogram za pomocą opcji [Monitoring] > [Video Signal Monitor] > [Setting] w menu kamery.
Pomarańczowa linia wskazuje ustawione wartości opcji [Level Marker 1] i [Level Marker 2].
Funkcję [Video Signal Monitor] można przypisać także do przycisku konfigurowalnego.

Monitorowanie obrazu docelowego
W trybach filmowania Log informacje o ustawieniu gamy kolorów lub ustawieniu LUT monitora są wyświetlane w prawym
górnym rogu monitora sygnału wideo, wskazując wartość docelową monitorowania.
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Znaczniki klipów

Do klipu można dodać znacznik klipu [OK], naciskając przycisk konfigurowalny, do którego przypisano funkcję [Clip Flag
OK], i wybierając opcję [Add OK].
Aby usunąć znacznik klipu [OK], należy dwukrotnie nacisnąć ten przycisk i wybrać opcję [Delete Clip Flag].

Wskazówka

Znacznik klipu można dodać również za pomocą opcji [Thumbnail] > [Set Clip Flag] w menu kamery.

Ekran miniatur można wyświetlić z sortowaniem według typu znacznika klipu (filtrowany ekran miniatur klipów). Szczegółowe
informacje na ten temat podano w sekcji „Operacje na nagranych klipach” w rozdziale „Ekran miniatur”.

Powiązany temat

Operacje na nagranych klipach
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Kompensacja efektu „oddychania” obiektywu

Kompensację efektu „oddychania” obiektywu można ustawić za pomocą opcji [Technical] > [Lens] > [Breathing
Compensation] w menu kamery.
Funkcja ta zapewnia korektę efektu polegającego na zmianie kąta widzenia przy zmianie pozycji ustawiania ostrości.
Po włączeniu funkcji kompensacji efektu „oddychania” obiektywu część obrazu jest elektronicznie kadrowana w celu
zachowania stałego kąta widzenia, tak aby efekt „oddychania” nie występował.

Uwaga

Po włączeniu funkcji kompensacji efektu „oddychania” obiektywu kąt widzenia i jakość obrazu mogą się nieznacznie zmienić.

W zależności od obiektywu korekta kąta widzenia może nie być możliwa, gdy włączona jest kompensacja efektu „oddychania”
obiektywu.

Kompensacja nie jest możliwa, gdy zamocowany jest obiektyw, który nie obsługuje kompensacji efektu „oddychania”.

Ta funkcja jest ustawiona na Off (bez możliwości zmiany) w podanych poniżej przypadkach.

W przypadku ustawienia opcji [Technical] > [Lens] > [Distortion Comp.] na [Off] w menu kamery
W przypadku ustawienia opcji [Shooting] > [S&Q Motion] > [Setting] na [On] w menu internetowym lub w menu kamery
W przypadku ustawienia opcji [Project] > [Rec Format] > [Codec] na [RAW] lub [RAW & XAVC-I] w menu internetowym lub w
menu kamery
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Informacje ogólne na temat nagrywania pomocniczego

Ta funkcja umożliwia nagrywanie danych pomocniczych o niskiej rozdzielczości jednocześnie z nagrywaniem
oryginalnych danych wideo o wysokiej rozdzielczości.

Szczegółowe informacje na temat obsługiwanych kart pamięci, formatowania kart pamięci i sprawdzania pozostałej
pojemności podano w sekcji „Obsługiwane karty pamięci” w rozdziale „Przygotowanie karty pamięci”.

Informacje o nagranym pliku
Rozszerzenie nazwy pliku to „.mp4”.
Jednocześnie nagrywany jest również kod czasowy.

Miejsce docelowe przechowywania nagranego pliku
Nagrany plik jest przechowywany w podanym poniżej katalogu.

Informacje o nazwie pliku
Nazwa pliku składa się z nazwy klipu zapisanej na karcie pamięci oraz sufiksu „S03”.
Informacje na temat nazw klipów podano w sekcji [TC/Media] > [Clip Name Format] w menu kamery.

Powiązany temat

Obsługiwane karty pamięci

5-041-958-33(1) Copyright 2022 Sony Corporation

Nośnik Ścieżka folderu

SDXC /PRIVATE/XDROOT/Sub

CFexpress typu A /XDROOT/Sub
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Nagrywanie pliku nagrywania pomocniczego

Nagrywanie można rozpocząć po włączeniu funkcji nagrywania pomocniczego.

Kończenie filmowania
Należy zakończyć nagrywanie.

Ustawianie kanału audio na potrzeby nagrywania pomocniczego
Ustaw kanał audio do nagrywania pomocniczego za pomocą opcji [Project] > [Proxy Rec] > [Audio Channel] w menu
kamery.
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Ustaw opcję [Project] > [Proxy Rec] > [Setting] na [On] w menu internetowym lub w menu kamery.1

Włóż kartę pamięci do gniazda kart CFexpress typu A / SD.

W przypadku karty CFexpress należy włożyć ją tak, by etykieta była skierowana do góry.
W przypadku karty SD należy włożyć ją tak, by etykieta była skierowana w dół.

Uwaga

Tryb nagrywania pomocniczego nie może być ustawiony na On w tym samym czasie co tryb zwolnionego/przyspieszonego
tempa lub tryb nagrywania interwałowego. Gdy tryb nagrywania pomocniczego jest ustawiony na On wymusza to
ustawienie tych innych trybów nagrywania na Off.

2

Naciśnij przycisk START/STOP do obsługi nagrywania.

Nagrywanie pomocnicze zostanie rozpoczęte.

Uwaga

Jeśli urządzenie zostanie wyłączone lub karta pamięci zostanie wyjęta podczas uzyskiwania dostępu do karty, integralność
danych na karcie nie jest gwarantowana.
Wszystkie dane zapisane na karcie pamięci mogą zostać usunięte. Przed wyłączeniem urządzenia lub wyjęciem karty
pamięci należy zawsze upewnić się, że wskaźnik dostępu do karty pamięci jest wyłączony.

Należy uważać, by karta pamięci nie wyskoczyła podczas wkładania lub wyjmowania.

3
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Informacje ogólne dotyczące wyglądu

Gdy urządzenie jest ustawione na tryb Custom, można dodać korekty czerni, macierzy i innych parametrów, aby
utworzyć wygląd oparty na wyglądzie podstawowym.

Można także szybko wybrać inny wygląd, zapisując różne kombinacje ustawień w plikach sceny.
Urządzenie oferuje łącznie siedem wstępnie ustawionych wyglądów.
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Wybieranie wyglądu

W tym temacie opisano sposób wybierania wyglądu.

Upewnij się, że opcja [Project] > [Base Setting] > [Shooting Mode] jest ustawiona na [Custom] w menu
internetowym lub w menu kamery.

Wskazówka

W trybie [Custom] w panelu podstawowej konfiguracji kamery zostanie wyświetlony przycisk [ISO/Gain] oraz przycisk
[Scene File].

1

Naciśnij przycisk [Scene File] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [Scene File] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień Scene File.

2

Naciśnij przycisk [Scene File] w panelu ustawień i wybierz z listy plik sceny o odpowiednim wyglądzie.

Poniższe ustawienia wstępne są skonfigurowane fabrycznie.

Wskazówka

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Plik Scene 1 [S-Cinetone] [HLG Live]

Plik Scene 2 [Standard] [HLG Natural]

Plik Scene 3 [Still] (Niezarejestrowane)

Plik Scene 4 [ITU709] (Niezarejestrowane)

Plik Scene 5 [709tone] (Niezarejestrowane)

Pliki Scene od 6 do 16 (Niezarejestrowane) (Niezarejestrowane)

245



5-041-958-33(1) Copyright 2022 Sony Corporation

Wygląd można wybrać także za pomocą opcji [Paint/Look] > [Scene File] > [Recall] w menu kamery. Można również
wywołać ustawiony wstępnie wygląd za pomocą opcji [Scene File] > [Preset Recall].

Uwaga

W przypadku wersji oprogramowania 2.0 lub nowszej ustawienie wstępne pliku Scene 5 to [709tone]. Jest ono wyświetlane
po uruchomieniu funkcji [Maintenance]> [Reset] > [Factory Default] w menu internetowym.
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Importowanie wyglądu podstawowego

Można zaimportować plik 3D LUT utworzony na komputerze lub innym urządzeniu jako wygląd podstawowy. Można
zaimportować maksymalnie 16 plików.
Format pliku: plik CUBE (*.cube) dla tablicy 3D LUT 17grid lub 33grid utworzonej za pomocą oprogramowania Catalyst
Browse, RAW Viewer lub DaVinci Resolve* (firmy Blackmagic Design Pty. Ltd.).

Wejściowa gama kolorów / gamma: [S-Gamut3.Cine/S-Log3] lub [S-Gamut3/S-Log3]

Korekcja niedoświetlenia

Zweryfikowano za pomocą oprogramowania Resolve w wersjach 9.0, 10.0 i 11.0.*

Zapisz plik 3D LUT w urządzeniu z uruchomioną aplikacją internetową.1

Wybierz kolejno opcje [Paint/Look] > [Base Look] w menu internetowym.

Zostanie wyświetlona lista zarejestrowanych wyglądów podstawowych.

2

Naciśnij przycisk [Import] w wierszu, w którym chcesz zaimportować plik.

Zostanie wyświetlone okno dialogowe wyboru pliku.

3

Wybierz przygotowany plik 3D LUT.

Zaimportowany plik 3D LUT stanie się wyglądem podstawowym na urządzeniu.

4

Wybierz zaimportowany plik 3D LUT za pomocą opcji [Paint/Look] > [Base Look] > [Select] w menu kamery.5

Skonfiguruj ustawienia [Paint/Look] > [Base Look] > [Input] i [Output] w menu kamery, aby dopasować
atrybuty zaimportowanego pliku 3D LUT.

6
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Jeśli podczas korzystania z zaimportowanego wyglądu podstawowego występuje tendencja do niedoświetlenia w
przypadku wybrania funkcji automatycznej regulacji ekspozycji, należy dostosować wygląd za pomocą opcji [Paint/Look]
> [Base Look] > [AE Level Offset] w menu internetowym.

Uwaga

Samo zaimportowanie pliku 3D LUT nie ma wpływu na obraz. Wczytaj zaimportowany plik 3D LUT za pomocą opcji [Paint/Look] >
[Base Look] > [Select] w menu kamery.

Jeśli opcja [Input] nie jest skonfigurowana prawidłowo, odpowiedni wygląd nie zostanie uzyskany.

Ustawienia pozycji menu [Input], [Output] i [AE Level Offset] są stosowane do wyglądu podstawowego wybranego za pomocą
opcji [Select]. Jeśli importowanych jest wiele plików 3D LUT, należy wybrać każdy plik 3D LUT za pomocą opcji [Select] i
skonfigurować ustawienia [Input], [Output] oraz [AE Level Offset] indywidualnie dla każdego pliku.

Skonfigurowane ustawienia [Input], [Output] i [AE Level Offset] są zapisywane dla każdego pliku 3D LUT.

Opcje wyboru wyglądu podstawowego / ustawienia LUT dla importowanych plików 3D LUT są wspólne dla trybów filmowania
[SDR(BT.709)], [HDR(HLG)] i Log, jednak konwersja gamy kolorów i konwersja gamma nie są przeprowadzane w tych trybach.

Pliki 3D LUT nie są usuwane, jeśli w menu internetowym zostanie uruchomiona funkcja [Maintenance] > [Reset] > [All Reset
(except for Network Settings)].

Komunikat  (błąd dołączania pliku 3D LUT) wyświetlany przed ekranem [Base Look Name] wskazuje, że plików 3D LUT nie
można dołączyć do klipów nagranych w trybach filmowania Log. Zaimportuj plik 3D LUT ponownie.
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Dostosowywanie wyglądu

Wygląd można dostosować w oparciu o wygląd podstawowy za pomocą suwaków [Master Black], [R Black] i [B Black] w
panelu ustawień Scene File w panelu podstawowej konfiguracji kamery oraz przy użyciu opcji [Paint/Look] > [Matrix] i
innych opcji konfiguracyjnych w menu kamery.
Należy podłączyć urządzenie do telewizora lub monitora i wyregulować jakość obrazu, obserwując obraz na ekranie
telewizora lub monitora.

1: Suwak/przyciski do regulacji ustawienia [R Black]
2: Suwak/przyciski do regulacji ustawienia [B Black]
3: Suwak/przyciski do regulacji ustawienia [Master Black]

Uwaga

W przypadku zaimportowania pliku 3D LUT i zastosowania go do obrazu żądany wygląd zdefiniowany w pliku 3D LUT nie
zostanie uzyskany, jeśli ustawienie [Paint/Look] > [Matrix] i ustawienia inne niż ustawienia wyglądu podstawowego w menu
kamery zostaną zmienione.

Wszystkie dostosowane ustawienia można zresetować za pomocą opcji [Paint/Look] > [Reset Paint Settings] > [Reset without
Base Look] w menu kamery.
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Zapisywanie wyglądu

Bieżący wygląd można zapisać jako plik sceny w pamięci wewnętrznej za pomocą opcji [Paint/Look] > [Scene File] >
[Store] w menu kamery.
Można szybko wywołać zapisany wygląd za pomocą panelu ustawień Scene File lub wykonać w tym celu operacje w
menu bezpośrednim.

Uwaga

W przypadku wybrania innego wyglądu bez uprzedniego zapisania bieżącego wyglądu bieżący wygląd zostanie usunięty.

Wskazówka

Wstępnie ustawione pliki sceny można zastąpić. Aby przywrócić wstępnie ustawiony plik sceny, należy wczytać wygląd, który ma
być przywrócony, za pomocą opcji [Paint/Look] > [Scene File] > [Preset Recall] w menu kamery, a następnie zapisać plik sceny
za pomocą opcji [Scene File] > [Store].

Usuwanie zapisanego wyglądu
Plik sceny zapisany w pamięci wewnętrznej można usunąć za pomocą opcji [Paint/Look] > [Scene File] > [Delete] w
menu kamery.

Wskazówka

Po usunięciu plik nie jest już wyświetlany w panelu ustawień Scene File ani w menu bezpośrednim.
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Usuwanie wyglądu podstawowego

Zaimportowane pliki 3D LUT można usuwać pojedynczo za pomocą opcji [Paint/Look] > [Base Look] > [Delete] w menu
kamery.
Można również usunąć wszystkie zaimportowane pliki 3D LUT za pomocą opcji [Paint/Look] > [Base Look] > [Delete All]
w menu kamery.

Uwaga

Przed usunięciem plików należy sprawdzić, czy wygląd podstawowy nie jest używany w żadnych plikach sceny. Jeśli używany
wygląd podstawowy zostanie usunięty, wygląd określany przez odpowiednie pliki sceny będzie nieprawidłowy.

Zaimportowane pliki 3D LUT nie są usuwane, jeśli w menu internetowym zostanie uruchomiona funkcja [Maintenance] > [Reset] >
[All Reset (except for Network Settings)].

Po usunięciu wyglądu podstawowego nie można go już stosować jako ustawienia LUT w trybach filmowania Log.
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Filmowanie z korektą wyglądu na etapie postprodukcji

W przypadku używania urządzenia w trybach filmowanie Log*1 i równomiernego rejestrowania gradacji od ciemnych do
jasnych obszarów można na etapie postprodukcji dokonywać drobnych korekt, takich jak miejscowe przywracanie
gradacji ciemnych i jasnych obszarów.
Jednak podczas oglądania zarejestrowanych obrazów na konwencjonalnym monitorze ogólny kontrast będzie wydawał
się niski, co utrudni regulację ostrości i ekspozycji.
Tablicę LUT można zastosować w urządzeniu do docelowego monitora, aby usprawnić wykonywanie różnych regulacji
podczas filmowania. Podczas odtwarzania można również automatycznie zastosować tablicę LUT używaną podczas
nagrywania, aby szybko sprawdzić wynik końcowy.
Tablice LUT są stosowane w podanych poniżej systemach. Można zastosować jednak tylko jedną tablicę LUT.

Wyjście SDI
Wyjście HDMI i przesyłanie strumieniowe
Klip nagrany na nośniku w trybie nagrywania pomocniczego
Klip o wysokiej rozdzielczości (główny) nagrany na nośniku
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Określenie ogólne dla trybu Flexible ISO/Cine EI/Cine EI Quick*1
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Stosowanie ustawienia LUT do wyjścia HDMI i przesyłania strumieniowego

Ustawienie LUT można zastosować do wyjścia HDMI i przesyłania strumieniowego.

Uwaga

Obraz w panelu obrazu z kamery w aplikacji internetowej jest również zawarty w obrazie przesyłanym strumieniowo.

Wskazówka

Można również użyć opcji [Shooting] > [LUT On/Off] > [HDMI/Stream] w menu kamery.

Wyjście SDI można ustawić w taki sam sposób.

W przypadku materiału wideo na nośniku przeznaczonym do nagrywania można użyć opcji [Shooting] > [LUT On/Off] > [Internal
Rec] i [Proxy] w menu kamery.

Komunikat  (błąd dołączania pliku 3D LUT) wyświetlany przed ekranem [Base Look/LUT] wskazuje, że plików 3D LUT nie
można dołączyć do klipów nagranych w trybach filmowania Log. Zaimportuj plik 3D LUT ponownie.
Ikona ta jest również wyświetlana, gdy nie uda się załączyć pliku powodu tymczasowego zatoru w przetwarzaniu.

Upewnij się, że opcja [Project] > [Base Setting] > [Shooting Mode] jest ustawiona na [Flexible ISO], [Cine EI]
lub [Cine EI Quick] w menu internetowym lub w menu kamery.

Wskazówka

W trybach filmowania Log w panelu podstawowej konfiguracji kamery zostanie wyświetlony przycisk [Base ISO/Exposure
Index] oraz przycisk [Base Look/LUT].

1

Naciśnij przycisk [Base Look/LUT] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [Base Look/LUT] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień Base Look/LUT.

2

Wybierz pozycję [HDMI/Stream] > [MLUT].3
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Zmienianie tablicy LUT

Można zmienić ustawienie LUT, które ma być stosowane.

Wskazówka

Urządzenie udostępnia następujące ustawienia wstępne LUT: [s709], [709(800%)] i [S-Log3].

Można także importować i stosować plik 3D LUT. Szczegółowe informacje na ten temat podano w sekcjach „Importowanie
wyglądu podstawowego” oraz „Usuwanie wyglądu podstawowego”.

Można również użyć opcji [Paint/Look] > [Base Look] > [Select] w menu kamery.

Powiązany temat
Importowanie wyglądu podstawowego

Usuwanie wyglądu podstawowego

5-041-958-33(1) Copyright 2022 Sony Corporation

Naciśnij przycisk [Base Look/LUT] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [Base Look/LUT] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień Base Look/LUT.

1

Naciśnij przycisk [Base Look/LUT] i wybierz wygląd podstawowy, który chcesz zastosować.2
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Zmienianie rozmieszczenia ciemnych i jasnych obszarów na nagranym obrazie

W trybach filmowania Cine EI i Cine EI Quick rozmieszczenie ciemnych i jasnych obszarów można zmienić na przykład
w sytuacji, gdy chce się nadać priorytet odcieniowi ciemnych obszarów w stosunku do odcienia jasnych obszarów,
zmieniając ustawienie Exposure Index z poziomu ustawień czułości podstawowej.

Naciśnij przycisk [Base Look/LUT] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [Base Look/LUT] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień Base Look/LUT.

1

Wybierz pozycję [HDMI/Stream] > [MLUT].

Ustawienie LUT jest stosowane do wyjścia HDMI i przesyłania strumieniowego.

2

Naciśnij przycisk [Base ISO/Exposure Index] w panelu podstawowej konfiguracji kamery.

Obramowanie przycisku [Base ISO/Exposure Index] zmieni kolor na pomarańczowy.

Zostanie wyświetlony panel ustawień Base ISO/Exposure Index.

3

Dostosuj wskaźnik ekspozycji zgodnie z wymaganym rozmieszczeniem ciemnych i jasnych obszarów,
korzystając z suwaka [Exposure Index] lub przycisków regulacji [Exposure Index].

Tryb [Cine EI]

Tryb [Cine EI Quick]
Czułość podstawowa jest ustawiana automatycznie zgodnie z określonym wskaźnikiem ekspozycji.

4
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Wskazówka

Można również użyć opcji [Shooting] > [ISO/Gain/EI] > [Exposure Index] w menu kamery.

W przypadku wyjścia SDI można skorzystać z tej samej procedury.

Druga wartość liczbowa ustawienia wskazuje, ile stopni jasności jest przypisanych do jasnych obszarów (jasność wyższa niż 18%
szarości). Obszary o jasności wyższej są prześwietlone.
Przykład: w ustawieniu „400EI/5.0E” jasnym obszarom przypisano 5,0 stopni jasności.

Można również używać tego jako wskazówki do sprawdzania odcienia ciemnych i jasnych obszarów podczas filmowania. Należy
pamiętać, aby po sprawdzeniu ekspozycji powrócić do oryginalnej wartości EI. Ponadto w trybie Cine EI Quick należy uważać,
aby nie wpłynąć negatywnie na czułość podstawową.

5-041-958-33(1) Copyright 2022 Sony Corporation

Wyreguluj oświetlenie i/lub filtr ND w taki sposób, aby obraz z kamery w menu [HDMI/Stream] miał
odpowiednią ekspozycję.

5
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Nagrywanie wideo w formacie RAW

Sygnał wyjściowy RAW ze złącza SDI OUT urządzenia można nagrywać za pomocą obsługiwanego rejestratora
zewnętrznego.
Obsługiwane formaty sygnału wyjściowego RAW podano poniżej.

Częstotliwość systemu [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Zewnętrzny rejestrator RAW należy podłączyć do złącza SDI OUT urządzenia.1

Ustaw opcję [Project] > [Base Setting] > [Shooting Mode] na [Cine EI], [Cine EI Quick] lub [Flexible ISO] w
menu internetowym lub w menu kamery.

2

Za pomocą opcji [Project] > [Rec Format] > [Imager Scan Mode] w menu internetowym lub w menu kamery
ustaw kąt widzenia na (FF wyłącznie).

3

Ustaw opcję [Project] > [Rec Format] > [Codec] na [RAW] w menu internetowym lub w menu kamery.

Wybranie opcji [RAW & XAVC-I] spowoduje jednoczesne nagrywanie obrazu wideo na rejestratorze zewnętrznym
RAW oraz na kartach pamięci w urządzeniu.

4

Ustaw rozdzielczość za pomocą opcji [Project] > [Rec Format] > [RAW Output Format] w menu
internetowym lub w menu kamery.

5

Sprawdź, czy rejestrator zewnętrzny jest włączony, a następnie naciśnij przycisk START/STOP do obsługi
nagrywania na ekranie sterowania w czasie rzeczywistym.

Stan nagrywania wideo w formacie RAW jest wskazywany przez ikonę w panelu obrazu z kamery.

6
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Uwaga

W przypadku rozpoczęciu nagrywania na rejestratorze zewnętrznym bez korzystania z przycisku START/STOP do obsługi
nagrywania na ekranie sterowania w czasie rzeczywistym klipy mogą nie zostać prawidłowo nagrane.

5-041-958-33(1) Copyright 2022 Sony Corporation

Uwaga

Sygnał sterujący nagrywaniem jest wyprowadzany ze złącza SDI OUT urządzenia, ale nie jest możliwe uzyskanie informacji
o stanie rejestratora zewnętrznego. W związku z tym urządzenie może wskazywać, że trwa nagrywanie w formacie RAW,
podczas gdy rejestrator zewnętrzny faktycznie nie nagrywa. Należy sprawdzić wskaźnik na rejestratorze zewnętrznym, aby
uzyskać prawidłowe informacje o stanie jego działania.

259



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nagrywanie wideo w formacie RAW w trybie zwolnionego/przyspieszonego tempa

Wideo w formacie RAW można nagrywać w trybie zwolnionego/przyspieszonego tempa.

Szczegółowe informacje na temat szybkości klatek obsługiwanych podczas filmowania podano w sekcji
„Zwolnione/przyspieszone tempo”.

Powiązany temat
Zwolnione/przyspieszone tempo

5-041-958-33(1) Copyright 2022 Sony Corporation
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Włączanie/wyłączanie funkcji sterowania efektem bokeh

Można łatwo dostosować poziom efektu bokeh poprzez powiązanie filtra ND i wzmocnienia z regulacją przysłony.

Włączanie/wyłączanie funkcji sterowania efektem bokeh

Tę funkcję można włączyć tylko w przypadku ręcznej regulacji ekspozycji. Należy ustawić filtr ND na tryb zmienny, a
następnie ustawić przysłonę, wzmocnienie, migawkę i filtr ND na regulację ręczną.
Funkcję sterowania bokeh można włączyć/wyłączyć za pomocą opcji [Shooting] > [Iris] > [Bokeh Control] w menu
kamery.
Gdy dla funkcji sterowania efektem bokeh wybrane jest ustawienie On, we wskaźnikach filtra ND i wzmocnienia
wyświetlana jest ikona  (B).

Uwaga

Ta funkcja jest aktywna tylko w przypadku obiektywów z mocowaniem typu E, które mogą komunikować się z urządzeniem.

Maksymalny efekt działania tej funkcji można uzyskać w przypadku korzystania z obiektywu Sony z mocowaniem typu E.

Funkcja sterowania efektem bokeh jest ustawiana na Off w każdej z poniższych sytuacji.

Wyłączenie urządzenia
W przypadku, gdy w odniesieniu do przysłony, wzmocnienia, migawki lub filtra ND wybrane jest ustawienie Auto
Przełączenie trybu filmowania
Ustawienie filtra ND na tryb neutralny lub tryb ustawień wstępnych
Zdjęcie obiektywu
Ponowne uruchomienie urządzenia, na przykład po przełączeniu częstotliwości

Wskazówka

Funkcję [Bokeh Control] można również przypisać do przycisku konfigurowalnego, aby móc przełączać między ustawieniami On i
Off funkcji sterowania efektem bokeh za pomocą tego przycisku.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Dostosowywanie poziomu efektu bokeh

Dostosuj ustawienia w krokach od 2 do 4 zgodnie z potrzebami.

Uwaga

Wygląd może się różnić w zależności od szybkości działania, obiektywu, ustawień filmowania i obiektu. Może się zmieniać
również jasność. Zdecydowanie zaleca się przetestowanie kamery przed przystąpieniem do filmowania.

Jasność może się zmieniać przy zmianie kierunku działania przysłony, na przykład przy otwieraniu przysłony po jej zamknięciu
lub przy zamykaniu przysłony po jej otwarciu. W takim przypadku należy wcześniej nastawić wartość trochę większą, niż jest to
wymagane, a następnie zmniejszyć nieco wartość, sprawdzić jasność i dopiero wtedy zacząć filmować. Jeśli chce się na przykład
otworzyć przysłonę do wartości F8 i rozmyć tło, należy najpierw przymknąć przysłonę do wartości większej niż F8, a następnie
wrócić do wartości F8, sprawdzić jasność i zacząć filmować.

Sterowanie efektem bokeh powinno odbywać się powoli. Jeśli wymagane jest szybsze działanie, spróbuj regulować stopniowo,
sprawdzając jednocześnie zmiany na obrazie.

Wskazówka

Gdy dla funkcji sterowania efektem bokeh wybrane jest ustawienie On, filtr ND i wzmocnienie działają w połączeniu w celu
skompensowania zmian ekspozycji spowodowanych regulacją przysłony, co umożliwia zmianę poziomu efektu bokeh.

Sterowanie efektem bokeh jest najpierw powiązane z filtrem ND w odpowiedzi na działanie przysłony. Gdy nie można już zmienić
filtra ND, następuje powiązanie wzmocnienia.

W trybie MF zaleca się, aby najpierw otworzyć przysłonę, a następnie ustawić ostrość.

Jeśli zamiast funkcji sterowania efektem bokeh używany jest automatyczny filtr ND, ustawienie filtra ND zależy od zmiany
jasności obiektu.

Informacje wyświetlane podczas działania w trybie powiązania ze wzmocnieniem
Gdy dla funkcji sterowania efektem bokeh wybrane jest ustawienie On, wzmocnienie może się zmieniać podczas
regulacji przysłony.

Wybierz ustawienie On funkcji sterowania efektem bokeh.1

Otwórz w pełni przysłonę.2

Ustaw filtr ND na 1/128.3

Ustaw wzmocnienie na 0 dB i dostosuj oświetlenie, aby uzyskać prawidłową ekspozycję.4

Wyreguluj ostrość.5

Nastaw przysłonę.

Poziom efektu bokeh zostanie odpowiednio zmieniony.

6
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Gdy powiązanie ze wzmocnieniem jest aktywne i wzmocnienie ulega zmianie, w górnej części ekranu pojawia się
komunikat, a ikona  (B) we wskaźniku wzmocnienia miga.
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Informacje ogólne na temat zapisywania i wczytywania danych konfiguracyjnych

Ustawienia urządzenia można zapisać w postaci danych konfiguracyjnych za pomocą aplikacji internetowej. Pozwala to
szybko wczytać zestaw ustawień menu odpowiednich do bieżącej sytuacji.
W przypadku tego urządzenia można zapisać prawie wszystkie ustawienia związane z funkcjami kamery, oprócz
wymienionych w poniższej uwadze, w postaci pliku ALL (plik ze wszystkimi ustawieniami).

Uwaga

Ustawienia funkcji sieciowych i informacje uwierzytelniające nie są zapisywane. Szczegółowe informacje na temat zapisywanych
ustawień podano w sekcji „Lista pozycji menu”.

Powiązany temat

Lista pozycji menu

5-041-958-33(1) Copyright 2022 Sony Corporation
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Zapisywanie pliku ALL

W tym temacie opisano sposób zapisywania pliku ALL.

5-041-958-33(1) Copyright 2022 Sony Corporation

Wybierz kolejno opcje [Project] > [All File] w menu internetowym.1

Naciśnij przycisk [Save All File] > [Save].

Przeglądarka internetowa pobierze po chwili plik o nazwie all-file.ALL.

2

Określ lokalizację i nazwę pliku dla pobranego pliku all-file.ALL i zapisz plik.

Szczegółowe informacje na temat operacji na plikach podano w instrukcji obsługi urządzenia.

3
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Wczytywanie pliku ALL

W tym temacie opisano sposób wczytywania pliku ALL.

Uwaga

Po wczytaniu danych konfiguracyjnych nastąpi automatycznie ponowne uruchomienie urządzenia. Po ponownym uruchomieniu
odśwież stronę w przeglądarce internetowej.

5-041-958-33(1) Copyright 2022 Sony Corporation

Wybierz kolejno opcje [Project] > [All File] w menu internetowym.1

Naciśnij przycisk [Load All File] > [Load].

Na urządzeniu z uruchomioną aplikacją internetową pojawi się okno dialogowe otwierania pliku.

2

Otwórz plik, który chcesz wczytać.

Szczegółowe informacje na temat operacji na plikach podano w instrukcji obsługi urządzenia.

3

Po wyświetleniu ekranu potwierdzenia nazwy pliku naciśnij przycisk [OK].4

Po wyświetleniu ekranu wyniku naciśnij przycisk [OK].5

Poczekaj aż urządzenie uruchomi się ponownie, a następnie ponownie nawiąż połączenie z aplikacją
internetową.

6
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Informacje na temat funkcji transferu plików

Plik nagrywania pomocniczego lub oryginalny plik nagrany na urządzeniu można przesłać na serwer w Internecie lub w
sieci lokalnej.

Uwaga

Gdy włączony jest stan zasilania w trybie gotowości, transfery plików są wstrzymane, mimo że urządzenie jest nadal zasilane.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Rejestrowanie miejsca docelowego transferu plików

Przed rozpoczęciem transferu plików można zarejestrować docelowy serwer transferu.

Wybierz opcję [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (lub [Server
Settings2], [Server Settings3]) w menu internetowym.

Wskazówka

Nazwa opcji wyboru zmieni się zgodnie z ustawieniem [Display Name], które zostanie skonfigurowane w następnym kroku.

1

Skonfiguruj następujące pozycje dla opcji [Network] > [FTP Server 1] – [FTP Server 3] w menu
internetowym.

[Display Name]
Służy do wprowadzania nazwy serwera, która ma być wyświetlana na liście zadań transferu przy wyborze
docelowego serwera transferu.
[Service]
Umożliwia wyświetlenie typu serwera.
[FTP]: serwer FTP
[Host Name]
Służy do wprowadzania adresu lub nazwy hosta serwera.
[Port]
Służy do wprowadzania numeru portu serwera w celu połączenia.
[User Name]
Służy do wprowadzania nazwy użytkownika.
[Password]
Służy do wprowadzania hasła.
[Passive Mode]
Służy do włączania/wyłączania trybu pasywnego.
[Destination Directory]
Służy do wprowadzania nazwy katalogu na serwerze docelowym.

Uwaga

Jeśli w polu [Destination Directory] zostaną wprowadzone znaki, które są nieprawidłowe na serwerze docelowym, pliki
zostaną przeniesione do głównego katalogu użytkownika. Nieprawidłowe znaki są różne w zależności od serwera.

[Using Secure Protocol]
Określa, czy ma zostać przeprowadzony bezpieczny transfer przy użyciu protokołu FTP.
[Root Certificate]
Służy do wczytywania/usuwania certyfikatu.
[Load]: wczytanie certyfikatu CA. Służy do wczytywania certyfikatów w formacie PEM.
[Clear]: usunięcie certyfikatu CA.
[None]: certyfikat nie zostanie wczytany ani usunięty.

Uwaga

Przed zaimportowaniem certyfikatu CA, należy ustawić właściwą godzinę zegara urządzenia.

Podczas nagrywania w formacie XAVC-I 4096×2160P / 3840×2160P 59.94/50P nie można wybrać opcji [Load].

2
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[Root Certificate Status]: służy do wyświetlania informacji o stanie wczytywania certyfikatu.
[Reset]: służy do przywracania wartości domyślnych ustawień Server Settings.
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Przesyłanie pliku nagrywania pomocniczego na kartę pamięci z poziomu ekranu
miniatur

Pliki nagrywania pomocniczego można przesyłać indywidualnie na kartę pamięci z poziomu ekranu miniatur.

Uwaga

Można zarejestrować do 200 zadań transferu.
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Naciśnij przycisk [Thumbnail] na ekranie sterowania w czasie rzeczywistym w aplikacji internetowej.

Widok na wyświetlaczu zmieni się z obrazu z kamery na ekran miniatur.

1

Wybierz opcję [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] w menu kamery.

Aby przesłać wszystkie pliki nagrywania pomocniczego jednocześnie, wybierz opcję [Transfer Clip (Proxy)] > [All
Clips].
Klipy można przesyłać z ekranu miniatur lub ekranu miniatur z filtrowaniem klipów.

2

Wybierz klip, który chcesz przesłać, za pomocą przycisku [Set], a następnie naciśnij przycisk [Menu].

Zostanie wyświetlony ekran potwierdzenia transferu.

3

Wybierz pozycję [Execute].

Plik nagrywania pomocniczego odpowiadający wybranemu klipowi zostanie zarejestrowany jako zadanie transferu i
rozpocznie się przesyłanie.
Gdy zadanie transferu zostanie pomyślnie zarejestrowane, pojawi się ekran wyników transferu.

4

Naciśnij przycisk [OK].5
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Przesyłanie oryginalnego pliku na kartę pamięci z poziomu ekranu miniatur

Oryginalny plik można przesłać na kartę pamięci z poziomu ekranu miniatur.

Uwaga

Można zarejestrować do 200 zadań transferu.
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Naciśnij przycisk [Thumbnail] na ekranie sterowania w czasie rzeczywistym w aplikacji internetowej.

Widok na wyświetlaczu zmieni się z obrazu z kamery na ekran miniatur.

1

Wybierz opcję [Thumbnail] > [Transfer Clip] > [Select Clip] w menu kamery.

Aby przesłać wszystkie oryginalne pliki jednocześnie, wybierz opcję [Transfer Clip] > [All Clips].
Klipy można przesyłać z ekranu miniatur lub ekranu miniatur z filtrowaniem klipów.

2

Wybierz klip, który chcesz przesłać, za pomocą przycisku [Set], a następnie naciśnij przycisk [Menu].

Zostanie wyświetlony ekran potwierdzenia transferu.

3

Wybierz pozycję [Execute].

Oryginalny plik wybranego klipu zostanie zarejestrowany jako zadanie transferu i rozpocznie się przesyłanie.
Gdy zadanie transferu zostanie pomyślnie zarejestrowane, pojawi się ekran wyników transferu.

4

Naciśnij przycisk [OK].5
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Sprawdzanie stanu transferu plików

Stan transferu plików można sprawdzić, wybierając kolejno opcje [Network] > [File Transfer] > [View Job List] w menu
kamery.

Uwaga

Można zarejestrować do 200 zadań transferu.

Zadania transferu są zachowywane po przełączeniu urządzenia do trybu gotowości, ale w przypadku odłączenia zasilania w inny
sposób może dojść do utraty maksymalnie 10 minut ostatnich informacji o postępie.

Jeśli podczas przesyłania pliku wystąpi błąd, transfer klipu o tej samej nazwie co przesyłany klip może nie zostać wznowiony w
zależności od ustawień i stanu serwera, na który dokonywany jest transfer. W takim przypadku należy sprawdzić ustawienia i stan
serwera, na który dokonywany jest transfer.

Wskazówka

Jeśli opcja [Network] > [File Transfer] > [Auto Upload (Proxy)] jest ustawiona na [On] w menu kamery i jest nawiązane połączenie
sieciowe, po zakończeniu nagrywania pliki nagrywania pomocniczego są automatycznie przesyłane na serwer określony za
pomocą opcji [Default Upload Server].

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przesyłanie za pomocą bezpiecznego protokołu FTP

W przypadku połączenia z docelowym serwerem plików można przesyłać pliki z szyfrowaniem za pomocą protokołu
FTPS w trybie Explicit (FTPES).
Aby włączyć bezpieczny transfer przy użyciu protokołu FTP, ustaw opcję [Using Secure Protocol] na [On] w ustawieniach
docelowego serwera plików i wczytaj certyfikat.

Szczegółowe informacje dotyczące konfiguracji podano w sekcji „Rejestrowanie miejsca docelowego transferu
plików”.

Powiązany temat

Rejestrowanie miejsca docelowego transferu plików

5-041-958-33(1) Copyright 2022 Sony Corporation
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Informacje dotyczące przesyłania strumieniowego

Urządzenie może jednocześnie przesyłać strumieniowo obraz i dźwięk ze złącza HDMI.

Uwaga

Aby przesyłać strumieniowo główny obraz wideo, w menu internetowym ustaw opcję [Monitoring] > [Output Display] > [SDI] na
[On], a dla opcji [HDMI/Stream] wybierz ustawienie [Off], a następnie monitoruj stan kamery na monitorze SDI.

Jeśli do złącza HDMI podłączony jest monitor, który nie obsługuje formatu wyjściowego HDMI skonfigurowanego za pomocą
menu [Monitoring] w menu internetowym lub w menu kamery, obraz z kamery nie będzie przekazywany do aplikacji internetowej.
Obraz wideo przesyłany strumieniowo również nie będzie przekazywany.

Nie można ustawić rozdzielczości wyższej niż rozdzielczość sygnału wyjściowego HDMI.

W przypadku wyświetlania obrazu przez wielu użytkowników obraz może ulec zniekształceniu w zależności od ustawień kodeka.

Urządzenie obsługuje podane poniżej metody przesyłania strumieniowego. Kodeki wideo dostępne do wyboru są
wyświetlane w nawiasach.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Skonfiguruj ustawienie formatu strumienia, ustawienie kodeka wideo i ustawienie kodeka audio w tej kolejności.

●: włączone, –: wyłączone

Wskazówka

Obraz w panelu obrazu z kamery w aplikacji internetowej jest również traktowany jako system przesyłania strumieniowego.

Format przesyłania strumieniowego
Ustawienie kodeka

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Aplikacja internetowa – – ● –

Protokół RTMP można wybrać, gdy opcja [Stream] > [Audio Stream] jest ustawiona na [On] w menu internetowym.*1

Gdy częstotliwość systemu jest ustawiona na 59.94 lub 50, a rozdzielczość formatu wyjściowego HDMI to 3840×2160 lub wyższa, wyjście „video
2” nie jest dostępne.

*2
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Ustawianie formatu przesyłania strumieniowego

Ustaw format przesyłania strumieniowego za pomocą opcji [Stream] > [Stream] > [Stream Setting] > [Setting] w menu
internetowym.

Gdy opcja [Setting] jest ustawiona na [RTSP]

W przypadku przesyłania strumieniowego przy użyciu protokołu RTSP obraz z jednej kamery może być wyświetlany
jednocześnie przez maksymalnie pięciu użytkowników.
Można skonfigurować maksymalnie dwa tryby kodeków wideo.
[Port Number]
Służy do ustawiania numer portu, który ma być używany do przesyłania strumieniowego przy użyciu protokołu RTSP.
Wartość domyślna to 554.
Zmiana tego ustawienia spowoduje ponowne uruchomienie serwera RTSP.
[Time Out]
Określa limit czasu działania polecenia Keep-Alive dla przesyłania strumieniowego przy użyciu protokołu RTSP. Limit
czasu można ustawić w zakresie od 0 sekund do 600 sekund. Wartość domyślna to 60 sekund.
W przypadku ustawienia na 0 sekund limit czasu działania polecenia Keep-Alive nie występuje.
[Authentication]
Określa, czy wymagane jest uwierzytelnienie.
[Video Port Number 1], [Video Port Number 2]
Określa numer portu do transmisji danych obrazu, który ma być używany do przesyłania strumieniowego unicast przy
użyciu protokołu RTSP. Fabryczna wartość domyślna dla opcji Video Port Number 1 to 51000. Fabryczna wartość
domyślna dla opcji Video Port Number 2 to 53000. Określ liczbę parzystą z zakresu od 1024 do 65534. Ustawiona tutaj
liczba i następująca po niej liczba nieparzysta (uzyskana poprzez dodanie 1) stają się dwoma numerami portów
używanych do transmisji danych obrazu i sterowania.
Ustawienia [Video Port Number 1] i [Video Port Number 2] odpowiadają ustawieniom [Stream] > [Video Stream] > [Video
Stream 1] i [Video Stream 2].
[Audio Port Number]
Określa numer portu do transmisji danych audio, który ma być używany do przesyłania strumieniowego unicast przy
użyciu protokołu RTSP. Wartość domyślna to 57000. Określ liczbę parzystą z zakresu od 1024 do 65534. Ustawiona tutaj
liczba i następująca po niej liczba nieparzysta (uzyskana poprzez dodanie 1) stają się dwoma numerami portów
używanych do transmisji danych audio i sterowania.

Gdy opcja [Setting] jest ustawiona na [RTMP]

Jedyny tryb kodeka wideo, który może być używany dla protokołu RTMP, to H.264. Aby korzystać z protokołu RTMP,
opcja [Stream] > [Audio Stream] musi być ustawiona na [On] w menu internetowym.
[Server URL]
Służy do ustawiania docelowego adres URL na potrzeby przesyłania. Należy wprowadzić ciąg znaków zaczynający się
od „rtmp://” lub „rtmps://”.
[Stream Key]
Wprowadź klucz przesyłania strumieniowego uzyskany z witryny, z której korzystasz. Naciśnięcie przycisku [Clear]
spowoduje usunięcie wpisu.

Uwaga

Należy zachować ostrożność podczas korzystania z klucza przesyłania strumieniowego. Jeśli klucz przesyłania strumieniowego
jest znany stronom trzecim, istnieje ryzyko spoofingu informacji przesyłanych strumieniowo.

[Root Certificate]
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Importuje certyfikat główny wymagany do przesyłania strumieniowego przy użyciu protokołu RTMPS. Aby zaimportować
certyfikat główny, naciśnij przycisk [Load] i wybierz certyfikat główny. Naciśnij przycisk [OK] w oknie dialogowym wyboru
pliku, aby zaimportować wybrany plik do urządzenia. Jeśli w urządzeniu znajduje się zaimportowany certyfikat główny,
zostanie on zaktualizowany. Aby usunąć zaimportowany certyfikat główny, naciśnij przycisk [Delete] na ekranie
konfiguracji. Stan certyfikatu głównego jest wyświetlany w pozycji [Root Certificate Status].

Uwaga

Zaimportuj certyfikat główny wymagany przez usługę przesyłania strumieniowego.

Gdy opcja [Setting] jest ustawiona na [SRT-Caller] lub [SRT-Listener]

Dostępny tryb kodeka wideo to wyłącznie H.264.
[Destination]
Pozycja wyświetlana po ustawieniu trybu przesyłania strumieniowego na [SRT-Caller]. Służy do ustawiania docelowego
adres URL połączenia.
[Port Number]
Pozycja wyświetlana po ustawieniu trybu przesyłania strumieniowego na [SRT-Listener]. Służy do ustawiania numer
portu, na którym ma odbywać się nasłuchiwanie. Wartość domyślna to 4201.
[Latency]
Służy do ustawiania opóźnienia w zakresie od 20 ms do 8000 ms. Wartość domyślna to 120.
[TTL]
Umożliwia ustawienie wartości TTL w zakresie od 1 do 255. Wartość domyślna to 64.
[Encryption]
Umożliwia wybranie metody szyfrowania. Można wybrać ustawienie Off, AES128 lub AES256. Wartość domyślna to Off.
[Passphrase]
Służy do ustawiania hasła używanego do szyfrowania. Naciśnięcie przycisku [Clear] spowoduje zresetowanie
skonfigurowanego hasła.
[ARC]
Aby włączyć funkcję Adaptive Rate Control wybierz dla tej opcji ustawienie On.
Gdy funkcja Adaptive Rate Control jest włączona, przerwy w wyświetlaniu obrazu spowodowane obciążeniem linii
komunikacyjnej mogą występować rzadziej.

Gdy opcja [Setting] jest ustawiona na [NDI|HX]

Urządzenie jest zgodne z protokołem NDI|HX w wersji 2 firmy NewTek.
Aby korzystać z protokołu NDI|HX, należy zakupić klucz licencyjny.
Zakup klucza licencyjnego
Klucz można zakupić w witrynie firmy NewTek pod następującym adresem URL:
https://www.newtek.com/ndihx/products/upgrade/

Uwaga

Pobierz najnowszy sterownik NDI|HX i zainstaluj go w produkcie firmy NewTek.

Szczegółowe informacje na temat rejestracji i użytkowania urządzenia z obsługą protokołu NDI|HX podano w instrukcji obsługi
produktu NewTek.

[License]
Służy do wyświetlania informacji o włączonej licencji.
[Source Name]
Służy do wyświetlania nazwy źródła.
[Group]
Aby włączyć funkcję grupowania NDI, ustaw tę opcję na On.
[Group Name]: Służy do ustawiania nazwy grupy NDI. Można skonfigurować wiele ustawień oddzielonych przecinkiem.
[Discovery Server 1], [Discovery Server 2]
Służy do ustawiania serwera odnajdywania NDI 1 i serwera odnajdywania NDI 2.
[Reliable UDP Mode]
Aby włączyć tryb UDP, ustaw tę opcję na On.

277



[Multicast Mode]
Aby włączyć przesyłanie strumieniowe multicast, ustaw tę opcję na On.
[Multicast Prefix]: Służy do ustawiania prefiksu używanego do przesyłania strumieniowego multicast.
[Multicast Netmask]: Służy do ustawiania maski sieci określającej zakres adresów multicast.
[Multicast TTL]: Umożliwia ustawienie wartości TTL dla przesyłania strumieniowego multicast w zakresie od 1 do 256.
Wartość domyślna to 3.
[Multi-TCP Mode]
Aby włączyć tryb Multi-TCP, ustaw tę opcję na On.
[Unicast UDP Mode]
Aby włączyć tryb Unicast UDP, ustaw tę opcję na On.

Informacje o usługach i oprogramowaniu innych firm
Mogą obowiązywać inne warunki użytkowania.

Świadczenie usług i aktualizowanie oprogramowania może zostać przerwane lub zakończone bez powiadomienia.
Opis usług i oprogramowania może ulec zmianie bez powiadomienia.
Może być wymagana osobna rejestracja i subskrypcja.

Firma Sony nie ponosi odpowiedzialności za jakiekolwiek roszczenia użytkowników ani osób trzecich wynikające z
korzystania z usług i oprogramowania innych firm.

5-041-958-33(1) Copyright 2022 Sony Corporation

278



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ustawianie kodeka wideo do przesyłania strumieniowego

Ustaw kodek wideo za pomocą opcji [Stream] > [Video Stream] w menu internetowym.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Można skonfigurować maksymalnie trzy tryby kodeka obrazu. Poniższe ustawienia należy skonfigurować oddzielnie dla
każdego trybu obrazu.
Opcja [Video Stream 3] jest używana do wyświetlania panelu obrazu z kamery w aplikacji internetowej.

Uwaga

Gdy opcja [Stream] > [Stream Setting] > [Setting] jest ustawiona na [RTMP], [SRT-Caller] lub [SRT-Listener], niektóre z ustawień
opcji [Video Stream 1], [Video Stream 2] i [Video Stream 3] ([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode]) mają
wartości domyślne.

[Codec 1], [Codec 2], [Codec 3]
Wybierz pozycję [H.264], [H.265] lub [Off]. Należy pamiętać, że opcji [Codec 1] nie można ustawić na [Off]. Ponadto
opcja [Codec 3] jest ustawiona na [JPEG] (bez możliwości zmiany).

Uwaga

W zależności od kombinacji różnych ustawień opcji [Codec 1], [Codec 2] i [Codec 3], takich jak rozmiar obrazu, szybkość klatek i
szybkość transmisji, mogą wystąpić podane poniżej objawy.

Zwiększone opóźnienie sygnału wideo.
Pomijanie klatek podczas odtwarzania wideo.
Przerywany dźwięk.
Powolna reakcja kamery na różne polecenia.
Powolna reakcja kamery na operacje wykonywane z pilota zdalnego sterowania.
Powolne wyświetlanie na ekranie monitora i powolne wykonywanie operacji konfiguracyjnych.

W przypadku wystąpienia tych objawów należy zmniejszyć wartości parametrów rozmiaru obrazu, szybkości klatek i szybkości
transmisji lub zmienić wartości innych parametrów konfiguracyjnych, aby rozwiązać problem.

Jeśli dla opcji [Stream] > [Stream Setting] > [Setting] wybrano ustawienie [RTMP], [SRT-Caller] lub [SRT-Listener], opcja [Codec
1] zostanie ustawiona na [H.264] (bez możliwości zmiany). Opcja [Codec 2] jest ustawiona na [Off] (bez możliwości zmiany).

W przypadku zmiany rozmiaru obrazu lub częstotliwości systemowej na wyjściu HDMI opcja [Codec 2] zostanie ustawiona na
[Off].

[Size 1], [Size 2], [Size 3]
Umożliwia wybranie rozmiaru obrazu, który ma być przesyłany strumieniowo z kamery.
Dostępne opcje rozmiaru obrazu zależą od rozmiaru obrazu na wyjściu HDMI.

Uwaga

W przypadku zmiany rozmiaru obrazu lub częstotliwości systemowej na wyjściu HDMI zostanie wybrany maksymalny rozmiar
obrazu.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Służy do ustawiania szybkości klatek.
Jednostki „fps” wskazują liczbę klatek przesyłanych strumieniowo na sekundę.
Dostępne opcje szybkości klatek zależą od rozmiaru obrazu na wyjściu HDMI.
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Uwaga

W przypadku zmiany rozmiaru obrazu lub częstotliwości systemowej na wyjściu HDMI zostanie wybrana maksymalna szybkość
klatek.

[I-Picture Mode 1], [I-Picture Mode 2]
Umożliwia ustawienie metody określania interwału wstawiania obrazów typu I dla kodeków H.264 i H.265 na opcję [Time]
lub [Frame].
Nie można ustawić w przypadku opcji [Codec 3].
[Time]: Służy do ustawiania interwału wstawiania obrazów typu I jako czasu.
[Frame]: Służy do ustawiania interwału wstawiania obrazów typu I jako liczby klatek.
[I-Picture Interval 1], [I-Picture Interval 2]
Służy do ustawiania interwału wstawiania obrazów typu I w sekundach. Umożliwia ustawienie wartości z zakresu od 1
sekundy do 5 sekund. Wartość domyślna to 1 sekunda.
Nie można ustawić w przypadku opcji [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Służy do ustawiania interwału wstawiania obrazów typu I dla kodeków H.264 i H.265 jako liczby klatek z zakresu od 15
do 300. Wartość domyślna to 300 klatek.
Nie można ustawić w przypadku opcji [Codec 3].
[Profile 1], [Profile 2]
Służy do ustawiania profilu kodeka obrazu H.264 lub H.265.
[H.264]: Wybierz profil [high], [main] lub [baseline].
[H.265]: Wybierz profil [main] lub [main10]. Gdy włączone są dwa kodeki wideo, dostępna jest tylko opcja wyboru profilu
[main].
Wydajność kompresji obrazu jest zwiększana w następującej kolejności: [high], [main] i [baseline]. Wybierz profil
obsługiwany przez system.
Jeśli dla opcji [H.265] wybrano ustawienie [main10], włączany jest profil [main10] w przypadku wyjścia HDMI
ustawionego na YCrCb lub profil [main] w przypadku wyjścia HDMI ustawionego na RGB.
Nie można ustawić w przypadku opcji [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Wybierz pozycję [CBR] lub [VBR].
Aby utrzymać stałą szybkość transmisji, wybierz opcję [CBR]. Aby utrzymać jakość obrazu, wybierz opcję [VBR].
Nie można ustawić w przypadku opcji [Codec 3].

Uwaga

Rzeczywista szybkość klatek i szybkość transmisji może się różnić od ustawionych wartości w zależności od rozmiaru obrazu,
filmowanej sceny, środowiska sieciowego i innych czynników.

Jeśli dla opcji [Stream] > [Stream Setting] > [Setting] wybrano ustawienie [RTMP], [SRT-Caller] lub [SRT-Listener], opcja [Bit Rate
Compression Mode 1] zostanie ustawiona na [CBR] (bez możliwości zmiany).

[Bit Rate 1], [Bit Rate 2]
Można ustawić szybkość transmisji dla każdego strumienia wideo, gdy opcja [Bit Rate Compression Mode] jest
ustawiona na [CBR]. Ustawienie wysokiej szybkości transmisji umożliwia przesyłanie strumienia wideo o wysokiej jakości
obrazu.
Nie można ustawić w przypadku opcji [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Umożliwia ustawienie jakości obrazu w zakresie od 1 do 10. Wartość 10 określa najwyższą jakość obrazu. Wartość
domyślna to 6.
W przypadku opcji [Quality 1] i [Quality 2] można ustawić jakość obrazu H.264, ustawiając opcję [Bit Rate Compression
Mode] na [VBR] i opcję [Codec] na [H.264]. Jakość obrazu H.265 można ustawić, wybierając dla opcji [Bit Rate
Compression Mode] ustawienie [VBR], a dla opcji [Codec] ustawienie [H.265].
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Ustawianie kodeka audio do przesyłania strumieniowego

Ustaw kodek audio za pomocą opcji [Stream] > [Audio Stream] w menu internetowym.
[Setting]
Aby włączyć przesyłanie strumieniowe dźwięku, ustaw na On.

Uwaga

Aby wybrać protokół RTMP, zawsze należy wcześniej wybrać ustawienie On.

[Codec]
Umożliwia wybór typu kodeka używanego do przesyłania strumieniowego dźwięku.
[AAC (256kbps)]: umożliwia nadanie priorytetu jakości dźwięku.
[AAC (128kbps)]: umożliwia nadanie priorytetu pojemności danych.
To ustawienie nie ma wpływu na klip nagrany na urządzeniu ani na sygnał audio osadzony w sygnale HDMI/SDI.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Rozpoczynanie/zatrzymywanie przesyłania strumieniowego

W przypadku ustawień [RTSP], [SRT-Listener] i [NDI|HX]

Urządzenie czeka na żądanie przesyłania strumieniowego.
Uruchom aplikację kliencką do wyświetlania obrazu przesyłanego strumieniowo i przejdź do adresu URL podanego w
poniższej tabeli.
Wprowadź nazwę użytkownika i hasło skonfigurowane w urządzeniu.

<adres_kamery>: adres IP urządzenia
<Port>: port urządzenia nasłuchującego skonfigurowany za pomocą opcji [Port Number]

Uwaga

Możliwość odtwarzania we wszystkich aplikacjach lub na wszystkich urządzeniach nie jest gwarantowana.

W przypadku ustawień [RTMP] i [SRT-Caller]

Naciśnij przycisk [Stream now] na karcie  (Stream) na ekranie sterowania w czasie rzeczywistym, aby rozpocząć
przesyłanie strumieniowe. Przycisk zmieni się na [Stop stream], a w górnej części panelu obrazu z kamery pojawi się
ikona [Stream].
Naciśnij przycisk [Stop stream] podczas przesyłania strumieniowego, aby zatrzymać przesyłanie strumieniowe. Przycisk
zmieni się z powrotem na [Stream now], a ikona [Stream] przestanie być wyświetlana w górnej części panelu obrazu z
kamery.

Uwaga

Możliwość odtwarzania we wszystkich aplikacjach lub na wszystkich urządzeniach nie jest gwarantowana.

5-041-958-33(1) Copyright 2022 Sony Corporation

Format przesyłania
strumieniowego Adres URL

RTSP
Video Stream 1 rtsp://<adres_kamery>:<Port>/video1

Video Stream 2 rtsp://<adres_kamery>:<Port>/video2

SRT-Listener srt://<adres_kamery>:<Port>

NDI|HX
Zapoznaj się z instrukcją obsługi urządzenia klienckiego zgodnego z protokołem
NDI|HX.
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Ekran miniatur

Po naciśnięciu przycisku [Thumbnail] na ekranie odtwarzania lub przycisku THUMBNAIL na pilocie zdalnego sterowania
na podczerwień klipy zapisane na karcie pamięci zostaną wyświetlone w panelu obrazu z kamery. Ten ekran w panelu
obrazu z kamery jest nazywany ekranem miniatur.
Możesz wybrać klip na ekranie miniatur i rozpocząć jego odtwarzanie.
Naciśnięcie przycisku [Thumbnail], gdy wyświetlany jest ekran miniatur, spowoduje zamknięcie ekranu miniatur i powrót
do wyświetlania obrazu z kamery.

Uwaga

Na ekranie miniatur wyświetlane są tylko klipy nagrane w aktualnie wybranym formacie nagrywania. Jeśli nie jest wyświetlany
właściwy nagrany klip, sprawdź format nagrywania. Należy zwrócić na to szczególną uwagę przed sformatowaniem (inicjalizacją)
nośnika.

Układ ekranu

Miniatura wybranego klipu zostanie wyświetlona na pomarańczowym tle.
Informacje dotyczące wybranego klipu są wyświetlane u dołu ekranu.
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Wybrana karta pamięci
Jeśli karta pamięci jest zabezpieczona przed zapisem, wyświetlana jest ikona blokady.

1.

Numer klipu / łączna liczba klipów2.

Miniatura (obraz indeksu)
Wyświetla obraz indeksu klipu. Gdy klip jest nagrywany, jego pierwsza klatka jest automatycznie ustawiana jako
obraz indeksu.
Pod miniaturą wyświetlane są informacje o klipie/klatce. Wyświetlane informacje można zmienić za pomocą opcji
[Thumbnail] > [Customize View] > [Thumbnail Caption] w menu kamery.

3.

Nazwa klipu
Wyświetla nazwę wybranego klipu.

4.

Format nagrywania
Wyświetla format pliku wybranego klipu.

5.

Specjalne informacje dotyczące nagrywania
Wyświetla tryb nagrywania tylko wtedy, gdy klip został nagrany w specjalnym trybie nagrywania.
W przypadku klipów w zwolnionym/przyspieszonym tempie liczba klatek na sekundę jest wyświetlana po prawej
stronie.

6.

Czas trwania klipu7.

Data utworzenia8.
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Odtwarzanie nagranych klipów

Nagrane klipy można odtwarzać, gdy urządzenie znajduje się w trybie gotowości (Stby).
W tym temacie opisano sposób odtwarzania nagranych klipów za pomocą panelu do obsługi interfejsu użytkownika.

Włóż kartę pamięci, aby rozpocząć odtwarzanie.1

Naciśnij przycisk [Thumbnail].

Zostaną wyświetlone miniatury klipów.

2

Użyj przycisków w panelu do obsługi interfejsu użytkownika, aby przesunąć kursor na miniaturę klipu,
który chcesz odtwarzać.

3
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Uwaga

Uwaga

Klipów nie można wybierać za pomocą dotyku.

Naciśnij przycisk [Set] w panelu do obsługi interfejsu użytkownika.

Odtwarzanie rozpocznie się od początku wybranego klipu.

4

Użyj odpowiednich przycisków w panelu sterowania odtwarzaniem.

Wskazówka

Operacje sterowania można wykonywać również za pomocą panelu do obsługi interfejsu użytkownika.

Odtwarzanie: Naciśnij przycisk [Set].
Wstrzymanie odtwarzania: Podczas odtwarzania naciśnij przycisk [Set]. Ponowne naciśnięcie powoduje powrót do
normalnego odtwarzania.
Przejście do początku klipu lub początku następnego klipu: Naciśnij przycisk w lewo / w prawo.
Przewijanie do przodu/do tyłu: Naciśnij i przytrzymaj przycisk w lewo / w prawo. Po zwolnieniu przycisku zostanie
przywrócona normalna szybkość odtwarzania.
Zatrzymanie odtwarzanie: Naciśnij przycisk [Cancel/Back].

5

Przycisk Funkcja

Przycisk  (wstrzymanie/odtwarzanie)
Służy do odtwarzania klipów. Podczas odtwarzania służy do
wstrzymywania odtwarzania klipu.

Przycisk  (przewijanie do przodu),
przycisk  (przewijanie do tyłu)

Służy do odtwarzania klipu z dużą szybkością. Naciśnięcie
przycisku powoduje zmianę szybkości odtwarzania (w trzech
stopniach).

Przycisk  (poprzedni), przycisk 
(następny)

Przejście do początku klipu lub poprzedniego/następnego klipu.

Przycisk  (zatrzymanie)
Powoduje zatrzymywanie odtwarzania i przejście do ekranu
filmowania.
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Na granicy między klipami mogą wystąpić chwilowe przerwy w odtwarzaniu obrazu lub może być wyświetlany obraz nieruchomy.
W tym czasie nie można obsługiwać urządzenia.

Po wybraniu klipu na ekranie miniatur i rozpoczęciu odtwarzania może nastąpić chwilowe zniekształcenie obrazu na początku
klipu. Aby wyświetlić początek klipu bez zniekształcenia, wstrzymaj odtwarzanie, naciśnij przycisk  (poprzedni), aby powrócić
do początku klipu, a następnie ponownie rozpocznij odtwarzanie.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Operacje na nagranych klipach

Na ekranie miniatur można wykonywać operacje na klipach lub sprawdzać właściwości klipów, korzystając z menu
[Thumbnail] w menu kamery.
Naciśnij przycisk [Menu] na ekranie operacji odtwarzania, aby wyświetlić menu kamery w panelu obrazu z kamery.
Za pomocą menu [Thumbnail] w menu kamery można wykonywać podane poniżej operacje.
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Wskazówka

W celu wyświetlenia menu kamery można również nacisnąć przycisk [Menu] na ekranie sterowania w czasie rzeczywistym.

Operacje wykonywane za pomocą menu [Thumbnail] w menu kamery
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Za pomocą przycisków strzałek w panelu do obsługi interfejsu użytkownika wybierz żądaną funkcję i naciśnij przycisk
[Set].
Naciśnij przycisk [Cancel/Back], aby powrócić do poprzedniego ekranu.

Uwaga

Niektórych pozycji nie można wybrać — zależy to od stanu w momencie wyświetlenia menu.

Pozycje menu służące do wykonywania operacji na klipach

Menu [Thumbnail] w menu kamery zawiera podane poniżej pozycje menu związane z operacjami na klipach.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Szczegółowe informacje na temat poszczególnych pozycji menu podano w sekcji „Menu [Thumbnail]”.

Wyświetlanie ekranu właściwości klipu
Wybierz pozycję [Thumbnail] > [Display Clip Properties] w menu kamery, aby wyświetlić ekran właściwości klipu.
Naciśnij przycisk  (poprzedni) lub przycisk  (następny), aby przejść do poprzedniego/następnego klipu.

Dodawanie znaczników klipów
Do klipów można dodawać znaczniki klipów (oznaczenia OK, NG lub KP), aby filtrować wyświetlane klipy na ich
podstawie.
Wybierz miniaturę klipu, do którego chcesz dodać znacznik klipu, a następnie wybierz znacznik klipu za pomocą opcji
[Thumbnail] > [Set Clip Flag] w menu kamery.

Wskazówka

Znaczniki klipów można dodawać również za pomocą przycisku konfigurowalnego, do którego przypisano funkcję znaczników
klipów.

Wyświetlanie ekranu miniatur z filtrowaniem klipów
Wybierz opcję [Thumbnail] > [Filter Clips] w menu kamery, a następnie wybierz typ znacznika klipu, aby wyświetlić tylko
te klipy, które mają określony znacznik.
Aby wyświetlić wszystkie klipy, wybierz opcję [All].
Możesz również nacisnąć przycisk [Display], aby posortować wyświetlane miniatury według znaczników.

Usuwanie klipów
Można usuwać klipy z kart pamięci.
Wybierz opcję [Thumbnail] > [Delete Clip] > [Select Clip] lub [All Clips] w menu kamery.
[Select Clip]: usuwa wybrany klip. Obsługiwany jest wybór wielu klipów.
[All Clips]: usuwa wszystkie wyświetlane klipy.

Ustawienie Dodawany znacznik klipu

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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Zmienianie informacji wyświetlanych na ekranie miniatur
Informacje o klipie/klatce wyświetlane pod miniaturą można zmienić.
W menu kamery wybierz kolejno [Thumbnail] > [Customize View] > [Thumbnail Caption], a następnie wybierz informacje,
które mają być wyświetlane.
[Date Time]: służy do wyświetlania daty i godziny utworzenia klipu i jego ostatniej modyfikacji.
[Time Code]: służy do wyświetlania kodu czasowego.
[Duration]: służy do wyświetlania czasu trwania klipu.
[Sequential Number]: służy do wyświetlania kolejnego numeru na każdej miniaturze.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Konfiguracja menu kamery

Po naciśnięciu przycisku [Menu] w panelu do obsługi interfejsu użytkownika lub przycisku MENU na pilocie zdalnego
sterowania na podczerwień w panelu obrazu z kamery zostanie wyświetlone menu kamery umożliwiające
skonfigurowanie różnych wymaganych ustawień filmowania i odtwarzania.

Menu to obejmuje podane poniżej pozycje menu.

Konfiguracja menu

Menu [User]
Zawiera pozycje menu konfigurowane przez użytkownika.
Można je edytować za pomocą opcji [Edit User Menu].
Menu [Edit User]
Zawiera pozycje menu służące do edycji menu [User].
Menu [Shooting]
Zawiera ustawienia związane z filmowaniem.
Menu [Project]
Zawiera podstawowe ustawienia projektu.
Menu [Paint/Look]
Zawiera ustawienia związane z jakością obrazu.
Menu [Pan-Tilt]
Zawiera ustawienia związane z funkcją obrotu w poziomie/pionie.
Menu [TC/Media]
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Zawiera ustawienia związane z kodami czasowymi i nośnikami służącymi do nagrywania.
Menu [Monitoring]
Zawiera ustawienia związane z wyjściem wideo i wyświetlaniem na ekranie.
Menu [Audio]
Zawiera ustawienia związane z dźwiękiem.
Menu [Thumbnail]
Zawiera ustawienia związane z wyświetlaniem miniatur.
Menu [Technical]
Zawiera ustawienia pozycji technicznych.
Menu [Network]
Zawiera ustawienia związane z sieciami.
Menu [Maintenance]
Zawiera ustawienia urządzeń, takie jak ustawienia zegara i języka.

Konfiguracja i hierarchia menu kamery

Poziom 1 Poziom 2

User
(Ustawienia fabryczne)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu

293



Poziom 1 Poziom 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix
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Poziom 1 Poziom 2

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR
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Poziom 1 Poziom 2

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter

296



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Korzystanie z menu kamery

Po naciśnięciu przycisku [Menu] w panelu do obsługi interfejsu użytkownika lub przycisku MENU na pilocie zdalnego
sterowania na podczerwień w panelu obrazu z kamery zostanie wyświetlone menu kamery umożliwiające
skonfigurowanie różnych wymaganych ustawień filmowania i odtwarzania.
Do obsługi menu służą przyciski w panelu do obsługi interfejsu użytkownika.

Przycisk [Menu]: Naciśnij, aby wyświetlić menu kamery. Naciśnij ponownie, gdy wyświetlane jest menu kamery, aby je
ukryć.
Przyciski strzałek: Naciskaj przyciski strzałki, aby przesuwać kursor w górę / w dół / w lewo / w prawo w celu wyboru
pozycji menu lub ustawień.
Przycisk [Set]: Naciśnij, aby zastosować wybraną pozycję.
Przycisk [Cancel/Back]: Naciśnij, aby powrócić do poprzedniego menu. Nieukończona zmiana zostanie anulowana.

Uwaga

Niektórych pozycji nie można wybrać — zależy to od stanu w momencie wyświetlenia menu.

Pozycje menu Setting

Za pomocą przycisków strzałek w panelu do obsługi interfejsu użytkownika przesuń kursor do pozycji, którą chcesz
ustawić, a następnie naciśnij przycisk [Set], aby zastosować ustawienie.

W obszarze wyboru pozycji menu może być wyświetlanych maksymalnie osiem wierszy. Jeśli opcje dostępne dla
danej pozycji nie mogą być wyświetlone jednocześnie, należy przewinąć ekran, przesuwając kursor w górę / w dół.
W przypadku pozycji podrzędnych o dużym zakresie ustawień (na przykład od −99 do +99) obszar ustawień nie jest
wyświetlany. Bieżące ustawienie jest wyróżnione, aby wskazać, że można zmienić jego wartość.
Wybranie opcji [Execute] dla funkcji spowoduje wykonanie danej funkcji.
Wybranie pozycji wymagającej potwierdzenia przed wykonaniem spowoduje tymczasowe ukrycie menu i
wyświetlenie komunikatu z prośbą o potwierdzenie. Należy przeczytać komunikat, a następnie wybrać, czy chce się
wykonać funkcję, czy też ją anulować.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Wprowadzanie ciągu znaków

Po wybraniu pozycji, takiej jak nazwa pliku, w przypadku której wymagane jest wprowadzenie znaków, zostanie
wyświetlony ekran wprowadzania znaków.

5-041-958-33(1) Copyright 2022 Sony Corporation

Za pomocą przycisków strzałek w panelu do obsługi interfejsu użytkownika wybierz typ znaku i zastosuj
ustawienie.

[ABC]: wielkie litery alfabetu
[abc]: małe litery alfabetu
[123]: znaki numeryczne
[!#$]: znaki specjalne

1

Wybierz znak i naciśnij przycisk [Set], aby zastosować ustawienie.

Kursor przejedzie do następnego pola.
[Space]: służy do wprowadzania znaku spacji w położeniu kursora.
[←] [→]: przyciski służące do przesuwania położenia kursora.
[BS]: służy do usuwania znaku po lewej stronie kursora (backspace).

2

Po zakończeniu naciśnij przycisk [Done], aby zastosować ustawienie.

Ciąg znaków zostanie potwierdzony, a ekran wprowadzania znaków przestanie być wyświetlany.

3
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User

W tym temacie opisano funkcję i ustawienia każdej pozycji menu.

Uwaga

Pozycje menu [User] można dodawać i usuwać, korzystając z menu [Edit User]. Można skonfigurować do 20 pozycji.

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Opis

Base Setting Pozycja Project > Base Setting

Focus Pozycja Shooting > Focus

S&Q Motion Pozycja Shooting > S&Q Motion

LUT On/Off Pozycja Shooting > LUT On/Off

Simul Rec Pozycja Project > Simul Rec

Proxy Rec Pozycja Project > Proxy Rec

Interval Rec Pozycja Project > Interval Rec

Picture Cache Rec Pozycja Project > Picture Cache Rec

Assignable Button Pozycja Project > Assignable Button

Scene File Pozycja Project > Scene File

Base Look Pozycja Paint/Look > Base Look

P/T Acceleration Pozycja Pan-Tilt > P/T Acceleration

Clip Name Format Pozycja TC/Media > Clip Name Format

Format Media Pozycja TC/Media > Format Media

Video Signal Monitor Pozycja Monitoring > Video Signal Monitor

Marker Pozycja Monitoring > Marker

Zoom Pozycja Technical > Zoom

Lens Pozycja Technical > Lens

Edit User Menu Umożliwia wyświetlenie menu Edit User.
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Edit User

Menu [Edit User] jest wyświetlane na najwyższym poziomie, gdy w menu [User] wybrano opcję [Edit User Menu].
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Add Item
Dodanie pozycji do
menu [User]

– –
Służy do dodawania pozycji drugiego poziomu
menu do menu [User].

Customize Reset
Resetowanie pozycji w
menu [User]

– –
Służy do przywracania domyślnych ustawień
fabrycznych pozycji menu zarejestrowanych w
menu [User].

Pozycja drugiego
poziomu menu wybrana
podczas edycji

Delete –
Służy do usuwania zarejestrowanej pozycji
drugiego poziomu menu z menu [User].

Move –
Służy do przenoszenia zarejestrowanych pozycji
menu w ramach menu [User].

Edit Sub Item –
Służy do edytowania (rejestrowania/usuwania)
zarejestrowanej pozycji podrzędnej (trzeci poziom
menu) w menu [User].
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ISO/Gain/EI

Służy do konfigurowania ustawień wzmocnienia.

Pozycja Ustawienie pozycji podrzędnej Domyślne ustawienie
fabryczne Opis

Mode ISO/dB dB
Służy do wyboru tryb ustawienia
wzmocnienia.

ISO/Gain<L>

Szczegółowe informacje na temat
ustawień podano w sekcji
„Ustawienia funkcji ISO/Gain i ich
wartości domyślne”.

–
Służy do konfigurowania
ustawienia wstępnego wartości
wzmocnienia <L>.

Exposure
Index<L>

Gdy opcja Base ISO jest ustawiona
na ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Gdy opcja Base ISO jest ustawiona
na ISO 12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Gdy opcja Base ISO
jest ustawiona na ISO
800: 800EI / 6.0E
Gdy opcja Base ISO
jest ustawiona na ISO
12800: 12800EI / 6.0E

Umożliwia ustawienie wartości
opcji Exposure Index<L>.

Shockless
Gain

On / Off Off
Służy do włączania/wyłączania
funkcji płynnego wzmocnienia.

Base
Sensitivity

High / Low Low Służy do ustawiania czułości
podstawowej dla trybu Custom.
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Powiązany temat

Ustawienia ISO/Gain i ich wartości domyślne
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Pozycja Ustawienie pozycji podrzędnej Domyślne ustawienie
fabryczne Opis

Base ISO ISO 12800 / ISO 800 ISO 800
Służy do ustawiania podstawowej
czułości ISO dla trybu Cine
EI/Flexible ISO.
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ND Filter

Służy do konfigurowania ustawień wstępnych wartości filtra ND.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Mode Preset / Variable Variable Służy do wyboru trybu filtra ND.

Preset1
1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/4
Służy do konfigurowania ustawienia wstępnego 1
wartości filtra ND.

Preset2
1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/16
Służy do konfigurowania ustawienia wstępnego 2
wartości filtra ND.

Preset3 1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/64 Służy do konfigurowania ustawienia wstępnego 3
wartości filtra ND.
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Shutter

Służy do ustawiania sposobu działania migawki elektronicznej.
Umożliwia rejestrowanie wyraźnego obrazu szybko poruszających się obiektów.

Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

Mode Speed / Angle Speed
Można wybrać tryb ustawiania czasu
otwarcia migawki w sekundach (Speed) lub
poprzez kąt otwarcia migawki (Angle).

Shutter
Speed
On/Off

On / Off Off

Umożliwia określenie, czy w przypadku
wybrania trybu Speed czas ekspozycji ma
być zgodny z wartością ustawienia [Shutter
Speed], czy też ma być ustawiony na pełną
ekspozycję.

Shutter
Speed

od 64F do 1/8000
Dostępne ustawienia różnią się w
zależności od częstotliwości klatek
wybranego formatu wideo.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F /
5F / 4F / 3F / 2F / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F
/ 4F / 3F / 2F / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F /
5F / 4F / 3F / 2F / 1/30 / 1/40 / 1/50 /
1/60 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F
/ 4F / 3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 /
1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F /
6F / 5F / 4F / 3F / 2F / 1/24 / 1/32 /
1/48 / 1/50 / 1/60 / 1/96 / 1/100 / 1/120
/ 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P:
1/24

Służy do ustawiania czasu otwarcia
migawki w przypadku wybrania trybu
Speed.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 360.0° / 300.0° / 270.0° /
240.0° / 216.0° / 210.0° / 180.0° /
172.8° / 150.0° / 144.0° / 120.0° / 90.0°
/ 86.4° / 72.0° / 45.0° / 30.0° / 22.5° /
11.25° / 5.6°

180.0°
Służy do ustawiania kąta otwarcia migawki
w przypadku wybrania trybu Angle.
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Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

ECS On/Off On / Off Off
Służy do włączania/wyłączania funkcji
Extended Clear Scan.

ECS
Frequency

od 23.99 do 8000
Dostępne ustawienia różnią się w
zależności od częstotliwości klatek
wybranego formatu nagrywania.

59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Służy do ustawiania częstotliwość ECS,
gdy opcja Mode jest ustawiona na ECS.
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Iris

Służy do konfigurowania ustawień przysłony.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Bokeh
Control

On / Off Off
Służy do włączania/wyłączania funkcji
sterowania efektem bokeh.
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Auto Exposure

Służy do konfigurowania ustawień automatycznej korekty ekspozycji.

Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 /
+1.75 / +1.5 / +1.25 / +1.0 / +0.75 /
+0.5 / +0.25 / ±0 / −0.25 / −0.5 / −0.75
/ −1.0 / −1.25 / −1.5 / −1.75 / −2.0 /
−2.25 / −2.5 / −2.75 / −3.0

±0
Służy do ustawiania poziomu jasności dla
automatycznie wykrytej ekspozycji.

Mode Backlight / Standard / Spotlight Standard

Służy do ustawiania trybu działania funkcji
automatycznej korekty ekspozycji.
Backlight: tryb oświetlenia tylnego (tryb
zwiększający jasność obiektu oświetlonego z
tyłu)
Standard: tryb standardowy
Spotlight: tryb oświetlenia punktowego (tryb
stosowany, gdy obiekt jest oświetlony
światłem punktowym)

Speed od −99 do +99 ±0
Służy do ustawiania szybkości regulacji przy
automatycznej korekcie ekspozycji.

AGC On / Off Off
Służy do włączania/wyłączania funkcji AGC
(automatycznej regulacji wzmocnienia).

AGC Limit

Szczegółowe informacje na temat
ustawień podano w sekcji
„Ustawienia funkcji AGC Limit i ich
wartości domyślne”.

–
Służy do ustawiania maksymalnego
wzmocnienia dla funkcji AGC.

AGC Point F2.8 / F4 / F5.6 F2.8
Służy do ustawiania nastawy przysłony, przy
której rozpoczyna się działanie funkcji AGC,
gdy dla funkcji tej wybrano ustawienie On.

Auto
Shutter

On / Off Off
Służy do włączania/wyłączania funkcji
automatycznego sterowania migawką.

A.SHT
Limit

1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Służy do ustawiania najkrótszego czasu
otwarcia migawki dla funkcji migawki
automatycznej.

A.SHT
Point

F5.6 / F8 / F11 / F16 F11
Służy do ustawiania nastawy przysłony, przy
której rozpoczyna się działanie funkcji
migawki automatycznej.
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Ustawienia AGC Limit i ich wartości domyślne
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Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

Clip High
light

On / Off Off

Służy do włączania/wyłączania funkcji, która
ignoruje najjaśniejsze obszary, aby zapewnić
bardziej płaską odpowiedź przy wysokiej
luminancji.

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

Służy do ustawiania obszaru pomiaru światła
w celu automatycznego dostosowania
ekspozycji zgodnie z jasnością obiektu.
(Pozycja niedostępna w przypadku ręcznej
korekty ekspozycji)

Detect
Window
Indication

On / Off Off
Służy do włączania/wyłączania wskazania
obszaru pomiaru światła.

Custom
Width

od 40 do 999 500
Służy do ustawiania szerokości obszaru
pomiaru światła.

Custom
Height

od 70 do 999 500
Służy do ustawiania wysokości obszaru
pomiaru światła.

Custom H
Position

od −479 do +479 ±0
Służy do ustawiania położenia poziomego
obszaru pomiaru światła.

Custom V
Position

od −464 do +464 ±0
Służy do ustawiania położenia pionowego
obszaru pomiaru światła.
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White

Służy do konfigurowania ustawień balansu bieli.
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Preset
White

od 2000K do
15000K

3200K Służy do konfigurowania ustawienia wstępnego balansu bieli.

Color
Temp <A>

od 2000K do
15000K

3200K

Służy do ustawiania temperatury barwowej balansu bieli zapisanej
w pamięci A.

Uwaga

Ponieważ ustawienie Color Temp jest ograniczane przy
wartościach 2000K i 15000K podczas działania funkcji R Gain/B
Gain, wyświetlenie prawidłowej wartości dla wartości Color Temp
dla wartości R Gain/B Gain może nie być możliwe.

Tint<A> od −99 do +99 ±0

Służy do ustawiania wartości odcienia balansu bieli zapisanej w
pamięci bieli A.

Uwaga

Ponieważ ustawienie Tint jest ograniczane przy wartościach ±99
podczas działania funkcji R Gain/B Gain, wyświetlenie prawidłowej
wartości odcienia dla wartości R Gain/B Gain może nie być
możliwe.

R Gain
<A>

od −99.0 do
+99.0

±0.0
Służy do ustawiania wartości wzmocnienia R balansu bieli
zapisanej w pamięci A.

B Gain
<A>

od −99.0 do
+99.0

±0.0
Służy do ustawiania wartości wzmocnienia B balansu bieli
zapisanej w pamięci A.
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White Setting

Służy do dostosowywania ustawień balansu bieli.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie fabryczne Opis

Shockless
White

Off / 1 / 2 / 3 2

Służy do ustawiania szybkości zmiany balansu bieli
przy przełączaniu trybu balansu bieli.
Off: przełączenie natychmiastowe.
Od 1 do 3: im wyższa wartość, tym przełączenie
następuje wolniej.

ATW Speed 1 / 2 / 3 / 4 / 5 3
Służy do ustawiania szybkości reakcji w trybie ATW.
Najwyższa szybkość reakcji to 1, a najniższa
szybkość reakcji to 5.
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Offset White

Służy do konfigurowania ustawień przesunięcia balansu bieli.
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Offset White
<A>

On / Off Off
Umożliwia określenie, czy wartość przesunięcia ma
zostać dodana (On), czy też nie (Off) do balansu bieli w
pamięci A.

Offset Color
Temp<A> od −99 do +99 ±0

Służy do ustawiania przesunięcia temperatury barwowej,
które ma zostać dodane do balansu bieli w pamięci A, gdy
opcja [Offset White <A>] jest ustawiona na On.

Offset Tint<A> od −99 do +99 ±0
Służy do ustawiania przesunięcia wartości odcienia, które
ma zostać dodane do balansu bieli w pamięci A, gdy
opcja [Offset White <A>] jest ustawiona na On.

Offset
White<ATW>

On / Off On
Umożliwia określenie, czy wartość przesunięcia ma
zostać dodana (On), czy też nie (Off) do balansu bieli w
trybie ATW.

Offset Color
Temp<ATW>

od −99 do +99 ±0
Służy do ustawiania przesunięcia temperatury barwowej,
które ma zostać dodane do balansu bieli w trybie ATW,
gdy opcja [Offset White<ATW>] jest ustawiona na On.

Offset
Tint<ATW>

od −99 do +99 ±0
Służy do ustawiania przesunięcia wartości odcienia, które
ma zostać dodane do balansu bieli w trybie ATW, gdy
opcja [Offset White<ATW>] jest ustawiona na On.
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Focus

Służy do konfigurowania ustawień ostrości.

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

AF
Transition
Speed

1(Slow) / 2 / 3 / 4
/ 5 / 6 / 7(Fast)

5
Służy do ustawiania prędkości napędu regulacji ostrości w
przypadku, gdy obiekt zmienia się podczas automatycznego
ustawiania ostrości.

AF Subj.
Shift Sens.

1(Locked On) / 2 /
3 / 4 /
5(Responsive)

5(Responsive)
Służy do ustawiania czułości regulacji ostrości w przypadku
zmieniającego się obiektu podczas automatycznego ustawiania
ostrości.

Focus Area
Wide / Zone /
Flexible Spot

Wide

Służy do ustawiania obszaru docelowego w trybie
automatycznego ustawiania ostrości oraz trybie
automatycznego ustawiania ostrości za pomocą przycisku
(AF).

Patrz: „Automatyczna regulacja ostrości (ustawienie Auto
Focus)” oraz „Ustawianie obszaru automatycznej regulacji
ostrości oraz jego położenia (ustawienie Focus Area)”.

Wide: wyszukuje obiekt na obrazie pod szerokim kątem
podczas ustawiania ostrości.
Zone: automatycznie wyszukuje punkt ostrości w określonej
strefie.
Flexible Spot: ustawia ostrość w określonej pozycji na obrazie.

Focus Area
(AF-S)

Flexible Spot Flexible Spot
Służy do ustawiania obszaru docelowego w trybie
automatycznego ustawiania ostrości za pomocą przycisku (AF-
S).

Face/Eye
Detection
AF

Face/Eye Only AF
/
Face/Eye Priority
AF / Off

Face/Eye Priority
AF

Służy do włączania/wyłączania trybu AF z wykrywaniem twarzy.
Patrz: „Śledzenia przy użyciu funkcji wykrywania twarzy i
oczu (ustawienie Face/Eye Detection AF)”.

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF
Służy do ustawiania trybu automatycznego ustawiania ostrości
za pomocą przycisku.

Touch
Function in
MF

Tracking AF /
Spot Focus

Tracking AF
Służy do ustawiania działania wykonywanego po dotknięciu
obrazu z kamery na ekranie sterowania w czasie rzeczywistym
w aplikacji internetowej w trybie MF.
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Powiązany temat

Ustawianie obszaru automatycznej regulacji ostrości oraz jego położenia (ustawienie Focus Area)

Śledzenia przy użyciu funkcji wykrywania twarzy i oczu (ustawienie Face/Eye Detection AF)

Ręczne określanie obiektu, na którym ma być automatycznie ustawiana ostrość (ustawienie AF Assist), za pomocą
aplikacji internetowej

Ręczna regulacja ostrości podczas automatycznego ustawiania ostrości za pomocą dołączonego do zestawu pilota
zdalnego sterowania na podczerwień
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

AF Assist On / Off On

W przypadku ustawienia na On pozwala tymczasowo wyłączyć
automatyczne ustawianie ostrości i ustawić ostrość ręcznie.

Patrz: „Ręczne określanie obiektu, na którym ma być
automatycznie ustawiana ostrość (ustawienie AF Assist), za
pomocą aplikacji internetowej” i „Ręczna regulacja ostrości
podczas automatycznego ustawiania ostrości za pomocą
dołączonego do zestawu pilota zdalnego sterowania na
podczerwień”.
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S&Q Motion

Umożliwia skonfigurowanie ustawień trybu zwolnionego/przyspieszonego tempa (patrz: sekcja „Zwolnione/przyspieszone
tempo”).

Powiązany temat

Zwolnione/przyspieszone tempo
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Setting On / Off Off
Służy do włączania/wyłączania trybu
zwolnionego/przyspieszonego tempa.

Frame
Rate

1fps – 60fps / 100fps /
120fps / 150fps / 180fps /
200fps / 240fps

–

Służy do ustawiania szybkości klatek dla trybu
filmowania w zwolnionym/przyspieszonym tempie.

Uwaga

Dostępne ustawienia różnią się w zależności od
wybranych ustawień: częstotliwości systemu, kodeka i
formatu wideo.

314



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

LUT On/Off

Służy do konfigurowania ustawienia LUT.

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

SDI
MLUT On / MLUT
Off

MLUT Off
Pozwala określić, czy zastosować ustawienie Monitor
LUT do wyjściowego obrazu wideo w formacie SDI.

HDMI/Stream
MLUT On / MLUT
Off

MLUT Off

Pozwala określić, czy zastosować ustawienie Monitor
LUT do wyjściowego obrazu wideo w formacie HDMI
oraz wyjściowego obrazu wideo przesyłanego
strumieniowo.

Proxy
MLUT On / MLUT
Off

MLUT Off
Pozwala określić, czy zastosować ustawienie Monitor
LUT do obrazu wideo rejestrowanego w ramach
nagrywania pomocniczego.

Internal Rec
MLUT On / MLUT
Off

MLUT Off
Pozwala określić, czy zastosować ustawienie Monitor
LUT do obrazu wideo rejestrowanego w ramach
nagrywania głównego.

LUT On/Off
Button Target

SDI / HDMI/Stream
/ SDI &
HDMI/Stream

HDMI/Stream
Służy do ustawiania docelowego sygnału wyjściowego
sterowanego za pomocą przycisku konfigurowalnego,
do którego przypisano opcję LUT On/Off.

315



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Noise Suppression

Pozwala skonfigurować ustawienia redukcji szumów.

Wskazówka

Ustawienia [Setting(Custom)] oraz [Level(Custom)] są odzwierciedlone w ustawieniu [Target Display].
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Setting(Custom) On / Off On
Służy do włączania/wyłączania funkcji redukcji
szumów w trybie Custom.

Level(Custom) Low / Mid / High Mid
Służy do ustawiania poziomu redukcji szumów
w trybie Custom.

Setting (Cine
EI/Flex. ISO) On / Off Off

Służy do włączania/wyłączania funkcji redukcji
szumów w trybach filmowania Log.

Level (Cine EI/Flex.
ISO)

Low / Mid / High Mid
Służy do ustawiania poziomu redukcji szumów
w trybie filmowania Log.
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Flicker Reduce

Służy do konfigurowania ustawień korekty migotania.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie fabryczne Opis

Mode Auto / On / Off Off Służy do ustawiania tryb korekty migotania.

Frequency 50Hz / 60Hz 60Hz
Służy do ustawiania częstotliwości źródła energii
zasilającego oświetlenie powodujące migotanie.
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SteadyShot

Służy do konfigurowania ustawień stabilizacji obrazu.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Setting
Active / Standard /
Off Off

Służy do ustawiania funkcji stabilizacji obrazu.

Uwaga

Ustawienie to jest włączone, gdy zainstalowany jest zgodny
obiektyw.

W przypadku wybrania opcji Active lub Standard może
wystąpić nieoczekiwane działanie podczas operacji obrotu w
poziomie/pionie.
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Base Setting

Służy do konfigurowania ustawień podstawowych.

Powiązany temat

Konfigurowanie podstawowych ustawień

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Shooting
Mode

Custom / Flexible ISO /
Cine EI Quick / Cine EI

Custom

Służy do ustawiania trybu filmowania.

Patrz: „Konfigurowanie trybu filmowania” w
sekcji „Konfigurowanie podstawowych
ustawień”.

Target
Display SDR(BT.709) / HDR(HLG) SDR(BT.709)

Służy do ustawiania gamy kolorów na potrzeby
nagrywania / wyprowadzania sygnałów w trybie
Custom.
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Rec Format

Służy do konfigurowania ustawień formatu nagrywania.

Ustawienia [RAW Output Format]

Wartości domyślne są wyróżnione pogrubieniem.

Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94 Służy do wyboru częstotliwości systemu.

Imager
Scan Mode

FF / S35 FF Służy do wyboru rozmiaru przetwornika obrazu.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Służy do ustawiania kodeka używanego do
nagrywania/odtwarzania klipu.

Uwaga

Jeśli dla opcji [Imager Scan Mode] wybrano
ustawienie [S35], nie można wybrać opcji
[RAW] i [RAW & XAVC-I].

RAW Output
Format

Dostępne ustawienia różnią się w
zależności od ustawienia opcji
[Frequency].

Patrz: sekcja „Ustawienia
opcji [RAW Output Format]”
poniżej.

–

Służy do ustawiania rozmiaru obrazu RAW,
który ma być wyprowadzany do zewnętrznego
rejestratora RAW.

Uwaga

Gdy opcja [Codec] jest ustawiona na [RAW &
XAVC-I], ustawienie [Video Format] jest
przełączane w połączeniu z ustawieniem
[RAW Output Format].

Video
Format

Dostępne ustawienia różnią się w
zależności od ustawień opcji
[Frequency], [Imager Scan Mode]
i [Codec]

Patrz: sekcja „Ustawienia
opcji [Video Format]” poniżej.

–
Służy do ustawiania rozmiaru obrazu i
szybkości transmisji.

Frequency Imager Scan Mode Codec Ustawienie

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Warunki, w których nie można ustawić opcji [RAW Output Format], zostały pominięte.

Ustawienia [Video Format]

Wartości domyślne są wyróżnione pogrubieniem.
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Frequency Imager Scan Mode Codec Ustawienie

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Cine EI/Flex.ISO Set

Służy do konfigurowania ustawień trybu filmowania Log (patrz: „Konfigurowanie trybu filmowania” w sekcji
„Konfigurowanie podstawowych ustawień”).

Powiązany temat

Konfigurowanie podstawowych ustawień
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3
Służy do ustawiania gamy kolorów dla trybów
filmowania Log ([Flexible ISO], [Cine EI Quick],
[Cine EI]).

Embed
LUT File

On / Off On
Służy do włączania/wyłączania rejestrowania
metadanych pliku 3D LUT (pliku CUBE).
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Simul Rec

Służy do konfigurowania ustawień trybu nagrywania jednoczesnego przy użyciu dwóch gniazd (patrz: „Jednoczesne
nagrywanie na karty pamięci A i B (nagrywanie jednoczesne przy użyciu dwóch gniazd)”).
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Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

Setting On / Off Off
Służy do włączania/wyłączania trybu
jednoczesnego nagrywania z użyciem 2
gniazd.

Rec
Button
Set

Rec Button:<Slot A> <Slot B> 2nd Rec
Button:<Slot A> <Slot B> / Rec Button:
<Slot A> 2nd Rec Button:<Slot B> / Rec
Button:<Slot B> 2nd Rec Button:<Slot
A>

Rec Button:<Slot A>
<Slot B> 2nd Rec
Button:<Slot A>
<Slot B>

Umożliwia przypisanie przycisków
nagrywania używanych do sterowania
każdym z nośników służących do
nagrywania.
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Proxy Rec

Służy do konfigurowania ustawień trybu nagrywania pomocniczego (patrz: „Nagrywanie pomocnicze”).
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Setting On / Off Off
Służy do włączania/wyłączania trybu nagrywania
pomocniczego.

Audio
Channel

CH1/CH2 / CH3/CH4 CH1/CH2
Umożliwia wybranie kanału audio do nagrywania
danych pomocniczych.

324



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Interval Rec

Służy do konfigurowania ustawień trybu nagrywania interwałowego (patrz: „Nagrywanie interwałowe (Interval Rec)”).
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Pozycja Ustawienie pozycji podrzędnej Domyślne ustawienie
fabryczne Opis

Setting On / Off Off

Służy do włączania/wyłączania trybu
nagrywania interwałowego. (Ustawienie
tego trybu na On spowoduje, że
wszystkie pozostałe tryby specjalne
zostaną ustawione Off).

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 /
15 / 20 / 30 / 40 / 50 (sek.)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 /
15 / 20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (godz.)

1

Służy do ustawiania interwału między
nagraniami w trybie nagrywania
interwałowego (gdy opcja Interval Rec
jest ustawiona na On).

Number
of
Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
Dostępne ustawienia różnią się w
zależności od częstotliwości
klatek wybranego formatu wideo.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Służy do ustawiania liczby klatek
nagrywanych w ramach jednego ujęcia
w trybie nagrywania interwałowego (gdy
opcja Interval Rec jest ustawiona na
On).
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Picture Cache Rec

Służy do konfigurowania ustawień trybu nagrywania obrazu z pamięci podręcznej (patrz: „Nagrywanie obrazu z pamięci
podręcznej (Picture Cache Rec)”).

Powiązany temat
Nagrywanie obrazu z pamięci podręcznej (Picture Cache Rec)
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Setting On / Off Off
Służy do włączania/wyłączania funkcji pamięci podręcznej
obrazów.

Cache Size
Short / Medium /
Long / Max

Max
Służy do ustawiania czasu gromadzenia obrazów w
pamięci podręcznej (czas zapisu w pamięci podręcznej).

Cache Rec
Time

– –
Służy do wyświetlania czasu gromadzenia obrazów w
pamięci podręcznej (czas zapisu w pamięci podręcznej).
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SDI/HDMI Rec Control

Służy do konfigurowania ustawień sterowania nagrywaniem w formacie SDI/HDMI.
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Setting
Off / SDI/HDMI
Remote I/F /
Parallel Rec

Off

Służy do ustawiania sposobu sterowania
rozpoczynaniem/zatrzymywaniem nagrywania sygnału wyjściowego w
formacie SDI/HDMI na podłączonym urządzeniu zewnętrznym.
Off: pilot zdalnego sterowania nie będzie używany.
SDI/HDMI Remote I/F: sterowanie zatrzymaniem/rozpoczynaniem
nagrywania na podłączonym urządzeniu zewnętrznym, gdy w
niniejszym urządzeniu nie ma nośnika. Nie jest synchronizowane z
dokładnością klatek z nośnikiem w urządzeniu.
Parallel Rec: sterowanie zatrzymaniem/rozpoczynaniem nagrywania
na podłączonym urządzeniu zewnętrznym, gdy do niniejszego
urządzenia jest włożony nośnik. Jest synchronizowane z dokładnością
klatek z nośnikiem w urządzeniu.

Uwaga

Aby sterować za pomocą sygnału wyjściowego HDMI, w menu kamery
ustaw opcję [TC/Media] > [HDMI TC Out] > [Setting] na [On].
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Assignable Button

Umożliwia przypisanie funkcji do przycisków konfigurowalnych (od <1> do <9>) oraz do opcji [Focus Hold Button].
Można przypisać podane poniżej funkcje.
[Off]: brak przypisania funkcji.
[Base ISO/Sensitivity]: służy do przełączania podstawowej czułości przetwornika obrazu.
[AGC]: służy do włączania/wyłączania funkcji AGC.
[Push AGC]: funkcja AGC jest włączona, gdy przycisk jest wciśnięty.
[ND Filter]

W trybie zmiennym: regulacja przepuszczalności filtra ND. Naciśnięcie i przytrzymanie powoduje przełączanie
między trybami Clear/Manual/Auto.
W trybie ustawień wstępnych: naciśnięcie i przytrzymanie powoduje przełączenie ustawień wstępnych.

[ND Filter Position]: służy do przełączania filtrów ND.
[Auto ND Filter]: służy do włączania/wyłączania funkcji automatycznego filtra ND.
[Push Auto ND]: funkcja automatycznego filtra ND jest włączona, gdy przycisk jest wciśnięty.
[Auto Iris]: służy do włączania/wyłączania funkcji automatycznej przysłony.
[Push Auto Iris]: funkcja automatycznej przysłony jest włączona, gdy przycisk jest wciśnięty.
[Bokeh Control]: służy do włączania/wyłączania trybu sterowania efektem bokeh.
[Auto Shutter]: służy do włączania/wyłączania funkcji migawki automatycznej.
[AE Level/Mode]: służy do regulacji poziomu AE. Naciśnięcie i przytrzymanie powoduje przełączanie trybu AE.
[Backlight]: służy do przełączania między opcjami Backlight i Standard.
[Spotlight]: służy do przełączania między opcjami Spotlight i Standard.
[Preset White Select]: służy do przełączania wartości w trybie wstępnych ustawień balansu bieli.
[ATW]: służy do włączania/wyłączania funkcji ATW.
[ATW Hold]: wstrzymuje działanie funkcji ATW.
[AF Speed/Sens.]: służy do przełączania ustawienia szybkości przejścia w trybie AF oraz ustawienia czułości zmiany
obiektu w trybie AF.
[Focus Setting]: służy do ustawiania obszaru regulacji ostrości.
[Face/Eye Detection AF]: służy do przełączania ustawień trybu AF z wykrywaniem twarzy/oczu.
[Push AF Mode]: służy do przełączania ustawienia trybu Push AF.
[Push AF/MF]: w trybie ustawiania ostrości MF aktywuje tryb AF, gdy przycisk jest wciśnięty. W trybie ustawiania ostrości
AF aktywuje tryb MF, gdy przycisk jest wciśnięty.
[Focus Hold]: w trybie ustawiania ostrości AF ostrość jest stała, gdy przycisk jest wciśnięty.
[S&Q Motion]: służy do włączania/wyłączania funkcji zwolnionego/przyspieszonego tempa. Umożliwia ustawienie
szybkości klatek po naciśnięciu i przytrzymaniu przycisku.
[LUT On/Off]: służy do włączania/wyłączania funkcji LUT. Cel przełączania jest ustawiany za pomocą opcji [Shooting] >
[LUT On/Off] > [LUT On/Off Button Target].
[SteadyShot]: służy do przełączania między opcjami Active, Standard i Off.
[Crop Select]: służy do przełączania trybu Imager Scan Mode. Możliwość przełączania jest włączona w ramach zakresu
bez zmiany formatu nagrywania.
[Rec]: rozpoczynanie/zatrzymywanie nagrywania.
[Picture Cache Rec]: służy do włączania/wyłączania trybu nagrywania obrazu z pamięci podręcznej.
[Rec Review]: służy do włączania/wyłączania funkcji przeglądania nagrań.
[Clip Flag OK]: służy do uruchamiania funkcji Add OK. Dwukrotne naciśnięcie powoduje uruchomienie funkcji Delete
Clip Flag.
[Clip Flag NG]: służy do uruchamiania funkcji Add NG. Dwukrotne naciśnięcie powoduje uruchomienie funkcji Delete
Clip Flag.
[Clip Flag Keep]: służy do uruchamiania funkcji Add KEEP. Dwukrotne naciśnięcie powoduje uruchomienie funkcji
Delete Clip Flag.
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[Slot Select]: służy do przełączania gniazdami kart pamięci (A) i (B).
[Color Bars]: służy do włączania/wyłączania kolorowych pasów.
[DURATION/TC/U-BIT]: służy do przełączania między opcjami Time Code, Users Bit i Duration.
[Display]: służy do włączania/wyłączania wskaźników ekranowych.
[Lens Info]: służy do przełączania wskaźnika głębi ostrości.
[Video Signal Monitor]: służy do przełączania monitora sygnału wideo (takiego jak oscyloskop sygnałów wizyjnych).
[Marker]: służy do włączania/wyłączania funkcji znaczników.
[Thumbnail]: służy do wyświetlania/zamykania ekranu miniatur.
[Auto Upload (Proxy)]: służy do włączania/wyłączania automatycznego transferu plików nagrywania pomocniczego.
[Direct Menu]: służy do wyświetlania/zamykania menu bezpośredniego.
[User Menu]: służy do wyświetlania/zamykania menu User.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Scene File

Służy do konfigurowania ustawień związanych z plikami scen (patrz „Filmowanie z odpowiednim wyglądem”).
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Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

Recall – –

Służy do wczytywania pliku sceny
przechowywanego w pamięci
wewnętrznej i stosowania ustawień jako
bieżących ustawień jakości obrazu.

Store – –
Służy do zapisywania aktualnego stanu
jakości obrazu jako pliku sceny w pamięci
wewnętrznej.

Delete – –
Służy do usuwania pliku sceny
przechowywanego w pamięci
wewnętrznej.

Preset
Recall

Gdy opcja Shooting Mode jest
ustawiona na Custom, a dla opcji Target
Display wybrano ustawienie
SDR(BT.709): S-Cinetone / Standard / Still
/ ITU709/ 709tone
Gdy opcja Shooting Mode jest
ustawiona na Custom, a dla opcji Target
Display wybrano ustawienie HDR(HLG):
HLG Live / HLG Natural

–

Wstępnie skonfigurowane ustawienia
jakości obrazu (bez możliwości
nadpisania) są stosowane jako bieżące
ustawienia jakości obrazu.
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Base Look

Służy do konfigurowania ustawień związanych z wyglądem podstawowym.

Pozycja Ustawienie pozycji podrzędnej Domyślne ustawienie
fabryczne Opis

Select

Gdy opcja Shooting Mode jest
ustawiona na Custom, a opcja Target
Display jest ustawiona na
SDR(BT.709): S-Cinetone / Standard /
Still / ITU709 / 709tone / User1 –
User16
Gdy opcja Shooting Mode jest
ustawiona na Custom, a opcja Target
Display jest ustawiona na HDR(HLG):
HLG Live / HLG Natural / User1 –
User16
Gdy opcja Shooting Mode jest
ustawiona na tryby filmowania Log:
s709 / 709(800) / S-Log3 / User1–
User16

Gdy opcja Shooting Mode jest
ustawiona na Custom, a opcja
Target Display jest ustawiona
na SDR(BT.709): S-Cinetone
Gdy opcja Shooting Mode jest
ustawiona na Custom, a opcja
Target Display jest ustawiona
na HDR(HLG): HLG Live
Gdy opcja Shooting Mode jest
ustawiona na tryby filmowana
log: s709

Umożliwia wybranie
wyglądu podstawowego.

Delete – –
Umożliwia usunięcie
wybranego wyglądu
podstawowego.

Delete
All

– –
Umożliwia usunięcie
wszystkich wyglądów
podstawowych.

Input
S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3

Służy do ustawiania
wejściowej gamy kolorów
dla wyglądu podstawowego
wybranego za pomocą opcji
[Select].

Output BT.709 / HLG BT.709

Służy do ustawiania
wyjściowej gamy kolorów
dla wyglądu podstawowego
wybranego za pomocą opcji
[Select].

AE Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /
5/3EV / 2EV

0EV

Służy do ustawiania
wartości odniesienia
ekspozycji dla wyglądu
podstawowego wybranego
za pomocą opcji [Select].
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Reset Paint Settings

Umożliwia zresetowanie ustawień menu [Paint/Look] z wyjątkiem wyglądu podstawowego.

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Reset without
Base Look

Execute / Cancel –
Umożliwia zresetowanie ustawień menu
[Paint/Look] z wyjątkiem wyglądu podstawowego.
Execute: uruchomienie funkcji.
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Black

Służy do konfigurowania ustawień czerni.

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Master
Black

od −99.0 do +99.0 ±0.0
Służy do ustawiania głównego poziomu
czerni.

R Black od −99.0 do +99.0 ±0.0 Służy do ustawiania poziomu R czerni.

B Black od −99.0 do +99.0 ±0.0 Służy do ustawiania poziomu B czerni.
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Knee

Służy do konfigurowania ustawień korekty zagięcia charakterystyki.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Setting

Gdy opcja Target Display
jest ustawiona na
SDR(BT.709): On / Off / ---
Gdy opcja Target Display
jest ustawiona na
HDR(HLG): On / Off / ---

Gdy opcja Target Display
jest ustawiona na
SDR(BT.709): Off
Gdy opcja Target Display
jest ustawiona na
HDR(HLG): Off

Służy do włączania/wyłączania funkcji korekty
zagięcia charakterystyki.

Uwaga

Pozycja dostępna tylko wtedy, gdy opcja
[Base Look] > [Select] jest ustawiona na
[Standard], [ITU709], [709tone], [HLG Live]
lub [HLG Natural].

Auto
Knee

Gdy opcja Target Display
jest ustawiona na
SDR(BT.709): On / Off / ---
Gdy opcja Target Display
jest ustawiona na
HDR(HLG): On / Off / ---

Gdy opcja Target Display
jest ustawiona na
SDR(BT.709): On
Gdy opcja Target Display
jest ustawiona na
HDR(HLG): Off

Służy do włączania/wyłączania funkcji
automatycznego zagięcia charakterystyki.

Uwaga

Pozycja dostępna tylko wtedy, gdy opcja
[Base Look] > [Select] jest ustawiona na
[Standard], [ITU709] lub [709tone].

Point 75%–109% 90%
Służy do ustawiania punktu zagięcia
charakterystyki.

Slope od −99 do +99 ±0
Służy do ustawiania nachylenia zagięcia
charakterystyki.

335



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Detail

Służy do konfigurowania ustawień regulacji poziomu szczegółów.
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Setting On / Off On
Służy do włączania/wyłączania funkcji regulacji poziomu
szczegółów.

Level od −7 do +7 ±0 Służy do ustawiania poziomu szczegółów.

Manual
Setting

On / Off / --- Off
Służy do włączania/wyłączania funkcji ręcznej regulacji poziomu
szczegółów.

H/V Ratio od −2 do +2 ±0

Służy do ustawiania balansu pomiędzy poziomym (H) i pionowym
(V) poziomem szczegółów na potrzeby ręcznej regulacji poziomu
szczegółów.

Uwaga

Pozycja ta różni się zależności od wersji oprogramowania*1.

B/W
Balance

Type1 / Type2 /
Type3 / Type4 /
Type5

Type3

Służy do ustawiania balansu pomiędzy poziomem szczegółów
czarnych (B) dla obszarów o niskiej luminancji i poziomem
szczegółów białych (W) dla obszarów o wysokiej luminancji na
potrzeby ręcznej regulacji poziomu szczegółów.

Limit od 0 do 7 7
Służy do ustawiania ograniczenia poziomu szczegółów na
potrzeby ręcznej regulacji poziomu szczegółów.

Crispening od 0 do 7 0
Służy do ustawiania poziomu wyostrzania na potrzeby ręcznej
regulacji poziomu szczegółów.

High Light
Detail

od 0 do 4 0
Służy do ustawiania poziomu szczegółów w obszarach o wysokiej
luminancji na potrzeby ręcznej regulacji poziomu szczegółów.

W wersji oprogramowania 1.00 ta pozycja menu nazywa się [V/H Balance]. W wersji oprogramowania 1.10 lub nowszej ta pozycja menu nazywa
się [H/V Ratio]. Zakres ustawień jest taki sam: od -2 do 0 do +2. Jednak wpływ regulacji na jakość obrazu jest inny.
Wersja oprogramowania 1.00: im wyższa wartość zostanie ustawiona, tym większy będzie poziomy (H) poziom szczegółów.
Wersja oprogramowania 1.10 lub nowsza: im wyższa wartość zostanie ustawiona, tym większy będzie pionowy (V) poziom szczegółów.
Po aktualizacji z wersji oprogramowania 1.00 do 1.10 lub nowszej ustawienia [All File], [Scene File] i inne są dziedziczone, ale z odwróconą
biegunowością (jakość obrazu jest zachowywana).
Jeśli pozycja menu [V/H Balance] została zarejestrowana w menu [User], zostanie ona automatycznie zastąpiona pozycją menu [H/V Ratio] w
menu [User] po aktualizacji oprogramowania.

*1
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Matrix

Służy do konfigurowania ustawień korekty macierzy.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

User Matrix On / Off Off
Służy do włączania/wyłączania funkcji korekty
macierzy użytkownika.

User Matrix
Level

od −99 do +99 ±0
Służy do dostosowywania nasycenia kolorów
całego obrazu.

User Matrix
Phase

od −99 do +99 ±0
Służy do dostosowywania barwy (fazy) całego
obrazu.

User Matrix
R-G

od −99 do +99 ±0
Służy do ustawiania niestandardowej macierzy
R-G użytkownika.

User Matrix
R-B

od −99 do +99 ±0
Służy do ustawiania niestandardowej macierzy
R-B użytkownika.

User Matrix
G-R

od −99 do +99 ±0
Służy do ustawiania niestandardowej macierzy
G-R użytkownika.

User Matrix
G-B

od −99 do +99 ±0
Służy do ustawiania niestandardowej macierzy
G-B użytkownika.

User Matrix
B-R

od −99 do +99 ±0
Służy do ustawiania niestandardowej macierzy
B-R użytkownika.

User Matrix
B-G

od −99 do +99 ±0
Służy do ustawiania niestandardowej macierzy
B-G użytkownika.
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Multi Matrix

Służy do konfigurowania ustawień korekty wielu macierzy.
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Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

Setting On / Off Off
Służy do włączania/wyłączania funkcji
korekty wielu macierzy.

Reset Execute / Cancel –
Umożliwia zresetowanie barwy i nasycenia
koloru w każdej osi do wartości domyślnych.

Axis
B / B+ / MG− / MG / MG+ / R / R+ /
YL− / YL / YL+ / G− / G / G+ / CY /
CY+ / B−

B Umożliwia wybranie osi.

Hue od −99 do +99 ±0
Służy do ustawiania odcienia koloru
używanego do korekty wielu macierzy.

Saturation od −99 do +99 ±0
Służy do ustawiania nasycenia koloru
używanego do korekty wielu macierzy.
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P/T Acceleration

Służy do konfigurowania ustawień związanych z przyspieszeniem dla operacji obrotu w poziomie/pionie.
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Ramp
Curve

od 1 do 9 8
Umożliwia wybranie przyspieszenia/opóźnienia dla operacji
obrotu w poziomie/pionie. Im większa wartość, tym większe
przyspieszenie.
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Timecode

Służy do konfigurowania ustawień kodu czasowego.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Mode Preset / Regen / Clock Preset

Służy do ustawiania trybu uruchamiania kodu
czasowego.
Preset: uruchamianie od wstępnie ustawionej
wartości.
Regen: uruchamianie od kodu czasowego końca
poprzedniego klipu.
Clock: używanie wewnętrznego zegara jako kodu
czasowego.

Run Rec Run / Free Run Rec Run

Rec Run: jest uruchomiony tylko podczas
nagrywania.
Free Run: jest zawsze uruchomiony niezależnie
od operacji nagrywania.

Setting – –
Służy do ustawiania kodu czasowego na dowolną
wartość.
Set: umożliwia ustawienie wartości.

Reset Execute / Cancel –
Umożliwia zresetowanie kodu czasowego do
wartości 00:00:00:00.
Execute: uruchomienie funkcji.

TC
Format

DF / NDF DF
Służy do ustawiania formatu kodu czasowego.
DF: tryb Drop Frame
NDF: tryb Non-Drop Frame
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TC Display

Służy do konfigurowania ustawień wyświetlania danych dotyczących czasu.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Display
Select

Timecode / Users Bit /
Duration

Timecode
Służy do przełączania wyświetlania danych
dotyczących czasu.
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Users Bit

Służy do konfigurowania ustawień związanych z bitami użytkownika.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Mode Fix / Time Fix

Służy do ustawiania trybu informacji użytkownika.
Fix: w bitach użytkownika używana jest dowolna
stała wartość.
Time: w bitach użytkownika używana jest aktualna
godzina, minuta i sekunda.

Setting – – Służy do ustawiania bitów użytkownika na dowolną
wartość.

342



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

HDMI TC Out

Służy do konfigurowania ustawień związanych z przekazywaniem kodu czasowego na wyjście podczas korzystania z
interfejsu HDMI.

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Setting On / Off Off
Służy do określania, czy kod czasowy ma być wysyłany do
urządzeń za pomocą interfejsu HDMI do wykorzystania w
innych celach.
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Clip Name Format

Służy do konfigurowania ustawień związanych z dodawaniem i usuwaniem nazw klipów.
Gdy opcja [Auto Naming] jest ustawiona na [Cam ID + Reel#], pierwsze cztery znaki nazw klipów są ustalane dla
każdego nośnika służącego do nagrywania. Po włożeniu nowego nośnika służącego do nagrywania lub w przypadku,
gdy ostatni klip na nośniku nie jest zgodny z ustawieniem [Camera ID] lub [Reel Number], nazwa klipu miga, aby o tym
powiadomić.
Gdy opcja [Auto Naming] jest ustawiona na [Title], można użyć dowolnego ciągu znaków jako pierwszej części nazwy
klipu.

Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Auto
Naming

Cam ID + Reel# /
Title

Służy do wyboru formatu nazw klipów.
Cam ID + Reel#: Camera ID + Reel Number + Shot Number +
data + losowy ciąg
Title: Dowolny ciąg znaków określony w ustawieniu [Title
Prefix] + numer klipu

Camera
ID

A–Z A

Służy do ustawiania identyfikatora kamery używanego
podczas generowania nazw klipów.

Uwaga

Ustawienie to można skonfigurować tylko wtedy, gdy opcja
[Auto Naming] jest ustawiona na [Cam ID + Reel#].

Reel
Number

od 001 do 999 001

Służy do ustawiania parametru Reel Number używanego
podczas generowania nazw klipów.

Uwaga

Ustawienie to można skonfigurować tylko wtedy, gdy opcja
[Auto Naming] jest ustawiona na [Cam ID + Reel#].

Camera
Position

C / L / R C

Służy do ustawiania pierwszej sekwencji znaków parametru
Shot Number używanego podczas generowania nazw klipów.

Uwaga

Ustawienie to można skonfigurować tylko wtedy, gdy opcja
[Auto Naming] jest ustawiona na [Cam ID + Reel#].
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Ustawianie parametru [Title Prefix]

Powiązany temat

Wprowadzanie ciągu znaków
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Title
Prefix

nnn_ (nnn to 3
ostatnie cyfry
numeru seryjnego)
(wyświetlanie maks.
7 cyfr)

nnn

Służy do ustawiania segmentu tytułu (od 4 do 46 znaków)
nazwy klipu.
Powoduje otwarcie ekranu wprowadzania ciągu znaków.

Aby uzyskać szczegółowe informacje na temat ustawiania
tytułów oraz o ekranie wprowadzania znaków, zapoznaj się
z poniższą sekcją „Ustawianie tytułu” oraz z sekcją
„Wprowadzanie ciągu znaków”.

Uwaga

Ustawienie to można skonfigurować tylko wtedy, gdy opcja
[Auto Naming] jest ustawiona na [Title].

Number
Set

od 0001 do 9999 0001

Służy do ustawiania 4-cyfrowego sufiksu nazwy klipu.

Uwaga

Ustawienie to można skonfigurować tylko wtedy, gdy opcja
[Auto Naming] jest ustawiona na [Title].

Wybierz znak do wstawienia w pozycji kursora w obszarze [Title Prefix] z obszaru wyboru znaków (znak
będzie wyróżniony), korzystając z przycisków strzałek w panelu do obsługi interfejsu użytkownika, a
następnie naciśnij przycisk [Set] w tym panelu.

Wybrany znak zostanie wstawiony, a kursor przesunie się w prawo.

1

Powtarzaj krok 1, aby ustawić tytuł.

W razie potrzeby użyj opcji [BS].

2

Po ustawieniu tytułu naciśnij przycisk [Done], aby zamknąć ekran wprowadzania znaków.

Aby uzyskać szczegółowe informacje na temat korzystania z ekranu wprowadzania znaków, zapoznaj się z
sekcją „Wprowadzanie ciągu znaków”.

Można wybierać podane poniżej znaki.
!#$%()+,-.;=@[ ]^_~ spacja
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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Update Media

Umożliwia zaktualizowanie pliku zarządzania na kartach pamięci (patrz „Przywracanie kart pamięci”).

Powiązany temat

Przywracanie kart pamięci
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Media(A) Execute / Cancel –
Służy do aktualizowania pliku zarządzania na
karcie pamięci w gnieździe A.
Execute: uruchomienie funkcji.

Media(B) Execute / Cancel –
Służy do aktualizowania pliku zarządzania na
karcie pamięci w gnieździe B.
Execute: uruchomienie funkcji.
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Format Media

Umożliwia sformatowanie (zainicjowanie) karty pamięci (patrz: „Formatowanie (inicjalizacja) kart pamięci”).

Powiązany temat

Formatowanie (inicjalizacja) kart pamięci
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Media(A)
Full Format / Quick Format /
Cancel

–
Służy do formatowania karty pamięci w
gnieździe A.

Media(B)
Full Format / Quick Format /
Cancel

–
Służy do formatowania karty pamięci w
gnieździe B.
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Media Life

Służy do wyświetlania pozostałego czasu eksploatacji kart pamięci.

Uwaga

Wymaga stosowania kart pamięci obsługujących wyświetlanie pozostałego czasu eksploatacji.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Media(A) – –
Służy do wyświetlania pozostałego czasu
eksploatacji karty pamięci w gnieździe A.

Media(B) – –
Służy do wyświetlania pozostałego czasu
eksploatacji karty pamięci w gnieździe B.
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Output Format

Służy do konfigurowania ustawień formatu wyjściowego.

Powiązany temat

Formaty wyjściowe i ograniczenia
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Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

SDI Szczegółowe informacje na temat ustawień
podano w sekcji „Formaty wyjściowe i
ograniczenia”.

– Służy do ustawiania
rozdzielczości wyjściowej SDI i
HDMI.HDMI –

349



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Display On/Off

Służy do konfigurowania ustawień wyświetlanych pozycji.
Aby wyświetlić pozycję, wybierz opcję On. Aby ukryć pozycję, wybierz opcję Off.

Pozycja Ustawienie pozycji podrzędnej Domyślne ustawienie fabryczne

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On
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Pozycja Ustawienie pozycji podrzędnej Domyślne ustawienie fabryczne

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Video Signal Monitor

Służy do konfigurowania ustawień monitora sygnału wideo.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Setting
Off / Waveform / Vector /
Histogram

Off
Służy do ustawiania typu monitora sygnału
wideo.

Level
Marker 1

0%–109% 70%
Służy do ustawiania poziomu znacznika
poziomu luminancji 1.

Level
Marker 2

0%–109% 100%
Służy do ustawiania poziomu znacznika
poziomu luminancji 2.
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Marker

Służy do konfigurowania ustawień wyświetlania znaczników.

Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Setting On / Off On
Służy do włączania/wyłączania wyświetlania
wszystkich znaczników.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

White Służy do wyboru koloru sygnału znacznika.

Center
Marker

1 / 2 / 3 / 4 / Off Off Służy do wyboru znacznika środkowego.

Safety
Zone

On / Off Off
Służy do włączania/wyłączania znacznika strefy
bezpieczeństwa.

Safety Area 80% / 90% / 92.5% / 95% 90%
Umożliwia wybór rozmiaru znacznika strefy
bezpieczeństwa (jako procenta całkowitego
rozmiaru ekranu).

Aspect
Marker

Line / Mask / Off Off
Umożliwia wybranie typu znacznika
współczynnika proporcji.

Aspect
Mask

od 0 do 15 12
Służy do ustawiania poziomu sygnału wideo poza
znacznikiem.

Aspect
Safety
Zone

On / Off Off
Służy do włączania/wyłączania znacznika strefy
bezpieczeństwa współczynnika proporcji.

Aspect
Safety Area

80% / 90% / 92.5% / 95% 90%
Umożliwia wybór rozmiaru znacznika strefy
bezpieczeństwa współczynnika proporcji (jako
procenta całkowitego rozmiaru ekranu).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 /
16:9 / 17:9 / 1.66:1 / 1.85:1 /
2.35:1 / 2.39:1 / Custom

2.39:1
Służy do ustawiania trybu wyświetlania znacznika
współczynnika proporcji.

Custom
Aspect
Ratio

Wprowadź dowolną wartość. 01.00:01.00

Umożliwia ustawienie współczynnika proporcji na
dowolną wartość.

Uwaga

Włączona, gdy dla opcji [Aspect Select] wybrano
ustawienie [Custom].

Guide
Frame

On / Off Off
Służy do włączania/wyłączania wyświetlania ramki
pomocniczej.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

100%
Marker

On / Off Off Służy do włączania/wyłączania znacznika 100%.

User Box On / Off Off
Służy do włączania/wyłączania wyświetlania
znacznika pola użytkownika.

User Box
Width od 3 do 479 240

Służy do ustawiania szerokości znacznika pola
użytkownika (odległość od środka do lewej i
prawej krawędzi).

User Box
Height

od 3 do 269 135
Służy do ustawiania wysokości znacznika pola
użytkownika (odległość od środka do górnej i
dolnej krawędzi).

User Box H
Position

od −476 do +476 0
Służy do ustawiania poziomego położenia środka
znacznika pola użytkownika.

User Box V
Position

od −266 do +266 0
Służy do ustawiania pionowego położenia środka
znacznika pola użytkownika.
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Interchangeable Lens Digital Camera
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Audio Input

Służy do konfigurowania ustawień wejścia audio.

Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

AUDIO IN
Select

MIC / LINE MIC
Umożliwia wybranie typu urządzenia podłączonego do
złącza AUDIO IN.

Phantom
Power +48V

On / Off Off Służy do wyświetlania stanu zasilania Phantom +48 V.

CH1 Input
Select

AUDIO IN CH1 AUDIO IN CH1 Służy do wyświetlania źródła sygnału wejściowego do
nagrywania na kanale 1.

CH2 Input
Select

AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2
Służy do przełączania źródła sygnału wejściowego do
nagrywania na kanał 2.

CH3 Input
Select

Off / AUDIO IN CH1 AUDIO IN CH1
Służy do przełączania źródła sygnału wejściowego do
nagrywania na kanał 3.

CH4 Input
Select

Off / AUDIO IN CH1
/ AUDIO IN CH2

AUDIO IN CH2
Służy do przełączania źródła sygnału wejściowego do
nagrywania na kanał 4.

AUDIO IN
CH1 MIC
Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Służy do ustawiania referencyjnego poziomu nagrywania
dla wejścia mikrofonowego XLR (AUDIO IN CH1).

AUDIO IN
CH2 MIC
Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Służy do ustawiania referencyjnego poziomu nagrywania
dla wejścia mikrofonowego XLR (AUDIO IN CH2).

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
Umożliwia wybranie poziomu referencyjnego na wejściu,
gdy opcja [AUDIO IN Select] jest ustawiona na LINE.

Reference
Level

−20dB / −18dB /
−16dB / −12dB /
EBUL

−20dB
Umożliwia wybranie poziomu nagrywania referencyjnego
sygnału tonowego 1 kHz.

CH1 Wind
Filter

On / Off Off
Służy do włączania/wyłączania filtru redukcji szumu wiatru
dla nagrywania na kanale 1.

CH2 Wind
Filter

On / Off Off
Służy do włączania/wyłączania filtru redukcji szumu wiatru
dla nagrywania na kanale 2.

CH3 Wind
Filter

On / Off Off
Służy do włączania/wyłączania filtru redukcji szumu wiatru
dla nagrywania na kanale 3.

CH4 Wind
Filter

On / Off Off
Służy do włączania/wyłączania filtru redukcji szumu wiatru
dla nagrywania na kanale 4.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

CH1 Level
Control

Auto / Manual Auto
Umożliwia wybranie automatycznej lub ręcznej regulacji
poziomu sygnału wejściowego audio dla kanału nagrywania
1.

CH2 Level
Control

Auto / Manual Auto
Umożliwia wybranie automatycznej lub ręcznej regulacji
poziomu sygnału wejściowego audio dla kanału nagrywania
2.

CH3 Level
Control

Auto / Manual Auto
Umożliwia wybranie automatycznej lub ręcznej regulacji
poziomu sygnału wejściowego audio dla kanału nagrywania
3.

CH4 Level
Control

Auto / Manual Auto
Umożliwia wybranie automatycznej lub ręcznej regulacji
poziomu sygnału wejściowego audio dla kanału nagrywania
4.

CH1 Input
Level

od 0 do 99 49
Służy do ustawiania poziomu wejściowego dla kanału
nagrywania 1.

CH2 Input
Level

od 0 do 99 49
Służy do ustawiania poziomu wejściowego dla kanału
nagrywania 2.

CH3 Input
Level

od 0 do 99 49
Służy do ustawiania poziomu wejściowego dla kanału
nagrywania 3.

CH4 Input
Level

od 0 do 99 49
Służy do ustawiania poziomu wejściowego dla kanału
nagrywania 4.

Master Input
Level

od 0 do 99 99 Służy do ustawiania poziomu sygnału wejściowego audio.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB /
−17dB

Off
Umożliwia wybranie charakterystyki ogranicznika dla dużych
sygnałów wejściowych podczas ręcznej regulacji poziomu
sygnału wejściowego audio.

CH1&2 AGC
Mode

Mono / Stereo Stereo

Służy do ustawiania trybu automatycznej regulacji poziomu
dla nagrywania na kanale 1 i kanale 2. Jeśli opcja ta
zostanie ustawiona na Stereo, funkcja AGC jest powiązana
między kanałami.

CH3&4 AGC
Mode

Mono / Stereo Stereo

Służy do ustawiania trybu automatycznej regulacji poziomu
dla nagrywania na kanale 3 i kanale 4. Jeśli opcja ta
zostanie ustawiona na Stereo, funkcja AGC jest powiązana
między kanałami.

AGC Spec
−6dB / −9dB /
−12dB / −15dB /
−17dB

−6dB Umożliwia wybranie charakterystyki AGC.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

1kHz Tone
on Color
Bars

On / Off Off

Służy do włączania/wyłączania referencyjnego sygnału
tonowego o częstotliwości 1 kHz podczas wyświetlania
kolorowych pasów.

Uwaga

W przypadku ustawienia na [On] sygnał referencyjny o
częstotliwości 1 kHz jest ustawiany na nagrywanie na
kanale 3 i kanale 4, nawet jeśli dla opcji [CH3 Input Select] i
[CH4 Input Select] wybrano ustawienie [Off].
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Output

Służy do konfigurowania ustawień wyjścia audio.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Służy do konfigurowania kombinacji kanałów audio
na wyjściu HDMI / wyjściu do przesyłania
strumieniowego.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Display Clip Properties

Umożliwia wyświetlenie ekranu właściwości klipu.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Display Clip
Properties

– –
Umożliwia wyświetlenie ekranu
właściwości klipu.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Set Clip Flag

Umożliwia ustawienie flagi klipu.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Add OK – – Umożliwia dodanie flagi OK.

Add NG – – Umożliwia dodanie flagi NG.

Add KEEP – – Umożliwia dodanie flagi KEEP.

Delete Clip
Flag

– –
Umożliwia usunięcie wszystkich
flag.

360
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lock/Unlock Clip

Służy do konfigurowania ustawień ochrony klipu.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Select Clip – –
Umożliwia wybranie oraz
zablokowanie/odblokowanie klipu.

Lock All
Clips

– – Umożliwia zablokowanie wszystkich klipów.

Unlock All
Clips

– – Umożliwia odblokowanie wszystkich klipów.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Delete Clip

Umożliwia usunięcie klipów.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Select
Clip

– –
Umożliwia usunięcie wybranego
klipu.

All Clips – –
Umożliwia usunięcie wszystkich
klipów.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Transfer Clip

Służy do transferu klipów.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Select
Clip

– – Służy do transferu wybranych klipów.

All Clips – –

Służy do transferu wszystkich klipów.

Uwaga

Można zarejestrować do 200 zadań
transferu.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Transfer Clip (Proxy)

Służy do transferu klipów nagrywania pomocniczego.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Select
Clip

– –
Służy do transferu klipów nagrywania pomocniczego
odpowiadających wybranym klipom.

All Clips – –

Służy do transferu klipów nagrywania pomocniczego
odpowiadających wszystkim klipom.

Uwaga

Można zarejestrować do 200 zadań transferu.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Filter Clips

Służy do konfigurowania ustawień klipów, które mają być wyświetlane.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

OK – –
Umożliwia wyświetlenie wyłączenie klipów z
flagą OK.

NG – –
Umożliwia wyświetlenie wyłączenie klipów z
flagą NG.

KEEP – –
Umożliwia wyświetlenie wyłączenie klipów z
flagą KEEP.

None – –
Umożliwia wyświetlenie wyłączenie klipów bez
flagi.

All – –
Umożliwia wyświetlenie wszystkich klipów
niezależnie od flag.
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Interchangeable Lens Digital Camera
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Customize View

Służy do przełączania widoku ekranu miniatur.
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Pozycja Ustawienie pozycji podrzędnej Domyślne
ustawienie fabryczne Opis

Thumbnail
Caption

Date Time / Time Code / Duration
/ Sequential Number

Time Code
Służy do przełączania informacji
wyświetlanych pod miniaturami.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Color Bars

Służy do konfigurowania ustawień kolorowych pasów.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Setting On / Off Off
Służy do włączania/wyłączania kolorowych
pasów.

Type
ARIB / 100% / 75% /
SMPTE

ARIB Umożliwia wybór typu kolorowych pasów.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Genlock

Służy do konfigurowania sposobu wyświetlania stanu trybu Genlock (patrz: „Synchronizacja fazy sygnałów wideo
(Genlock))”.

Powiązany temat

Synchronizacja fazy sygnałów wideo (Genlock)
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Reference
Internal / External(HD) /
External(SD)

–
Służy do wyświetlania typu sygnału
referencyjnego w trybie Genlock.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tally

Służy do konfigurowania ustawień kontrolki nagrywania (lampki typu Tally) (patrz: „Doprowadzanie sygnału lampki typu
Tally”).

Powiązany temat

Doprowadzanie sygnału lampki typu Tally
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Tally Lamp
Brightness

High / Low / Off High
Umożliwia ustawienie jasności kontrolki nagrywania
(lampki typu Tally).

G Tally Lamp Enable / Disable Enable Służy do włączania/wyłączania lampki typu Tally G.

Tally Control External / Internal Internal

Umożliwia wybranie urządzenia docelowego
przyjmującego informacje sterujące kontrolką nagrywania
(lampką typu Tally) urządzenia.
External: zewnętrzne sterowanie lampką typu Tally.
Internal: sterowanie poprzez operacje nagrywania na
kamerze.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rec Review

Służy do konfigurowania ustawień przeglądania nagrań (patrz: „Przeglądanie nagrania (funkcja Rec Review)”).

Powiązany temat

Przeglądanie nagrania (funkcja Rec Review)
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie fabryczne Opis

Setting 3s / 10s / Clip 3s
Umożliwia ustawienie czasu odtwarzania właśnie
nagranych klipów na potrzeby przeglądania nagrań.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zoom

Służy do konfigurowania ustawień zoomu („Regulacja zoomu”).
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Pozycja Ustawienie pozycji podrzędnej Domyślne ustawienie
fabryczne Opis

Zoom
Type

Optical Zoom Only / On(Clear Image
Zoom)

Optical Zoom Only
Służy do ustawiania typu
zoomu.
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Interchangeable Lens Digital Camera
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Lens

Służy do konfigurowania ustawień związanych z obiektywami.

Powiązany temat

Kompensacja efektu „oddychania” obiektywu

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Lens Calibration Execute / Cancel –

Służy do uruchamiania funkcji, która koryguje różnice
w pozycji zoomu powstałe ze względu na różnice w
poszczególnych obiektywach podczas korzystania z
obiektywu z elektryczną regulacją zoomu.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

Służy do ustawiania kierunku działania pierścienia
zoomu.

Uwaga

Opcja ta jest dostępna tylko w przypadku używania
obiektywu z mocowaniem typu E, który obsługuje
przełączanie kierunku pierścienia zoomu.

Shading
Compensation Auto / Off Auto

Służy do ustawienia automatycznej korekty
winietowania.

Chroma
Aberration
Comp.

Auto / Off Auto
Służy do ustawienia automatycznej korekty aberracji
chromatycznej.

Distortion Comp. Auto / Off Auto
Służy do ustawienia automatycznej korekty
zniekształceń.

Breathing
Compensation

Auto / Off Off

Służy do ustawienia automatycznej kompensacji
efektu „oddychania” obiektywu.

Patrz „Kompensacja efektu „oddychania”
obiektywu”.

Distance Display Meter / Feet Meter
Służy do ustawiania jednostek, w jakich mają być
wyświetlane informacje o obiektywie i pozycji
ustawiania ostrości.

Zoom Position
Display

Focal Length /
Number / Bar

Focal Length
Służy do ustawiania formatu wyświetlania pozycji
zoomu.
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ILME-FR7 / ILME-FR7K

APR

Służy do włączania funkcji APR.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

APR Execute / Cancel –

Włącza funkcję APR (Automatic Pixel Restoration) w celu
automatycznej regulacji przetwornika obrazu.
Execute: uruchomienie funkcji.

Uwaga

Zawsze przed włączeniem funkcji APR należy założyć
osłonę obiektywu.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Wired LAN

Służy do konfigurowania ustawień związanych z połączeniami z przewodową siecią LAN.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

HTTP Port – 80 Umożliwia wyświetlenie portu dostępu HTTP.

Detail
Settings

– –
Umożliwia wyświetlenie właściwości połączenia z
przewodową siecią LAN.

DHCP
On / Off

On
Umożliwia wyświetlenie informacji o tym, czy protokół
DHCP jest włączony (On), czy wyłączony (Off).

IP Address –
Umożliwia wyświetlenie adresu IP urządzenia, gdy
opcja [DHCP] jest ustawiona na [Off].

Subnet Mask –
Umożliwia wyświetlenie maski podsieci urządzenia, gdy
opcja [DHCP] jest ustawiona na [Off].

Gateway –
Umożliwia wyświetlenie domyślnej bramy, gdy opcja
[DHCP] jest ustawiona na [Off].

DNS Auto
On / Off

On
Umożliwia wyświetlenie ustawienia automatycznego
pobierania adresu serwera DNS.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

File Transfer

Służy do konfigurowania ustawień związanych z przesyłaniem plików (patrz: „Informacje na temat funkcji transferu
plików”).

Powiązany temat
Informacje na temat funkcji transferu plików
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Auto Upload
(Proxy)

On / Off Off
Służy do włączania/wyłączania automatycznego przesyłania
plików nagrywania pomocniczego.

Default
Upload
Server

Server
Settings1–3 >
Display Name

–

Umożliwia wybranie serwera do przesyłania plików. Wybrany
tutaj serwer staje się miejscem docelowym automatycznego
przesyłania plików nagrywania pomocniczego oraz miejscem
docelowym przesyłania plików z ekranu miniatur.
Służy do wyświetlania ustawień [Display Name]
skonfigurowanych w obszarze [Server Settings1–3]

Clear
Completed
Jobs

Execute /
Cancel

–
Umożliwia usunięcie ukończonych zadań transferu z listy.
Execute: uruchomienie funkcji.

Clear All
Jobs

Execute /
Cancel

– Umożliwia usunięcie wszystkich zadań transferu z listy.
Execute: uruchomienie funkcji.

View Job List – – Umożliwia wyświetlenie listy zadań transferu.
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Language

Służy do ustawiania języka wyświetlania informacji.

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Select – –
Służy do ustawiania języka wyświetlania
informacji.
Set: umożliwia ustawienie wartości.
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Interchangeable Lens Digital Camera
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Clock Set

Służy do konfigurowania ustawień zegara wewnętrznego.

Uwaga

Po zmianie tego ustawienia z poziomu menu kamery należy wyłączyć zasilanie urządzenia i ponownie uruchomić urządzenie. W
przypadku zainicjowania trybu gotowości za pomocą pilota zdalnego sterowania na podczerwień lub aplikacji internetowej może
wystąpić nieoczekiwane działanie.

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Time
Zone

UTC − 12:00 do UTC +
14:00

–
Służy do ustawiania różnicy czasu w stosunku do
czasu UTC w jednostkach 30-minutowych.

Date
Mode

YYMMDD / MMDDYY /
DDMMYY

YYMMDD

Umożliwia wybranie formatu wyświetlania dat.
YYMMDD: rok, miesiąc, dzień
MMDDYY: miesiąc, dzień, rok
DDMMYY: dzień, miesiąc, rok

12H/24H 12H / 24H 24H
Umożliwia wybranie formatu wyświetlania zegara.
12H: tryb 12-godzinny
24H: tryb 24-godzinny

Date – –
Służy do ustawiania bieżącej daty.
Set: umożliwia ustawienie wartości.

Time – –
Służy do ustawiania bieżącej godziny.
Set: umożliwia ustawienie wartości.
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Hours Meter

Umożliwia wyświetlenie łącznego czasu działania.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Hours(System) – –
Umożliwia wyświetlenie łącznej liczby godzin
użytkowania (tej wartości nie można zresetować).

Hours(Reset) – –
Umożliwia wyświetlenie łącznej liczby godzin
użytkowania (tę wartość można zresetować).

Reset Execute / Cancel –
Umożliwia zresetowanie łącznego czasu działania
do wartości 0.
Execute: uruchomienie funkcji.
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Ustawienia ISO/Gain i ich wartości domyślne

Zakres ustawień opcji [ISO/Gain<L>] i wartości domyślne różnią się w zależności od ustawień [Mode], [Base Look] >
[Select] oraz [Base Sensitivity].
Wartości domyślne w tabelach są wyróżnione pogrubieniem.

Gdy opcja [Mode] jest ustawiona na [ISO]

Gdy opcja [Base Look] > [Select] jest ustawiona na [S-Cinetone], [Standard], [ITU709], [709tone] lub
[Still]

Gdy opcja [Base Look] > [Select] jest ustawiona na [HLG Live] lub [HLG Natural]

Gdy opcja [ISO/Gain/EI] > [Base Sensitivity] jest
ustawiona na [Low]

Gdy opcja [ISO/Gain/EI] > [Base Sensitivity] jest
ustawiona na [High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Gdy opcja [Base Look] > [Select] jest ustawiona na [User1] – [User16]

Gdy opcja [Mode] jest ustawiona na [dB]

Można skonfigurować wartość w zakresie od −3dB do +30dB z regulacją co 1dB.
Wartość domyślna to 0dB.
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Gdy opcja [ISO/Gain/EI] > [Base Sensitivity] jest
ustawiona na [Low]

Gdy opcja [ISO/Gain/EI] > [Base Sensitivity] jest
ustawiona na [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Gdy opcja [ISO/Gain/EI] > [Base Sensitivity] jest
ustawiona na [Low]

Gdy opcja [ISO/Gain/EI] > [Base Sensitivity] jest
ustawiona na [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Ustawienia AGC Limit i ich wartości domyślne

Zakres ustawień menu [AGC Limit] i wartości domyślne różnią się w zależności od ustawień [Mode], [Base Look] >
[Select] oraz [Base Sensitivity].
Wartości domyślne w tabelach są wyróżnione pogrubieniem.

Gdy opcja [Mode] jest ustawiona na [ISO]

Gdy opcja [Base Look] > [Select] jest ustawiona na [S-Cinetone], [Standard], [ITU709], [709tone] lub
[Still]

Gdy opcja [Base Look] > [Select] jest ustawiona na [HLG Live] lub [HLG Natural]

Gdy opcja [ISO/Gain/EI] > [Base Sensitivity] jest
ustawiona na [Low]

Gdy opcja [ISO/Gain/EI] > [Base Sensitivity] jest
ustawiona na [High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Gdy opcja [Base Look] > [Select] jest ustawiona na [User1] – [User16]

Gdy opcja [Mode] jest ustawiona na [dB]

Wartości do wyboru: 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
Wartość domyślna to 15dB.
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Gdy opcja [ISO/Gain/EI] > [Base Sensitivity] jest
ustawiona na [Low]

Gdy opcja [ISO/Gain/EI] > [Base Sensitivity] jest
ustawiona na [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Gdy opcja [ISO/Gain/EI] > [Base Sensitivity] jest
ustawiona na [Low]

Gdy opcja [ISO/Gain/EI] > [Base Sensitivity] jest
ustawiona na [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Ustawienia jakości obrazu zapisane dla każdego trybu filmowania

Aktualny stan pozycji ustawień konfiguracyjnych związanych z jakością obrazu jest zapisywany dla każdego z podanych
poniżej trybów filmowania. W przypadku zmiany trybu filmowania stosowane są odpowiednie ustawienia zapisane dla
docelowego trybu filmowania.

Docelowy tryb wyświetlania Custom SDR(BT.709)
Docelowy tryb wyświetlania Custom HDR(HLG)
Filmowanie Log (Cine EI, Cine EI Quick, Flexible ISO)

W poniższych tabelach przedstawiono pozycje ustawień konfiguracyjnych związanych z jakością obrazu, które są
zapisywane dla każdego z trybów filmowania.
„Tak” wskazuje ustawienie, które jest zapisywane, a „Nie” oznacza ustawienie, które nie jest zapisywane. „Tak”
obejmujące wiele kolumn wskazuje wspólne ustawienia.

Pozycja

Tryb filmowania

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Menu
Shooting

ISO/Gain/EI

ISO/Gain Tak1) Tak Nie

Exposure Index Nie Nie Tak Tak

Base Sensitivity Tak Nie

Base ISO Nie Tak4) Nie3) Tak4)

White
Preset White Tak Tak

Inne niż powyższe Tak

White Setting Tak

Offset White Tak Nie

LUT On/Off Nie Tak

Noise
Suppression

Setting(Custom) Tak Tak Nie

Level(Custom) Tak Tak Nie

Setting (Cine
EI/Flex. ISO)

Nie Tak

Level (Cine EI/Flex.
ISO)

Nie Tak

384



5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja

Tryb filmowania

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Menu
Paint/Look

Base Look

Select Tak Tak Tak

Input2) Tak

Output2) Tak

AE Level Offset2) Tak

Black Tak Tak Nie

Knee
Auto Knee Tak Nie Nie

Inne niż powyższe Tak Tak Nie

Detail Tak Tak Nie

Matrix Tak Tak Nie

Multi Matrix Tak Tak Nie

Oddzielne ustawienia czułości ISO są zapisywane zarówno dla trybu Custom SDR(BT.709), jak i HDR(HLG).1)

Ustawienia są zapisywane dla każdego ustawienia wyglądu podstawowego i nie zależą od trybu filmowania.2)

Czułość podstawowa ISO zmienia się w połączeniu ze wskaźnikiem ekspozycji.3)

Wspólna wartość ustawienia w trybach filmowania Flexible ISO i Cine EI.4)
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Konfiguracja menu internetowego

Naciśnij kartę przełączania ekranu obsługi [Settings], aby wyświetlić ekran ustawień.
Użyj ekranu ustawień do skonfigurowania różnych pozycji konfiguracji urządzenia, w tym ustawień początkowych,
ustawień sieciowych oraz ustawień filmowania/odtwarzania, za pomocą menu internetowego.

Menu to obejmuje podane poniżej pozycje menu.

Konfiguracja i hierarchia menu

Poziom 1 Opis poziomu 1 Poziom 2

Shooting Zawiera ustawienia związane z filmowaniem. Focus
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Poziom 1 Opis poziomu 1 Poziom 2

Project Zawiera podstawowe ustawienia projektu.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Zawiera ustawienia związane z jakością obrazu. Base Look

Pan-Tilt Zawiera ustawienia związane z funkcją obrotu w poziomie/pionie.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring
Zawiera ustawienia związane z wyjściem wideo i wyświetlaniem na
ekranie.

Output Format

Output Display

Audio Zawiera ustawienia związane z dźwiękiem. Audio

Technical Zawiera ustawienia pozycji technicznych.

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network Zawiera ustawienia związane z sieciami.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack
Protection
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Uwaga

Pozycja [Accessibility] jest dostępna tylko w modelach przeznaczonych na rynek Ameryki Północnej.
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Poziom 1 Opis poziomu 1 Poziom 2

Stream Zawiera ustawienia związane z przesyłaniem strumieniowym.

Stream

Video Stream

Audio Stream

Maintenance Zawiera ustawienia urządzeń, takie jak ustawienia zegara i języka.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software
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Operacje w menu internetowym

Naciśnij kartę przełączania ekranu obsługi [Settings], aby wyświetlić ekran ustawień i skonfigurować różne pozycje
konfiguracji urządzenia, w tym ustawienia początkowe, ustawienia sieciowe oraz ustawienia filmowania/odtwarzania, za
pomocą menu internetowego.
Skonfiguruj ustawienia w menu internetowym na tablecie za pomocą dotyku lub na komputerze za pomocą myszy.
Naciśnij przycisk menu dla pozycji, które chcesz skonfigurować, aby wyświetlić pozycje konfiguracji w tym menu i ich
ustawienia.

Metoda konfiguracji

Wybór wartości

Menu (poziom 1)1.

Menu (poziom 2)2.

Ustawienia3.
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Naciśnij przycisk wyboru dla danej pozycji. Przycisk wyboru dla wybranej pozycji jest wyświetlany na pomarańczowo.

Włączanie/wyłączanie pozycji

Naciśnij przełącznik, aby włączyć/wyłączyć daną pozycję. Gdy pozycja jest włączona, przełącznik ma kolor
pomarańczowy, a gdy jest wyłączona, ma kolor biały.

Wybór wartości z listy

Naciśnij przycisk listy rozwijanej i wybierz pozycję z wyświetlonej listy.

Wybór wartości liczbowej

Naciśnij przycisk < lub >, aby zmienić wartość liczbową. Jeśli wartość liczbowa jest podkreślona, można również
wprowadzić wartość bezpośrednio.

Wprowadzanie znaków/cyfr

Konfiguracja na osobnym ekranie
Naciśnij przycisk, aby przeprowadzić operacje konfiguracji na osobnym ekranie.

Komunikat informacyjny

Zawiera informacje pomocne przy konfiguracji niektórych ustawień oraz komunikaty wymagające uwagi użytkownika.

Zapisywanie ustawienia

Po zakończeniu konfigurowania ustawienia naciśnij przycisk [OK], aby zapisać ustawienie.
Naciśnij przycisk [Cancel], aby odrzucić zmiany wprowadzone w ustawieniu i przywrócić poprzednie ustawienie.
Naciśnij przycisk [Reload], aby zaktualizować wyświetlany ekran.

Uwaga

Jeśli naciśniesz przycisk [Reload] przed zapisaniem ustawienia, zmiany w tym ustawieniu zostaną odrzucone.

Jeśli przed zapisaniem ustawienia przejdziesz na inną stronę, zmiany w tym ustawieniu zostaną odrzucone.
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Focus

Służy do konfigurowania ustawień ostrości.

Powiązany temat

Ręczne określanie obiektu, na którym ma być automatycznie ustawiana ostrość (ustawienie AF Assist), za pomocą
aplikacji internetowej
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF
Służy do ustawiania trybu automatycznego ustawiania ostrości
za pomocą przycisku.

Touch
Function in
MF

Tracking AF /
Spot Focus

Tracking AF
Umożliwia ustawienie sposobu działania po dotknięciu ekranu
kamery w trybie MF.

AF Assist
Control

On / Off On

Po wybraniu ustawienia [On] można używać suwaka regulacji
ostrości w aplikacji internetowej podczas automatycznej
regulacji ostrości, aby dostosować pozycję ustawiania ostrości.

Szczegółowe informacje na ten temat podano w sekcji
„Ręczne określanie obiektu, na którym ma być
automatycznie ustawiana ostrość (ustawienie AF Assist), za
pomocą aplikacji internetowej”.

Uwaga

Ta pozycja jest dostępna tylko wtedy, gdy opcja [AF Assist] jest
ustawiona na [On] w menu kamery.
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Base Setting

Służy do konfigurowania ustawień podstawowych.

Powiązany temat

Konfigurowanie podstawowych ustawień
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Shooting
Mode

Custom / Flexible ISO /
Cine EI Quick / Cine EI

Custom

Służy do ustawiania trybu filmowania.

Patrz: „Tryb filmowania” w sekcji
„Konfigurowanie podstawowych ustawień”.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Służy do ustawiania gamy kolorów na potrzeby
nagrywania / wyprowadzania sygnałów w trybie
Custom.
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Rec Format

Służy do konfigurowania ustawień formatu nagrywania.

Ustawienia [RAW Output Format]

Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94

Służy do wyboru częstotliwości systemu.

Uwaga

Jeśli częstotliwość zostanie zmieniona,
nastąpi ponowne uruchomienie kamery. Po
ponownym uruchomieniu odśwież stronę w
przeglądarce internetowej.

Imager
Scan Mode

FF / S35 FF Służy do wyboru rozmiaru przetwornika obrazu.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Służy do ustawiania kodeka używanego do
nagrywania/odtwarzania klipu.

Uwaga

Jeśli dla opcji [Imager Scan Mode] wybrano
ustawienie [S35], nie można wybrać opcji
[RAW] i [RAW & XAVC-I].

RAW Output
Format

Dostępne ustawienia różnią się w
zależności od ustawienia opcji
[Frequency].

Patrz: sekcja „Ustawienia
opcji [RAW Output Format]”
poniżej.

–

Służy do ustawiania rozmiaru obrazu RAW,
który ma być wyprowadzany do zewnętrznego
rejestratora RAW.

Uwaga

Gdy opcja [Codec] jest ustawiona na [RAW &
XAVC-I], ustawienie [Video Format] jest
przełączane w połączeniu z ustawieniem
[RAW Output Format].

Video
Format

Dostępne ustawienia różnią się w
zależności od ustawień opcji
[Frequency], [Imager Scan Mode]
i [Codec]

Patrz: sekcja „Ustawienia
opcji [Video Format]” poniżej.

– Służy do ustawiania rozmiaru obrazu.

394



Wartości domyślne są wyróżnione pogrubieniem.
Warunki, w których nie można ustawić opcji [RAW Output Format], zostały pominięte.

Ustawienia [Video Format]

Wartości domyślne są wyróżnione pogrubieniem.
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Frequency Imager Scan Mode Codec Ustawienie

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160

Frequency Imager Scan Mode Codec Ustawienie

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Simul Rec

Służy do konfigurowania ustawień trybu nagrywania jednoczesnego przy użyciu dwóch gniazd (patrz: „Jednoczesne
nagrywanie na karty pamięci A i B (nagrywanie jednoczesne przy użyciu dwóch gniazd)”).

Powiązany temat
Jednoczesne nagrywanie na karty pamięci A i B (nagrywanie jednoczesne przy użyciu dwóch gniazd)
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Setting On / Off Off
Służy do włączania/wyłączania funkcji jednoczesnego
nagrywania oraz do ustawiania docelowego nośnika
służącego do nagrywania.

Rec
Button

Slot A / Slot B /
Slot A/Slot B

Slot A/Slot B Służy do wyświetlania przypisania przycisku nagrywania dla
każdego nośnika służącego do nagrywania.
Ustaw opcję [Project] > [Simul Rec] > [Rec Button Set] w
menu kamery.

2nd Rec
Button

Slot A / Slot B /
Slot A/Slot B

Slot A/Slot B
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Proxy Rec

Służy do konfigurowania ustawień trybu nagrywania pomocniczego (patrz: „Nagrywanie pomocnicze”).
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Setting On / Off Off
Służy do włączania/wyłączania trybu nagrywania
pomocniczego.
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Interval Rec

Służy do konfigurowania ustawień trybu nagrywania interwałowego (patrz: „Nagrywanie interwałowe (Interval Rec)”).

Powiązany temat

Nagrywanie interwałowe (Interval Rec)
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Pozycja Ustawienie pozycji podrzędnej Domyślne ustawienie
fabryczne Opis

Setting On / Off Off

Służy do włączania/wyłączania trybu
nagrywania interwałowego. (Ustawienie
tego trybu na On spowoduje, że
wszystkie pozostałe tryby specjalne
zostaną ustawione Off).

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 /
15 / 20 / 30 / 40 / 50 (sek.)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 /
15 / 20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (godz.)

1

Służy do ustawiania interwału między
nagraniami w trybie nagrywania
interwałowego (gdy opcja Interval Rec
jest ustawiona na On).

Number
of
Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
Dostępne ustawienia różnią się w
zależności od częstotliwości
klatek wybranego formatu wideo.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Służy do ustawiania liczby klatek
nagrywanych w ramach jednego ujęcia
w trybie nagrywania interwałowego (gdy
opcja Interval Rec jest ustawiona na
On).

398



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Picture Cache Rec

Służy do konfigurowania ustawień trybu nagrywania obrazu z pamięci podręcznej (patrz: „Nagrywanie obrazu z pamięci
podręcznej (Picture Cache Rec)”).

Powiązany temat
Nagrywanie obrazu z pamięci podręcznej (Picture Cache Rec)
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Setting On / Off Off
Służy do włączania/wyłączania funkcji pamięci podręcznej
obrazów.

Cache Size
Short / Medium /
Long / Max

Max
Służy do ustawiania czasu gromadzenia obrazów w
pamięci podręcznej (czas zapisu w pamięci podręcznej).

Cache Rec
Time

– –
Służy do wyświetlania czasu gromadzenia obrazów w
pamięci podręcznej (czas zapisu w pamięci podręcznej).
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All File

Służy do wykonywania operacji na plikach ALL (patrz: „Zapisywanie i wczytywanie danych konfiguracyjnych”).
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Load All
File

– –

Umożliwia wczytanie pliku ALL z urządzenia z uruchomioną
aplikacją internetową do niniejszego urządzenia.

Uwaga

Po wczytaniu pliku ALL do urządzenia nastąpi ponowne
uruchomienie urządzenia. Po ponownym uruchomieniu
odśwież stronę w przeglądarce internetowej.

Save All
File

– –
Umożliwia zapisanie ustawień niniejszego urządzenia w
postaci pliku ALL w urządzeniu z uruchomioną aplikacją
internetową.
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Base Look

Do urządzenia można wczytać wygląd podstawowy.
Na ekranie zostanie wyświetlona lista dostępnych wyglądów podstawowych. Aktualnie stosowany wygląd podstawowy
jest oznaczony znacznikiem ● po lewej stronie numeru wyglądu podstawowego.

[No.]: numer wyglądu podstawowego
[Base Look Name]: nazwa wyglądu podstawowego
[Input]: sygnał wejściowy wyglądu podstawowego
[Output]: sygnał wyjściowy wyglądu podstawowego
[AE Level Offset]: referencyjna wartość przesunięcia ekspozycji dla wyglądu podstawowego

Dodawanie wyglądu podstawowego
Naciśnij przycisk [Import], aby zaimportować nowy wygląd podstawowy. Postępuj zgodnie z instrukcjami wyświetlanymi
na ekranie.
Po zaimportowaniu ustaw odpowiednie wartości dla opcji [Input], [Output] i [AE Level Offset]. Szczegółowe informacje na
ten temat podano w sekcji „Importowanie wyglądu podstawowego”.

Powiązany temat
Importowanie wyglądu podstawowego
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P/T Speed

Służy do konfigurowania ustawień związanych z prędkością obrotu w poziomie/pionie.
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Speed
Step

Normal /
Extended

Extended

Służy do ustawiania liczby stopni regulacji prędkości
mechanizmu napędu obrotu w poziomie/pionie.
Normal: prędkość można określić w 24-stopniowym zakresie. Z
ustawienia tego należy korzystać w celu zapewnienia zgodności
z istniejącymi zdalnie sterowanymi kamerami firmy Sony.
Extended: prędkość można określić w 50-stopniowym zakresie.

Speed
Mode

Normal / Slow Normal

Służy do ustawiania trybu prędkości mechanizmu napędu obrotu
w poziomie/pionie.
Włączona, gdy dla opcji [Speed Step] wybrano ustawienie
[Normal].
Normal: działanie w normalnym zakresie prędkości (od
prędkości minimalnej do maksymalnej (60 stopni/sekundę)).
Slow: działanie w niskim zakresie prędkości (od prędkości
minimalnej do maksymalnej (40 stopni/sekundę)).
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P/T Acceleration

Służy do konfigurowania ustawień związanych z prędkością obrotu w poziomie/pionie.
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Acceleration od 1 do 9 8
Umożliwia wybranie przyspieszenia/opóźnienia dla operacji
obrotu w poziomie/pionie. Im większa wartość, tym większe
przyspieszenie.
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P/T Range Limit

Służy do konfigurowania ustawień związanych z ograniczaniem zakresu obrotu w poziomie/pionie.
Limity zakresu obrotu w poziomie/pionie można ustawić na poniższym ekranie.

Uwaga

Po włączeniu urządzenia lub wykonaniu resetu obrotu w poziomie/pionie, to ustawienie ograniczenia zakresu jest ignorowane. Tej
funkcji nie można używać do omijania przeszkód w pobliżu urządzenia.

Przestaw przełącznik [Setting] w położenie włączenia.

Funkcja ograniczania zakresu obrotu w poziomie/pionie zostanie włączona.

1

Sprawdź obraz za pomocą elementów sterujących obrotem kamery w poziomie/pionie.2

Aby ustawić położenia, w których ma zostać ograniczony obrót kamery, naciśnij w tych położeniach
przycisk [Left], [Right], [Up], [Down] > [Set Current Value].

[Left]: lewa strona kamery
[Right]: prawa strona kamery
[Up]: górna strona kamery

3
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Uwaga

Położenia kamery poza położeniami granicznymi nie mogą zostać zapisane jako ustawienia wstępne.

W przypadku zmiany ustawienia[Pan-Tilt] > [P/T Direction] > [Ceiling] skonfigurowane ustawienia położeń granicznych zostaną
przywrócone do domyślnych ustawień fabrycznych.

Nie można zmienić ustawienia podczas odtwarzania, wyświetlania miniatur, w przypadku wystąpienia błędu obrotu w
poziomie/pionie, a także w przypadku, gdy funkcja obrotu w poziomie/pionie nie jest zainicjowana lub gdy obrót w poziomie/pionie
jest zablokowany.
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[Down]: dolna strona kamery

Położenia graniczne zostaną ustawione i będą wyświetlane w postaci wartości numerycznych (kąt).
Aby anulować ograniczenie, naciśnij przycisk [Reset] dla poszczególnych położeń.

Naciśnij przycisk [OK].

Działanie funkcji obrotu w poziomie/pionie jest ograniczone do skonfigurowanych położeń granicznych.

4
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P/T Direction

Służy do konfigurowania ustawień związanych z kierunkiem obrotu w poziomie/pionie.

Uwaga

Po zastosowaniu zmienionego ustawienia [Ceiling] wszystkie ustawienia wstępne położenia zostaną usunięte, ponieważ
współrzędne obrotu w poziomie/pionie zostaną odwrócone.

Zakres obrotu mechanizmu napędu obrotu w poziomie/pionie zmienia się w zależności od ustawienia opcji [Ceiling] w
sposób przedstawiony na poniższym rysunku.

A: gdy dla opcji [Ceiling] wybrano ustawienie [Off]
B: gdy dla opcji [Ceiling] wybrano ustawienie [On]

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Ceiling On / Off Off

W przypadku montażu urządzenia na suficie należy wybrać
ustawienie [Off]. W przypadku montażu urządzenia na biurku należy
wybrać ustawienie [On]. Jeśli dla opcji [Ceiling] wybrano ustawienie
[On], opcja [Pan Direction] zostanie automatycznie ustawiona na
[Opposite].

Pan
Direction

Normal /
Opposite

Normal
Służy do ustawiania kierunku obrotu mechanizmu napędu obrotu w
poziomie. Po zmianie ustawienia kierunek obrotu mechanizmu
napędu ulega odwróceniu.

Tilt
Direction

Normal /
Opposite

Normal
Służy do ustawiania kierunku obrotu mechanizmu napędu obrotu w
pionie. Po zmianie ustawienia kierunek obrotu mechanizmu napędu
ulega odwróceniu.
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P/T Preset

Służy do konfigurowania ustawień związanych z ustawieniami wstępnymi kamery.

Pan-Tilt
Służy do ustawiania prędkości dla ustawień wstępnych.

Default
Ustawia wartości domyślne, które są konfigurowane po zapisaniu ustawienia wstępnego położenia.

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Pan-Tilt
Speed Setting
Way

Separate /
Common

Separate
Umożliwia określenie, czy wstępnie ustawione prędkości
mają być konfigurowane oddzielnie, czy też mają być
używane wspólne ustawienia.

Pan-Tilt
Speed for
Common

od 1 do 50 50

Służy do ustawiania wspólnej prędkości w ustawieniach
wstępnych.

Uwaga

Maksymalna szybkość działania napędu (24) jest
stosowana, jeśli ustawiona jest wartość 25 lub wyższa, a dla
opcji [Pan-Tilt] > [P/T Speed] > [Speed Step] wybrano
ustawienie [Normal].

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Pan-Tilt Speed
for Separate

od 1 do 50 50
Służy do ustawiania prędkości dla ustawień wstępnych,
gdy metoda wyboru prędkości jest ustawiona na
[Separate].

Zoom Sync On / Off On
Służy do określania, czy operacje obrotu w
poziomie/pionie i zoomu są synchronizowane podczas
przywracania ustawienia wstępnego położenia.

Zoom Speed od 0 do 32767 32767 Służy do ustawiania szybkości zoomu.

Focus Recall On / Off On
Służy do określania,czy ustawienia ostrości mają być
przywracane.

MF Speed od 0 do 32767 32767
Służy do ustawiania szybkości ustawiania ostrości dla
ręcznego ustawiania ostrości.
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Output Format

Służy do konfigurowania ustawień formatu wyjściowego.

Powiązany temat

Formaty wyjściowe i ograniczenia
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Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

SDI Szczegółowe informacje na temat ustawień
podano w sekcji „Formaty wyjściowe i
ograniczenia”.

– Służy do ustawiania
rozdzielczości wyjściowej SDI i
HDMI.HDMI –
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Output Display

Służy do konfigurowania ustawień dotyczących sygnałów wyjściowych.
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

SDI On / Off Off
Umożliwia określenie, czy menu i informacje o stanie mają być
osadzone w sygnale wyjściowym SDI.

HDMI/Stream On / Off On

Umożliwia określenie, czy menu i informacje o stanie mają być
osadzone w sygnale wyjściowym HDMI.

Uwaga

To ustawienie jest stosowane również do obrazu
przekazywanego wyjściowym sygnałem HDMI, obrazu
przekazywanego na wyjściu do przesyłania strumieniowego
oraz obrazu w panelu obrazu z kamery w aplikacji internetowej.
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Audio Input

Służy do konfigurowania ustawień związanych z wejściami audio CH1–CH4.

Służy do ustawiania poziomu sygnału wejściowego audio. Poziom główny sygnału wejściowego audio jest stosowany do
wszystkich kanałów (od 1 do 4).
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Level
Control

Auto / Manual Auto
Umożliwia wybór automatycznej lub ręcznej regulacji
poziomu sygnału wejściowego audio.

Level od 0 do 99 49 Służy do ustawiania poziomu sygnału wejściowego.

Input
Select

AUDIO IN CH1 /
AUDIO IN CH2 / Off

CH1 i CH3: AUDIO IN
CH1
CH2 i CH4: AUDIO IN
CH2

Służy do ustawiania źródła sygnału wejściowego
audio.

Uwaga

Opcja CH1 jest ustawiona na [AUDIO IN CH1] (bez
możliwości zmiany).

Wind
Filter

On / Off Off
Służy do włączania/wyłączania filtru redukcji szumu
wiatru.

Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Master od 0 do 99 99
Służy do ustawiania głównego poziomu sygnału
wejściowego.
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Audio Output

Służy do konfigurowania ustawień związanych z wyjściem audio.

Uwaga

To ustawienie jest stosowane również do dźwięku na wyjściu do przesyłania strumieniowego.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Służy do konfigurowania kombinacji kanałów audio
na wyjściu HDMI / wyjściu do przesyłania
strumieniowego.
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Tracking Data Output

Menu to umożliwia konfigurowanie ustawień związanych z przesyłaniem informacji śledzenia (zgodnych z protokołem
free-d).
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Transfer
Mode

Off / Always / On
Demand

Off Umożliwia wybór metody przesyłania informacji śledzenia.

Camera ID od 0 do 255 255 Umożliwia ustawienie identyfikatora urządzenia.

Destination
Address

Adres IPv4 –
Gdy opcja [Transfer Mode] jest ustawiona na [Always],
umożliwia ustawienie docelowego adresu IP do
przesyłania informacji śledzenia.

Destination
Port

od 1024 do 65534 40000
Gdy opcja [Transfer Mode] jest ustawiona na [Always],
umożliwia ustawienie docelowego numeru portu do
przesyłania informacji śledzenia.

Listen Port od 1024 do 65534 40000
Gdy opcja [Transfer Mode] jest ustawiona na [On
Demand], umożliwia ustawienie numeru portu w
urządzeniu do nasłuchiwania żądań z klientów.
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Tally

Służy do konfigurowania ustawień kontrolki nagrywania (lampki typu Tally) (patrz: „Doprowadzanie sygnału lampki typu
Tally”).

Powiązany temat
Doprowadzanie sygnału lampki typu Tally
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Tally Lamp
Brightness

High / Low / Off High
Umożliwia ustawienie jasności kontrolki nagrywania
(lampki typu Tally).

G Tally Lamp Enable / Disable Enable Służy do włączania/wyłączania lampki typu Tally G.

Tally Control External / Internal Internal
Umożliwia wybranie urządzenia docelowego
przyjmującego informacje sterujące kontrolką nagrywania
(lampką typu Tally) urządzenia.
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IR Remote

Służy do konfigurowania ustawień związanych z pilotem zdalnego sterowania na podczerwień.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Setting On / Off On
Służy do włączania/wyłączania obsługi urządzenia za
pomocą pilota zdalnego sterowania na podczerwień.
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RCP/MSU

Menu to umożliwia konfigurowanie ustawień w przypadku podłączenia jednostki RCP/MSU (do nabycia osobno).
Szczegółowe informacje na ten temat podano w sekcji „Podłączenie jednostki RCP/MSU (do nabycia osobno)”.

Uwaga

Skonfiguruj ustawienia na jednostce RCP/MSU zgodnie z potrzebami.

W przypadku systemu z wieloma kamerami wymagana jest jednostka MSU.

W przypadku korzystania z wielu jednostek MSU należy ustawić jedną z nich jako nadrzędną, a wszystkie pozostałe jako
podrzędne.
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

CNS Mode
Off / Bridge / MCS /
PC Control

Off
Służy do ustawiania trybu połączenia dla jednostki
RCP/MSU.

Master IP
Address Adres IPv4 0.0.0.0

Służy do ustawiania adresu IP urządzenia nadrzędnego w
przypadku tworzenia systemu z wieloma kamerami
opartego na sieci LAN.

Camera
No.

Camera No. (od 1
do 96)

1
Służy do ustawiania unikatowego numeru kamery w
systemie w przypadku tworzenia systemu z wieloma
kamerami opartego na sieci LAN.
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Lens Controller

Menu to umożliwia konfigurowanie ustawień podłączonego sterownika obiektywu (do nabycia osobno).
Szczegółowe informacje na ten temat podano w sekcji „Podłączanie sterownika obiektywu”.

Uwaga

W przypadku zmiany ustawienia [Setting] urządzenie zostanie uruchomione ponownie. Należy odświeżyć stronę w przeglądarce
internetowej.
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Setting On / Off Off
Umożliwia określenie, czy ma być używany sterownik obiektywu (do
nabycia osobno).

Mode od 0 do 15 0

Umożliwia ustawienie trybu pracy sterownika obiektywu (do nabycia
osobno).
Dostępne są wartości z zakresu od 0 do 15, ale rzeczywiste
wartości, które można wybrać, będą się różnić w zależności od
sterownika obiektywu (do nabycia osobno). Szczegółowe informacje
można znaleźć w instrukcji obsługi sterownika obiektywu.

Reverse On / Off Off
Odwraca kierunek obrotu sterownika obiektywu (do nabycia
osobno).

Initialize – – Umożliwia zainicjowanie sterownika obiektywu (do nabycia osobno).
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Camera Name

Służy do konfigurowania ustawień związanych z nazwą kamery (nazwa urządzenia).

W ustawieniu Camera Name można wprowadzić maksymalnie osiem (od 0 do 8) znaków spośród podanych poniżej.
Znaki alfanumeryczne
Symbole (spacja !#$`*+-./;<=>?@[\]^_`{|})

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Camera
Name

– FR7
Umożliwia ustawienie nazwy
kamery.
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User

Służy do konfigurowania ustawień związanych z dostępem użytkownika do urządzenia.

Ustawienia związane z użytkownikami administracyjnymi (Administrator) (wymagane)

Ustawienia związane z użytkownikami ogólnymi (User 1 – User 9) (opcjonalne)

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

User Name – admin Służy do ustawiania nazwy użytkownika.

Current
Password

– –
Podczas zmiany hasła należy wprowadzić
bieżące hasło.

New Password – – Wprowadź nowe hasło.

Re-Type
Password

– –
Wprowadź ponownie nowe hasło w celu
potwierdzenia.

Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

User Name – – Służy do ustawiania nazwy użytkownika.

Current
Password

– –
Podczas zmiany hasła należy wprowadzić
bieżące hasło.

New Password – – Wprowadź nowe hasło.

Re-Type
Password – –

Wprowadź ponownie nowe hasło w celu
potwierdzenia.
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Wired LAN

Status
Służy do wyświetlania informacji o stanie sieci.

IPv4
Służy do konfigurowania ustawień związanych z siecią IPv4.

Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Host Name – – Służy do wyświetlania nazwy hosta.

MAC Address – –
Umożliwia wyświetlenie adresu MAC
urządzenia.

Ethernet Status – –
Służy do wyświetlania bieżącej szybkości
komunikacji.

IP Address – –
Umożliwia wyświetlenie adresu IP
urządzenia.

Subnet Mask – –
Umożliwia wyświetlenie maski podsieci
urządzenia.

Gateway – –
Służy do wyświetlania domyślnej bramy
IPv4 urządzenia.

Primary DNS
Server – –

Służy do wyświetlania głównego serwera
DNS urządzenia.

Secondary DNS
Server

– –
Służy do wyświetlania pomocniczego
serwera DNS urządzenia.

IPv6 Address 1 – –
Służy do wyświetlania adresu IPv6 (1)
urządzenia.

IPv6 Address 2 – –
Służy do wyświetlania adresu IPv6 (2)
urządzenia.

IPv6 Gateway – –
Służy do wyświetlania domyślnej bramy
IPv6 urządzenia.

Link-local IPv6
Address

– –
Służy do wyświetlania lokalnego adresu
IPv6 urządzenia.

Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

DHCP On / Off On Służy do włączania/wyłączania funkcji [DHCP].
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IPv6
Służy do konfigurowania ustawień związanych z siecią IPv6.

Common
Służy do konfigurowania ustawień wspólnych dla sieci IPv4/IPv6.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

IP Address – –
Umożliwia ustawienie adresu IPv4 kamery, gdy
opcja[DHCP] jest ustawiona na Off.

Subnet
Mask

– –
Umożliwia ustawienie maski podsieci, gdy opcja
[DHCP] jest ustawiona na Off.

Gateway – –
Umożliwia ustawienie domyślnej bramy IPv4, gdy
opcja [DHCP] jest ustawiona na Off.

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Obtain an IP
Address
Automatically

On / Off On
Służy do włączania/wyłączania automatycznego
pobierania adresu IPv6.

IP Address – –
Umożliwia ustawienie adresu IPv6 kamery, gdy
opcja[Obtain an IP Address Automatically] jest
ustawiona na Off.

Prefix Length – –
Umożliwia ustawienie prefiksu, gdy opcja [Obtain an
IP Address Automatically] jest ustawiona na Off.

Gateway – –
Umożliwia ustawienie domyślnej bramy IPv6, gdy
opcja [Obtain an IP Address Automatically] jest
ustawiona na Off.

Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

HTTP Port
80, od 1024 do
65534

80 Służy do ustawiania numer portu HTTP.

DNS Auto On / Off On
Umożliwia określenie, czy adresy DNS mają być
uzyskiwane z serwera DHCP.

Primary DNS
Server

Adres IPv4/IPv6 –
Umożliwia ustawienie adresu głównego serwera
DNS, gdy opcja [DNS Auto] jest ustawiona na Off.

Secondary DNS
Server

Adres IPv4/IPv6 –
Umożliwia ustawienie adresu pomocniczego
serwera DNS, gdy opcja [DNS Auto] jest ustawiona
na Off.
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File Transfer

Służy do konfigurowania ustawień związanych z przesyłaniem plików.

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Auto
Upload
(Proxy)

On / Off Off
Służy do włączania/wyłączania automatycznego przesyłania
plików nagrywania pomocniczego.

Default
Upload
Server

Server
Settings1–3 >
Display Name

Server
Settings1

Umożliwia wybranie serwera do przesyłania plików. Wybrany tutaj
serwer staje się miejscem docelowym automatycznego
przesyłania plików nagrywania pomocniczego oraz miejscem
docelowym przesyłania plików z ekranu miniatur.
Służy do wyświetlania ustawień [Display Name] skonfigurowanych
w obszarze [Server Settings1–3]
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FTP Server 1–3

Służy do konfigurowania ustawień związanych z transferem plików przy użyciu protokołu FTP.
Ustawienia są wspólne dla serwerów FTP Server 1–3.

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Display Name – –
Służy do ustawiania nazwy wyświetlanej widocznej w
menu konfiguracji miejsca docelowego transferu.

Service – – Umożliwia wyświetlenie typu serwera.

Host Name – – Służy do ustawiania nazwy hosta docelowego serwera
transferu.

Port
21, 990, od 1024
do 65534

21
Służy do ustawiania numeru portu docelowego serwera
transferu.

User Name – –
Służy do ustawiania nazwy użytkownika do
uwierzytelniania połączenia z docelowym serwerem
transferu.

Password – –
Służy do ustawiania hasła uwierzytelniania połączenia z
docelowym serwerem transferu.

Passive Mode On / Off Off Służy do włączania/wyłączania trybu pasywnego.

Destination
Directory

– –
Służy do ustawiania nazwy docelowego katalogu
transferu.

Using Secure
Protocol

On / Off Off
Służy do określania, czy bezpieczny transfer przy użyciu
protokołu FTP ma być używany (On), czy też nie ma być
używany (Off).

Root
Certificate

– –

Umożliwia wczytanie certyfikatu głównego dla
bezpiecznego transferu przy użyciu protokołu FTP.
Naciśnij przycisk [Load] i wybierz certyfikat główny na
wyświetlonym ekranie.
Naciśnij przycisk [Delete], aby usunąć załadowany
certyfikat główny.

Root
Certificate
Status

– –
Służy do wyświetlania informacji o stanie wczytywania
certyfikatu głównego.

Reset – – Służy do przywracania wartości domyślnych ustawień
[Server Settings].
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SSL

Służy do konfigurowania ustawień związanych z SSL.

SSL
Służy do włączania/wyłączania funkcji SSL.

SSL Server Authentication
Służy do konfigurowania ustawień związanych z uwierzytelnianiem serwera SSL.

Pozycja Ustawienie pozycji podrzędnej Domyślne ustawienie
fabryczne Opis

Function
Disable / Enable / Enable (Allow HTTP
connection for some clients)

Disable
Służy do włączania/wyłączania
funkcji SSL.

Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Certificate
Options

Use a self-signed
certificate (For test use)
/ Use an external
certificate

–
Służy do ustawiania metody instalacji certyfikatu
serwera SSL.

Status – –

Umożliwia wyświetlenie informacji o ważności
certyfikatu serwera SSL, gdy dla opcji [Certificate
Options] wybrano ustawienie [Use a self-signed
certificate (For test use)].

Issuer DN – –

Umożliwia wyświetlenie nazwy wyróżniającej
wydawcy certyfikatu serwera SSL, gdy dla opcji
[Certificate Options] wybrano ustawienie [Use a self-
signed certificate (For test use)].

Subject DN – –

Umożliwia wyświetlenie nazwy wyróżniającej
podmiotu objętego certyfikatem serwera SSL, gdy dla
opcji [Certificate Options] wybrano ustawienie [Use a
self-signed certificate (For test use)].

Available
Period – –

Umożliwia wyświetlenie okresu ważności certyfikatu
serwera SSL, gdy dla opcji [Certificate Options]
wybrano ustawienie [Use a self-signed certificate (For
test use)].

Extended Key
Usage

– –

Umożliwia wyświetlenie metody rozszerzonego
użycia klucza, gdy dla opcji [Certificate Options]
wybrano ustawienie [Use a self-signed certificate (For
test use)].
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Delete – –

Ten przycisk jest wyświetlany, gdy dla opcji
[Certificate Options] wybrano ustawienie [Use a self-
signed certificate (For test use)].
Umożliwia usunięcie zainstalowanego certyfikatu
serwera SSL.

Import – –
Umożliwia zainstalowanie zewnętrznego certyfikatu
serwera SSL z listy, gdy dla opcji [Certificate Options]
wybrano ustawienie [Use an external certificate].

Private Key
Password

– –

Umożliwia ustawienie hasła do informacji klucza
prywatnego certyfikatu serwera SSL, gdy dla opcji
[Certificate Options] wybrano ustawienie [Use an
external certificate].

Reset – –
Ten przycisk umożliwia wyłączenie wyświetlania hasła
klucza prywatnego przy wprowadzaniu nowego hasła.

Self-Signed
Certificate
Generation

– –

Naciśnij przycisk [Generate], aby wygenerować
certyfikat z podpisem własnym, jeśli dla opcji
[Certificate Options] wybrano ustawienie [Use a self-
signed certificate (For test use)].
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Referer Check

Służy do konfigurowania ustawień dotyczących sprawdzania referrera.

Exception List
Służy do konfigurowania ustawień dotyczących listy wyjątków przy sprawdzaniu referrera.

Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Setting On / Off On
Służy do włączania/wyłączania funkcji
sprawdzania referrera.

Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

No. od 1 do 10 – Umożliwia wybór numeru wyjątku z listy.

Host
Name

– – Służy do ustawiania nazwy hosta dla wyjątku.

Port
Number

– – Służy do ustawiania numeru portu dla wyjątku.

Set – –
Naciśnij, aby zarejestrować skonfigurowany wyjątek na
liście wyjątków.
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Delete – –
Wybierz wyjątek, który chcesz usunąć, a następnie naciśnij
przycisk, aby usunąć zarejestrowany wyjątek z listy
wyjątków.
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Brute Force Attack Protection

Służy do konfigurowania ustawień związanych z zapobieganiem atakom siłowym.

Po wykryciu atakującego wyświetlane są informacje na liście atakujących.

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Setting On / Off On
Służy do włączania/wyłączania funkcji [Brute Force Attack
Protection].

Count od 3 do 100 8
Służy do ustawiania liczby prób, która będzie uznawana za
atak.
Włączona, gdy dla opcji [Setting] wybrano ustawienie On.

Release
Mode

Always / Timer Timer

Służy do ustawiania warunku wyzwolenia.
Włączona, gdy dla opcji [Setting] wybrano ustawienie On.
Always: wpisy nie są usuwane z listy atakujących.
Timer: wpisy są usuwane z listy atakujących po upływie
czasu wyzwolenia ustawionego za pomocą opcji [Release
Time].

Release
Time

od 30 do 86400 s 60

Służy do ustawiania czasu wyzwolenia.
Włączona, gdy dla opcji [Setting] wybrano ustawienie On.
Gdy opcja Release Mode jest ustawiona na [Timer], wpisy
są usuwane z listy atakujących po upływie czasu
wyzwolenia.
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Stream

Służy do konfigurowania ustawień przesyłania strumieniowego (patrz: „Informacje dotyczące przesyłania
strumieniowego”).

Stream Setting
Służy do konfigurowania ustawień związanych z protokołem przesyłania strumieniowego.

Uwaga

Aby korzystać z protokołu RTMP, należy wcześniej ustawić opcję [Stream] > [Audio Stream] > [Setting] na [On].

RTSP
Podane poniżej pozycje są wyświetlane, gdy dla opcji [Stream Setting] wybrano ustawienie [RTSP].
Służy do konfigurowania ustawień związanych z przesyłaniem strumieniowym przy użyciu protokołu RTSP.

RTMP

Pozycja Ustawienie pozycji podrzędnej Domyślne ustawienie
fabryczne Opis

Setting
RTSP / RTMP / SRT-Caller / SRT-
Listener / NDI|HX / Off

RTSP
Umożliwia wybór protokołu przesyłania
strumieniowego.

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Port Number 554, od 1024 do
65534

554 Służy do ustawiania numeru portu RTSP.

Time Out od 0 do 600 60
Służy do ustawiania limitu czasu dla polecenia Keep Alive
dla przesyłania strumieniowego przy użyciu protokołu
RTSP.

Authentication On / Off On
Służy do włączania/wyłączania funkcji uwierzytelniania
RTSP.

Video Port
Number 1 od 1024 do 65534 51000

Służy do ustawiania numeru portu do przesyłania obrazu
wideo 1 w ramach przesyłania strumieniowego unicast
przy użyciu protokołu RTSP.

Video Port
Number 2

od 1024 do 65534 53000
Służy do ustawiania numeru portu do przesyłania obrazu
wideo 2 w ramach przesyłania strumieniowego unicast
przy użyciu protokołu RTSP.

Audio Port
Number

od 1024 do 65534 57000
Służy do ustawiania numeru portu do przesyłania
dźwięku w ramach przesyłania strumieniowego unicast
przy użyciu protokołu RTSP.
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Podane poniżej pozycje są wyświetlane, gdy dla opcji [Stream Setting] wybrano ustawienie [RTMP].
Służy do konfigurowania ustawień związanych z przesyłaniem strumieniowym przy użyciu protokołu RTMP.

SRT
Podane poniżej pozycje są wyświetlane, gdy dla opcji [Stream Setting] wybrano ustawienie [SRT-Caller] lub [SRT-
Listener].
Służy do konfigurowania ustawień związanych z przesyłaniem strumieniowym przy użyciu protokołu SRT.

NDI|HX
Podane poniżej pozycje są wyświetlane, gdy dla opcji [Stream Setting] wybrano ustawienie [NDI|HX].
Służy do konfigurowania ustawień związanych z NDI|HX.

Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie fabryczne Opis

Server URL – –
Służy do ustawiania docelowego adres URL RTMP
lub RTMPS połączenia.

Stream Key – –
Służy do ustawiania klucza przesyłania
strumieniowego uzyskany ze strony serwera RTMP.

Root
Certificate

– –

Wczytuje certyfikat główny wymagany do połączenia
z serwerem RTMP.
Naciśnij przycisk [Load] i wybierz certyfikat główny
na wyświetlonym ekranie.
Naciśnij przycisk [Delete], aby usunąć załadowany
certyfikat główny.
Stan jest wyświetlany w pozycji [Root Certificate
Status].

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Destination – –
Służy do ustawiania adresu URL miejsca docelowego
połączenia, gdy urządzenie działa jako urządzenie
wywołujące.

Port
Number

od 1024 do 65534 4201
Służy do ustawiania numeru portu do nasłuchiwania, gdy
urządzenie działa jako urządzenie nasłuchujące.

Latency od 20 do 8000 ms 120 Służy do ustawiania opóźnienia.

TTL od 1 do 255 64 Służy do ustawiania wartości TTL.

Encryption Off / AES128 /
AES256

Off Służy do włączania/wyłączania szyfrowania oraz
ustawiania metody szyfrowania.

Passphrase
0 lub ciąg od 10 do
79 znaków

0
Służy do ustawiania hasła używanego do szyfrowania.
Naciśnij przycisk Reset, aby usunąć wprowadzone hasło.

ARC On / Off On
Służy do włączania/wyłączania funkcji Adaptive Rate
Control.

432



Powiązany temat

Informacje dotyczące przesyłania strumieniowego
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Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie fabryczne Opis

License – –
Służy do wyświetlania stanu instalacji klucza
licencji NDI.

Source Name – – Służy do wyświetlania nazwy źródła NDI.

Group On / Off Off
Służy do włączania/wyłączania funkcji grupowania
NDI.

Group Name – –
Pozycja wyświetlana, gdy funkcja grupowania NDI
jest ustawiona na On.
Służy do ustawiania nazwy grupy.

Discovery
Server 1

– – Służy do ustawiania serwera odnajdywania NDI 1.

Discovery
Server 2

– – Służy do ustawiania serwera odnajdywania NDI 2.

Multicast
Mode

On / Off Off
Służy do włączania/wyłączania przesyłania
strumieniowego multicast.

Multicast
Prefix

239.255.0.0 239.255.0.0

Pozycja wyświetlana, gdy dla opcji [Multicast
Mode] wybrano ustawienie On.
Służy do ustawiania prefiksu używanego do
przesyłania strumieniowego multicast.

Multicast
Netmask

255.255.0.0 255.255.0.0

Pozycja wyświetlana, gdy dla opcji [Multicast
Mode] wybrano ustawienie On.
Służy do ustawiania maski sieci określającej zakres
adresów multicast.

Multicast TTL od 1 do 256 3

Pozycja wyświetlana, gdy dla opcji [Multicast
Mode] wybrano ustawienie On.
Służy do ustawiania wartości TTL dla przesyłania
strumieniowego multicast.

Multi-TCP
Mode

On / Off Off Służy do włączania/wyłączania trybu Multi-TCP.

Unicast UDP
Mode

On / Off On Służy do włączania/wyłączania trybu Unicast UDP.
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Video Stream

Służy do konfigurowania ustawień związanych z kodekiem przesyłania strumieniowego obrazu wideo.

Video Stream 1
Służy do konfigurowania ustawień związanych z kodekiem wideo 1.

Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

Codec 1 H.264 / H.265 H.264
Służy do ustawiania kodeku
obrazu 1.

Size 1
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360

1920×1080
Służy do ustawiania rozmiaru
obrazu 1.

Frame Rate 1

Aby uzyskać szczegółowe informacje na
temat obsługiwanych szybkości klatek,
zapoznaj się z sekcją „Ustawianie kodeka
wideo do przesyłania strumieniowego”.

–
Służy do ustawiania szybkości
klatek obrazu 1.

I-Picture Mode
1

Time / Frame Time

Służy do ustawiania interwału
wstawiania klatek typu IDR
obrazu 1 jako czasu lub liczby
klatek.

I-Picture
Interval 1

1 / 2 / 3 / 4 / 5 s 1

Pozycja wyświetlana, gdy dla
opcji [I-Picture Mode 1] wybrano
ustawienie Time.
Służy do ustawiania interwału
wstawiania klatek typu IDR dla
kodeków H.264 i H.265 jako
czasu.

I-Picture Ratio 1 od 15 do 300 klatek 30

Pozycja wyświetlana, gdy dla
opcji [I-Picture Mode 1] wybrano
ustawienie Frame.
Służy do ustawiania interwału
wstawiania klatek typu IDR dla
kodeków H.264 i H.265 jako
liczby klatek.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264: high
Służy do ustawiania profilu
H.264 lub H.265.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Służy do ustawiania trybu
kompresji szybkości bitowej
obrazu 1.
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Video Stream 2
Służy do konfigurowania ustawień związanych z kodekiem wideo 2.

Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

Bit Rate 1
512 / 768 / 1000 / 2000 / 3000 / 4000 / 5000 /
6000 / 7000 / 8000 / 16000 / 24000 / 32000 /
50000 / 64000 / 80000 kbps

16000

Pozycja wyświetlana, gdy dla
opcji [Bit Rate Compression
Mode 1] wybrano ustawienie
On.
Służy do ustawiania wartości
docelowej szybkości bitowej,
gdy tryb kompresji szybkości
bitowej jest ustawiony na CBR.

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6
Służy do ustawiania jakości
H.264 lub H.265.

Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

Codec 2 H.264 / H.265 / Off Off
Służy do ustawiania kodeku
obrazu 2.

Size 2 4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360 / 512×270

1920×1080 Służy do ustawiania rozmiaru
obrazu 2.

Frame Rate 2

Aby uzyskać szczegółowe informacje na
temat obsługiwanych szybkości klatek,
zapoznaj się z sekcją „Ustawianie kodeka
wideo do przesyłania strumieniowego”.

–

Pozycja wyświetlana, gdy opcja
[Codec 2] nie jest ustawiona na
Off.
Służy do ustawiania szybkości
klatek obrazu 2.

I-Picture Mode
2 Time / Frame Time

Pozycja wyświetlana, gdy opcja
[Codec 2] nie jest ustawiona na
Off.
Służy do ustawiania interwału
wstawiania klatek typu IDR
obrazu 2 jako czasu lub liczby
klatek.

I-Picture
Interval 2

1 / 2 / 3 / 4 / 5 s 1

Pozycja wyświetlana, gdy opcja
[Codec 2] nie jest ustawiona na
Off, a dla opcji [I-Picture Mode 2]
wybrano ustawienie [Time].
Służy do ustawiania interwału
wstawiania klatek typu IDR dla
kodeków H.264 i H.265 jako
czasu.
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Video Stream 3
Służy do konfigurowania ustawień związanych z kodekiem wideo 3.

Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

I-Picture Ratio
2

od 15 do 300 klatek 30

Pozycja wyświetlana, gdy opcja
[Codec 2] nie jest ustawiona na
Off, a dla opcji [I-Picture Mode 2]
wybrano ustawienie [Frame].
Służy do ustawiania interwału
wstawiania klatek typu IDR dla
kodeków H.264 i H.265 jako
liczby klatek.

Profile 2
H.264: high / main / baseline
H.265: main

–
Służy do ustawiania profilu H.264
lub H.265.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Pozycja wyświetlana, gdy opcja
[Codec 2] nie jest ustawiona na
Off.
Służy do ustawiania trybu
kompresji szybkości bitowej
obrazu 2.

Bit Rate 2
512 / 768 / 1000 / 2000 / 3000 / 4000 / 5000 /
6000 / 7000 / 8000 / 16000 / 24000 / 32000 /
50000 / 64000 / 80000 kbps

8000

Pozycja wyświetlana, gdy opcja
[Codec 2] nie jest ustawiona na
Off, a dla opcji [Bit Rate
Compression Mode 2] wybrano
ustawienie [On].
Służy do ustawiania wartości
docelowej szybkości bitowej, gdy
tryb kompresji szybkości bitowej
jest ustawiony na CBR.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Pozycja wyświetlana, gdy opcja
[Codec 2] jest ustawiona na
H.264, a dla opcji [Bit Rate
Compression Mode 2] wybrano
ustawienie Off.
Służy do ustawiania jakości H.264
lub H.265.

Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

Codec 3 JPEG JPEG
Służy do ustawiania
kodeku obrazu 3.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Służy do ustawiania
rozmiaru obrazu 3.
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Powiązany temat

Ustawianie kodeka wideo do przesyłania strumieniowego

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji podrzędnej
Domyślne
ustawienie
fabryczne

Opis

Frame
Rate 3

Aby uzyskać szczegółowe informacje na temat
obsługiwanych szybkości klatek, zapoznaj się z sekcją
„Ustawianie kodeka wideo do przesyłania
strumieniowego”.

–
Służy do ustawiania
szybkości klatek
obrazu 3.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6
Służy do ustawiania
jakości.
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Interchangeable Lens Digital Camera
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Audio Stream

Służy do konfigurowania ustawień związanych z kodekiem przesyłania strumieniowego dźwięku.

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Setting On / Off Off
Służy do włączania/wyłączania wyjścia do przesyłania
strumieniowego dźwięku.

Codec
AAC (128kbps) / AAC
(256kbps)

AAC (128kbps)

Pozycja wyświetlana, gdy dla opcji [Setting] wybrano
ustawienie On.
Służy do ustawiania kodeka audio do przesyłania
strumieniowego.
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Language

Służy do ustawiania języka wyświetlania informacji.

Uwaga

Dostępne języki mogą się różnić w zależności od kraju lub regionu.

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Language – –
Służy do ustawiania języka wyświetlania
informacji.

439



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Accessibility

Służy do konfigurowania ustawień związane z odczytem tekstu (zamiana tekstu na mowę).

Uwaga

Ta funkcja jest dostępna tylko w modelach sprzedawanych w Ameryce Północnej. Z funkcji czytnika ekranu można korzystać tylko
wtedy, gdy język jest ustawiony na angielski (stan na dzień wydania).

Włącz funkcję czytnika ekranu w przeglądarce internetowej na urządzeniu z uruchomioną aplikacją internetową.

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Screen
Reader

On / Off Off 
Służy do włączania/wyłączania funkcji czytnika
ekranu w panelu obrazu z kamery w aplikacji
internetowej.

Speech
Rate

Slow2 / Slow1 / Normal /
Fast1 / Fast2 / Fast3 /
Fast4

Normal

Służy do ustawiania szybkości działania funkcji
czytnika ekranu.
Przykładowy fragment jest odczytywany na głos ze
skonfigurowaną szybkością.

Speech
Volume

od 1 do 15 7

Służy do ustawiania głośności funkcji czytnika
ekranu aplikacji internetowej.
Przykładowy fragment jest odczytywany na głos ze
skonfigurowaną głośnością.
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Clock Set

Służy do konfigurowania ustawień zegara wewnętrznego.

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Current
Date & Time

– –
Służy do wyświetlania aktualnej daty i godziny
skonfigurowanej w urządzeniu.

PC Clock – –
Służy do wyświetlania aktualnej daty i godziny
ustawionej na tablecie lub komputerze
używanym do konfiguracji.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-
dd-yyyy hh:mm:ss / dd-mm-
yyyy hh:mm:ss

yyyy-mm-dd
Umożliwia ustawienie formatu wyświetlania daty
i godziny.

12 h / 24 h 12 h / 24 h 24 h
Umożliwia ustawienie 12-godzinnego lub 24-
godzinnego formatu wyświetlania godziny.

Time Setting
Keep current setting /
Synchronize with PC / Manual
setting / Synchronize with NTP

–
Umożliwia ustawienie metody konfiguracji daty i
godziny.

yy-mm-dd
hh:mm:ss

yy: od 19 do 37
mm: od 01 do 12
dd: od 01 do 31
hh: od 00 do 23
mm: od 00 do 59
ss: od 00 do 59 (sek.)

–
Pozycja wyświetlana, gdy dla opcji [Time
Setting] wybrano ustawienie Manual setting.
Służy do ręcznego ustawiania daty i godziny.

NTP Auto On / Off Off

Pozycja wyświetlana, gdy dla opcji [Time
Setting] wybrano ustawienie Synchronize with
NTP.
Umożliwia określenie, czy adres IP serwera NTP
ma być uzyskiwany z serwera DHCP.

NTP Server
Adres IPv4/IPv6 lub nazwa
hosta

–

Pozycja wyświetlana, gdy opcja [Time Setting]
jest ustawiona na [Synchronize with NTP], a dla
opcji [NTP Auto] wybrano ustawienie Off.
Służy do określania serwera NTP używanego do
synchronizacji czasu.

Time Zone UTC − 12:00 do UTC + 14:00 – Umożliwia wybór strefy czasowej.
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Reset

Służy do inicjowania urządzenia.

Reboot
Służy do ponownego uruchamiania urządzenia.

Reset
Służy do resetowania ustawień urządzenia.

Pozycja Ustawienie pozycji
podrzędnej

Domyślne ustawienie
fabryczne Opis

Reboot Execute –

Służy do ponownego uruchamiania urządzenia.
Execute: uruchomienie funkcji.

Uwaga

Po ponownym uruchomieniu odśwież stronę w
przeglądarce internetowej.

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

All Reset (except
for Network
Settings)

Execute –

Służy do resetowania ustawień urządzenia (z wyjątkiem
ustawień sieciowych).
Execute: uruchomienie funkcji.

Uwaga

Zaimportowane pliki wyglądu podstawowego i pliki LUT
nie są usuwane.

Network Reset Execute –

Służy do resetowania ustawień sieciowych urządzenia.
Execute: uruchomienie funkcji.

Uwaga

Po uruchomieniu funkcji Network Reset urządzenie
zostanie uruchomione ponownie. Po ponownym
uruchomieniu odśwież stronę w przeglądarce
internetowej.
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Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Factory Default Execute –

Służy do przywracania domyślnych ustawień fabrycznych
urządzenia.
Execute: uruchomienie funkcji.

Uwaga

Po uruchomieniu funkcji Factory Default urządzenie
zostanie uruchomione ponownie. Po ponownym
uruchomieniu odśwież stronę w przeglądarce
internetowej.
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Information

Umożliwia wyświetlenie informacji dotyczących kamery i obiektywu. Służy również do aktualizacji oprogramowania.

Camera
Służy do wyświetlania informacji dotyczących kamery i aktualizowania oprogramowania.

Lens
Służy do wyświetlania informacji o obiektywie i aktualizowania oprogramowania.

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Model
Name

– – Umożliwia wyświetlenie nazwy modelu kamery.

Serial
Number

– – Umożliwia wyświetlenie numeru seryjnego kamery.

Version
Number

– –
Umożliwia wyświetlenie informacji o wersji oprogramowania
kamery.

Version Up – –

Naciśnij przycisk [Choose File] i postępuj zgodnie z
instrukcjami wyświetlanymi na ekranie, aby zaktualizować
oprogramowanie kamery.

Uwaga

Po ukończeniu aktualizacji urządzenie zostanie uruchomione
ponownie. Po ponownym uruchomieniu odśwież stronę w
przeglądarce internetowej.

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Model
Name

– – Umożliwia wyświetlenie nazwy modelu obiektywu.

Serial
Number

– – Umożliwia wyświetlenie numeru seryjnego obiektywu.

Version
Number – –

Umożliwia wyświetlenie informacji o wersji oprogramowania
obiektywu.
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Powiązany temat

Aktualizacja oprogramowania obiektywu z mocowaniem typu E

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Version
Up – –

Naciśnij przycisk [Choose File] i postępuj zgodnie z
instrukcjami wyświetlanymi na ekranie, aby zaktualizować
oprogramowanie obiektywu.

Szczegółowe informacje na ten temat podano w sekcji
„Aktualizacja oprogramowania obiektywu z mocowaniem
typu E”.

Uwaga

Po ukończeniu aktualizacji obiektywu urządzenie zostanie
uruchomione ponownie. Po ponownym uruchomieniu odśwież
stronę w przeglądarce internetowej.
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System Log

Służy do konfigurowania ustawień związanych z dziennikiem systemowym.

Uzyskany dziennik jest wyświetlany w sposób przedstawiony poniżej.

Powiązany temat

Aktualizacja oprogramowania obiektywu z mocowaniem typu E

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Log Level
Critical, Warning & Info /
Critical & Warning /
Critical

Critical, Warning &
Info

Służy do określania poziomu dodawania wpisów do
dziennika systemowego.

Log Size od 200 do 1024 1024
Służy do ustawiania rozmiaru zapisywanego
dziennika systemowego.

Download
as File

– –
Naciśnij przycisk [Download] i z poziomu
wyświetlonego ekranu zapisz dziennik systemowy
na tablecie lub komputerze.
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HTTP Access Log

Służy do konfigurowania ustawień związanych z dziennikiem dostępu HTTP.

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja Ustawienie pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

Log Level
Critical, Warning & Info /
Critical & Warning /
Critical

Critical, Warning &
Info

Służy do określania poziomu dodawania wpisów do
dziennika dostępu HTTP.

Log Size od 200 do 1024 1024
Służy do ustawiania rozmiaru zapisywanego
dziennika dostępu HTTP.

Download
as File

– –
Naciśnij przycisk [Download] i z poziomu
wyświetlonego ekranu zapisz dziennik dostępu
HTTP na tablecie lub komputerze.
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Service

Umożliwia uzyskanie informacji o urządzeniu. Należy skorzystać z tego menu w przypadku kontaktowania się z
przedstawicielem serwisu firmy Sony.

5-041-958-33(1) Copyright 2022 Sony Corporation

Pozycja
Ustawienie

pozycji
podrzędnej

Domyślne
ustawienie
fabryczne

Opis

I agree to
download device
information.

– –

Zaznacz pole wyboru, aby wyrazić zgodę na pozyskiwanie
informacji o urządzeniu, a następnie naciśnij przycisk [OK].
Naciśnij wyświetlony przycisk [Download]. Przeglądarka
internetowa pobierze po chwili plik o nazwie
deviceinformation.dat.

Uwaga

Po pobraniu urządzenie zostanie uruchomione ponownie.
Jeśli urządzenie nie zostanie automatycznie uruchomione
ponownie, należy je uruchomić ręcznie. Po ponownym
uruchomieniu odśwież stronę w przeglądarce internetowej.
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EULA

Umożliwia wyświetlenie umowy licencyjnej użytkownika końcowego (EULA).

5-041-958-33(1) Copyright 2022 Sony Corporation
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Software

Umożliwia wyświetlenie licencji na oprogramowanie.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Podłączanie zewnętrznych monitorów i urządzeń nagrywających

Aby wyświetlać nagrywane/odtwarzane obrazy na monitorze zewnętrznym, należy ustawić typ wyjściowego sygnału
wideo doprowadzanego do monitora zewnętrznego i użyć kabla odpowiedniego do podłączanego monitora.
Można również podłączyć zewnętrzne urządzenie nagrywające, aby nagrywać sygnał wyjściowy z urządzenia.
Na monitorze zewnętrznym można wyświetlać te same informacje, które są widoczne na panelu obrazu z kamery, na
przykład menu oraz informacje o stanie. Wybierz ustawienie On dla odpowiedniego typu systemu do wyświetlania
informacji na ekranie w obszarze [Monitoring] > [Output Display] w menu internetowym.

Uwaga

Jeśli do złącza HDMI podłączony jest monitor, który nie obsługuje formatu wyjściowego HDMI skonfigurowanego za pomocą
menu [Monitoring] w menu internetowym lub w menu kamery, obraz z kamery nie będzie przekazywany do aplikacji internetowej.
Obraz wideo przesyłany strumieniowo również nie będzie przekazywany.

Można wybrać ustawienie [Off] zarówno dla opcji [Output Display] > [SDI], jak i [HDMI/Stream], ale uniemożliwi to korzystanie z
menu kamery i funkcji wymagających wyświetlania informacji na ekranie. Ponadto powiadomienia o błędach dotyczących
urządzenia będą ograniczone do kontrolek (świecących lub migających) urządzenia oraz wyświetlania symbolu powiadomienia w
prawym górnym rogu aplikacji internetowej. Aby wyświetlić szczegółowe informacje o stanie urządzenia, należy dla opcji [Output
Display] wybrać ustawienie [On].

Wskazówka

Domyślne ustawienie fabryczne opcji [Output Display] > [SDI] to [Off], a opcji [HDMI/Stream] to [On]. Aby przesyłać strumieniowo
główny obraz wideo, ustaw opcję [SDI] na [On] oraz opcję [HDMI/Stream] na [Off], a następnie monitoruj stan kamery na
monitorze SDI.

Złącze SDI OUT (typu BNC)

Ustaw format sygnału wyjściowego za pomocą menu [Monitoring] w menu internetowym lub w menu kamery.
Do podłączenia użyj dostępnego na rynku kabla koncentrycznego 75 Ω.

Uwaga

Przed włączeniem urządzeń sprawdź, czy połączenie między tym urządzeniem a urządzeniem zewnętrznym jest uziemione.

Zaleca się włączenie tego urządzenia i urządzenia zewnętrznego po podłączeniu kabla koncentrycznego 75 Ω.
Jeśli urządzenie zewnętrzne musi zostać podłączone do niniejszego urządzenia, gdy jest ono włączone, należy najpierw
podłączyć kabel koncentryczny 75 Ω do urządzenia zewnętrznego, a następnie do tego urządzenia.

Rozpoczynanie nagrywania jednocześnie na tym urządzeniu i urządzeniu zewnętrznym
Przy włączonym wyprowadzaniu sygnału SDI ustaw w menu kamery opcję [Project] > [SDI/HDMI Rec Control] > [Setting]
na [SDI/HDMI Remote I/F] lub [Parallel Rec], aby włączyć wyprowadzanie sygnału wyzwalającego REC do urządzenia
zewnętrznego podłączonego do złącza SDI OUT. Spowoduje to zsynchronizowanie nagrywania na urządzeniu
zewnętrznym z niniejszym urządzeniem.

Uwaga

Jeśli podłączone urządzenie zewnętrzne nie obsługuje sygnału wyzwalającego REC, nie można z niego korzystać.
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W przypadku ustawienia w menu kamery opcji [Project] > [SDI/HDMI Rec Control] > [Setting] na [SDI/HDMI Remote I/F] po
naciśnięciu przycisku START/STOP do obsługi nagrywania wyprowadzany jest tylko sygnał wyzwalający REC, jeśli aktualnie nie
jest włożony żaden nośnik służący do nagrywania.

Złącze HDMI OUT (typu A)

Skonfiguruj ustawienie On/Off oraz format sygnału wyjściowego w menu [Monitoring] w menu kamery.

Rozpoczynanie nagrywania jednocześnie na tym urządzeniu i urządzeniu zewnętrznym
Przy włączonym wyprowadzaniu sygnału HDMI ustaw w menu kamery opcję [TC/Media] > [HDMI TC Out] > [Setting] na
[On] oraz opcję [Project] > [SDI/HDMI Rec Control] > [Setting] na [SDI/HDMI Remote I/F] lub [Parallel Rec], aby włączyć
wyprowadzanie sygnału wyzwalającego REC do urządzenia zewnętrznego podłączonego do złącza HDMI OUT.
Spowoduje to zsynchronizowanie nagrywania na urządzeniu zewnętrznym z niniejszym urządzeniem.

Uwaga

Jeśli podłączone urządzenie zewnętrzne nie obsługuje sygnału wyzwalającego REC, nie można z niego korzystać.

W przypadku ustawienia w menu kamery opcji [Project] > [SDI/HDMI Rec Control] > [Setting] na [SDI/HDMI Remote I/F] po
naciśnięciu przycisku START/STOP do obsługi nagrywania wyprowadzany jest tylko sygnał wyzwalający REC, jeśli aktualnie nie
jest włożony żaden nośnik służący do nagrywania.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Łączenie z jednostką RCP/MSU

Niektórymi funkcjami urządzenia można sterować zdalnie po podłączeniu do niego panelu zdalnego sterowania (RCP),
takiego jak RCP-3500/3501, lub głównego modułu sterującego (MSU), takiego jak MSU-3500, za pomocą kabla LAN.
Metoda połączenia będzie różna w zależności od konfiguracji powiązanych urządzeń i aplikacji.

Szczegółowe informacje na temat połączenia indywidualnego między urządzeniem a jednostką RCP podano w
rozdziale „Połączenie indywidualne między urządzeniem a jednostką RCP”.
Szczegółowe informacje na temat podłączania wielu kamer za pomocą jednostki MSU lub oprogramowania do
sterowania kamerami podano w rozdziale „Korzystanie z urządzenia w środowisku z wieloma kamerami z jednostką
MSU / oprogramowaniem do zdalnego sterowania kamerami”.

Powiązany temat

Połączenie indywidualne między urządzeniem a jednostką RCP

Korzystanie z urządzenia w środowisku z wieloma kamerami z jednostką MSU / oprogramowaniem do zdalnego
sterowania kamerami

5-041-958-33(1) Copyright 2022 Sony Corporation
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Połączenie indywidualne między urządzeniem a jednostką RCP

Uwaga

Zapoznaj się z sekcją „Lista obsługiwanych funkcji” i dostosuj ustawienia urządzenia tak, aby spełniało warunki konfiguracyjne dla
funkcji, których chcesz używać, a następnie uaktywnij połączenie z jednostką RCP, postępując zgodnie z poniższą procedurą.

Powiązany temat
Lista obsługiwanych funkcji

5-041-958-33(1) Copyright 2022 Sony Corporation

Włącz każde z urządzeń.1

Ustaw opcję [Technical] > [RCP/MSU] > [CNS Mode] na [Bridge] w menu internetowym kamery.2

Skonfiguruj poniższe ustawienia na jednostce RCP.

Szczegółowe informacje na temat konfiguracji można znaleźć w instrukcji obsługi jednostki RCP.

3

Ustaw tryb połączenia na „Bridge”.1.
Zarejestruj adres IP kamery.2.

454



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Korzystanie z urządzenia w środowisku z wieloma kamerami z jednostką MSU /
oprogramowaniem do zdalnego sterowania kamerami

Za pomocą jednostki MSU lub oprogramowania do zdalnego sterowania kamerami można podłączyć wiele kamer.

Uwaga

Zapoznaj się z sekcją „Lista obsługiwanych funkcji” i dostosuj ustawienia urządzenia tak, aby spełniało warunki konfiguracyjne dla
funkcji, których chcesz używać, a następnie uaktywnij połączenie z jednostką MSU lub oprogramowaniem do zdalnego
sterowania kamerami, postępując zgodnie z poniższą procedurą.

Powiązany temat
Lista obsługiwanych funkcji

5-041-958-33(1) Copyright 2022 Sony Corporation

Włącz każde z urządzeń.1

Skonfiguruj ustawienia sieciowe systemu za pomocą jednostki MSU lub oprogramowania do zdalnego
sterowania kamerami.

Szczegółowe informacje na temat konfiguracji można znaleźć w instrukcji obsługi jednostki MSU lub
oprogramowania do zdalnego sterowania kamerami.

2

Skonfiguruj następujące ustawienia za pomocą opcji [Technical] > [RCP/MSU] w menu internetowym
kamery.

3

W przypadku korzystania z jednostki MSU ustaw opcję [CNS Mode] na [MCS]. W przypadku korzystania z
oprogramowania do zdalnego sterowania kamerami ustaw opcję [CNS Mode] na [PC Control].

1.

W pozycji [Master IP Address] ustaw adres IP nadrzędnej jednostki MSU lub oprogramowania do zdalnego
sterowania kamerami.

2.

W pozycji [Camera No.] ustaw numer kamery, pod którym zostanie zarejestrowana kamera.3.
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Lista obsługiwanych funkcji

W poniższej tabeli zaprezentowano obsługiwane funkcje i odpowiadające im warunki konfiguracyjne.

Panel
konfiguracji Funkcje urządzenia Warunki konfiguracyjne

IRIS Ręczna regulacja przysłony –

AUTO IRIS Włączanie/wyłączanie funkcji Auto Iris –

ND
Przełączanie ustawień wstępnych filtra ND
(Clear/Preset1–Preset3)

Ta funkcja jest dostępna, gdy opcja [Shooting] >
[ND Filter] > [Mode] jest ustawiona na [Preset] w
menu kamery.

MASTER
GAIN

Ręczna regulacja wzmocnienia (krok regulacji: 3
dB)

Ta funkcja jest dostępna, gdy tryb filmowania jest
ustawiony na Custom, a opcja [Shooting] >
[ISO/Gain/EI] > [Mode] w menu kamery jest
ustawiona na [dB].

WHITE (R/B) Ręczna regulacja balansu bieli (R Gain/B Gain)

Ta funkcja jest dostępna, gdy dla opcji [White
Mode] wybrano ustawienie [Memory A(R/B)] lub
[Memory A(T/T)].

WHITE (Color
Temp)

Ręczna regulacja balansu bieli (temperatura
barwowa / odcień)

RCP – [Color Temp]: temperatura barwowa
balansu bieli
RCP – [Balance]: wartość odcienia balansu
bieli

ATW
Włączanie/wyłączanie funkcji ATW
(automatyczne śledzenie balansu bieli)

Ta funkcja jest dostępna, gdy tryb filmowania jest
ustawiony na Custom.

BLACK R/B Regulacja balansu czerni
Ta funkcja jest dostępna, gdy tryb filmowania jest
ustawiony na Custom.
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Uwaga

Dostosuj ustawienia urządzenia tak, aby spełniało warunki konfiguracyjne dla funkcji, których chcesz używać, a następnie
uaktywnij połączenie z jednostką RCP/MSU. Jeśli po uaktywnieniu połączenia zostaną zmienione warunki konfiguracyjne, może
wystąpić nieoczekiwane działanie.

Panel
konfiguracji Funkcje urządzenia Warunki konfiguracyjne

MASTER
BLACK

Umożliwia regulację głównego poziomu czerni

Ta funkcja jest dostępna, gdy tryb filmowania
jest ustawiony na Custom.
Funkcje H/V Ratio i Crispening są dostępne,
gdy opcja [Paint/Look] > [Detail] > [Manual
Setting] jest ustawiona na [On] w menu
kamery.

DETAIL

Włączanie/wyłączanie funkcji regulacji
poziomu szczegółów
Ustawianie poziomu szczegółów
Ustawianie funkcji H/V Ratio
Ustawianie funkcji Crispening

User Matrix

Włączanie/wyłączanie funkcji korekty
macierzy użytkownika
Ustawianie wartości korekty macierzy (R-
G/R-B/G-R/G-B/B-R/B-G)

Multi Matrix

Włączanie/wyłączanie funkcji korekty wielu
macierzy
Ustawianie odcienia i nasycenia koloru
używanego do korekty wielu macierzy

Knee

Włączanie/wyłączanie funkcji korekty zagięcia
charakterystyki
Włączanie/wyłączanie funkcji automatycznego
zagięcia charakterystyki
Ustawianie punktu zagięcia charakterystyki i jej
nachylenia

BARS Włączanie/wyłączanie kolorowych pasów

SHUTTER

Włączanie/wyłączanie funkcji migawki
Ustawianie wartości czasu otwarcia migawki
(Włączanie/wyłączanie funkcji migawki
automatycznej, ustawianie kąta otwarcia
migawki, ustawianie wolnej migawki oraz
ustawianie ECS nie są obsługiwane).

Uwaga

Ustawienia migawki RCP mogą nie być
wyświetlane w zależności od
skonfigurowanej wartości czasu otwarcia
migawki.

Ustawienia migawki RCP mogą nie być
wyświetlane poprawnie, jeśli migawka nie
może być obsługiwana z poziomu jednostki
RCP.

Gdy funkcja migawki automatycznej jest
włączona, będzie ona nadal działać nawet po
włączeniu/wyłączeniu migawki lub zmianie
wartości czasu otwarcia migawki za pomocą
jednostki RCP.
Gdy migawka jest ustawiona na opcję [Angle],
możliwość włączania/wyłączania migawki i
zmiany ustawienia czasu otwarcia migawki z
poziomu jednostki RCP nie jest obsługiwana.
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Informacje o obsłudze za pomocą pilota zdalnego sterowania RM-IP500 (do nabycia
osobno)

Urządzenie można obsługiwać za pomocą pilota zdalnego sterowania RM-IP500 firmy Sony z oprogramowaniem w
wersji 2.2 lub nowszej. Urządzenia komunikują się za pomocą protokołu VISCA over IP (LAN).
W zależności od docelowej pozycji interfejsu może być konieczne wyświetlenie informacji z urządzenia na ekranie.
Należy przygotować monitor, który może być używany do sprawdzania informacji wyświetlanych na ekranie.
Następujące operacje są obsługiwane przez pilot zdalnego sterowania RM-IP500.

Wybór kamery docelowej
Kadrowanie (obrót w poziomie/pionie, zoom)
Regulacja ostrości (bez obsługi dotykowej)
Rejestrowanie i wywoływanie ustawień wstępnych położenia
Korzystanie z menu urządzenia (z wyjątkiem menu internetowego)
Regulacja jasności
Regulacja balansu bieli
Regulacja balansu czerni
Regulacja poziomu sygnału wejściowego audio
Rozpoczynanie/zatrzymywanie nagrywania
Wykonywanie funkcji przypisanych do przycisków konfigurowalnych urządzenia

Szczegółowe informacje na temat obsługi za pomocą pilota zdalnego sterowania RM-IP500 podano w instrukcji obsługi
pilota RM-IP500.

Wskazówka

W przypadku korzystania z pilota RM-IP500 należy używać przeznaczonego dla tego urządzenia arkusza nakładanego na panel,
który jest dostarczany z pilotem RM-IP500.
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RM-IP500 (z przeznaczonym dla tego urządzenia arkuszem nakładanym na panel)

5-041-958-33(1) Copyright 2022 Sony Corporation
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Podłączanie pilota zdalnego sterowania RM-IP500

Szczegółowe informacje na temat przypisywania funkcji podano w instrukcji obsługi pilota zdalnego sterowania RM-
IP500.

5-041-958-33(1) Copyright 2022 Sony Corporation

Przestaw przełącznik 3 w sekcji SETUP urządzenia w położenie ON, aby włączyć komunikację VISCA over
IP.

Uwaga

Ustawienie przełącznika jest stosowane po następnym włączeniu urządzenia.

1

Połącz pilot zdalnego sterowania RM-IP500 z tą samą siecią, z którą jest połączone urządzenie.2

Postępuj zgodnie z procedurą podaną w instrukcji obsługi pilota zdalnego sterowania RM-IP500, aby
skonfigurować połączenie VISCA over IP (LAN) na pilocie RM-IP500.

Przypisz urządzenie, wybierając kolejno: menu RM > AUTO IP SETUP > ASSIGN CAM.

3

W razie potrzeby funkcje tego urządzenia można przypisać do przycisków i pokręteł, korzystając z
poniższych pozycji menu RM pilota RM-IP500.

SW ASSIGN
AE CONFIG2
WB MODE

4
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Informacje o synchronizacji z urządzeniem zewnętrznym

Podczas filmowania przy użyciu wielu urządzeń można zsynchronizować urządzenia z określonym sygnałem
referencyjnym lub sygnałem kodu czasowego za pomocą ich złącza GENLOCK.

Szczegółowe informacje na temat trybu Genlock można znaleźć w sekcji „Synchronizacja fazy sygnałów wideo
(Genlock)”.
Szczegółowe informacje na temat synchronizowania kodów czasowych podano w sekcji „Synchronizowanie kodu
czasowego z innymi urządzeniami”.

Powiązany temat

Synchronizacja fazy sygnałów wideo (Genlock)

Synchronizowanie kodu czasowego z innymi urządzeniami

5-041-958-33(1) Copyright 2022 Sony Corporation
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Synchronizacja fazy sygnałów wideo (Genlock)

Aby włączyć tryb Genlock, można doprowadzić sygnał referencyjny do złącza GENLOCK.
Wejściowe sygnały referencyjne, których można użyć, różnią się w zależności od częstotliwości systemowej wybranego
formatu nagrywania.

Stan synchronizacji zewnętrznej można sprawdzić za pomocą opcji [Technical] > [Genlock] > [Reference] w menu
kamery.

Uwaga

Jeśli sygnał referencyjny jest niestabilny, nie można włączyć trybu Genlock.

Podnośna nie jest synchronizowana.

5-041-958-33(1) Copyright 2022 Sony Corporation

Częstotliwość systemowa formatu nagrywania Obsługiwane wejściowe sygnały referencyjne

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P 1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i 1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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Synchronizowanie kodu czasowego z innymi urządzeniami

Ustaw urządzenie dostarczające kod czasowy na tryb, w którym włączone jest wyjście kodu czasowego (na przykład
Free Run lub Clock).

Uwaga

Sprawdź, czy między doprowadzonym sygnałem referencyjnego kodu czasowego oraz referencyjnym sygnałem wideo występuje
zależność fazowa zgodna ze standardem kodów czasowych SMPTE.

Podczas pracy z synchronizacją zewnętrzną kod czasowy jest natychmiast synchronizowany z zewnętrznym kodem czasowym, a
wartość zewnętrznego kodu czasowego pojawia się w obszarze wyświetlania danych. Nie należy jednak od razu rozpoczynać
nagrywania. Przed rozpoczęciem nagrywania należy odczekać kilka sekund, aż generator kodu czasowego się ustabilizuje.

Jeśli częstotliwość referencyjnego sygnału wideo i częstotliwość klatek w urządzeniu nie są takie same, nie można uzyskać
synchronizacji i urządzenie nie będzie działać prawidłowo. W takim przypadku kod czasowy nie zostanie pomyślnie
zsynchronizowany z zewnętrznym kodem czasowym.

Jeśli zewnętrzne źródło sygnału kodu czasowego zostanie odłączone, kod czasowy może być przesunięty o jedną klatkę na
godzinę w stosunku do referencyjnego kodu czasowego.

Wyłączenie synchronizacji zewnętrznej
W menu kamery zmień ustawienie [TC/Media] > [Timecode].
Synchronizacja zewnętrzna jest również wyłączana po zmianie częstotliwości systemowej, a także po rozpoczęciu
nagrywania w specjalnym trybie nagrywania (tryb zwolnionego/przyspieszonego tempa lub tryb nagrywania
interwałowego).

5-041-958-33(1) Copyright 2022 Sony Corporation

Skonfiguruj poniższe ustawienia w obszarze [TC/Media] > [Timecode] w menu kamery.

Ustaw opcję [Mode] na [Preset].
Ustaw opcję [Run] na [Free Run].

1

Naciśnij przycisk konfigurowalny, do którego przypisano funkcję [DURATION/TC/U-BIT], aby wyświetlić kod
czasowy na ekranie.

2

Doprowadź referencyjny sygnał wideo HD lub SD do złącza GENLOCK oraz sygnał referencyjnego kodu
czasowego do złącza TC IN.

Generator kodów czasowych urządzenia zostanie zsynchronizowany z referencyjnym kodem czasowym, a na
ekranie wyświetli się komunikat „EXT-LK”.
Po upływie około dziesięciu sekund od zsynchronizowania kodu czasowego stan synchronizacji zewnętrznej będzie
utrzymywany, nawet jeśli źródło zewnętrznego referencyjnego kodu czasowego zostanie odłączone.

3
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Podłączanie mikrofonu zewnętrznego lub zewnętrznego urządzenia audio

Można doprowadzić sygnał z zewnętrznego mikrofonu lub zewnętrznego urządzenia audio i osadzić dźwięk w nagranym
materiale wideo lub wyjściowym sygnale wideo urządzenia.

Podłącz mikrofon zewnętrzny lub zewnętrzne urządzenie audio za pomocą kabla XLR.

Jeśli skonfigurowano ustawienie dźwięku [LINE] przy użyciu opcji [Audio] > [Audio Input] > [AUDIO IN Select] w
menu kamery, złącze AUDIO IN działa jako złącze AUDIO IN CH-1 i złącze AUDIO IN CH-2.

1

Nr styku Funkcja

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Wyłącz urządzenie i podłącz kabel XLR do złącza AUDIO IN.2

Przestaw przełącznik 2 w sekcji SETUP tak, aby włączyć zasilanie Phantom zgodnie z wymaganiami.

Przełącz zasilacz +48 V (zasilanie Phantom) w sposób opisany poniżej.
Przełącznik 2
Decyduje o tym, czy zasilanie +48 V (zasilanie Phantom) jest włączane/wyłączane po podłączeniu urządzenia
wejściowego audio.

3

Ustawienie Opis

OFF
(domyślne)

Powoduje wyłączenie zasilania Phantom +48 V i ustawienie wejścia LINE lub MIC jako źródła
dźwięku CH-1 i CH-2.
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Uwaga

Przestawienie tego przełącznika w położenie ON i podłączenie mikrofonu, który nie jest zgodny ze źródłem +48 V, może
spowodować uszkodzenie podłączonego urządzenia. Należy sprawdzić ustawienie przed podłączeniem urządzenia.

Ustawienie Opis

ON
Powoduje włączenie zasilania Phantom +48 V i ustawienie mikrofonu zgodnego z zasilaniem
Phantom jako źródła dźwięku CH-1 i CH-2.

Włącz urządzenie i w ustaw w menu kamery typ podłączonego urządzenia za pomocą opcji [Audio] > [Audio
Input] > [AUDIO IN Select].

4
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Zarządzanie klipami i ich edytowanie za pomocą komputera

Klipami można zarządzać i je edytować za pomocą komputera.

Importowanie klipów przy użyciu czytnika kart (do nabycia osobno)

Podłącz czytnik kart CFexpress typu A lub czytnik kart SD do komputera i użyj oprogramowania obsługującego format
zapisu tego urządzenia, takiego jak Catalyst Browse, aby zaimportować klipy.

Korzystanie z nieliniowego systemu edycji

W nieliniowym systemie edycji wymagane jest oprogramowanie do edycji (do nabycia osobno), które obsługuje formaty
nagrywane przez urządzenie.

5-041-958-33(1) Copyright 2022 Sony Corporation

467



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Wyprowadzanie sygnału światłowodowego

Sygnał SDI konwertowany na sygnał optyczny można wyprowadzić, podłączając moduł SFP+ (do nabycia osobno) do
złącza OPTICAL urządzenia. Należy użyć modułu SFP+, który odpowiada pasmom sygnałów poszczególnych formatów.
Pasmo sygnału

4K (59.94p, 50p): 12G
4K (inna niż 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (inna niż 59.94p, 50p): 1.5G

Uwaga

Należy użyć modułu spełniającego poniższe standardy.

Standardy SFF
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

Standardy SDI
ST297/ST292/ST424/ST425/ST2081/ST2082

Do modułu SFP+ doprowadzany jest taki sam sygnał jak na złączu wyjściowym SDI.

Urządzenie nie obsługuje światłowodowego sygnału wejściowego.

Do wyprowadzania sygnału światłowodowego należy użyć modułu SFP+. Szczegółowe informacje na temat zweryfikowanych
modułów SFP+ można uzyskać u sprzedawcy lub przedstawiciela serwisu firmy Sony.

5-041-958-33(1) Copyright 2022 Sony Corporation

* Poziom mocy I (1,0 W)
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Doprowadzanie sygnału lampki typu Tally

W tym temacie opisano sterowanie sygnałem lampki typu Tally.

Włączanie lampki typu Tally za pomocą sygnału z pilota zdalnego sterowania

Lampkę typu Tally można włączyć za pomocą polecenia protokołu VISCA over IP z urządzenia zewnętrznego, takiego jak
pilot zdalnego sterowania RM-IP500.
Ustaw opcję [Technical] > [Tally] > [Tally Control] na [External] w menu internetowym lub w menu kamery.

Włączanie lampki typu Tally z urządzenia zewnętrznego

Lampkę typu Tally urządzenia (czerwoną lub zieloną) można włączyć za pomocą urządzenia zewnętrznego, takiego jak
pilot zdalnego sterowania RM-IP500 lub przełącznik. Lampką typu Tally można sterować za pomocą poleceń
przesyłanych przez sieć lub przy użyciu sygnału wejściowego lampki typu Tally doprowadzanego do złącza OPTION
urządzenia.
Ustaw opcję [Technical] > [Tally] > [Tally Control] na [External] w menu internetowym lub w menu kamery.
Gdy sygnał lampki typu Tally jest doprowadzany do złącza OPTION, zwarcie styku 7 do masy (GND, styk 4 lub 5)
powoduje włączenie zielonej lampki typu Tally, a zwarcie styku 8 do masy (GND, styk 4 lub 5) powoduje włączenie
czerwonej lampki typu Tally.

Uwaga

Gdy opcja [Tally Control] jest ustawiona na [External], stan nagrywania na urządzeniu nie jest wskazywany przez lampkę typu
Tally.

Gdy jednocześnie doprowadzany jest sygnał czerwonej i zielonej lampki typu Tally, lampka typu Tally urządzenia świeci na
czerwono.

Specyfikacja styków złącza OPTION

Nr
styku

Kierunek
sygnału Specyfikacja sygnału

1 – Sygnał TX RS-232C (dla sterownika obiektywu)

2 – Sygnał RX RS-232C (dla sterownika obiektywu)

3 OUT

Wyjście sygnału zielonej lampki typu Tally
Wyjście niskiego poziomu, gdy zielona lampka typu Tally jest włączona.
Wyjście Hi-Z (wyjście typu „otwarty dren”), gdy zielona lampka typu Tally jest
wyłączona.
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Włączanie lampki typu Tally urządzenia zewnętrznego za pomocą sygnału z niniejszego
urządzenia

Lampkę typu Tally urządzenia zewnętrznego można włączyć za pomocą sygnału z niniejszego urządzenia, podłączając
styki 3 i 6 złącza OPTION w sposób przedstawiony poniżej.
Przykład połączeń styków 3 i 6 złącza OPTION

Uwaga

Nie wolno doprowadzać napięcia do styków 7 i 8.

Nie wolno podłączać urządzenia zewnętrznego, które może doprowadzić napięcie do złącza OPTION.

Jeśli do styku 3 lub 6 zostanie przyłożone napięcie rozruchowe lub wsteczne przekraczające wartość znamionową, może to
spowodować awarię, emisję dymu lub pożar.

Ustaw sygnał wyjściowy za pomocą opcji [Technical] > [Tally] > [Tally Control] w menu internetowym lub w menu kamery.
[Internal]: stan operacji nagrywania na urządzeniu
[External]: sygnały logiczne oraz sygnał czerwonej/zielonej lampki typu Tally odbierane przez urządzenie za pośrednictwem
sygnałów IN oraz sygnałów z pilotów zdalnego sterowania.

5-041-958-33(1) Copyright 2022 Sony Corporation

Nr
styku

Kierunek
sygnału Specyfikacja sygnału

4 – GND (masa)

5 – GND (masa)

6 OUT

Wyjście sygnału czerwonej lampki typu Tally
Wyjście niskiego poziomu, gdy czerwona lampka typu Tally jest włączona.
Wyjście Hi-Z (wyjście typu „otwarty dren”), gdy czerwona lampka typu Tally jest
wyłączona.

7 IN
Wejście sygnału sterowania zewnętrznego zieloną lampką typu Tally
Zwarcie do masy (styk 4 lub 5) powoduje, że lampka typu Tally urządzenia zaczyna
świecić na zielono.

8 IN
Wejście sygnału sterowania zewnętrznego czerwoną lampką typu Tally
Zwarcie do masy (styk 4 lub 5) powoduje, że lampka typu Tally urządzenia zaczyna
świecić na czerwono.
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Przesyłanie danych śledzenia (free-d)

Urządzenie może wysyłać informacje śledzenia ustawień obrotu w poziomie/pionie oraz zoomu, ostrości i przysłony
synchronizowane z sygnałem synchronizacyjnym.
Dane wyjściowe są zgodne z protokołem free-d, który jest standardem branżowym. Można wybrać metodę przesyłania:
stałe przesyłanie lub przesyłanie na żądanie z klientów. Wybierz metodę przesyłania zgodnie z posiadanym systemem
VR/AR.

Format przesyłania danych

Wskazówka

Szczegółowe informacje techniczne są dostępne w sekcji „Instrukcja integracji dla protokołu free-d”. Skontaktuj się z
przedstawicielem handlowym firmy Sony.

Dane śledzenia przesyłane przez urządzenie obejmują następujące dane zgodnie z formatem określonym w Type D0/D1
protokołu free-d.
Type D0 – poll/command

Sprawdź, czy urządzenie jest włączone.1

Ustaw metodę przesyłania danych śledzenia.

Stałe przesyłanie

Przesyłanie na żądanie klientów

2

Ustaw opcję [Technical] > [Tracking Data Output] > [Transfer Mode] na [Always] w menu internetowym.1.
Ustaw identyfikator urządzenia za pomocą opcji [Camera ID].2.
Określ docelowy adres IP za pomocą opcji [Destination Address].3.
Określ docelowy numer portu za pomocą opcji [Destination Port].4.
Naciśnij przycisk [OK].5.

Ustaw opcję [Technical] > [Tracking Data Output] > [Transfer Mode] na [On Demand] w menu internetowym.1.
Ustaw identyfikator urządzenia za pomocą opcji [Camera ID].2.
Określ numer portu do nasłuchiwania żądań z klientów za pomocą opcji [Listen Port].3.
Naciśnij przycisk [OK].4.

Symbol Zawartość Opis

<D0> Message type

<CA> Camera ID

<CD> command

Obsługiwane są następujące polecenia:
00 Stop stream mode
01 Start stream mode
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Type D1 – camera position/orientation data

Uwaga

W następujących sytuacjach dane śledzenia mogą być opóźnione lub wartości mogą nie być aktualizowane:

Podczas wyprowadzania sygnału wideo RAW
Gdy opcja S&Q Motion jest włączona
Podczas wyświetlania menu kamery
Podczas wyświetlania ekranu miniatur
Podczas odtwarzania nagranych klipów
Podczas wyświetlania menu internetowego

5-041-958-33(1) Copyright 2022 Sony Corporation

Symbol Zawartość Opis

<CK> Checksum

Symbol Zawartość Opis

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle Kąt obrotu w poziomie (od −170° do +170°)

<TH><TM><TL> Camera Tilt Angle Kąt obrotu w pionie (od −30° do +195°)

<RH><RM><TL> Camera Roll Angle Nieobsługiwane (zawsze 0)

<XH><XM><XL> Camera X-Position Nieobsługiwane (zawsze 0)

<YH><YM><YL> Camera Y-Position Nieobsługiwane (zawsze 0)

<HH><HM><HL> Camera Height Nieobsługiwane (zawsze 0)

<ZH><ZM><ZL> Camera Zoom Ogniskowa

<FH><FM><FL> Camera Focus Odległość ogniskowania

<SH><SL> Spare/User Defined Położenie przysłony

<CK> Checksum
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Podłączanie sterownika obiektywu

Zoom obiektywu z ręczną regulacją zoomu można dostosowywać za pomocą aplikacji internetowej, pilota zdalnego
sterowania RM-IP500 (do nabycia osobno) lub pilota zdalnego sterowania na podczerwień po podłączeniu dostępnego
na rynku sterownika obiektywu (do nabycia osobno), który jest zgodny z tym urządzeniem.
Szczegółowe informacje na temat podłączania sterownika obiektywu można znaleźć w instrukcji obsługi sterownika
obiektywu.
Szczegółowe informacje na temat dostosowywania zoomu za pomocą sterownika obiektywu można znaleźć w sekcji
„Dostosowywanie zoomu za pomocą sterownika obiektywu”.

Uwaga

Przed użyciem sterownika obiektywu należy dokładnie zapoznać się z instrukcją obsługi sterownika obiektywu i upewnić się, że
informacje o sposobie korzystania z niego są w pełni zrozumiałe. Firma Sony nie ponosi odpowiedzialności za jakiekolwiek
roszczenia wynikające z używania sterownika obiektywu.

Funkcja Clear Image Zoom nie jest dostępna, gdy sterownik obiektywu jest włączony. Zaleca się ustawienie współczynnika Clear
Image Zoom na 1.0× lub wyłączenie funkcji Clear Image Zoom.

Gdy sterownik obiektywu jest włączony, nie można rejestrować ani odtwarzać operacji kadrowania wykonywanych przez kamerę.

Powiązany temat

Dostosowywanie zoomu za pomocą sterownika obiektywu

5-041-958-33(1) Copyright 2022 Sony Corporation
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Dostosowywanie zoomu za pomocą sterownika obiektywu

Postępuj zgodnie z poniższą procedurą, aby podłączyć sterownik obiektywu (do nabycia osobno) i dostosować zoom.

Sprawdzanie stanu sterownika obiektywu

Podłącz sterownik obiektywu do złącza OPTION w bloku złączy urządzenia.

Szczegółowe informacje na temat podłączania można znaleźć w instrukcji obsługi sterownika obiektywu.

1

Skonfiguruj sterownik obiektywu odpowiednio do danego obiektywu zmiennoogniskowego.

Szczegółowe informacje można znaleźć w instrukcji obsługi sterownika obiektywu.

2

Zablokuj mechanizm obrotu w poziomie/pionie urządzenia i podłącz obiektyw zmiennoogniskowy.

Szczegółowe informacje na ten temat podano w sekcji „Mocowanie obiektywu”.

3

Dostosuj ustawienia sterownika obiektywu tak, aby mógł obsługiwać obiektyw zmiennoogniskowy.4

Wyreguluj głowicę kamery, tak aby była zapewniona równowaga podczas ruchu do przodu / do tyłu, a
podstawa do przesuwania była ustawiona poziomo.

Szczegółowe informacje można znaleźć w instrukcji obsługi sterownika obiektywu oraz w sekcji „Mocowanie
obiektywu”.

5

W menu internetowym ustaw opcję [Technical] > [Lens Controller] > [Setting] na [On] i naciśnij przycisk
[OK].

Urządzenie zostanie uruchomione ponownie. Poczekaj, aż operacja resetowania obrotu w poziomie/pionie zostanie
zakończona.

6

Naciśnij przycisk  (inicjowanie sterownika obiektywu) na karcie  (Others) w panelu
ustawień kamery na ekranie sterowania w czasie rzeczywistym w aplikacji internetowej.

Sterownik obiektywu uruchomi się w celu wykrycia zakresu zoomu. Szczegółowe informacje można znaleźć w
instrukcji obsługi sterownika obiektywu.
Gdy w lewym górnym rogu panelu obrazu z kamery wskaźnik  (błąd sterownika obiektywu) zmieni się na 
(sterownik obiektywu gotowy), oznacza to, że faza przygotowania została zakończona.

Uwaga

Podczas inicjowania sterownika obiektywu należy zwrócić uwagę na zakres roboczy obiektywu.

7

Dostosuj zoom za pomocą suwaka [Zoom] w aplikacji internetowej lub przycisków sterowania zoomem na
pilocie zdalnego sterowania na podczerwień.

8
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Naciśnij przycisk  (stan kamery) w obszarze wspólnym ekranu aplikacji internetowej, aby wyświetlić ekran stanu
kamery.

Stan sterownika obiektywu można sprawdzić na tym ekranie.

Uwaga

Po wymianie obiektywu należy zainicjować sterownik obiektywu.

Funkcja Clear Image Zoom nie jest dostępna, gdy sterownik obiektywu jest włączony. Zaleca się ustawienie współczynnika Clear
Image Zoom na 1.0× lub wyłączenie funkcji Clear Image Zoom.
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Stan Opis

Off Użyj obiektywu z mocowaniem typu E i elektryczną regulacją zoomu.

Communication
Error

Wystąpił błąd komunikacji między urządzeniem a sterownikiem obiektywu.
Sprawdź połączenie między urządzeniem a sterownikiem obiektywu, a następnie zapoznaj się z
instrukcją obsługi sterownika obiektywu i zainicjuj sterownik obiektywu.

Uninitialized Rozpocznij operację inicjowania.

Initializing Poczekaj na zakończenie operacji inicjowania.

Initialization
Failed

Sprawdź połączenie między urządzeniem a sterownikiem obiektywu, a następnie zapoznaj się z
instrukcją obsługi sterownika obiektywu i zainicjuj sterownik obiektywu.

Working Sterowanie zoomem za pomocą sterownika obiektywu.

Rotation Error
Zapisany zakres ruchu sterowania zoomem i zakres ruchu obiektywu mogą nie być zgodne.
Zainicjuj sterownik obiektywu.

System Error Sprawdź połączenie między urządzeniem a sterownikiem obiektywu, zapoznaj się z instrukcją
obsługi sterownika obiektywu i zainicjuj sterownik obiektywu lub wyłącz zasilanie urządzenia i
sterownika obiektywu, a następnie włącz ponownie.Unknown Error
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Zalecenia eksploatacyjne

Zalecenia eksploatacyjne dotyczące transportu i pakowania
Podczas transportu lub pakowania urządzenia należy zachować następujące warunki i unikać narażania go na silne
wibracje lub wstrząsy.

Zdejmij obiektyw i załóż pokrywę na korpus.
Po przesunięciu głowicy kamery (A) do przodu obróć dźwignię blokady głowicy kamery (B) w kierunku wskazanym
strzałką, aby zablokować głowicę kamery.

Ustaw głowicę kamery tak, aby była skierowana do przodu, i zablokuj ją za pomocą suwaka blokady obrotu w
poziomie/pionie.

Odłącz kable połączeniowe.

Kondensacja
Jeśli urządzenie zostanie nagle przeniesione z miejsca o niskiej temperaturze w miejsce o wysokiej temperaturze lub
jeśli temperatura otoczenia nagle wzrośnie, na zewnętrznej powierzchni urządzenia i/lub wewnątrz urządzenia może
pojawić się wilgoć. Zjawisko to jest znane jako kondensacja. Jeśli wystąpi kondensacja, należy wyłączyć urządzenie i
przed ponownym uruchomieniem urządzenia poczekać, aż wilgoć zniknie. Użytkowanie urządzenia w przypadku
występowania kondensacji może spowodować jego uszkodzenie.

Zjawiska związane z przetwornikiem obrazu CMOS kamery

Uwaga

Następujące zjawiska, które mogą wystąpić na obrazach, są specyficzne dla przetworników obrazu. Nie wskazują na wadliwe
działanie.
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Białe plamki
Wprawdzie przetworniki obrazu są produkowane przy użyciu bardzo precyzyjnych technologii, w rzadkich
przypadkach mogą pojawiać się drobne białe plamki na ekranie — są one spowodowane działaniem promieniowania
kosmicznego itp.
Jest to związane z zasadą działania przetworników obrazu i nie oznacza usterki. Uruchamiaj regularnie funkcję APR.
Białe plamki są szczególnie widoczne w następujących przypadkach:

Podczas pracy w wysokiej temperaturze otoczenia
W przypadku zwiększenia wzmocnienia (czułości)

Migotanie
Podczas filmowania przy świetle wytwarzanym przez lampy fluorescencyjne, lampy sodowe, lampy rtęciowe lub
diody LED ekran może migotać lub kolory mogą się różnić.

Napęd obiektywu oraz napęd mechanizmu obrotu w poziomie/pionie
Jeśli napęd obiektywu oraz napęd mechanizmu obrotu w poziomie/pionie nie będą używane przez dłuższy czas, lepkość
smaru nałożonego wewnątrz mechanizmu może się zwiększyć, uniemożliwiając jego ruch. Należy regularnie korzystać z
napędu obiektywu oraz napędu mechanizmu obrotu w poziomie/pionie.

Elementy podlegające normalnemu zużyciu
Wentylator i wbudowany akumulator to części eksploatacyjne, które wymagają okresowej wymiany.
Przy pracy w temperaturze pokojowej należy je wymieniać co ok. 5 lat. Jest to jednak wyłącznie ogólna wskazówka,
która nie stanowi gwarancji trwałości tych elementów.
Aby uzyskać szczegółowe informacje na temat wymiany części, należy skontaktować się ze sprzedawcą.

Przewidywana trwałość tego zasilacza prądu zmiennego i kondensatora elektrolitycznego wynosi około 5 lat w
normalnych temperaturach roboczych i przy typowym użytkowaniu (8 godzin dziennie, 25 dni w miesiącu). Jeśli
urządzenie użytkowane jest bardziej intensywnie, jego przewidywana trwałość może ulec odpowiednio skróceniu.

Zalecane są okresowe przeglądy, aby zapewnić prawidłowe działanie urządzenia i przedłużyć okres jego eksploatacji.
Aby uzyskać więcej informacji na temat przeglądów, należy skontaktować się z przedstawicielem serwisu firmy Sony.

Informacje o wbudowanym akumulatorze
Urządzenie jest wyposażone we wbudowany akumulator, który umożliwia przechowywanie daty, godziny i innych
ustawień, nawet gdy urządzenie jest wyłączone. Wbudowany akumulator zostanie naładowany po upływie 24 godzin,
jeśli urządzenie jest podłączone do gniazdka elektrycznego poprzez zasilacz sieciowy lub jest zasilane przez PoE++,
niezależnie od tego, czy urządzenie jest włączone, czy wyłączone. Akumulator zostanie całkowicie rozładowany po około
2 miesiącach, jeśli zasilacz sieciowy nie jest podłączony do zasilania. Z urządzenia należy korzystać po naładowaniu
akumulatora. Jednak nawet jeśli akumulator nie jest naładowany, nie będzie to miało wpływu na działanie urządzenia, o
ile nie ma potrzeby dodawania daty podczas nagrywania.

Miejsce użytkowania i przechowywania
Przechowywać w wentylowanym miejscu na równej powierzchni.
Unikać używania lub przechowywania urządzenia w podanych poniżej warunkach.

W miejscach narażonych na działanie deszczu lub wody (w tym pod okapami).
Na zewnątrz i w miejscach o temperaturze przekraczającej 40 °C.
Należy pamiętać, że latem w ciepłym klimacie temperatura wewnątrz samochodu z zamkniętymi oknami może łatwo
przekroczyć 50 °C.
W miejscach o temperaturze niższej niż 0 °C.
W wilgotnych lub zakurzonych miejscach. W miejscach, w których urządzenie może być narażone na działanie
deszczu.
W miejscach narażonych na silne wibracje lub wstrząsy.
W miejscach, w których wytwarzane jest promieniowanie rentgenowskie lub silne pole magnetyczne.
W pobliżu nadajników radiowych lub telewizyjnych wytwarzających silne pola elektromagnetyczne.
W bezpośrednim świetle słonecznym lub w pobliżu grzejników (w przypadku długiego okresu przechowywania).
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Uwaga dotycząca wiązek lasera
Wiązki lasera mogą uszkodzić przetwornik obrazu CMOS. Jeśli filmuje się scenę obejmującą wiązkę lasera, należy
uważać, aby nie skierować wiązki lasera na przetwornik obrazu CMOS kamery. W szczególności wiązki laserowe o dużej
mocy emitowane z urządzeń medycznych lub innych urządzeń mogą powodować uszkodzenia wywołane odbitym i
rozproszonym światłem.

Zapobieganie zakłóceniom elektromagnetycznym z przenośnych urządzeń komunikacyjnych
Używanie telefonów przenośnych i innych urządzeń komunikacyjnych w pobliżu tego urządzenia może powodować jego
wadliwe działanie oraz zakłócenia sygnałów audio i wideo. Zaleca się wyłączenie przenośnych urządzeń
komunikacyjnych znajdujących się w pobliżu tego urządzenia.

Nie umieszczać produktu w sąsiedztwie urządzeń medycznych
Ten produkt (wraz z osprzętem) wyposażony jest w magnes(y) mogący(-e) zakłócać pracę rozruszników serca,
programowalnych zastawek przetokowych do leczenia wodogłowia lub innych urządzeń medycznych. Nie należy
umieszczać produktu w pobliżu osób, które korzystają ze wspomnianych urządzeń medycznych. Jeżeli stosowane są
wspomniane urządzenia medyczne, przed przystąpieniem do użytkowania tego produktu należy zasięgnąć porady
lekarskiej.

Środki ostrożności
FIRMA SONY NIE PONOSI ODPOWIEDZIALNOŚCI ZA JAKIEKOLWIEK SZKODY WYNIKAJĄCE Z
NIEZASTOSOWANIA ODPOWIEDNICH ŚRODKÓW ZABEZPIECZAJĄCYCH URZĄDZENIA PRZESYŁOWE,
NIEUNIKNIONYCH WYCIEKÓW DANYCH ZGODNYCH ZE SPECYFIKACJĄ TRANSMISJI ANI ZA JAKIEKOLWIEK
PROBLEMY ZWIĄZANE Z BEZPIECZEŃSTWEM.
W zależności od środowiska pracy nieuprawnione osoby trzecie mogą uzyskać dostęp do urządzenia przez sieć.
Podczas podłączania urządzenia do sieci należy sprawdzić, czy sieć jest odpowiednio zabezpieczona.
Z punktu widzenia bezpieczeństwa, w przypadku korzystania z urządzenia podłączonego do sieci zdecydowanie
zalecane jest otwarcie okna sterowania poprzez przeglądarkę internetową i zmienienie wstępnie skonfigurowanych
ustawień ograniczeń dostępu. Ponadto zaleca się ustawienie hasła zawierającego wystarczająco długi ciąg znaków,
który jest trudny do odgadnięcia przez inne osoby, i bezpieczne przechowywanie tego hasła.
Po podłączeniu tego produktu do sieci należy nawiązać połączenie za pośrednictwem systemu, który zapewnia
funkcje zabezpieczające, takiego jak router lub zapora internetowa. W przypadku połączenia bez takiego
zabezpieczenia mogą wystąpić problemy z bezpieczeństwem.

Zasilanie
Urządzenie nie jest wyposażone w wyłącznik zasilania. Aby wyłączyć urządzenie, sprawdź, czy wszystkie operacje
zostały zakończone, a urządzenie znajduje się w stanie zasilania w trybie gotowości, a następnie odłącz zasilacz
sieciowy. W przypadku korzystania z zasilania PoE++ odłącz kabel LAN.
W miarę możliwości należy korzystać ze źródła zasilania w miejscu, w którym można łatwo włożyć i wyjąć wtyczkę.
W przypadku korzystania z gniazdka w zakurzonym miejscu należy regularnie czyścić obszar wokół gniazdka, aby
zapobiec przewodzeniu prądu przez nagromadzony kurz.
Odłącz zasilanie, gdy urządzenie nie jest używane.

Zalecenia eksploatacyjne dotyczące ruchomych elementów
Należy dopilnować, by do ruchomych elementów nie przedostały się ciała obce.
Podczas ręcznego poruszania elementami nie wolno stosować nadmiernej siły. W przeciwnym razie może dojść do
awarii.
Nie należy zakłócać działania ruchomych elementów podczas ruchu. Może to spowodować obrażenia ciała lub
wadliwe działanie.
Ruchome elementy mogą nie działać prawidłowo, jeśli urządzenie nie jest używane przez dłuższy czas. Należy
regularnie korzystać z funkcji obrotu w poziomie/pionie.

Zalecenia eksploatacyjne dotyczące pracy ciągłej
Urządzenie może być włączone 24 godziny na dobę, 365 dni w roku (stan zasilania w trybie gotowości).
Należy zawsze wykonać test funkcji filmowania i sprawdzić, czy urządzenie działa normalnie.

Możliwość ciągłego filmowania przez okres dłuższy niż 24 godziny nie jest gwarantowana.
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W przypadku filmowania przez ponad 24 godziny należy przełączyć urządzenie w stan zasilania w trybie
gotowości, a następnie uruchomić je ponownie.

Należy pamiętać, że firma Sony nie będzie zobowiązana do wypłaty żadnego odszkodowania związanego z
rejestrowanym obrazem, jeśli filmowanie nie będzie możliwe z powodu wystąpienia jakiejkolwiek usterki podczas
korzystania z tego urządzenia.
Zawsze przed użyciem należy sprawdzić, czy urządzenie działa prawidłowo. FIRMA SONY NIE PONOSI
ODPOWIEDZIALNOŚCI ZA JAKIEKOLWIEK SZKODY, A W SZCZEGÓLNOŚCI NIE JEST ZOBOWIĄZANA DO
WYPŁATY ODSZKODOWANIA ANI ZWROTU PIENIĘDZY Z POWODU UTRATY OBECNYCH LUB
SPODZIEWANYCH ZYSKÓW W WYNIKU AWARII TEGO URZĄDZENIA PODCZAS OKRESU GWARANCYJNEGO
ALBO PO WYGAŚNIĘCIU GWARANCJI, ANI TEŻ Z JAKICHKOLWIEK INNYCH PRZYCZYN.
FIRMA SONY NIE PONOSI ODPOWIEDZIALNOŚCI ZA JAKIEKOLWIEK ROSZCZENIA ZE STRONY
UŻYTKOWNIKÓW TEGO URZĄDZENIA ANI ZE STRONY OSÓB TRZECICH.
FIRMA SONY NIE PONOSI ODPOWIEDZIALNOŚCI ZA ZAKOŃCZENIE LUB WYCOFANIE USŁUG ZWIĄZANYCH
Z TYM URZĄDZENIEM NA SKUTEK OKOLICZNOŚCI JAKIEGOKOLWIEK RODZAJU.

Zalecenia eksploatacyjne dotyczące funkcji nagrywania
Zawsze przed przystąpieniem do nagrywania należy przeprowadzić nagrywanie próbne i sprawdzić, czy nagranie
zostało pomyślnie zapisane. FIRMA SONY NIE PONOSI ODPOWIEDZIALNOŚCI ZA JAKIEKOLWIEK SZKODY, A W
SZCZEGÓLNOŚCI NIE JEST ZOBOWIĄZANA DO WYPŁATY ODSZKODOWANIA ANI ZWROTU PIENIĘDZY Z
POWODU NIEPOWODZENIA NAGRYWANIA ZAWARTOŚCI JAKIEGOKOLWIEK TYPU NA TYM URZĄDZENIU
LUB NA JEGO NOŚNIKACH DANYCH ALBO INNYCH NOŚNIKACH BĄDŹ SYSTEMACH MAGAZYNOWANIA
DANYCH.
Zawsze przed użyciem należy sprawdzić, czy urządzenie działa prawidłowo. FIRMA SONY NIE PONOSI
ODPOWIEDZIALNOŚCI ZA JAKIEKOLWIEK SZKODY, A W SZCZEGÓLNOŚCI NIE JEST ZOBOWIĄZANA DO
WYPŁATY ODSZKODOWANIA ANI ZWROTU PIENIĘDZY Z POWODU UTRATY OBECNYCH LUB
SPODZIEWANYCH ZYSKÓW W WYNIKU AWARII TEGO URZĄDZENIA PODCZAS OKRESU GWARANCYJNEGO
ALBO PO WYGAŚNIĘCIU GWARANCJI, ANI TEŻ Z JAKICHKOLWIEK INNYCH PRZYCZYN.
FIRMA SONY NIE PONOSI ODPOWIEDZIALNOŚCI ZA JAKIEKOLWIEK ROSZCZENIA ZE STRONY
UŻYTKOWNIKÓW TEGO URZĄDZENIA ANI ZE STRONY OSÓB TRZECICH.
FIRMA SONY NIE ODPOWIADA ZA UTRATĘ, NAPRAWĘ LUB POWIELANIE JAKICHKOLWIEK DANYCH
ZAPISANYCH W WEWNĘTRZNYM SYSTEMIE MAGAZYNOWANIA DANYCH, NOŚNIKACH DANYCH LUB
INNYCH NOŚNIKACH LUB SYSTEMACH MAGAZYNOWANIA DANYCH.
FIRMA SONY NIE PONOSI ODPOWIEDZIALNOŚCI ZA ZAKOŃCZENIE LUB WYCOFANIE USŁUG ZWIĄZANYCH
Z TYM URZĄDZENIEM NA SKUTEK OKOLICZNOŚCI JAKIEGOKOLWIEK RODZAJU.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Formaty wyjściowe i ograniczenia

W tym temacie opisano formaty wyjściowe i ograniczenia.

Uwaga

Rozdzielczość formatu wyjściowego jest ograniczona przez ustawienia [Project] > [Rec Format] > [Frequency], [Codec] oraz
[Video Format] w menu internetowym lub w menu kamery.

Rozdzielczość formatu wyjściowego jest ograniczona również przez połączenie z liczbą klatek na sekundę w trybie
zwolnionego/przyspieszonego tempa. Niezależnie od tabeli formatów wyjściowych na złączu SDI OUT/HDMI OUT przedstawionej
poniżej sygnał wyjściowy HDMI zmienia się na Full HD lub sygnał w niższej rozdzielczości, gdy spełnione są wszystkie poniższe
warunki.

Opcja [Shooting] > [S&Q Motion] > [Setting] jest ustawiona na [On]
Ustawienie [Shooting] > [S&Q Motion] > [Frame Rate] ma wartość wyższą niż 60fps.

Gdy powyższe warunki są spełnione, opcje wyboru rozdzielczości 4096×2160P oraz 3840×2160P dla wyjścia HDMI w pozycji
[Monitoring] > [Output Format] > [SDI/HDMI] są wyszarzone i nie można ich wybrać.

Obraz nie jest przekazywany na wyjście, jeśli skonfigurowano rozdzielczość wyższą niż rozdzielczość odtwarzanego obrazu.

Formaty sygnału wyjściowego na złączu SDI OUT/HDMI OUT

Gdy częstotliwość systemu wynosi 50/59.94 Hz

Ustawienie Dostępne do wyboru formaty sygnału
wyjściowego

Tryb
nagrywania/odtwarzania

Rozdzielczość na wyjściu
RAW /

rozdzielczość nagrywania
wewnętrznego

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(domyślna)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
(domyślna)
1920×1080i
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Gdy częstotliwość systemu wynosi 25/29.97 Hz

Ustawienie Dostępne do wyboru formaty sygnału
wyjściowego

Tryb
nagrywania/odtwarzania

Rozdzielczość na wyjściu
RAW /

rozdzielczość nagrywania
wewnętrznego

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(domyślna)

1920×1080P
(domyślna)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(domyślna)

1920×1080P
(domyślna)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A)
(domyślna)

1920×1080P
(domyślna)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Zatrzymanie przekazywania
sygnału wyjściowego)

720×480P2)

720×576P3)

Informacje wyświetlane na ekranie nie mogą się nakładać.1)

Gdy częstotliwość systemu wynosi 59.942)

Gdy częstotliwość systemu wynosi 503)
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Gdy częstotliwość systemu wynosi 23.98 Hz

Ustawienie Output Format (rozdzielczość wyjściowa)

Tryb
nagrywania/odtwarzania

Rozdzielczość na wyjściu RAW /
rozdzielczość nagrywania

wewnętrznego
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i
(domyślna)

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
1920×1080i
(domyślna)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(domyślna)

1920×1080i
(domyślna)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(domyślna)

1920×1080i
(domyślna)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Ustawienie Output Format (rozdzielczość wyjściowa)

Tryb
nagrywania/odtwarzania

Rozdzielczość na wyjściu RAW /
rozdzielczość nagrywania

wewnętrznego
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(domyślna)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P
(domyślna)
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Gdy częstotliwość systemu wynosi 24 Hz

5-041-958-33(1) Copyright 2022 Sony Corporation

Ustawienie Output Format (rozdzielczość wyjściowa)

Tryb
nagrywania/odtwarzania

Rozdzielczość na wyjściu RAW /
rozdzielczość nagrywania

wewnętrznego
SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P
(domyślna)

1920×1080P
(domyślna)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P
(domyślna)

1920×1080P
(domyślna)

1920×1080
1920×1080P
(domyślna)

1920×1080P
(domyślna)

Ustawienie Output Format (rozdzielczość wyjściowa)

Tryb
nagrywania/odtwarzania

Rozdzielczość na wyjściu RAW /
rozdzielczość nagrywania

wewnętrznego
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P
(domyślna)

XAVC-I 4096×2160
4096×2160 (2SI)
1920×1080P
(domyślna)

4096×2160P
1920×1080P
(domyślna)
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rozwiązywanie problemów

Zasilanie

Wyprowadzanie sygnału obrazu

Objawy Przyczyna Rozwiązanie

Urządzenie nie
włącza się.

Zasilacz sieciowy nie jest poprawnie podłączony do
złącza DC IN.

Podłącz poprawnie przewód zasilający,
wkładając go do oporu.

Przewód zasilający nie jest poprawnie podłączony
do zasilacza sieciowego ani do gniazdka
sieciowego.

Podłącz poprawnie przewód zasilający,
wkładając go do oporu.

Kabel LAN nie jest poprawnie podłączony do
urządzenia zasilającego PoE++ i niniejszego
urządzenia.

Sprawdź, czy kabel jest włożony tak, aby był
zablokowany.

Kabel LAN jest podłączony do złącza OPTION, ale
nie do złącza LAN.

Podłącz poprawnie kabel LAN do złącza
LAN.

Urządzenie jest podłączone do urządzenia
zasilającego, które nie obsługuje PoE++
(niezgodnego ze standardem IEEE802.3bt, typ 4,
klasa 8).

Podłącz urządzenie zasilające obsługujące
technologię PoE++ (zgodne ze standardem
IEEE802.3bt, typ 4, klasa 8).

Całkowity pobór mocy przekracza maksymalną
wartość znamionową urządzenia zasilającego
PoE++.

Zapoznaj się z instrukcją obsługi urządzenia
zasilającego PoE++.

Podłączono kabel sieciowy o kategorii, która nie
obsługuje zasilania PoE++.

Użyj kabla sieciowego kategorii 5e lub
wyższej podłączonego do złącza LAN.

Kamera, urządzenie zasilające PoE++ i urządzenia
peryferyjne nie są podłączone do uziemienia.

Podłącz kamerę, urządzenie zasilające
PoE++ i urządzenia peryferyjne do
uziemienia.

Objawy Przyczyna Rozwiązanie

Sygnał obraz nie jest
wyprowadzany.

Podłączone urządzenia nie są poprawnie podłączone.
Podłącz urządzenia
poprawnie.

Konfiguracja wstępna nie została ukończona.
Dokończ wstępną konfigurację
za pomocą aplikacji
internetowej.
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Pilot zdalnego sterowania

Pilot zdalnego sterowania na podczerwień

Objawy Przyczyna Rozwiązanie

Ze złącza HDMI nie jest
wyprowadzany sygnał
obrazu.

Skonfigurowano sygnał, który nie jest obsługiwany
przez urządzenie docelowe podłączone do wyjścia
HDMI.

Zmień ustawienie formatu
wyjściowego HDMI lub użyj
urządzenia obsługującego
sygnał wyjściowy.

Używany jest przewód, który nie obsługuje
wyjściowego standardu HDMI.

Użyj przewodu obsługującego
używany wyjściowy standard
HDMI.

Ze złącza SDI nie jest
wyprowadzany sygnał
obrazu.

Używany jest przewód, który nie obsługuje
wyjściowego standardu SDI.

Użyj przewodu obsługującego
używany standard SDI.

Monitor podłączony do złącza SDI nie obsługuje
sygnału wyjściowego.

Użyj monitora obsługującego
standard sygnału wyjściowego
SDI.

Format nagrywania jest ustawiony na wyjście RAW.
Zmień format nagrywania na
ustawienie inne niż wyjście
RAW.

Wyjście HDMI jest ustawione na rozdzielczość SD. Ustaw wyjście HDMI na
rozdzielczość inną niż SD.

Ze światłowodu nie jest
przekazywany obraz lub
przekazywany obraz jest
zniekształcony.

Używany moduł nie jest zgodny ze standardem SFF lub
SMPTE albo nie spełnia wymagań dotyczących
poziomu mocy I (1,0 W).

Patrz: „Wyprowadzanie
sygnału światłowodowego”.

Podczas korzystania z
synchronizacji zewnętrznej
obraz nie jest
wyprowadzany lub jest
zniekształcony.

Zewnętrzny sygnał synchronizacji odpowiedni dla
skonfigurowanego formatu sygnału wideo nie jest
doprowadzany.

Doprowadź zewnętrzny sygnał
synchronizacji odpowiedniego
dla skonfigurowanego formatu
sygnału wideo.

Występują zakłócenia
dźwięku.

Kamera, urządzenie zasilające PoE++ i urządzenia
peryferyjne nie są podłączone do uziemienia.

Podłącz niniejsze urządzenie,
urządzenie zasilające PoE++ i
urządzenia peryferyjne do
uziemienia.

Urządzenie jest używane w środowisku, w którym
znajdują się urządzenia wytwarzające silne pola
elektryczne i magnetyczne (takie jak anteny nadajników
radiowych/telewizyjnych, amatorskie nadajniki radiowe,
silniki klimatyzatorów, transformatory zasilające).

Należy trzymać się z dala od
urządzeń wytwarzających
silne pola elektryczne i
magnetyczne.

Obiektyw, wspornik obiektywu i zespół napędowy
stykają się z urządzeniem lub obiektem w otoczeniu i
emitowany jest nietypowy hałas.

Zamocuj obiektyw
poprawnie.

Sprawdź, czy w pobliżu
kamery nie ma żadnych
przeszkód.
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RM-IP500

Aplikacja internetowa

Objawy Przyczyna Rozwiązanie

Przycisk pilota zdalnego
sterowania na podczerwień
nie działa po naciśnięciu.

Obsługa za pomocą pilota zdalnego
sterowania na podczerwień jest wyłączona.

Ustaw opcję [Technical] > [IR Remote]
> [Setting] na [On] w menu
internetowym.

Bateria została rozładowana lub
biegunowość baterii jest nieprawidłowa.

Użyj pilota zdalnego sterowania na
podczerwień w pobliżu czujnika
podczerwieni urządzenia. Jeśli dioda
LED zasilania miga, wymień baterię.

Konfiguracja wstępna nie została ukończona. Dokończ wstępną konfigurację za
pomocą aplikacji internetowej.

Szybkość działania funkcji
obrotu w poziomie/pionie
jest niska.

Szybkość działania funkcji obrotu w
poziomie/pionie w przypadku obsługi za
pomocą pilota zdalnego sterowania na
podczerwień jest ustawiona na tryb
normalny.

Przestaw przełącznik 4 w sekcji SETUP
na bloku złączy urządzenia w położenie
ON.

Sterowanie kamerą inną niż
kamera, do której jest
przeznaczony.

Sygnał podczerwieni został odebrany przez
niewłaściwą kamerę.

W menu internetowym kamery, którą
nie chcesz sterować, ustaw opcję
[Technical] > [IR Remote] > [Setting] na
[Off].

Objawy Przyczyna Rozwiązanie

Nie można obsługiwać kamery za
pomocą pilota zdalnego sterowania
RM-IP500.

Zasilanie kamery nie jest
podłączone.

Sprawdź, czy kontrolka POWER urządzenia
świeci na zielono, czy na pomarańczowo.

Kamera lub pilot zdalnego
sterowania nie są
połączone z siecią.

Sprawdź połączenia urządzenia i pilota zdalnego
sterowania.

Wstępna konfiguracja
kamery nie została
ukończona.

Dokończ wstępną konfigurację za pomocą
aplikacji internetowej.

Komunikacja VISCA over
IP nie jest włączona.

Przestaw przełącznik 3 w sekcji SETUP na panelu
złącz urządzenia w położenie ON i uruchom
urządzenie ponownie.

Zmieniono adres IP
kamery.

Sprawdź adres IP kamery, wybierając kolejno
opcje [Network] > [Wired LAN] w menu
internetowym lub w menu kamery.

Adres IP kamery został zmieniony
za pomocą funkcji AUTO IP SETUP
na pilocie zdalnego sterowania RM-
IP500.

Od uruchomienia kamery
upłynęło co najmniej 20
minut.

Uruchom ponownie urządzenie. Adres IP można
zmienić za pomocą funkcji AUTO IP SETUP w
ciągu pierwszych 20 minut od uruchomienia
urządzenia.
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Objawy Przyczyna Rozwiązanie

Nie można połączyć za pomocą
przeglądarki internetowej.

Kabel LAN kategorii 5e lub
wyższej nie jest podłączony.

Podłącz kabel LAN kategorii 5e lub
wyższej.

Nie połączono poprawnie z
siecią LAN lub sieć, z którą
nawiązano połączenie, nie
działa prawidłowo.

Sprawdź, czy dioda LED Link dla złącza
LAN się świeci. Jeśli dioda LED Link nie
świeci się, skontaktuj się z administratorem
sieci.

Zasilanie kamery nie jest
podłączone.

Patrz: sekcja „Zasilanie” powyżej.

Nie skonfigurowano
prawidłowego adresu IP dla
urządzenia.

Wykonaj resetowanie sieci.

Skonfigurowany adres IP
jest używany przez inne
urządzenie.

Sprawdź, czy adresy IP urządzeń
peryferyjnych są unikatowe.

Skonfigurowana maska
podsieci nie jest zgodna z
używaną podsiecią.

Wykonaj resetowanie sieci.

Dostęp do urządzenia
odbywa się w tej samej
sieci lokalnej za
pośrednictwem serwera
proxy.

Zmień konfigurację tak, aby serwer proxy
nie był używany.

Skonfigurowana brama
domyślna dla urządzenia
jest nieprawidłowa.

Wykonaj resetowanie sieci.

Wprowadzony adres URL
jest nieprawidłowy.

Wprowadź prawidłowy adres URL i spróbuj
ponownie.

Port HTTP jest
nieprawidłowy.

Wyświetl menu kamery na monitorze
zewnętrznym i sprawdź ustawienie
[Network] > [Wired LAN] > [HTTP Port].
Jeśli skonfigurowano wartość inną niż 80,
dodaj numer portu HTTP do nazwy hosta
lub adresu IP podczas wprowadzania w
przeglądarce internetowej.
Przykład: Jeśli port HTTP jest ustawiony na
8080, wprowadź http://<adres IP>:8080

Numer portu HTTP
urządzenia jest filtrowany
lub blokowany.

Zmień numer portu HTTP urządzenia na
port, który nie jest filtrowany ani blokowany.

Stara pamięć podręczna
przeglądarki internetowej
ma niekorzystny wpływ.

Wyczyść pamięć podręczną w
przeglądarce internetowej.
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Objawy Przyczyna Rozwiązanie

Nie można połączyć z aplikacją
internetową za pomocą kodu 2D (kodu
QR).

Używane urządzenie nie
obsługuje mDNS.

Użyj urządzenia obsługującego mDNS.
W przypadku korzystania z urządzenia,
które nie obsługuje mDNS, wprowadź
adres IP bezpośrednio w przeglądarce
internetowej.

Tablet lub komputer jest
podłączony do innej sieci
niż kamera.

Podłącz tablet lub komputer do tej samej
sieci lokalnej co urządzenie.

Nie można połączyć z aplikacją
internetową poprzez ręczne
wprowadzenie adresu URL.

Używane urządzenie nie
obsługuje mDNS.

Użyj urządzenia obsługującego mDNS.

Tablet lub komputer jest
podłączony do innej sieci
niż kamera.

Podłącz tablet lub komputer do tej samej
sieci lokalnej co urządzenie.

Ekran uwierzytelniania jest stale
wyświetlany.

Nie wprowadzono
prawidłowej nazwy
użytkownika lub hasła.

Wprowadź zarejestrowaną nazwę
użytkownika i hasło. Jeśli nie pamiętasz
zarejestrowanych danych użytkownika,
zobacz „Przełącznik RESET” w sekcji „Blok
złączy”, aby zainicjować dane użytkownika
dla połączenia sieciowego.

Nazwa użytkownika i hasło
mogły zostać zmienione
przez użytkownika
zalogowanego za pomocą
innej przeglądarki
internetowej.

Sprawdź u administratora urządzenia, czy
nazwa użytkownika i hasło są prawidłowe.

Obraz z kamery nie jest wyświetlany w
aplikacji internetowej.

Wyjście HDMI kamery jest
ustawione na 720×480 lub
720×576.

Zmień rozdzielczości na wyjściu HDMI
urządzenia.

Podłączono monitor HDMI,
który nie obsługuje sygnału
wyjściowego HDMI kamery.

Odłącz monitor HDMI lub użyj monitora
HDMI obsługującego ustawienia wyjścia
HDMI.

Urządzenie zostało
ponownie uruchomione i
nastąpiło rozłączenie sesji.

Odczekaj około minuty i odśwież
przeglądarkę internetową.

Stara pamięć podręczna
przeglądarki internetowej
ma niekorzystny wpływ.

Wyczyść pamięć podręczną w
przeglądarce internetowej.

Rozdzielczość obrazu z kamery
wyświetlanego w aplikacji internetowej
jest niska.

Rozdzielczość strumienia
wideo 3 używana przez
aplikację internetową jest
niska.

Zwiększ wartość za pomocą opcji [Stream]
> [Video Stream] > [Size 3] w menu
internetowym.

Menu kamery nie pojawia się po
naciśnięciu przycisku [Menu].

Menu kamery jest
skonfigurowane w taki
sposób, że nie jest
osadzone w sygnale
wyjściowym HDMI.

Ustaw opcję [Monitoring] > [Output Display]
> [HDMI/Stream] na [On] w menu
internetowym.
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Filmowanie

Kamera

Objawy Przyczyna Rozwiązanie

Wartość ustawienia na ekranie ustawień
nie jest prawidłowo
uaktualniana/wyświetlana.

Ekran ustawień aplikacji
internetowej nie
odzwierciedla
automatycznie ustawień
zmienionych w innej
aplikacji internetowej.

Naciśnij przycisk [Reload] u dołu ekranu
ustawień aplikacji internetowej. Wartości
ustawień na wyświetlonym ekranie
konfiguracji zostaną ponownie załadowane
i zaktualizowane.

Mają na to wpływ
ustawienia tymczasowych
plików internetowych.

Wyczyść pamięć podręczną w
przeglądarce internetowej.

Nie można pobrać pliku konfiguracyjnego
lub dziennika.

Funkcja pobierania pliku w
przeglądarce internetowej
jest wyłączona.

Włącz funkcję pobierania pliku w
przeglądarce internetowej.

Ekran ustawień aplikacji internetowej jest
dostępny, ale nie można wykonywać
operacji na ekranie sterowania w czasie
rzeczywistym ani na ekranie operacji
odtwarzania.

Ekran obsługi aplikacji
internetowej jest
zablokowany.

Przestaw przełącznik blokady obsługi w
prawym górnym rogu aplikacji internetowej
w położenie  (odblokowanie operacji).

Wyświetlenie ekranu aplikacji
internetowej trwa dość długo.

Obraz przesyłany
strumieniowo z urządzenia
jest wyświetlany
jednocześnie przez wielu
użytkowników.

Zmniejsz liczbę użytkowników, którzy mogą
uzyskać dostęp do aplikacji internetowej
jednocześnie.

Obraz jest zniekształcony lub zacina się.

Informacje wizualne nie są
prawidłowo przesyłane ze
względu na przeciążenie
ścieżki komunikacji.

Zmniejsz szybkość transmisji
strumieniowej, ustaw [Video Stream 3] >
[Size] na najmniejszą opcję lub zmniejsz
szybkość, aby utworzyć rezerwę w paśmie
komunikacyjnym.

Na tablecie uruchomionych
jest wiele przeglądarek
internetowych, które
zajmują pamięć.

Zamknij wszystkie przeglądarki internetowe
działające w tle.

Otwartych jest zbyt wiele
kart przeglądarki
internetowej, co spowalnia
działanie.

Zamknij wszystkie nieużywane karty.

Nadmierne zapełnienie
pamięci podręcznej
przeglądarki internetowej i
historii przeglądania
spowalnia działanie.

Wyczyść pamięć podręczną przeglądarki
internetowej.

Objawy Przyczyna Rozwiązanie

Obraz na początku i na końcu operacji
obrotu w poziomie/pionie jest
zniekształcony.

Jeśli funkcja stabilizacji obrazu w
obiektywie jest włączona, obraz może być
zniekształcony.

Wyłącz funkcję stabilizacji
obrazu w obiektywie.
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Obrót w poziomie/pionie

Objawy Przyczyna Rozwiązanie

Kąta widzenia uległ zmianie bez udziału
użytkownika.

Wystąpił efekt „oddychania” obiektywu.
Patrz „Kompensacja efektu
„oddychania” obiektywu”.

Nie można regulować ostrości, zoomu
ani przysłony.

Ustawienia przełączników na obiektywie
mogą być nieprawidłowe.

Patrz: „Sprawdzanie
przełączników obiektywu”.

Objawy Przyczyna Rozwiązanie

Nie można zresetować
obrotu w
poziomie/pionie.

Suwak blokady obrotu w
poziomie/pionie znajduje się w
położeniu LOCK.

Przestaw suwak blokady obrotu w
poziomie/pionie w położenie UNLOCK.

Kamera nie zatrzymuje
się w oczekiwanym
położeniu.

Blok kamery jest niewyważony.

Przesuń blok kamery do przodu/do tyłu do
odpowiedniego położenia, jak opisano w sekcji
„Mocowanie obiektywu”, a następnie ponownie
włącz urządzenie.

Zamocowany jest obiektyw, który nie
obsługuje funkcji obrotu w
poziomie/pionie.

Zapoznaj się z informacjami dotyczącymi
zgodności obiektywów i zamocuj obiektyw
obsługujący funkcję obrotu w poziomie/pionie, a
następnie włącz urządzenie ponownie.

Nie można zresetować obrotu w
poziomie/pionie.

Wykonaj resetowanie obrotu w poziomie/pionie
zgodnie z opisem w sekcji „Resetowanie obrotu w
poziomie/pionie”.

Do głowicy kamery została przyłożona
nieoczekiwana siła, co spowodowało
błąd sterowania obrotem w
poziomie/pionie.

Kamera nie powraca do
przodu po naciśnięciu
przycisku 
(położenie początkowe
obrotu w
poziomie/pionie).

Został włączony tryb mocowania
sufitowego.

W menu internetowym wybierz kolejno opcje
[Pan-Tilt] > [P/T Direction] > [Ceiling], zgodnie z
faktycznym sposobem instalacji, a następnie
włącz urządzenie ponownie. Po zamontowaniu na
suficie blok złączy znajduje się z przodu kamery.

Działanie funkcji obrotu
w poziomie/pionie jest
ograniczone.

Skonfigurowano ograniczenie zakresu
obrotu w poziomie/pionie.

W razie potrzeby należy usunąć ustawienia
ograniczenie zakresu obrotu w poziomie/pionie
zgodnie z opisem w sekcji „P/T Range Limit”.

Do głowicy kamery została przyłożona
nieoczekiwana siła, co spowodowało
błąd obrotu w poziomie/pionie.

Wykonaj resetowanie obrotu w poziomie/pionie
zgodnie z opisem w sekcji „Resetowanie obrotu w
poziomie/pionie”.

Operacja obrotu w
poziomie/pionie została
zrealizowana w
przeciwnym kierunku.

Ustawienie trybu mocowania
sufitowego nie odpowiada
faktycznemu sposobowi instalacji.

W menu internetowym wybierz kolejno opcje
[Pan-Tilt] > [P/T Direction] > [Ceiling], zgodnie z
faktycznym sposobem instalacji.

Zmieniono ustawienia związane z
kierunkiem obrotu w poziomie/pionie.

Sprawdź ustawienia [Pan-Tilt] > [P/T Direction] w
menu internetowym.
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Objawy Przyczyna Rozwiązanie

Obraz nie przesuwa się
płynnie na początku i
na końcu operacji
obrotu w
poziomie/pionie.

Ustawienie przyspieszenia/opóźnienia
operacji obrotu w poziomie/pionie jest
zbyt wysokie.

Zmniejsz ustawienie przyspieszenia/opóźnienia
operacji obrotu w poziomie/pionie, aby ruch na
początku i na końcu operacji obrotu w
poziomie/pionie był płynniejszy. W tym celu użyj
opcji [Pan-Tilt] > [P/T Acceleration] > [Ramp
Curve] w menu internetowym lub w menu kamery.
Pamiętaj, że osiągnięcie maksymalnej prędkości
przez obiektyw będzie trwało dłużej.

Operacja obrotu w
poziomie/pionie została
zatrzymana.

Blok kamery jest niewyważony.

Przesuń blok kamery do przodu/do tyłu do
odpowiedniego położenia, jak opisano w sekcji
„Mocowanie obiektywu”, a następnie ponownie
włącz urządzenie.

Ustawienie krzywej
narastania/opadania
(przyspieszenie/opóźnienie) jest zbyt
wysokie dla zamocowanego
obiektywu.

Jeśli zamocowany jest duży obiektyw, zmniejsz
wartość opcji [Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve] w menu internetowym lub w menu
kamery.

Używany jest duży obiektyw.
Skontaktuj się z pracownikiem pomocy
technicznej firmy Sony.

Urządzenie jest
zablokowane podczas
korzystania z funkcji
obrotu w
poziomie/pionie.

Dźwignia zaciskowa śruby mocującej
podstawę wspornika obiektywu uderza
w kamerę.

Obróć dźwignię zaciskową śruby mocującej
podstawę wspornika obiektywu tak, aby była
skierowana do góry.

Dźwignia zacisku wspornika obiektywu
uderza w kamerę.

Obróć dźwignię zaciskową wspornika obiektywu,
tak aby była skierowana do góry.

Dźwignia blokady głowicy kamery
uderza w kamerę.

Sprawdź, czy dźwignia blokady głowicy kamery
znajduje się w pełni w położeniu LOCK.

Podczas pracy w trybie
obrotu w
poziomie/pionie
występują nietypowe
odgłosy.

Kamera jest niewyważona.
Przesuń głowicę kamery do przodu/do tyłu do
odpowiedniego położenia, tak aby podstawa do
przesuwania była ustawiona poziomo.

Ustawienie krzywej
narastania/opadania
(przyspieszenie/opóźnienie) jest zbyt
wysokie dla zamocowanego
obiektywu.

Jeśli zamocowany jest duży obiektyw, zmniejsz
wartość opcji [Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve] w menu internetowym lub w menu
kamery.

Położenie głowicy kamery nie jest
zablokowane i podczas jej działania
słychać odgłosy przesuwania.

Przestaw dźwignię blokady głowicy kamery w
położenie LOCK.

Nie można zapisać
ustawienia wstępnego
położenia.

Ustawienia wstępnego nie można
zapisać, jeśli działa funkcja Clear
Image Zoom.

Ustaw współczynnik Clear Image Zoom z
powrotem na 1× (stan, w którym współczynnik nie
jest wyświetlany po prawej stronie pozycji 
(współczynnik powiększenia)).
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Nagrywanie/odtwarzanie

Objawy Przyczyna Rozwiązanie

Kadrowanie jest
przesunięte podczas
odtwarzania ustawienia
wstępnego położenia.

Temperatura otoczenia mogła ulec
znacznej zmianie między momentem
zapisania ustawienia wstępnego
położenia a momentem jego
odtworzenia.

Zapisz ustawienie wstępne położenia ponownie.

Kalibracja obiektywu nie jest
wykonywana.

Uruchom kalibrację za pomocą opcji [Technical] >
[Lens] > [Lens Calibration] w menu kamery.

Podłączony jest obiektyw inny niż ten,
który był podłączony podczas
zapisywania ustawienia wstępnego
położenia. Możliwe jest również, że
pozycja zoomu dla zoomu ręcznego
jest inna.

Zapisz ustawienie wstępne położenia ponownie.

Panel kadrowania w
aplikacji internetowej
jest wyszarzony i nie
można z niego
korzystać.

Funkcja obrotu w poziomie/pionie jest
niedostępna, gdy wyświetlany jest
ekran miniatur oraz gdy trwa
odtwarzanie.

Wyświetl ekran sterowania odtwarzaniem i wyjdź
z widoku ekranu miniatur lub zatrzymaj
odtwarzanie.

Funkcja obrotu w poziomie/pionie jest
niedostępna, gdy obraz z kamery nie
może być wyświetlany w aplikacji
internetowej.

Zapoznaj się z sekcją „Aplikacja internetowa” w
rozdziale „Rozwiązywanie problemów”.

Suwak blokady obrotu w
poziomie/pionie znajduje się w
położeniu LOCK.

Przestaw suwak blokady obrotu w
poziomie/pionie w położenie UNLOCK.

Poniżej panelu
kadrowania w aplikacji
internetowej
wyświetlany jest
komunikat „Execute
Pan-Tilt Reset”.

Do głowicy kamery została przyłożona
nieoczekiwana siła, co spowodowało
błąd obrotu w poziomie/pionie.

Wykonaj resetowanie obrotu w poziomie/pionie
zgodnie z opisem w sekcji „Resetowanie obrotu w
poziomie/pionie”.

Objawy Przyczyna Rozwiązanie

Nagrywanie nie rozpoczyna
się po naciśnięciu przycisku
START/STOP do obsługi
nagrywania.

Karta pamięci jest pełna.
Należy wymienić kartę pamięci na taką, na
której jest wystarczająco dużo miejsca.

Wymagane jest przywrócenie karty
pamięci.

Wykonaj operację przywracania karty pamięci
zgodnie z opisem w sekcji „Przywracanie kart
pamięci”.

Kontrolka nagrywania (lampka typu
Tally) jest skonfigurowana jako lampka
typu Tally, więc stan nagrywania nie
może być określony przy użyciu tej
kontrolki.

Skonfiguruj kontrolkę nagrywania (lampkę
typu Tally) tak, aby działała jako kontrolka
nagrywania zgodnie z opisem w sekcji
„Doprowadzanie sygnału lampki typu Tally”.
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Przesyłanie plików

Przesyłanie strumieniowe przy użyciu adresu IP

Objawy Przyczyna Rozwiązanie

Nie można nagrywać
dźwięku.

Mikrofon nie jest podłączony.
Podłącz mikrofon lub urządzenie audio do
złącza AUDIO IN na bloku złączy.

Ustawienie [Master Input Level] ma
wartość minimalną.

Dostosuj ustawienie [Master Input Level].

Nagrany dźwięk jest
zniekształcony.

Ustawienie poziomu sygnału
wejściowego audio jest zbyt wysokie.

Dostosuj ustawienia [CH1 Input Level] – [CH4
Input Level] oraz ustawienie [Master Input
Level].

W przypadku korzystania z mikrofonu w
głośnym otoczeniu, na przykład w miejscu z
muzyką na żywo, należy najpierw
dostosować opcje [AUDIO IN CH1 MIC Ref.] i
[AUDIO IN CH2 MIC Ref.].

Nagrany dźwięk ma wysoki
poziom szumów.

Ustawienie poziomu sygnału
wejściowego audio jest zbyt niskie.

Dostosuj ustawienia [Audio Input Level] oraz
[Audio] > [Audio] > [Audio Input] > [AUDIO IN
CH1 MIC Ref.] lub [AUDIO IN CH2 MIC Ref.]

Nie można odtwarzać
klipów.

Klip jest edytowany.

Klipy nie mogą być odtwarzane, jeśli
zmieniono nazwy plików lub folderów, lub jeśli
klip jest używany na komputerze. Nie stanowi
to wadliwego działania.

Klip został nagrany za pomocą kamery
innej niż to urządzenie.

Klipy nagrane za pomocą kamery innej niż to
urządzenie mogą nie być odtwarzane lub
mogą być wyświetlane w nieprawidłowym
rozmiarze. Nie stanowi to wadliwego
działania.

Objawy Przyczyna Rozwiązanie

Przesyłanie pliku kończy się
niepowodzeniem.

Nazwa użytkownika i hasło na
serwerze są niepoprawne.

Nazwa użytkownika i hasło na serwerze mogą
być niepoprawne. Wprowadź poprawne dane.
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Objawy Przyczyna Rozwiązanie

Przesyłanie strumieniowe
niedostępne.

Nazwa użytkownika lub hasło
wprowadzone w aplikacji
klienckiej w celu wyświetlania
danych przesyłanych
strumieniowo z urządzenia są
nieprawidłowe.

Jeśli format przesyłania strumieniowego w
urządzeniu jest ustawiony na [RTSP], [SRT-
Listener] lub [NDI|HX], konieczne jest
wprowadzenie nazwy użytkownika i hasła
ustawionych dla tego urządzenia w aplikacje
klienckiej. Wprowadź prawidłową nazwę
użytkownika i hasło.

Protokół przesyłania
strumieniowego nie jest
ustawiony.

Wybierz protokół docelowy za pomocą opcji
[Stream] > [Stream Setting] w menu
internetowym.

Ustawiono co najmniej sześć
sesji RTSP.

Ustaw liczbę sesji na pięć lub mniej.

Numer portu UDP nie jest
ustawiony prawidłowo.

Skonfiguruj numer portu i inne ustawienia
protokołu docelowego za pomocą opcji
[Stream] > [Stream] > [Stream Setting] w menu
internetowym.

Komunikacja przy użyciu
protokołu UDP jest
zablokowana.

Sprawdź ustawienia oprogramowania
zabezpieczającego.

Dźwięk nie jest przesyłany
strumieniowo.

Przesyłanie strumieniowe
dźwięku jest ustawione na
[Off].

Ustaw opcję [Stream] > [Audio Stream] >
[Setting] na [On] w menu internetowym.

Przesyłanie strumieniowe zostało
przerwane.

Ustawienia protokołu lub
kodeka przesyłania
strumieniowego zostały
zmienione podczas
przesyłania strumieniowego.

Skonfiguruj ustawienia protokołu i kodeka
przesyłania strumieniowego przed
rozpoczęciem przesyłania strumieniowego.

Nie można ustawić rozmiaru
obrazu dla strumienia [Video
Stream 1] na 4096×2160 lub
3840×2160.

Rozmiar obrazu jest ustawiony
na 1920×1080, gdy dla opcji
[Output Format] wybrano
ustawienie HDMI.

Dla przesyłania strumieniowego nie można
ustawić rozmiaru obrazu wyższego niż rozmiar
obrazu HDMI. Zmień rozmiar obrazu HDMI za
pomocą opcji [Monitoring] > [Output Format] w
menu internetowym.

Nie można ustawić szybkości
klatek dla strumienia [Video
Stream 1] na 60 kl./s lub 50 kl./s.

Szybkość klatek dla
przesyłania strumieniowego
jest ustawiona na 29.97 lub
niższą wartość.

Szybkość klatek używana przy przesyłaniu
strumieniowym jest ograniczona przez
częstotliwość systemu. Zmień częstotliwość
systemu za pomocą opcji [Rec Format] >
[Frequency] w menu internetowym.

Nie można uzyskać dostępu do
strumienia [Video Stream 3].

Strumień [Video Stream 3] nie
obsługuje protokołów
RTSP/SRT/NDI.

Użyj strumienia [Video Stream 1] lub [Video
Stream 2].

Ekran RTSP/SRT nie jest
prawidłowo
aktualizowany/wyświetlany.

Numer portu używany przez
protokół RTSP lub SRT jest
filtrowany lub blokowany.

Zmień numer portu RTSP lub SRT na numer
portu, który nie jest filtrowany ani blokowany
przez urządzenia odbierające strumień.
Możesz także zmienić numer portu używany w
urządzeniu do obsługi protokołu RTSP lub
SRT.
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Połączenie z urządzeniami zewnętrznymi

Synchronizacja zewnętrzna

Tally

Objawy Przyczyna Rozwiązanie

Obraz jest zniekształcony lub
zacina się.

Informacje wizualne nie są
prawidłowo przesyłane ze
względu na przeciążenie
ścieżki komunikacji.

Zmniejsz szybkość transmisji strumieniowej
lub ustaw kodek [Video Stream 2] ([Codec 2])
na [Off], aby utworzyć rezerwę w paśmie
komunikacyjnym.

Kolejność pakietów wideo w
kanale komunikacyjnym uległa
zmianie.

Korzystaj z usług tego samego dostawcy usług
internetowych zarówno po stronie urządzenia,
jak i po stronie odbiornika.

Nie wykryto urządzenia NDI.
Protokół przesyłania
strumieniowego nie jest
ustawiony na NDI|HX.

Aby urządzenie było wykrywane jako
urządzenie NDI, protokół przesyłania
strumieniowego musi być ustawiony na
NDI|HX. Ustaw opcję [Stream] > [Stream
Setting] na [NDI|HX] w menu internetowym.

Urządzenie nie może być używane
jako urządzenie NDI.

Licencja NDI|HX nie jest
zainstalowana.

Zainstaluj licencję NDI|HX. Możesz sprawdzić,
czy licencja NDI|HX jest zainstalowana,
korzystając z opcji [Stream] > [Stream] >
[Stream Setting] > [NDI|HX] > [License] w
menu internetowym.

Objawy Przyczyna Rozwiązanie

Nie można
zsynchronizować ze
źródłem zewnętrznym.

Zewnętrzny sygnał synchronizacji
odpowiedni dla skonfigurowanego
formatu sygnału wideo nie jest
doprowadzany.

Doprowadź zewnętrzny sygnał synchronizacji
odpowiedniego dla skonfigurowanego formatu
sygnału wideo.

Urządzenie ma dwa rezystory
zakończeniowe.

Urządzenie jest wyposażone we wbudowany
rezystor zakończeniowy 75 Ω. Podłącz
bezpośrednio do źródła sygnału (1 do 1) lub
użyj rozdzielacza.

Objawy Przyczyna Rozwiązanie

Lampka typu
Tally nie
świeci się.

Jasność lampki typu Tally jest ustawiona
na Off.

Ustaw odpowiednią jasność za pomocą opcji [Technical]
> [Tally] > [Tally Lamp Brightness] w menu internetowym.

Kontrolka nagrywania (lampka typu Tally)
jest skonfigurowana jako kontrolka
nagrywania.

Skonfiguruj kontrolkę nagrywania (lampkę typu Tally) tak,
aby działała jako lampka typu Tally zgodnie z opisem w
sekcji „Doprowadzanie sygnału lampki typu Tally”.

Pilot zdalnego sterowania RM-IP500 jest
podłączony, a funkcja komunikacji
VISCA over IP jest wyłączona.

Przestaw przełącznik 3 w sekcji SETUP na bloku złączy
urządzenia w położenie ON.

Połączenie ze złączem OPTION jest
nieprawidłowe lub styk docelowy nie jest
zwarty z masą (GND).

Zewrzyj styk 7 lub styk 8 złącza OPTION z masą (GND),
jak opisano w sekcji „Doprowadzanie sygnału lampki typu
Tally”.
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Sterownik obiektywu

Powiązany temat

Wyprowadzanie sygnału światłowodowego

Blok złączy

Kompensacja efektu „oddychania” obiektywu

Sprawdzanie przełączników obiektywu

Mocowanie obiektywu

Resetowanie obrotu w poziomie/pionie

P/T Range Limit

Przywracanie kart pamięci

Doprowadzanie sygnału lampki typu Tally

5-041-958-33(1) Copyright 2022 Sony Corporation

Objawy Przyczyna Rozwiązanie

W pozycji  (stan kamery)
wyświetlany jest komunikat
[Communication Error].

Kamera nie może
komunikować się ze
sterownikiem
obiektywu.

Sprawdź połączenie między urządzeniem a sterownikiem
obiektywu, wyłącz zasilanie urządzenia oraz sterownika
obiektywu, a następnie włącz ponownie.

W pozycji  (stan kamery)
wyświetlany jest komunikat
[Rotation Error].

W sterowniku
obiektywu wystąpił
błąd obrotu.

Zapisany zakres ruchu sterowania zoomem i zakres ruchu
obiektywu mogą nie być zgodne. Zainicjuj sterownik
obiektywu.
Jeśli problem będzie się powtarzał, skontaktuj się z
przedstawicielem producenta sterownika obiektywu.

W pozycji  (stan kamery)
wyświetlany jest komunikat
[System Error].

W sterowniku
obiektywu wystąpił
błąd systemu.

Sprawdź połączenie między urządzeniem a sterownikiem
obiektywu, zapoznaj się z instrukcją obsługi sterownika
obiektywu i zainicjuj sterownik obiektywu lub wyłącz zasilanie
urządzenia i sterownika obiektywu, a następnie włącz
ponownie.
Jeśli problem będzie się powtarzał, skontaktuj się z
przedstawicielem producenta sterownika obiektywu.

W pozycji  (stan kamery)
wyświetlany jest komunikat
[Unknown Error].

Wystąpił nieznany błąd
w sterowniku
obiektywu.

Sprawdź połączenie między urządzeniem a sterownikiem
obiektywu, zapoznaj się z instrukcją obsługi sterownika
obiektywu i zainicjuj sterownik obiektywu lub wyłącz zasilanie
urządzenia i sterownika obiektywu, a następnie włącz
ponownie.
Jeśli problem będzie się powtarzał, skontaktuj się z
przedstawicielem producenta sterownika obiektywu.
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Komunikaty o błędach / komunikaty ostrzegawcze

Jeśli w urządzeniu wystąpi stan ostrzegawczy lub wymagający uwagi albo stan pracy wymagający potwierdzenia, w
panelu obrazu z kamery zostanie wyświetlony komunikat, na panelu przednim zaświeci się kontrolka POWER i kontrolka
NETWORK, a kontrolka nagrywania (lampka typu Tally) zacznie migać.

Uwaga

Wskazywanie za pomocą migającej kontrolki nagrywania (lampki typu Tally) jest włączone tylko wtedy, gdy w menu internetowym
lub w menu kamery wybrano ustawienie [Internal] dla opcji [Technical] > [Tally] > [Tally Control], a opcja [Tally Lamp Brightness]
nie jest ustawiona na [Off].

Komunikaty o błędach

Jeśli kontrolka POWER i kontrolka NETWORK migają w sposób opisany poniżej, wykonaj następujące działania.

Urządzenie przestanie działać w przypadku wyświetlenia podanych poniżej komunikatów.

Komunikaty ostrzegawcze

W przypadku pojawienia się jednego z poniższych komunikatów należy postępować zgodnie z podanymi instrukcjami.

Kontrolka
POWER

Kontrolka
NETWORK Przyczyna i rozwiązanie

Miga powoli na
pomarańczowo

Miga powoli
na zielono

Urządzenie nie może działać normalnie. Szczegółowe informacje są dostępne w
sekcji [Maintenance] > [System Log] w menu internetowym. Jeśli problem nie
ustąpi nawet po przełączeniu urządzenia do trybu gotowości lub wyłączeniu i
ponownym włączeniu zasilania, należy skontaktować się z przedstawicielem
serwisu firmy Sony.

Miga szybko na
pomarańczowo

Miga szybko
na zielono

W urządzeniu wystąpiła usterka. Należy skontaktować się z przedstawicielem
serwisu firmy Sony.

Wyświetlany
komunikat

Kontrolka
nagrywania

(lampka typu
Tally)

Przyczyna i rozwiązanie

E + kod błędu Miga szybko

Wskazuje nieprawidłowe działanie urządzenia. Nagrywanie zostanie
zatrzymane, nawet jeśli w panelu obrazu z kamery wyświetlany jest symbol
●REC.
Należy wyłączyć urządzenie i sprawdzić, czy nie ma problemów z podłączonymi
urządzeniami, kablami lub nośnikami. Jeśli błąd nadal występuje po ponownym
włączeniu urządzenia, należy skontaktować się z przedstawicielem serwisu
firmy Sony. W zależności od stanu urządzenia może nie być wyświetlany
komunikat o błędzie ani emitowany dźwiękowy sygnał ostrzegawczy.
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Wyświetlany
komunikat

Kontrolka nagrywania
(lampka typu Tally) Przyczyna i rozwiązanie

Temperature High Miga
Temperatura wewnętrzna jest wysoka.
Należy wyłączyć kamerę i przed ponownym użyciem
odczekać, aż jej temperatura się obniży.

Media Temperature
High

Miga
Temperatura karty CFexpress jest wysoka.
Należy wymienić kartę lub przed ponownym użyciem
odczekać, aż jej temperatura się obniży.

Voltage Low Miga Napięcie DC IN jest niskie (poziom 1). Należy sprawdzić źródło
zasilania.

Insufficient Voltage Miga szybko
Napięcie DC IN jest zbyt niskie (poziom 2). Możliwość
nagrywania jest wyłączona.
Należy podłączyć inne źródło zasilania.

Media Near Full Miga
Pozostała pojemność karty pamięci jest niska.
Należy wymienić kartę jak najszybciej.

Media Full Miga szybko
Nie można nagrywać ani kopiować klipów, ponieważ na karcie
pamięci nie ma już wolnego miejsca.
Należy natychmiast wymienić kartę.

Clips Near Full Miga
Liczba dodatkowych klipów, które można zapisać na karcie
pamięci, jest niska.
Należy wymienić kartę jak najszybciej.

Clips Full Miga szybko

Osiągnięto maksymalną liczbę klipów, które można zapisać na
karcie pamięci.
Nie można nagrać ani skopiować kolejnych klipów. Należy
natychmiast wymienić kartę.

Last Clip Recording Miga
Aktualnie nagrywany klip jest ostatnim klipem, który można
zapisać, ponieważ osiągnięto maksymalną liczbę klipów.
Należy przygotować nową kartę pamięci.

Media(A) Life Near
End1) Miga

Zbliża się koniec okresu eksploatacji karty pamięci. Należy
wymienić kartę jak najszybciej.

Media(A) Life End1) Miga szybko
Okres eksploatacji karty pamięci dobiegł końca. Należy
natychmiast wymienić kartę.

Media(A) Near Full1) Miga W przypadku korzystania z funkcji Simul Rec

Media(A) Full1) Miga szybko W przypadku korzystania z funkcji Simul Rec

Media(A) Clips Near
Full1) Miga W przypadku korzystania z funkcji Simul Rec

Media(A) Clips Full1) Miga szybko W przypadku korzystania z funkcji Simul Rec

Media(A) Last Clip
Rec1) Miga W przypadku korzystania z funkcji Simul Rec

(Wskaźnik nie jest
wyświetlany)

Miga

Wystąpił nieznany błąd w sterowniku obiektywu.
Sprawdź stan kamery w aplikacji internetowej.
Szczegółowe informacje można znaleźć w dzienniku
systemowym w aplikacji internetowej.
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Komunikaty o stanie wymagającym uwagi oraz komunikaty o stanie pracy

Podane poniżej komunikaty o stanie wymagającym uwagi oraz komunikaty o stanie pracy mogą być wyświetlane
pośrodku ekranu. Aby rozwiązać problem, należy postępować zgodnie z podanymi instrukcjami.

W przypadku karty w gnieździe B wyświetlany jest symbol „(B)”.1)

Wyświetlany komunikat Przyczyna i rozwiązanie

Backup Battery End
Please Change

Pozostała pojemność akumulatora rezerwowego jest niewystarczająca.
Podłącz urządzenie do zasilania na co najmniej 24 godziny, aby naładować
akumulator rezerwowy.

Unknown Media(A)1)

Please Change

Została włożona karta pamięci, która została podzielona na partycje, lub karta
pamięci zawierająca liczbę klipów większą niż obsługiwana przez urządzenie.
Karty nie można używać w urządzeniu i należy ją wymienić.

Cannot Use Media(A)1)

Unsupported File System

Została włożona karta korzystająca z innego systemu plików lub
niesformatowana.
Karty nie można używać w urządzeniu i należy ją wymienić lub sformatować
przy użyciu urządzenia.

Media Error
Media(A) Needs to be Restored1)

Wystąpił błąd na karcie pamięci i należy wykonać operację jej przywrócenia.
Należy wykonać operację przywracania karty pamięci.

Media Error
Cannot Record to Media(A)1)

Karta pamięci może być uszkodzona i nie można jej już używać do
nagrywania.
Odtwarzanie jest możliwe, więc zaleca się wykonanie kopii i wymianę karty
pamięci.

Media Error
Cannot Use Media(A)1)

Karta pamięci może być uszkodzona i nie można jej już używać do
nagrywania i odtwarzania.
Karty nie można używać w urządzeniu i należy ją wymienić.

Media(A) Error1)

Recording Halted
Playback Halted

Operacje nagrywania i odtwarzania zostały zatrzymane, ponieważ wystąpił
błąd podczas korzystania z karty pamięci.
Jeśli problem nie ustąpi, należy wymienić kartę pamięci.

Media Reached Rewriting Limit
Change Media(A)1)

Okres eksploatacji karty pamięci dobiegł końca.
Należy wykonać kopię zapasową i natychmiast wymień kartę. Jeśli będzie się
nadal korzystać z karty, odtwarzanie z karty lub nagrywanie na niej może nie
być możliwe.
Szczegółowe informacje można znaleźć w instrukcji obsługi karty pamięci.

The specified address is invalid.
Podany adres jest nieprawidłowy.
Należy sprawdzić, czy ustawienie jest prawidłowe.

Cannot Use Specified Port Number
Podany numer portu jest nieprawidłowy.
Należy sprawdzić, czy ustawienie jest prawidłowe.

Lens I/F Error(xx:xx)

Wykryto błąd obiektywu podczas komunikacji przez interfejs obiektywu po
zamocowaniu obiektywu z mocowaniem typu E.
Należy sprawdzić stan połączenia z obiektywem z mocowaniem typu E.
Jeśli problem nie ustąpi, należy skontaktować się z przedstawicielem serwisu
firmy Sony i podać kod błędu (pięć znaków w nawiasach).

Cannot add auto upload job of Proxy
file because maximum number of
upload jobs was reached.

Osiągnięto maksymalną liczbę zadań transferu.
Należy usunąć niepotrzebne zadania. Ustawienie miejsca docelowego
automatycznego przesyłania plików nagrywania pomocniczego może również
być nieprawidłowe. Należy sprawdzić, czy ustawienie jest prawidłowe.
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Informacje o błędach przesyłania strumieniowego RTMP

Na urządzeniu mogą być wyświetlane następujące informacje o błędach. W razie potrzeby wykonaj następujące
czynności.

Informacje o błędach przesyłania strumieniowego SRT

Na urządzeniu mogą być wyświetlane następujące informacje o błędach. W razie potrzeby wykonaj następujące
czynności.

Wyświetlany komunikat Przyczyna i rozwiązanie

Fan Stopped

Wentylator przestał działać.
Należy sprawdzić, czy nie ma kurzu lub ciał obcych.
Jeśli błąd nadal występuje po usunięciu kurzu i ciał obcych, należy
skontaktować się z przedstawicielem serwisu firmy Sony.

W przypadku karty w gnieździe B wyświetlany jest symbol „(B)”.1)

Kod błędu
Opis Rozwiązanie

RTMP RTMPS

1002
1004

2002
2004

Nie można połączyć się z serwerem
RTMP.

Sprawdź, czy ustawienie adresu URL serwera jest
prawidłowe.
Sprawdź połączenie sieciowe.

1003 2003
Nie można rozpoznać nazwy
domeny.

Sprawdź, czy ustawienie adresu URL serwera jest
prawidłowe.
Sprawdź połączenie z serwerem DNS.

–
2005
2008

Błąd CRL

Sprawdź, czy ustawienie adresu URL serwera jest
prawidłowe.
Sprawdź, czy miejsce docelowe połączenia jest zaufaną
witryną.

2006 Błąd certyfikatu CA
Sprawdź, czy ustawienie zegara jest prawidłowe.
Sprawdź, czy certyfikat CA jest prawidłowy.

– 2007

Certyfikat CA nie jest
zainstalowany.
Błąd uwierzytelniania certyfikatu
serwera.

Zainstaluj certyfikat CA.
Sprawdź, czy miejsce docelowe połączenia jest zaufaną
witryną.

4002 Nastąpiło rozłączenie sesji RTMP.

Urządzenie mogło zostać odłączone po stronie serwera
RTMP.
Sprawdź, czy ustawienia są zgodne z zalecanymi
parametrami kodeka usługi.

4003
Jakość połączenia sieciowego jest
niska.

Sprawdź połączenie sieciowe.

Inne Inne błędy.
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Kod
błędu

Opis Rozwiązanie
SRT-
Caller

1001 Nieoczekiwany błąd
Urządzenie może nie działać prawidłowo. Wyłącz zasilanie
urządzenia, a następnie włącz ponownie.

1002
Komunikacja przerwana z powodu
zmiany ustawień

Komunikacja została przerwana ze względu na zmianę ustawień.
Nawiąż ponownie połączenie.

5001 Nieoczekiwany błąd Urządzenie może nie działać prawidłowo. Wyłącz zasilanie
urządzenia, a następnie włącz ponownie.

5005 Błąd połączenia
Sprawdź, czy ustawienie miejsca docelowego połączenia jest
prawidłowe.

5006 Błąd szyfrowania Sprawdź, czy ustawienie szyfrowania jest prawidłowe.

5007 Nieoczekiwany błąd Urządzenie może nie działać prawidłowo. Wyłącz zasilanie
urządzenia, a następnie włącz ponownie.5008 Nieoczekiwany błąd

5009 Błąd transmisji
Urządzenie zostało odłączone podczas komunikacji.
Sprawdź połączenie sieciowe.
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Lista pozycji menu

W poniższych tabelach przedstawiono pozycje menu urządzenia.

Legenda
„menu kamery” i „menu internetowe”
●: pozycja dostępna
▲: niektóre pozycje są dostępne
–: pozycja niedostępna

„All File” i „Scene File”
Tak: pozycja zapisywana w pliku ALL lub pliku sceny
Nie: pozycja nie jest zapisywana

„All Reset (except for Network Settings)”
Po uruchomieniu funkcji [Reset]> [Reset] > [All Reset (except for Network Settings)] w menu internetowym:
Tak: inicjowana pozycja (z wyłączeniem ustawień sieciowych)
Nie: nie ma zastosowania

„Network Reset”
Po uruchomieniu funkcji [Reset]> [Reset] > [Network Reset] w menu internetowym:
Tak: inicjowana pozycja (ustawienia sieciowe)
Nie: nie ma zastosowania

„Factory Default”
Tak: przywrócenie domyślnego ustawienia fabrycznego pozycji
Nie: nie ma zastosowania

Shooting

Pozycja
(poziom 2)

Menu
kamery

Menu
internetowe

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ● – Tak Tak Tak Tak Tak

ND Filter ● – Tak Tak*1 Tak Nie Tak

Shutter ● – Tak Tak Tak Nie Tak

Iris ● – Tak Tak Tak Nie Tak

Auto Exposure ● – Tak Tak*2 Tak Nie Tak

White ● – Tak Tak*3 Tak Nie Tak

White Setting ● – Tak Nie Tak Nie Tak

Offset White ● – Tak Nie Tak Nie Tak

Focus ● ▲ Tak Nie Tak Nie Tak

S&Q Motion ● – Tak Nie Tak Nie Tak
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Project

Paint/Look

Pozycja
(poziom 2)

Menu
kamery

Menu
internetowe

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

LUT On/Off ● – Tak Nie Tak Nie Tak

Noise
Suppression

● – Tak Tak Tak Nie Tak

Flicker Reduce ● – Tak Nie Tak Nie Tak

SteadyShot ● – Tak Nie Tak Nie Tak

[Mode] nie ma zastosowania*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] nie ma zastosowania*2

[Preset White] nie ma zastosowania*3

Pozycja
(poziom 2)

Menu
kamery

Menu
internetowe

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Base Setting ● ● Tak Nie Tak Nie Tak

Rec Format ● ● Tak Nie Tak*1 Nie Tak

Cine
EI/Flex.ISO Set

● – Tak Nie Tak Nie Tak

Simul Rec ● ● Tak Nie Tak Nie Tak

Proxy Rec ● ▲ Tak Nie Tak Nie Tak

Interval Rec ● ● Tak*2 Nie Tak Nie Tak

Picture Cache
Rec

● ● Tak*2 Nie Tak Nie Tak

SDI/HDMI Rec
Control

● – Tak Nie Tak Nie Tak

Assignable
Button

● – Tak Nie Tak Nie Tak

All File – ● Nie Nie Nie Nie Nie

[Frequency] nie ma zastosowania*1

[Setting] nie ma zastosowania*2

Pozycja
(poziom 2)

Menu
kamery

Menu
internetowe

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Scene File ● – Nie Nie Nie Nie Nie

Base Look ● ▲ Tak*1 Nie Tak*1 Nie Tak*1

Reset Paint
Settings

● – Nie Nie Nie Nie Nie
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Pan-Tilt

TC/Media

Pozycja
(poziom 2)

Menu
kamery

Menu
internetowe

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Black ● – Tak Tak Tak Nie Tak

Knee ● – Tak Tak Tak Nie Tak

Detail ● – Tak Nie Tak Nie Tak

Matrix ● – Tak Tak Tak Nie Tak

Multi Matrix ● – Tak*2 Tak*2 Tak Nie Tak

Dane LUT importowane jako wygląd podstawowy nie mają zastosowania*1

[Axis] nie ma zastosowania*2

Pozycja
(poziom 2)

Menu
kamery

Menu
internetowe

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

P/T Speed – ● Nie Nie Tak Nie Nie

P/T
Acceleration

● ● Nie Nie Tak Nie Nie

P/T Range
Limit

– ● Nie Nie Tak Nie Nie

P/T Direction – ● Nie Nie Tak Nie Nie

P/T Preset – ● Nie Nie Tak Nie Nie

Pozycja
(poziom 2)

Menu
kamery

Menu
internetowe

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Timecode ● – Tak*1 Nie Tak Nie Tak

TC Display ● – Tak Nie Tak Nie Tak

Users Bit ● – Tak*1 Nie Tak Nie Tak

HDMI TC
Out

● – Tak Nie Tak Nie Tak

Clip Name
Format

● – *2 Nie Tak Nie Tak

Update
Media

● – Nie Nie Nie Nie Nie

Format
Media

● – Nie Nie Nie Nie Nie

Media Life ● – Nie Nie Nie Nie Nie

[Setting] nie ma zastosowania*1
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Monitoring

Audio

Thumbnail

Technical

[Auto Naming] ma zastosowanie, [Camera ID] nie ma zastosowania*2

Pozycja
(poziom 2)

Menu
kamery

Menu
internetowe

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Output
Format ● ● Tak Nie Tak Nie Tak

Output
Display

– ● Tak Nie Tak Nie Tak

Display
On/Off

● – Tak Nie Tak Nie Tak

Video Signal
Monitor

● – Tak Nie Tak Nie Tak

Marker ● – Tak Nie Tak Nie Tak

Pozycja
(poziom

2)

Menu
kamery

Menu
internetowe

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Audio
Input

● ▲ Tak Nie Tak Nie Tak

Audio
Output

● ▲ Tak Nie Tak Nie Tak

Pozycja
(poziom 2)

Menu
kamery

Menu
internetowe

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Display Clip
Properties

● – Nie Nie Nie Nie Nie

Set Clip Flag ● – Nie Nie Nie Nie Nie

Lock/Unlock
Clip

● – Nie Nie Nie Nie Nie

Delete Clip ● – Nie Nie Nie Nie Nie

Transfer Clip ● – Nie Nie Nie Nie Nie

Transfer Clip
(Proxy)

● – Nie Nie Nie Nie Nie

Filter Clips ● – Nie Nie Nie Nie Nie

Customize View ● – Tak Nie Tak Nie Tak
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Network

Stream

Pozycja
(poziom

2)

Menu
kamery

Menu
internetowe

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Color
Bars

● – *1 Nie *1 Nie Tak

Genlock ● – Nie Nie Nie Nie Nie

Tally ● ● Tak Nie Tak Nie Tak

Rec
Review

● – Tak Nie Tak Nie Tak

Zoom ● – Tak Nie Tak Nie Tak

IR
Remote

– ● Nie Nie Tak Nie Tak

Lens ● – Tak Nie Tak Nie Tak

APR ● – Nie Nie Nie Nie Nie

[Type] ma zastosowanie, [Setting] nie ma zastosowania*1

Pozycja
(poziom 2)

Menu
kamery

Menu
internetowe

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Camera Name – ● Nie Nie Nie Nie Tak

User – ● Nie Nie Nie Tak Tak

Wired LAN*1 ▲ ● Nie Nie Nie Tak Nie

File Transfer ● ▲ Tak Nie Tak Tak Tak

FTP Server 1 – ● Nie Nie Tak Nie Tak

FTP Server 2 – ● Nie Nie Tak Nie Tak

FTP Server 3 – ● Nie Nie Tak Nie Tak

SSL – ● Nie Nie Nie Tak Tak

Referer Check – ● Nie Nie Nie Tak Tak

Brute Force
Attack Protection

– ● Nie Nie Nie Tak Tak

Brak możliwości konfiguracji za pomocą menu kamery (tylko wyświetlanie)*1

Pozycja
(poziom 2)

Menu
kamery

Menu
internetowe

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Stream
Setting

– ● Nie Nie Tak*1 Nie Tak*1
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Maintenance
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Pozycja
(poziom 2)

Menu
kamery

Menu
internetowe

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Video
Stream

– ● Tak Nie Tak Nie Tak

Audio
Stream

– ● Tak Nie Tak Nie Tak

Opcja [NDI|HX] > [License] nie ma zastosowania*1

Pozycja
(poziom 2)

Menu
kamery

Menu
internetowe

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Language ● ● Tak Nie Tak Nie Tak

Accessibility – ● Tak Nie Nie Nie Tak

Clock Set ● ● Tak*1 Nie Tak*2 Nie Tak

Reset – ● Nie Nie Nie Nie Nie

Hours Meter ● – Nie Nie Nie Nie Nie

Information – ● Nie Nie Nie Nie Nie

System Log – ● Nie Nie Nie Nie Tak

HTTP Access
Log

– ● Nie Nie Nie Nie Tak

Service – ● Nie Nie Nie Nie Nie

EULA – ● Nie Nie Nie Nie Nie

Software – ● Nie Nie Nie Nie Nie

Informacje o dacie i godzinie nie mają zastosowania*1

[Time Zone], data i godzina nie ma zastosowania*2
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Zapisane ustawienia wstępne położenia

„Tak” wskazuje zapisywane ustawienie wstępne położenia, a „Nie” oznacza ustawienie, które nie jest zapisywane.

Ustawienia obrotu w poziomie/pionie

Ustawienia zoomu

Ustawienia regulacji ostrości

Miejsce wyświetlania Pozycja Możliwość
zapisania

Panel kadrowania na ekranie sterowania w czasie
rzeczywistym

Kąt obrotu w poziomie/pionie Tak

[Pan-Tilt Speed] Nie

[Pan-Tilt] w menu internetowym

[P/T Speed] Nie

[P/T Acceleration] Nie

[P/T Range Limit] Nie

[P/T Direction] Nie

[P/T Preset] > [Pan-Tilt] Nie

[P/T Preset] > [Default] > [Pan-Tilt
Speed] Tak1)

Podczas zapisywania wstępnego położenia wartości ustawień są zapisywane jako wartości danego wstępnego położenia. Po zapisaniu wartości
można je zmienić dla każdego ustawienia wstępnego położenia. Szczegółowe informacje na ten temat podano w sekcji „Zmienianie szybkości
przejścia (obrót w poziomie/pionie, zoom, ostrość) w odniesieniu do ustawień wstępnych położenia za pomocą aplikacji internetowej”.

1)

Miejsce wyświetlania Pozycja Możliwość
zapisania

Panel kadrowania na ekranie sterowania w czasie
rzeczywistym

Pozycja zoomu (odległość
ogniskowania)

Tak

[Zoom Speed] Nie

[Pan-Tilt] > [P/T Preset] > [Default] w menu
internetowym

[Zoom Sync] Tak1)

[Zoom Speed] Tak1)

[Technical] > [Zoom] w menu kamery [Zoom Type] Nie

Podczas zapisywania wstępnego położenia wartości ustawień są zapisywane jako wartości danego wstępnego położenia. Po zapisaniu wartości
można je zmienić dla każdego ustawienia wstępnego położenia. Szczegółowe informacje na ten temat podano w sekcji „Zmienianie szybkości
przejścia (obrót w poziomie/pionie, zoom, ostrość) w odniesieniu do ustawień wstępnych położenia za pomocą aplikacji internetowej”.

1)
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Powiązany temat

Zmienianie szybkości przejścia (obrót w poziomie/pionie, zoom, ostrość) podczas przywracania ustawienia
wstępnego położenia

5-041-958-33(1) Copyright 2022 Sony Corporation

Miejsce wyświetlania Pozycja Możliwość
zapisania

Panel obrazu z kamery na ekranie
sterowania w czasie rzeczywistym

Śledzony obiekt określony dla trybu AF ze śledzeniem
w czasie rzeczywistym

Nie

Określone współrzędne dla punktowej regulacji ostrości Nie

Karta  (Focus) na ekranie sterowania
w czasie rzeczywistym

Przełącznik [Touch Focus] Nie

Przełącznik [Auto Focus] Tak

Stan przycisku [Focus Hold] Nie

Stan przycisku [Push AF/MF] Nie

[Face/Eye Detection AF] Tak

[AF Subj. Shift Sens.] Tak

[AF Transition Speed] Tak

Położenie obszaru ustawiania ostrości Tak1)

[Shooting] > [Focus] w menu
internetowym

[Push AF Mode] (w tym ustawienia za pomocą
przycisków konfigurowalnych)

Nie

[Touch Function in MF] Nie

[AF Assist Control] Nie

[Pan-Tilt] > [P/T Preset] > [Default] w
menu internetowym

[Focus Recall] Tak2)

[MF Speed] Tak2)

[Shooting] > [Focus] w menu kamery

Rozmiar i położenie obszaru ustawiania ostrości
skonfigurowane za pomocą opcji [Focus Area]

Tak

Położenie obszaru ustawiania ostrości skonfigurowane
za pomocą opcji [Focus Area (AF-S)]

Tak

Ustawienie nie jest przywracane, gdy przełącznik [Auto Focus] jest ustawiony w położeniu włączonym. Jest przywracane w przypadku
ustawienia go w położeniu wyłączonym.

1)

Podczas zapisywania wstępnego położenia wartości ustawień są zapisywane jako wartości danego wstępnego położenia. Po zapisaniu wartości
można je zmienić dla każdego ustawienia wstępnego położenia. Szczegółowe informacje na ten temat podano w sekcji „Zmienianie szybkości
przejścia (obrót w poziomie/pionie, zoom, ostrość) podczas przywracania ustawienia wstępnego położenia”.

2)

509



Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Schematy blokowe

Audio Input

Audio Output

5-041-958-33(1) Copyright 2022 Sony Corporation
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Aktualizacja oprogramowania obiektywu z mocowaniem typu E

Oprogramowanie obiektywu z mocowaniem typu E można aktualizować przy użyciu tego urządzenia.
Informacje o obiektywach z możliwością aktualizacji i odpowiednie oprogramowanie można znaleźć na stronie
internetowej odpowiedniego obiektywu.
Oprogramowanie jest aktualizowane za pomocą menu internetowego.

Uwaga

Nie wykonuj podanych poniżej czynności do czasu zakończenia aktualizacji.

Odłączanie od sieci
Odłączanie obiektywu
Wyłączanie zasilania

Jeśli zostanie wyświetlony komunikat informujący, że aktualizacja się nie powiodła, sprawdź wyświetlany opis i spróbuj
zaktualizować ponownie.

5-041-958-33(1) Copyright 2022 Sony Corporation

Podłącz obiektyw z mocowaniem typu E do urządzenia.1

W menu internetowym wybierz kolejno opcje [Maintenance] > [Information] > [Lens] > [Model Name] i
[Version Number].

Numer wersji oprogramowania obiektywu z mocowaniem typu E jest wyświetlany z boku.
Sprawdź numer wersji oprogramowania, a następnie w razie potrzeby zaktualizuj oprogramowanie.

2

Pobierz plik aktualizacji oprogramowania obiektywu dla systemu Windows (rozszerzenie .exe) do
urządzenia z uruchomioną aplikacją internetową.

3

W obszarze [Maintenance] > [Information] > [Lens] > [Version Up] naciśnij przycisk [Choose File] i wybierz
pobrany plik aktualizacji.

4

Postępuj zgodnie z instrukcjami wyświetlanymi na ekranie.5
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Mocowanie osłony przycisku zwalniania obiektywu

Można zapobiec przypadkowemu odłączeniu obiektywu, mocując osłonę przycisku zwalniania obiektywu dostarczoną
wraz z uchwytem sufitowym CIB-PCM1 (opcja) do przycisku zwalniania obiektywu.

Uwaga

Nie zabezpiecza to przed pełnym odłączeniem obiektywu.

Powiązany temat

Mocowanie obiektywu

Zamocuj obiektyw.

Szczegółowe informacje na temat mocowania obiektywu podano w sekcji „Mocowanie obiektywu”.

1

Przestaw suwak blokady obrotu w poziomie/pionie w położenie LOCK, aby zablokować obrót głowicy
kamery w poziomie/pionie.

2

Przesuń blok kamery w położenie umożliwiające zamocowanie osłony przycisku zwalniania obiektywu.3

Załóż osłonę przycisku zwalniania obiektywu tak, aby zakryła przycisk zwalniania obiektywu.4

Zamocuj osłonę przycisku zwalniania obiektywu za pomocą wkrętu mocującego osłonę przycisku
zwalniania obiektywu.

5
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Licencje

Licencja MPEG-4 AVC Patent Portfolio

TEN PRODUKT JEST LICENCJONOWANY NA PODSTAWIE LICENCJI AVC PATENT PORTFOLIO DO UŻYTKU
OSOBISTEGO KONSUMENTA LUB DO INNYCH ZASTOSOWAŃ, W KTÓRYCH NIE OTRZYMUJE SIĘ
WYNAGRODZENIA, W CELU:
(i) KODOWANIA WIDEO ZGODNIE ZE STANDARDEM AVC („WIDEO AVC”) I/LUB
(ii) DEKODOWANIA WIDEO AVC, KTÓRE ZOSTAŁO ZAKODOWANE PRZEZ KONSUMENTA W RAMACH
DZIAŁALNOŚCI OSOBISTEJ I/LUB ZOSTAŁO UZYSKANE OD DOSTAWCY USŁUG WIDEO POSIADAJĄCEGO
LICENCJĘ NA DOSTARCZANIE WIDEO AVC.
NIE UDZIELA SIĘ ŻADNYCH LICENCJI W ODNIESIENIU DO JAKIEGOKOLWIEK INNEGO ZASTOSOWANIA ANI NIE
MOGĄ BYĆ ONE DOROZUMIANE. DODATKOWE INFORMACJE MOŻNA UZYSKAĆ OD FIRMY MPEG LA, L.L.C.
PATRZ: HTTP://WWW.MPEGLA.COM

Uzyskiwanie oprogramowania na licencji GPL/LGPL

Ten produkt wykorzystuje oprogramowanie, do którego mają zastosowanie warunki dotyczące licencji GPL/LGPL.
Oznacza to, że użytkownik ma prawo do uzyskiwania dostępu do kodu źródłowego tego oprogramowania na warunkach
licencji GPL/LGPL oraz do modyfikacji i redystrybucji tego kodu.
Kod źródłowy jest dostępny w Internecie. Należy przejść do poniższego adresu URL i postępować dalej zgodnie z
instrukcjami pobierania.
https://oss.sony.net/Products/Linux/
Prosimy, by nie kontaktować się z nami w sprawie zawartości kodu źródłowego.

Kod źródłowy μT-Kernel

Ten produkt wykorzystuje kod źródłowy μT-Kernel w ramach licencji T-License 2.1 udzielonej przez TRON Forum
(www.tron.org).

5-041-958-33(1) Copyright 2022 Sony Corporation
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Dane techniczne

Ogólne

Masa
ok. 4,6 kg (sam korpus)
ok. 6,0 kg (z obiektywem SELP28135G)

Wymiary
Patrz: „Wymiary zewnętrzne”.

Wymagania dotyczące zasilania
19,5 V DC
PoE++ (zgodność ze standardem IEEE802.3bt, typ 4, klasa 8)

Pobór mocy
19,5 V DC: 80,0 W (maks.)
PoE++: 71,3 W (maks.) 

Temperatura pracy
od 0 °C do 40 °C

Temperatura przechowywania
od −20 °C do +60 °C

Format nagrywania (wideo)
XAVC Intra
Tryb XAVC-I 4K/QFHD: VBR, szybkość bitowa (maks.): 600 Mb/s, MPEG-4 AVC/H.264
Tryb XAVC-I HD: CBG, 223 Mb/s (maks.), MPEG-4 AVC/H.264

XAVC Long
Tryb XAVC-L QFHD: VBR, szybkość bitowa (maks.): 150 Mb/s, MPEG-4 H.264/AVC
Tryb XAVC-L HD 50: VBR, 50 Mb/s (maks.), MPEG-4 H.264/AVC
Tryb XAVC-L HD 35: VBR, 35 Mb/s (maks.), MPEG-4 H.264/AVC

Format nagrywania (audio)
LPCM, 24 bity, 48 kHz, 4 kanały

Szybkość klatek przy nagrywaniu

XAVC Intra
Tryb XAVC-I 4K: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
Tryb XAVC-I QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Tryb XAVC-I HD: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
Tryb XAVC-L QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Tryb XAVC-L HD 50: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
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Tryb XAVC-L HD 35: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Czas nagrywania/odtwarzania
XAVC Intra
Tryb XAVC-I QFHD: 59.94P, ok. 30 minut (w przypadku korzystania z karty pamięci CEA-G160T)
Tryb XAVC-I HD: 59.94P, ok. 78 minut (w przypadku korzystania z karty pamięci CEA-G160T)

XAVC Long
Tryb XAVC-L QFHD: 59.94P, ok. 115 minut (w przypadku korzystania z karty pamięci CEA-G160T)
Tryb XAVC-L HD 50: 59.94P, ok. 155 minut (w przypadku korzystania z karty pamięci CEA-G80T)
Tryb XAVC-L HD 35: 59.94P, ok. 210 minut (w przypadku korzystania z karty pamięci CEA-G80T)

Uwaga

Czas nagrywania/odtwarzania może się różnić w zależności od warunków użytkowania i parametrów karty pamięci. Czasy
nagrywania i odtwarzania podano w odniesieniu do ciągłego nagrania w postaci pojedynczego klipu. Rzeczywiste czasy mogą
być krótsze w zależności od liczby nagranych klipów.

Sekcja dotycząca napędu mechanizmu obrotu w poziomie/pionie

Minimalna prędkość obrotu w poziomie: 0,02 st./s
Minimalna prędkość obrotu w pionie: 0,02 st./s
Maksymalna prędkość obrotu w poziomie: 60 st./s
Maksymalna prędkość obrotu w pionie: 60 st./s
Zakres obrotu w poziomie: od −170 st. do +170 st.
Zakres obrotu w pionie: od −30 st. do +195 st.
Poziom hałasu: NC35 lub niższy
Ustawienia wstępne położenia: 100

Sekcja kamery

Przetwornik obrazu
Przetwornik CMOS Exmor R, pełnoklatkowy 35 mm (35,6 × 23,8 mm)

Liczba pikseli
Około 12,9 megapiksela (łączna liczba pikseli)
Około 10,3 megapiksela (efektywna liczba pikseli)

Automatyczne ustawianie ostrości
Metoda pomiaru: pomiar kontrastu / przesunięcia fazowego

Wewnętrzne filtry ND
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Zmienny liniowo filtr ND: od 1/4ND do 1/128ND

Czułość ISO
ISO 800/12800 (tryb Cine EI źródło światła D55)

Mocowanie obiektywu
Mocowanie typu E

Zakres dynamiki
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Ponad 15 nastaw

Czas otwarcia migawki
od 64F do 1/8000 s (23.98P)

Kąt otwarcia migawki
od 5,6° do 360°, od 2 do 64 klatek

Zwolnione/przyspieszone tempo
XAVC QFHD: od 1 kl./s do 120 kl./s
XAVC HD: od 1 kl./s do 240 kl./s
XAVC 4K: od 1 kl./s do 60 kl./s
XAVC HD (S35): od 1 kl./s do 120 kl./s

Balans bieli
od 2000 K do 15000 K

Wzmocnienie
od −3 dB do +30 dB (z regulacją co 1 dB)

Wygląd podstawowy
S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Sekcja dźwięku

Częstotliwość próbkowania
48 kHz

Kwantyzacja
24-bitowa

Pasmo przenoszenia
Tryb MIC wejścia XLR: od 20 Hz do 20 kHz (±3 dB lub mniej)
Tryb LINE wejścia XLR: od 20 Hz do 20 kHz (±3 dB lub mniej)

Zakres dynamiczny
Tryb MIC wejścia XLR: 80 dB (typowo)
Tryb LINE wejścia XLR: 90 dB (typowo)

Zniekształcenie
Tryb MIC wejścia XLR: 0,08% lub mniej (poziom wejściowy: −40 dBu)
Tryb LINE wejścia XLR: 0,08% lub mniej (poziom wejściowy: +14 dBu)

Sekcja dotycząca wejść/wyjść

Wejścia
DC IN

Złącze zgodne ze standardem EIAJ, 19,5 V DC

AUDIO IN

Złącze żeńskie typu XLR, 5-stykowe
LINE / MIC / MIC+48V (możliwość przełączania)
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MIC: poziom odniesienia od −30 dBu do −80 dBu

GENLOCK IN

Złącze BNC, 1,0 Vp-p, 75 Ω

TC IN

Złącze BNC

Wyjścia
SDI OUT

Złącze BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Złącze typu A

Złącze wyjściowe OPTICAL

Zgodność ze standardem SFP+
* Urządzenie nie obsługuje optycznego sygnału wejściowego.

Wejścia/wyjścia
Złącze LAN

RJ-45, 1000BASE-T

Złącze OPTION

RJ-45, złącze wejścia/wyjścia lampki typu Tally

Sekcja dotycząca gniazd nośników

Gniazdo na karty CFexpress typu A / karty SD (2)

Dołączone akcesoria

Zasilacz sieciowy (1)
Przewód zasilający (1)
Pilot zdalnego sterowania na podczerwień (1)
Dekielek na korpus (1) (zamocowany do urządzenia)
Płytka mocująca do kabla HDMI (1)
Przed użyciem tego urządzenia (1)
Książeczka gwarancyjna (1)

Wymiary zewnętrzne

Wartości wymiarów są przybliżone.
Jednostka: mm

Obudowa kamery
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Uchwyt sufitowy
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Konstrukcja i dane techniczne mogą ulec zmianie bez powiadomienia.

5-041-958-33(1) Copyright 2022 Sony Corporation
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Przewodnik pomocy

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Znaki towarowe

 to znak towarowy firmy Sony Group Corporation.
XAVC i  są zarejestrowanymi znakami towarowymi firmy Sony Group Corporation.
Nazwy HDMI i HDMI High-Definition Multimedia Interface oraz logo HDMI są znakami towarowymi lub zastrzeżonymi
znakami towarowymi firmy HDMI Licensing Administrator, Inc., zarejestrowanymi w Stanach Zjednoczonych i innych
krajach.
Microsoft i Windows są znakami towarowymi lub zastrzeżonymi znakami towarowymi firmy Microsoft Corporation,
zarejestrowanymi w Stanach Zjednoczonych i/lub innych krajach.
Mac i macOS są zastrzeżonymi znakami towarowymi firmy Apple Inc., zarejestrowanymi w Stanach Zjednoczonych i
innych krajach.
Logo „Catalyst Browse” jest znakiem towarowym lub zarejestrowanym znakiem towarowym firmy Sony Group
Corporation.
IOS jest znakiem towarowym lub zastrzeżonym znakiem towarowym firmy Cisco, zarejestrowanym w Stanach
Zjednoczonych i innych krajach. Jest wykorzystywany na podstawie licencji.
iPadOS, Safari oraz iPad są znakami towarowymi firmy Apple Inc., zarejestrowanymi w Stanach Zjednoczonych oraz
innych krajach i regionach.
Android i Google Chrome są znakami towarowymi lub zastrzeżonymi znakami towarowymi firmy Google LLC.
Wi-Fi jest zastrzeżonym znakiem towarowym stowarzyszenia Wi-Fi Alliance.
Logo SDXC jest znakiem towarowym firmy SD-3C, LLC.
CFexpress i logo CFexpress Type A są znakami towarowymi stowarzyszenia CompactFlash Association.
NewTek™ i NDI® są znakami towarowymi lub zastrzeżonymi znakami towarowymi firmy NewTek, Inc.
JavaScript jest zastrzeżony znakiem towarowym firmy Oracle i/lub jej podmiotów stowarzyszonych.
Intel, logo Intel i Intel Core są znakami towarowymi firmy Intel Corporation lub jej podmiotów zależnych.
QR Code jest znakiem towarowym Denso Wave Inc.
Wszystkie inne nazwy firm i nazwy produktów są znakami towarowymi lub zastrzeżonymi znakami towarowymi ich
właścicieli. Pozycje chronione znakiem towarowym nie są oznaczone symbolami ™ lub ® w niniejszym dokumencie.

5-041-958-33(1) Copyright 2022 Sony Corporation
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